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Chapter 1. Release Notes

Operations Hub Release Notes
This topic provides a list of product changes in Operations Hub for this release.

Version: 2.1

Table 1. Enhancements and New Features

The following enhancements and new features have been added.

Description Tracking IDs

Added these features to the Trend Card (page 376) widget:

• Introduced the option to trend historical data using ‘Now’ (current time) and go back
in time to view past trends. Previously in the trend charts, ‘start time plus duration’
was employed instead of ‘end time minus duration’, which led to missing trends. The
‘Now’ enabled charts can be saved to favorites to reload later.

• Enabled to select a favorite trend chart during designing the application. The
selected favorite loads by default in the end application.

• Added the ability to have a common Y-axis for all the tags/sources trending on the
chart.

• Allowed for configuring a default sampling mode from the available modes during
designing the application.

F58643

F54465

F60413

F60129

Provided support for working with alarms in Operations Hub:

• Use alarm card (page 396) and alarm count (page 406) widgets.
• Apply filter conditions (page 403) and acknowledge alarms (page 405).

F49616, F49617

Provided support for working with mimics in Operations Hub:

• Import mimics from your HMI SCADA systems (page 240).
• Configure mimics (page 241).
• Use the mimic widget in your applications (page 406).

F49619

Introduced the Indicator (page 393) widget. It contains several options (Analog, Status,
and Image), which supports the plugin features released with Operations Hub 2.0. This
widget will appear under the Integration > General group in the Designer. All integrated
plugins cannot be deleted.

Included the CIMPLICITY HMI Webspace (page 354) widget for this release.

F58211

Added two new widgets - Solid Gauge (page 420) and Timeline (page 422). F60615, F60534

Support for installing both Operations Hub and Historian on the same box (page 38). F58922

Table 2. Known Issues and Limitations
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The following known issues and limitations exist.

Description Tracking ID

When you save a favorite in a trend chart, if you include a special character in the name,
the error message that appears does not specify the issue.

DE123967

In a trend chart, if you add a tag that is identical to the one that is already plotted but the
case of the tag name does not match the case of the tag name in Historian, a straight
line appears in the trend chart. To resolve this issue, modify the tag name to match the
case of the tag name in Historian.

DE123833

During Operations Hub installation, when you provide the tenant user ID, the following
conditions apply:

• If you are installing Operations Hub for the first time, do not provide StudioAdmin as
the tenant user ID because it is used by Operations Hub.

• If you want to use a shared UAA to work with Operations Hub, do not provide the
user ID of an existing user of the UAA instance. If you do so, the installation fails.

• If you are installing Operations Hub after uninstalling it without purge, do not provide
a tenant user ID that matches any previously used user ID (including any previously
used tenant ID). This is because after you uninstall Operations Hub without purge,
previous Operations Hub users (along with tenant administrators, their groups, and
privilege assignments) still exist in the database.

DE123770

Some widgets, such as a table, do not work as expected when used with a REST query.
In particular, features which require additional queries to fetch more data (such as
pagination), as well as features limiting data (such as row limits) may not work.

DE118883

When you create a data source, you can provide a certificate only in the base-64-
encoded format. A DER-encoded certificate is not supported.

DE116706

Operations Hub uses Kafka, which generates a large number of logs in the following
location: C:\tmp\kafka-logs\. To avoid consuming too much space for these logs,
we recommend that you periodically delete the logs, especially if the system has low disk
space.

N/A

If you encounter intermittent responsiveness issues with the Operations Hub runtime
environment when using the Safari browser on your mobile device, it is recommended
that you use the Chrome browser instead.

DE131011

When adding environment variables to Windows System Variables, be aware that
environment variables are case-sensitive. If your environment variables in Operations
Hub do not match the case of the ones used by the target Historian Server, the data
source will fail when tested. Be sure that you use the same case when configuring data
sources in Operations Hub. A data source target in Operations Hub should match the
case in the environment variables, as the variables are case-sensitive.

DE130896

Historian REST response time increases exponentially when there are over 30 users
logged into Operations Hub accessing an End app that utilizes Historian REST queries.

DE134904

When using Safari 13+ on iOS, trend card functionality like adding tags to the trend,
favorites, and annotations perform inconsistently. The workaround is to use the Chrome
browser on the iPad.

DE136597, DE149433
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Description Tracking ID

If a Historian data point being trended transitions to a bad quality (such is the case when
a collector goes down or loses communications), the trend card displays a flatline for the
last known good value. If you experience one or more flatlines in your trends, and all the
various requests from the same source, you should check the communication chain for
an issue with Historian, a collector, or a SCADA driver, for instance.

DE138128

There are currently some page printing issues. For instance, if you have iframe that spills
over to a second page, that can cause an issue.

DE146462

The uaa-provisioning.log file generates in a new folder if the location path provided
during Operations Hub installation contains a space in it. For example, C:\Custom
Logs.

DE148827

As a workaround to address VC++ (x64) failure, follow these steps to install Task Client
on Operations Hub 2.1.

1. Uninstall the VC++ 2015-2019 Redistributable (x64) version installed with
Operations Hub 2.1.

2. Open the Workflow install media, navigate to the  \Installers\Resources\Microsoft
\2015_2019 folder, and run the vc_redist.x64.exe.

3. Open the Services console dialog and restart these services:
• GE Operations IQP PostgreSQL Database
• GE Operations UAA PostgreSQL Database

4. Install Workflow Task Client.
5. Install the VC++ 2015-2019 Redistributable (x64) version that got installed with

Operations Hub 2.1.

DE161643

If the Data Distributor service started at a time when the datasource was offline, reload
the end application.

DE158762

For REST connection, if you enter an IP address instead of the hostname in the Auth
URL field, it results in a 404 error. You must add the IP address to the list of supported
subdomains/zones. To do this:

1. Browse to the location directory on the machine where Operations Hub is installed:
..\ProgramData\GE\Operations Hub\uaa-config

2. Open the uaa.yml file in a text editor.
3. Search for hostnames in the file, and enter the IP address.
4. Save and close the file.
5. Restart UAA for the changes to take effect.

DE153631

When importing a model containing a second CIMPLICITY namespace table, it
overwrites the values in the first namespace table.

Workaround: Combine the server and namespace information from the two namespace
tables into one namespace table, and then import the model again.

DE47669

The inline mimic write operations performed in Operations Hub are indicated as
successful even if the entries did not meet the criteria of these CIMPLICITY attributes.

• WARNING_LOW_N
• WARNING_HIGH_N
• ALARM_LOW_N
• ALARM_HIGH_N

The values do not get updated to the CIMPLICITY point control panel.

DE156030

https://www.ge.com/digital/documentation/workflow/t_wf_install_task_client.html
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Description Tracking ID

Error message does not appear when you perform a write operation on a CIMPLICITY
tag value that is outside of a given range.

DE157698

If you select Acknowledge All in Operations Hub to acknowledge 5000 iFIX alarms, an
internal error occurs in the iFIX application.

DE161742

Only a single instance of the CIMPLICITY HMI Webspace widget per app is supported. If
using multiple instances of webspace widgets across multiple pages, you may encounter
access error messages when navigating between pages that contain webspace
instances. After confirming the message, the widget loads as expected.

The typeName parameter in the custom widget’s manifest.json file does not support
special characters.

DE162893

Table 3. Fixed Defects

The following fixed defects have been addressed with this version of Operations Hub.

Description Tracking ID

Data definition queries did not acknowledge a data source by its alias name. References
were hard coded to the actual Historian or the OPCUA server, which resulted in loss of
data if the data source name was changed. As a workaround, queries had to be rebuilt to
recognize the changed data source name to make them work with widgets. Support for
data source alias name resolves this issue.

To support data source aliasing, the SIM introduces a change in the format on how data
sources are referenced in the extension queries. After the upgrade,

• Newly created extension queries in Operations Hub 2.01 SIM 1 will reference data
sources in the appropriate format.

• For extension queries built in Operations Hub 2.0, resave the applications to
automatically update the existing data source references to use the appropriate
format.

DE146120

Added Proficy Workflow as a connection type. This fix allows Operations Hub to import
model export files using Workflow 2.6 SP1 SIM3. Refer to Configure the Task Client
(page 388) for setup information.

DE149749

Previously, acknowledging a session timeout dialog led to an expired or invalid license
key page. This issue has been resolved.

DE149966

Previously, the Base URL field was missing on opening a REST query page. This issue
has been resolved.

DE153796

Previously, app globals were not taking the flowInstanceId into consideration when
dependencies were deleted. This issue has been resolved.

DE154344

Previously on duplicating a page, app global bindings were lost. This issue has been
resolved.

DE153940

Previously on duplicating a page, system global bindings were lost. This issue has been
resolved.

DE151225

Custom widget bindings were lost after upgrading to a newer version or importing the
app. This issue has been resolved.

DE153791



Operations Hub for Windows | 1 - Release Notes | 14

Description Tracking ID

Previously, the data source server was not updating data to the widgets. This issue has
been resolved.

DE154705

Previously, the IQP shadow user account was not getting created upon logging into the
end application. This issue has been resolved.

DE154014

Data source information was missing after upgrading from Operations Hub 2.0 to SIM3/
SIM4 version. This issue has been resolved.

DE156281

Previously, modifying globals did not allow to save the application. This issue has been
resolved.

DE156088

Previously, the test connection for a new data source failed with the message, "Failed
to connect to the System API endpoint" even when the data source server was up and
running. This issue has been resolved.

DE154279

Previously, the auto-update requests from the client were not being sent to the server.
As a result, the data from the data source was not getting populated to the widgets. This
issue has been resolved.

DE154653

Issues with copy/paste of widgets in an Operations Hub 2.0 Development Environment
have been resolved.

DE154604

Previously, it was not possible to run queries if an 'out of range' occurred on the page.
This issue has been resolved.

DE154628

Previously, SQL error triggered an 'Unknown Error' and locked the query. This issue has
been resolved.

DE154630

Previously, 'Error running an extension query' popped up occasionally. This issue has
been resolved.

DE156840

After upgrading from version 1.7 to 2.0, the export model feature stopped working. This
issue has been resolved.

DE154108

Successfully renamed apps retained their original name after reloading the browser. This
issue has been resolved.

DE156188

Widgets with inputs, which feed an entity query were not working properly. This issue has
been resolved.

DE157340

Previously, the OPC UA test connection failed with a ‘Certificate Uri is Invalid' error if the
URI specified in the UA SDK session call did not match with the URI in the certificate.
This issue has been resolved.

If upgrading from Operations Hub 2.0 to 2.1, make sure to revert the changes made to
the ServerConfig.xml file. Follow these steps:

1. Go to C:\Program Files\GE\Operations hub\BrowseService.
2. Open ServerConfig.xml and search for:

<ServerUri>urn:<machine name in capital
 letters>:proficy:webhmi:dataservices</ServerUri>

Replace <machine name in capital letters> with [NodeName].

3. Save and close the XML file.
4. Go to Operations Hub trusted store C:\ProgramData\GE\Operations Hub\pki\trusted

\certs and delete the existing certificate.
5. Visit your data sources and trust them all over again to reissue the certificate.

DE149878, DE149879
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Description Tracking ID

At runtime, when you mouseover a visualization widget (bar chart) after zooming in and
moving the X-axis, the text box containing time and value was displayed away from the
mouse pointer. This issue has been resolved. Data is displayed whereever the mouse
points even if you zoom in and move the X-axis on the widget.

DE150562 / SF 00907369

Previously, multiple attempts to open an application page at runtime led to display freeze.
This issue has been resolved.

DE153382 / SF 00919035

When working with the dropdown widget, there was no check box for the Submit on
Change property. This issue has been resolved to provide a check box option to submit
the query.

DE153383 / SF 00919907

Previously on launching an application, images in the application were loaded incorrectly.
However, after refreshing the page, all images load correctly. This issue has been
resolved.

DE153386 / SF 00921978

Previously, Operations Hub login was unsuccessful with an error stating that the email
or password could not be verified for the OphubAdmin account. This issue has been
resolved.

For 2.0 version, the password cannot be 15 characters long. This rule does not apply for
versions 1.7 and earlier, and also for 2.1 and later.

DE154026 / SF 00927322

Previously for SQL data source, if you changed the default static port for SQL to a
different port, it was not getting saved. This issue has been resolved.

DE155933

The Favorite dialog in the trend widget appeared blank on attempting to add a trend
to favorites. The fields in the dialog box did not display any text. This issue has been
resolved.

DE155935

The date picker widget had inconsistencies in choosing a date and time. This has been
fixed. You can use the 24-hour clock time format to pick a time.

DE156422 / SF 00934396

Previously, interactive map images in a duplicated app were lost if the original app was
deleted from Operations Hub. Code has been modified to fix this issue. The image
references also get duplicated instead of referring to the images from the original app.

DE156513 / SF 00935551

Previously, check box was always aligned to the left at runtime even when you specified
a different alignment in the Operations Hub designer. This has been fixed to align as
expected. The check box includes a label to enter text.

DE156613 /SF 00936087

Deleting one of the many queries from an application page with interactive map led to
data loss on all the markers. This issue has been resolved.

DE156754 / SF 00935377

Widget IDs were getting deleted on duplicating an application page. As a result, the UI
page globals that utilized the IDs as a reference stopped working. This issue has been
resolved.

DE157191

Previously, the table widget properties Allow Download and Load <number> rows at a
time were not delivering results as expected at runtime. This issue has been resolved.

DE157267

If the grid and breadcrumb widgets were used in an application page, the grid overlapped
the breadcrumb at runtime. This issue has been resolved.

DE157790 / SF 00937306

The date picker widget was not displaying properly at runtime due to a CSS issue. The
CSS for the widget was being imported via. CDN URL, which failed at times leading to
improper display of the date picker. The CSS stylesheet is now bundled with the date
picker to fix the issue.

DE158072 / SF 00940530
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Description Tracking ID

Previously, the trend card did not respond to the selected asset context. To fix this,
enabled to read the manual and global value on loading the breadcrumb at runtime.

DE158133 / SF 00940524

Previously data sources in Operations Hub were loaded only after waiting for a few
minutes. Initially an error message appeared that data sources cannot be loaded. The
error message has been updated to fix this issue. If the IQP Tomcat service has just
started (under 10 minutes), then an error message alerts to try accessing data sources
again in a few minutes.

DE158134

Previously, you were not able to delete Actions defined for an interactive map widget.
This issue has been resolved.

DE158410 / SF 00939430

Previously during app import, duplicating an app that is already present in Operations
Hub led to inconsistencies in naming convention. The query/entity in the duplicated
page appears with its original name instead of the duplicated name. This issue has been
resolved.

DE158423 / SF 00935860

Previously, application pages were accessible to users who did not possess access
permission to those pages. This issue has been resolved.

DE158827 / SF 00939012

On opening an application page with breadcrumb, the root was always getting displayed.
This has been fixed to load the default asset whenever loading the page.

DE159272 / SF 00936366

Table 4. Compatibility Matrix

The following products are compatible with Operations Hub.

Product Required Version

Proficy Historian
• Historian 7.2 with the latest SIM
• Historian 8.0
• Historian 8.1
• Historian 9.0
• Historian 9.1

Note:  Historian REST APIs are required for REST
integration between Operations Hub and Historian 8.x and above.
Historian REST APIs are installed automatically when you install
Historian web-based clients.

Proficy Plant Applications
• Version 8.0, SIM3, for Integrated Process Apps
• Version 8.1
• Version 8.2

User Authentication and Authorization (UAA)
service

Version 2.1
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Product Required Version

Proficy iFIX
• 6.0 (read operations)
• 6.1 (read operations)
• 6.5 with latest SIM (OPC UA + Workspace) (read and write

operations)

Note:  Mimic and model publish to Operations Hub 2.1 is
supported only with iFIX 6.5.

Proficy CIMPLICITY
• 10 (read operations)
• 11 (read operations)
• 11.1 (read and write operations)

Note:  Mimic and model publish to Operations Hub 2.1 is
supported only with CIMPLICITY 11.1.

GE Common Licensing Version 23.0.0.406



Chapter 2. Getting Started in Windows

Installing Operations Hub on Windows

System Requirements
This topic provides the requirements for hardware components, browsers, and operating systems.

When you install Operations Hub, all the required components are automatically installed.

Minimum Hardware Requirements

You can install Operations Hub on a processor with 4-core configuration and a RAM of 16 GB.

To support up to 300 concurrent users, you need a hardware configuration of at least 32GB and an 8-
core CPU.

Supported Operating Systems

You can install Operations Hub on any of the following desktop operating systems:

• Microsoft Windows Server 2016
• Microsoft Windows Server 2019

Supported SQL Versions

You can use Operations Hub with external data sources from the following relational databases:

• Microsoft SQL Server 2016
• Microsoft SQL Server 2017
• Microsoft SQL Server 2019

Supported Browsers

You can access Operations Hub using any of the following web browsers:

• Google Chrome (recommended)
• Mozilla Firefox
• Apple Safari
• Chromium Edge
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We recommend using a resolution of 1600 x 1200 for the browser. In addition, use a relatively
modern device so that the browser has enough resources to render the visualizations and respond to
user interactions with adequate performance.

The following mobile devices are supported for client access (end-app support only):

• iOS 12.0 or later
• Android 9.0 or later

Note:  We recommend using a device with medium to high resolution, and in landscape mode.

Compatibility Matrix

The following products are compatible with Operations Hub.

Product Required Version

Proficy Historian
• Historian 7.2 with the latest SIM
• Historian 8.0
• Historian 8.1
• Historian 9.0
• Historian 9.1

Note:  Historian REST APIs are required for REST
integration between Operations Hub and Historian 8.x and above.
Historian REST APIs are installed automatically when you install
Historian web-based clients.

Proficy Plant Applications
• Version 8.0, SIM3, for Integrated Process Apps
• Version 8.1
• Version 8.2

User Authentication and Authorization (UAA)
service

Version 2.1

Proficy iFIX
• 6.0 (read operations)
• 6.1 (read operations)
• 6.5 with latest SIM (OPC UA + Workspace) (read and write

operations)

Note:  Mimic and model publish to Operations Hub 2.1 is
supported only with iFIX 6.5.
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Product Required Version

Proficy CIMPLICITY
• 10 (read operations)
• 11 (read operations)
• 11.1 (read and write operations)

Note:  Mimic and model publish to Operations Hub 2.1 is
supported only with CIMPLICITY 11.1.

GE Common Licensing Version 23.0.0.406

Licenses for Operations Hub
This topic describes the licenses available, and the differences between them.

Install the licensing client software from the Operations Hub ISO right after installing Operations
Hub.

Note:  Previous licensing is replaced with Proficy licensing. For information on installing and
configuring your license, refer to the GE Support site.

These are the three license levels for using Operations Hub.

Trial Version

If you do not have a license yet, you can start with a trial version that lasts for a period of two hours,
and is limited to a single user.

Operations Hub Add-On for Historian

It is available as an Add-On when you purchase Proficy Historian. This is the only application
provided for this tier with limited functionality. Refer to the Functionality Comparison (page 21)
table to compare with the full product functionality.

https://ge-ip.force.com/communities/en_US/Article/GE-Intelligent-Platforms-Software-Product-Licensing
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Analysis Tier

With this tier, you have complete access to Operations Hub end-to-end functionality.

Functionality Comparison

Functionality
Operations Hub Add-

On for Historian
Analysis Tier

Ability to create, edit, and delete data
sources

Yes Yes

Ability to create, edit, and delete
entities

Yes Yes

Ability to create, edit, and delete
queries

Yes Yes

Ability to assign permissions for
events

Yes Yes

Ability to view Out of the box Analysis
App

Yes Yes

Ability to create, edit, and delete apps No Yes

Ability to assign permissions for apps Yes Yes

Ability to assign permissions for app
pages

Yes Yes

Ability to create, edit, and delete
users

Yes Yes

Ability to change your own password Yes Yes

Ability to create, edit, and delete roles Yes Yes

Ability to map existing UAA groups Yes Yes

Ability to map Existing LDAP groups Yes Yes

Install Operations Hub
This topic describes how to perform step-by-step installation of Operations Hub.

• Ensure that the machine on which you want to install Operations Hub meets the System
Requirements (page 18).

• Use a machine that does not host any applications that are bundled with Operations Hub.
• Run a Windows update (including security updates).
• Use a host name that contains up to 24 characters and any of the following characters:

◦ Alphabetic characters
◦ Numeric characters
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◦ Minus
◦ Period

• Ensure that you have administrative privileges to the machine on which you want to install
Operations Hub.

This topic describes how to install Operations Hub stand-alone (by downloading the installer from
Salesforce). If, however, you want to use only the Historian analysis application in Operations Hub,
you can choose to install just the Operations Hub add-on for Historian. If you do so, you will not be
able to create, modify, or delete any applications or components of applications in Operations Hub.

You can also install Operations Hub automatically (page 36).

1. Run the Operations Hub installation DVD, and then select Install GE Operations Hub 2.0.
The Welcome to GE Operations Hub page appears.

2. Select Next.
The Read and accept the license agreement to continue page appears.
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3. Select the Accept check box, and then select Next.
The TCP port check page appears, specifying whether the ports chosen for Operations Hub are
available.
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4. If you want to review or change the ports that will be used by Operations Hub, select the Show
Details check box.
The TCP port assignments page appears, providing a list of ports that will be used by the
various components in Operations Hub.
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Note:  Use care when changing port numbers so that there is a not a conflict with an existing
application. Generally, a port number higher than 1023 should be assigned, since ports 0 to1023
are well known ports typically already assigned on Windows systems for different purposes.

5. If needed, modify the port numbers, and then select Next.
The Host Names page appears. By default, the All Host Names box contains a value, and the
Primary Host Name box is disabled and populated with the first value in the All Host Names
box.
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6. In the All Host Names box, enter any of the following details of the machine for which you
want to access Operations Hub following the install:

• Fully qualified domain name
• host name
• IP address

Note:
• If you want to provide more than one of the aforementioned values, use a comma to

separate them.
• If you want to add the Fully Qualified Domain Name (FQDN) after completion of the

install, the safest way to apply the FQDN is to uninstall without purge, and then reinstall
with the FQDN in the Host Names screen.

The Primary Host Name box is updated with the first value in the All Host Names box.

7. Select Next.
The User Authentication and Authorization Service page appears.
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8. If you want to use the User Authentication and Authorization (UAA) service that is integrated
with Operations Hub, enter a password in the Admin Client Secret and Re-enter Secret boxes.
Otherwise, skip to the next step.

Note:  The client secret password cannot contain the ampersand (&) or percent (%) special
characters.

9. If you want to use an external UAA service, select the Use External UAA check box.
When this check box is selected, the following information appears in the install screen.
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10. For external UAA, provide values as specified in the following table.

Item Description

UAA Base URL Enter the URL of the UAA service.

Note:
• If referencing Historian 7.x UAA, then use a

URL similar to this: https://Historian7x:8443; if
referencing Historian 8.x then use a URL of https://
Historian8x (no port number).

• Historian 7.x requires a different port than Historian
8.x. For Historian 7.x, the default port to connect to
UAA is 8443. For Historian 8.x, the default port to
connect to UAA is 443.

• If the ports were customized, then use the selected
port.

Admin Client Id Enter the ID of the administrator account of the UAA
client.

Admin Client Secret Enter the password of the administrator account.
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Item Description

UAA certificate file Enter the path to the certificate file used by the UAA
service.

Note:
• If provided, the certificate file must be a .pem file for

the root issuer (not the UAA server certificate).
• Export the root certificate from Historian and

save using the Base 64 option (as shown in the
following figure). Then, rename the exported .cer
file to .pem so you can use it here in Operations
Hub.

• After completion of install, this certificate should
also be imported into Trusted Root Certification
Authorities certificate store on client machines,
to suppress warnings given by browsers such as
Chrome.

The Test button allows you to test the connection to the External UAA instance based on the
information provided in the dialog box. Some of the possible messages encountered that a user
may need to correct when the Test button is exercised are summarized in the table below:
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Issue Warning Resolution

Invalid credentials 401 Unauthorized. Check the admin client id and
admin client secret provided to the
External UAA URL.

No certificate The test will pass, but the user is
requested to provide the UAA root
issuer’s certificate.

Provide the UAA root issuer
certificate file in the install.

Invalid certificate Test succeeds but the certificate
is not used- error reported if bad
certificate used.

Provide the correct UAA root issuer
certificate file in the install.

Incorrect case sensitivity in URL or
host name has a mismatch

Test succeeds but changes are
required due:

• External UAA server name
resolution.

• Actual mismatch with the “UAA
base URL” and the issuer Uri in
the “uaa.yml file.

Make sure the issuer Uri in the
uaa.yml file and the UAA Base URL
match exactly.

Error connecting to External UAA External UAA server name
resolution issue.

Check to make sure the External
UAA is running. Check to make
sure the issuer Uri in the uaa.yml
file and the UAA Base URL match.

Error negotiating TLS connection The issuer Uri in the uaa.yml has
just the host name while the user
provides an FQDN in the UAA base
URL.

This error happens either while
testing the user entered UAA Base
URL or when testing the issuer Uri.
The error message will indicate
what issue is. The root cause is due
to either the name in the UAA base
url or the issuer URI name under
testing can not be authenticated by
the certificate provided.

Again, make sure the issuer Uri in
the uaa.yml file and the UAA Base
URL match exactly.

Note:
• To locate the uaa.yml file on the Historian machine, go to the following folder: C:

\ProgramData\GE\Operations Hub\uaa-config\uaa.yml. Find the issuer: uri: https://
Hist80vm/uaa.

• The install is not blocked from proceeding without the corrections from the previous
table. However, there will be some runtime errors which may require an administrator to
reconfigure. See the following Historian 8.x and Historian 7.x scenarios.
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For Historian 8.x: If the UAA URL in the Operations Hub install does NOT match the
Historian 8.x UAA URL, then you will receive an "Issue not trusted" error when attempting
to import a model. Examples of UAA URLs used during the Operations Hub install may be a
URL with a Fully Qualified Domain Name (FQDN) or one that includes a Port Number such
as: https://z840his2019:443/uaa. If there is a mismatch, change Historian UAA’s uaa.yml file so
the issuer uri matches what’s in the certificate. If Historian 8.x is installed with a Fully Qualified
Domain Name (FQDN), then utilize the FQDN when specifying the external UAA URL. For
example: http://HistFQDN/uaa.

If Historian 8.x is installed with a host name like “Historian8,” then utilize the host name when
specifying the external UAA URL. For example: http://Historian8/uaa

Basically, the issuer Uri in the uaa.yml file and the UAA Base URL must match exactly. This
will ensure the Operations Hub Administrator user is able to login successfully.

For Historian 7.x: If the UAA URL in the Operations Hub install does NOT match the
Historian 7.x UAA URL, then you will receive an "Issue not trusted" error when attempting to
import a model. To resolve this:

a. Get the external UAA URL that you entered during install. For example, it might be
something like: https://historian7:8443/uaa.

b. Go to the Historian machine.
c. Locate the uaa.yml file at this location: C:\Program Files\GE Digital\UAA\uaa.yml.
d. At the end of the file, add the following lines:

issuer:
uri: https://historian7:8443/uaa

If Historian 7.x has been installed with a host name like “historian7,” then it is recommended to
use the external UAA URL of https://historian7:8443/uaa during the Operations Hub install. In
this case, the Operations Hub Admin user is created correctly, and it will avoid “invalid redirect
URL” error.

11. Select Next.
The Create Tenant Admin Account page appears.

https://historian7:8443/uaa
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12. Provide values as specified in the following table, and then select Next.

Item Description

User Id Enter the user ID of the administrator account for
Operations Hub. When you provide the tenant user ID,
the following conditions apply:

• If you are installing Operations Hub for the first
time, do not provide StudioAdmin as the tenant
user ID because it is used by Operations Hub.

• If you want to use a shared UAA to work with
Operations Hub, do not provide the user ID of an
existing user of the UAA instance. If you do so, the
installation fails.

• If you are reinstalling Operations Hub, do not
provide the tenant user ID that you previously
provided. This is because even if you purged the
data while uninstalling Operations Hub, the user
account, along with the groups and privileges
assigned to the user, still exists in the UAA
instance.

Password Enter a password for the administrator account.

Re-enter Password To confirm, re-enter the password for the administrator
account.

The Select Drive for Programs and Data page appears.

13. If you want to choose a different drive to install, select the Customize Install Drive check box.
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A list of available fixed hard drives on your system appears on the install screen. This screen
appears only when there is more than one fixed hard drive on the host machine.

14. Select the drive where you want to install, then select Next.
The Customize Log Files and Postgres Data Locations page appears.
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15. Provide values as specified in the following table, and then select Next.

Item Description

Log Files Base Folder Enter the path to the log files generated by
Operations Hub. By default, the value in this box is
%ProgramData%\OphubLogs.

Base Folder for Databases Enter the path to the base folder for the UAA,
Operations Hub, and WebHMI databases. If you
want to use the default folder, leave this box blank.
Otherwise, enter the path to the folder that you want to
use.

Customize database locations individually for
subsystems

Select this check box if you want to use different folders
for each database.

UAA Database Folder This box appears only if you have selected the
Customize database locations individually for
subsystems check box. Enter the database folder that
you want to use for UAA. If you want to use the default
folder, leave this box blank.

IQP Database Folder This box appears only if you have selected the
Customize database locations individually for
subsystems check box. Enter the database folder that
you want to use for Operations Hub. If you want to use
the default folder, leave this box blank.
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Item Description

WebHMI Database Folder This box appears only if you have selected the
Customize database locations individually for
subsystems check box. Enter the database folder that
you want to use for WebHMI. If you want to use the
default folder, leave this box blank.

The You are ready to install page appears.

16. Select Install.
After the installation is complete, a message appears, specifying that the installation is complete.
A link to the log folder appears. All the services used by Operations Hub are started.

Important:
a. It is recommended that you restart your computer following an upgrade of Operations Hub

if Plant Applications and Operations Hub coexist on the same resource.
b. After upgrading to Operations Hub 2.0, you will notice the IQP designer uses app_name

instead of app_id in its URLs.
c. If upgrading from 2.0 to 2.1, restart the WebClient services to allow the Plant Applications

Web Client to connect successfully to Operations Hub.
• If using Enterprise WebClient version, restart the Docker service.
• If using Standard WebClient version, restart the GE PlantApps WebClient Master

Control service.
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d. Remember to clear your browser cache after upgrading to a newer version of Operations
Hub.

Install the Certificate on your Clients (page 37) (on each client that you will use to access
Operations Hub ), and then log in to Operations Hub (page 43).

Install Operations Hub Automatically
This topic describes how to install Operations Hub automatically.

1. In the Operations Hub installation folder, open the windows.env file in a text editor.

Note:  We recommend that you back up the original windows.env file.

2. As needed, provide values for the parameters, and save the file.

3. Open Command Prompt, and run the following command: <Operations Hub installation
folder>\OpHub-Windows-Installer>ophub_bundle <switch>, where <switch> is one of
the following values:

• -q, -quiet, -s, -silent: Use one of these values to initiate the automated installation.
• -passive: Use this value if you want progress bar to appear during the installation.
• -norestart: Use this value if you do not want services to be restarted during the installation.
• -promptrestart: Use this value if you want a message to appear, asking whether services

must be restarted.

Operations Hub is installed.

To install to a different drive from the command line, refer to Non-System Drive Install (page
36).

You can also install Operations Hub manually (page 21).

Log in to Operations Hub (page 43).

Non-System Drive Install

This topic describes how to install to a drive other than C: drive using command line.

Open Windows PowerShell or the Command Prompt with Administrative privileges to install from
command line.

1. Right-click Windows PowerShell or Command Prompt and select Run as administrator.
2. Type Ophub_bundle.exe CUSTOM_INSTALL_DRIVE=E:
3. Press Enter on your keyboard.
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The application program files (which usually go to C:\Program Files\GE) and runtime data
directories (usually under C:\ProgramData\GE\) are relocated to E: drive.

Install the Certificate on your Clients
This topic describes how to install the Certificate Authority (CA) certificate on each client that you
will use to access Operations Hub.

1. On the client machine, open a browser such as Google Chrome and access the Operations Hub
server using the url: https://opshubservername/iqp.
The browser should display a "Not secure" icon.

2. Right-click the Not Secure icon, which should lead you to a Certificate dialog box.

3. Find the issuer in the Certificate Path tab.

4. On the issuer, select View Certificate.

5. In the Certificate dialog box, on the issuer certificate, select the Details tab and then Copy To
File.

6. Right-click that exported certificate file, and choose to import it into the Trusted Root
Certificate Authorities store.
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Install Operations Hub and Historian on a Single Machine
This topic describes the installation of Operations Hub and Historian on the same computer.

Ensure that the machine on which you want to install meets the installation requirements for these
applications.

• Operations Hub 2.1
• Historian 9.1

You can choose any order of install for the applications on the same machine.

• Install Operations Hub followed by Historian (OR)
• Install Historian followed by Operations Hub

1. Run the installation DVD for Historian 9.1, and install web-based clients:
• Historian Web Admin
• Historian Trend Client
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The installation creates an application shortcut for the components on your desktop. UAA is
also installed as part of the Historian installation.

2. On the same machine, run the installation DVD for Operations Hub 2.1, and follow the wizard
to install the application (page 21).
Important points to consider:

• The FQDN details cannot be modified if you install Operations Hub after installing
Historian on the same machine. The host names provided during Historian installation are
acquired by default.

• Do not select Use External UAA if installing Operations Hub after installing Historian on
the same machine. Historian's UAA instance is already installed on your machine.
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3. After installing, log in to Operations Hub with your user credentials.
If you open Historian Web Admin while logged into Operations Hub on the same machine, you
may receive an error stating that access is denied due to insufficient privileges.

4. In Operations Hub, go to Manage > Users, and access your user account.

5. Add historian_visualization.admin and historian_visualization.user to Groups
and save.
Historian privileges are assigned to the user account.

6. If you run into a Unable to load data sources error, refer to troubleshooting (page 477) for
resolving the issue.

If you installed Operations Hub followed by Historian on the same machine, then search for
Operations Hub log files in the Historian's log folder. Both application log files are created in C:
\ProgramData\HistorianWebBasedClientLogs.

Backup and Restore
This topic describes how to perform backups and restore the Operations Hub database.

You must have Administrator access.
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1. Download the PowerShell scripts for backup, restore, and scheduler.
2. Unzip the downloaded file to access the scripts and jar files.
3. Perform an Operations Hub backup (page 41).
4. Restore from an Operations Hub backup (page 41).
5. Schedule a backup of Operations Hub (page 41).

Back Up the Operations Hub Database

Refer Backup and Restore (page 40).

1. Launch Windows PowerShell, and navigate to the location of the backup script file.

2. Execute BackUp_OperationsHub.ps1 to perform a backup of the UAA, IQP, and WebHMI
database.
The OPERATIONS_HUB_BKP_20211013-120559.zip backup is saved to C:\ProgramData.
The filename includes the respective backup's datetime in the YYYYMMDD-HHMMSS format.

Restore the Operations Hub Database

It is recommended to take a backup of your current database before continuing with the restore
operation. In case you cancel the restore operation, you can recover your current data from the
backup.

Refer Backup and Restore (page 40).

1. Log in to the machine where Operations Hub is installed.

2. Copy the db-intializer.jar of the version you want to restore to this location:
\Program_Files\GE\Operations Hub\iqp-tomcat\webapps\site\WEB-INF

3. Launch Windows PowerShell, and navigate to the location of the restore script file.

4. Enter the path to the backup zip file, and execute Restore_OperationsHub.ps1 to restore the
database.
For example:

PS C:\Users\Administrator\Desktop> .\Restore_OperationsHub.ps1 C:
\ProgramData\OPERATIONS_HUB_BKP_20211013-120559.zip

The database is restored.

Schedule Operations Hub Database Backup

Refer Backup and Restore (page 40).

1. Launch Windows PowerShell, and navigate to the location of the backup scheduler script file.

https://www.ge.com/digital/documentation/opshub/windows/pdf/file_downloads/operations-hub-backup-restore.zip
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2. Execute BackupScheduler_OperationsHub.ps1 to schedule a backup.

a. To create a scheduler, enter Create.

b. Enter a name for your backup.

c. Enter a description of your backup.

d. Enter Daily to take a backup every day, or Weekly to backup every week.

e. Enter time in the suggested format to take a daily/weekly backup at the given time.

f. Enter the location of your backup script.
For example:

PS C:\Users\Administrator\Documents\db-backup-restore
\Backup_OperationsHub.ps1

A daily/weekly backup is scheduled.

a. To delete a scheduler, enter Delete.

b. Enter the name of the backup for which you want to delete the schedule.
The daily/weekly schedule for the respective backup is deleted.

The backups are saved to C:\ProgramData.

Troubleshooting:

• When you run a .ps1 PowerShell script you might get the following message .ps1 is not
digitally signed. The script will not execute on the system.

To fix it you have to run the following command to run Set-ExecutionPolicy and change the
Execution Policy setting.

Set-ExecutionPolicy -Scope Process -ExecutionPolicy Bypass

This command sets the execution policy to bypass for only the current PowerShell session after
the window is closed. The next PowerShell session will open running with the default execution
policy. “Bypass” means nothing is blocked. No warnings, prompts, or messages are displayed.

• For LDAP user connectivity, make sure the Active Directory server is accessible to both the
servers:

◦ the server from where we take the data backup
◦ the server to which we restore the data

If the data restored server cannot access LDAP server, the Invalid Credentials error
message appears.
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Post-Installation Tasks

Setting Up Operations Hub

Log in to Operations Hub

Use your credentials to login and access the Operations Hub homepage.

Only a single user from a UAA instance can be logged into a browser instance at a time, even across
multiple tabs.

If you want to log in as a different user, you must first log out of all the active product sessions.
For Operations Hub, this includes the Operations Hub Designer, the Site Admin console, and
applications created using Operations Hub.

1. In a web browser, enter the server name. Alternatively, you can use the shortcut provided on
the desktop after installation.

2. Log in with the credentials that you specified during installation.

The Operations Hub home page appears.
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Depending on the Operations Hub solution you purchased, perform one of the following steps:

• If you have installed Operations Hub by downloading it from Salesforce, run the
siteadmin_addon installer package (page 44) to access the Site Admin console, which is
used to configure an MQTT server (page 46) or an email server.

• If you have installed the Operations Hub add-on for Historian, access the Historian analysis
application. This is the only application you can access. You cannot modify or delete this
application.

On iOS devices (iPhone/iPad), enable the self-signed certificate to secure websockets.

1. Go to Settings > General > About > Certificate Trust Settings.
2. Under Enable Full Trust for Root Certificates, enable your root certificate.

Install Site Administration Addon

You must install the addon to access the Site Administration Console.

Log out and close all the browser windows before you run the installer.
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1. Run the siteadmin_addon Windows installer package from the Operations Hub installation
DVD.

2. Accept the license agreement and install the package.

3. Make a note of the Site Admin user account credentials before you finish the installation.

• In case you closed the setup wizard without making a note of the credentials (password),
then reinstall the addon and note them down.

• If you changed the password of the Site Admin user account, remember to enter the new
password on the login page. Some web browsers may populate cached credentials that are
outdated.

• The Site Admin Console is used to configure MQTT settings or an email server. Do not use
the console to change the password.

• If you have configured Historian UAA as the external UAA to be used with Operations
Hub, you can change the password only after performing the following steps:

a. Access the uaa.yml file. By default, this file is located in the following folder: C:
\Program Files\GE Digital\UAA

b. Add the following line at the end of the uaa.yml file: issuer: uri: https://
historian:8443/uaa. Do not enter a leading space before the line.

https://historian:8443/uaa
https://historian:8443/uaa
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c. Restart the Historian Embedded Tomcat Container service.

Configure MQTT Broker Settings (page 46).

Configure MQTT Broker Settings

If you want to use an MQTT broker to connect to devices, you must configure the settings.

Install Site Administration Addon (page 44).

1. In the Site Administration Console page, select Server settings, and then select Mqtt settings.

2. In the Select tenant to configure drop-down list box, select the tenant, and then select
Continue.
The Account Settings workspace appears.

3. Enter values as specified in the following table, and then select Update.

Field Description

Cloud url Enter the IP address or the URL of the MQTT broker
that you want to use.

Pull interval Enter the time interval, in milliseconds, at which the
Operations Hub MQTT client will connect to send or
receive data. By default, it is set to 500 milliseconds.

Use password Specify if the MQTT broker requires a user name and
password to connect. By default, the value in this field is
False.

Password If you selected True in the Use Password field, enter
the password in this field. The default password for the
installed MQTT broker is mqttpassword.

Note:  It is highly recommended to create a new
password if using MQTT in a production environment.
The Mosquitto password file is located here: C:\Program
Files\GE\Operations Hub\mosquitto.

To create a new password file, run the following
command:

mosquitto_passwd -c passwordfile mqttuser

Visit https://mosquitto.org/man/
mosquitto_passwd-1.html for command related
information.

Visit https://mosquitto.org/man/mosquitto-conf-5.html for
information on Mosquitto configuration.

User If you have selected true in the Use password field,
enter the user name in this field. The default user for
the installed MQTT broker is mqttuser.

https://mosquitto.org/man/mosquitto_passwd-1.html
https://mosquitto.org/man/mosquitto_passwd-1.html
https://mosquitto.org/man/mosquitto-conf-5.html
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Field Description

Qos Specify the quality of service (QoS) of the MQTT broker
by entering one of the following values:

• 0: Indicates that the message is delivered at most
once or it is not delivered at all.

• 1: Indicates that the message is always delivered
at least once.

• 2: Indicates that the message is delivered once.

Port The port number of the MQTT broker. By default, the
value in this field is 1883, which is the standard MQTT
port number.

The MQTT broker settings are configured.

Display Asset Locations on a Map

Enable Google Maps for your applications to display asset locations.

While designing a page, you can use the Google Maps widget to display the locations of assets on a
map. To do so, you require the API key generated by Google. This topic describes how to access the
key and use it in the application that you want to create.

1. Access https://cloud.google.com/maps-platform/, and follow the on-screen instructions to
generate the API key.
The API key is generated.

Note:  Ensure that the following APIs are enabled for the key:
• The Geocoding API
• The Maps JavaScript API

2. Modify the userconfig.json file located here:
C:\Program Files\GE\Operations Hub\iqp-endapp\public\scripts\data

3. Update the file using the API key and version information provided by Google:
Search for "googleMapsVersion" and enter the version number for it.
Search for [GOOGLEAPIKEY] and replace (including the brackets) with your API key.

4. Save and close the file.

5. Restart the Operations Hub IQP Tomcat Web Server service.
The Google Map widget is now available for use in the application. Asset locations are now
displayed on a map.

Configure Timeout

After upgrading to a newer version of Operations Hub, configure these timeout settings.

https://cloud.google.com/maps-platform/
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Operations Hub Session Timeout

Access the web.xml file from these locations, and update the code as follows:

• C:\Program Files\GE\Operations Hub\iqp-tomcat\conf
• C:\Program Files\GE\Operations Hub\iqp-tomcat\webapps\app\WEB-INF
• C:\Program Files\GE\Operations Hub\iqp-tomcat\webapps\site\WEB-INF

<session-config>
          <session-timeout>30</session-timeout>
   </session-config>

UAA Token Timeout

Access the web.xml file from C:\ProgramFiles\GE\Operations Hub\uaa-tomcat\conf, and
update the code as follows:

• <session-config>
          <session-timeout>30</session-timeout>
   </session-config>

Note:

1. session-timeout and cookie max-age must be in sync.
2. session-timeout is measured in minutes, whereas cookie-config is measured in seconds.
3. Any manual configuration changes, including changes for timeouts, are overwritten on upgrade.

Mapping UAA Groups

About User Groups

A user group is created for specific type of users, likely to perform the same type of activities.

These are the different types of users in Operations Hub:
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Type of User Description

Site administrator This user creates tenants and tenant administrators using
the Site Admin Console application. This user is created
automatically when installing Operations Hub. You cannot
access, modify, or delete this user from the Designer.

Tenant administrator This user manages the user accounts of developers and
application users. The first tenant administrator is created
automatically when installing Operations Hub. You cannot
delete this user from the Designer.

Developer This user creates applications using Operations Hub.

Application user This user accesses applications created using Operations
Hub.

You can create new user groups in the UAA application. Refer to Create UAA Groups.

Important:  Exercise caution in modifying the membership of a user because it is possible for
a user to remove their privileges to access Operations Hub, including the user management section,
thus preventing themselves from accessing Operations Hub.

About User Account and Authentication (UAA)

User authentication in Operations Hub is handled using Proficy UAA (User Account and
Authentication).

Proficy UAA provides identity-based security for Proficy based applications and APIs. It supports
open standards for authentication and authorization, including Oauth2.

When a user is created or deleted in a product that uses Proficy UAA, the associated user account is
created or deleted in the UAA instance, respectively.

Note:  This is done in the backend automatically. Therefore, most users will not need knowledge
on UAA to perform basic user management, except when additional configuration is required.

Several Proficy products use Proficy UAA, including Historian, Plant Applications, and Operations
Hub. To use Proficy UAA, you must install one of these products. Each product can install an
independent instance of UAA, or it can reuse an existing instance of UAA which was previously
installed by another Proficy product. When more than one product uses the same instance of Proficy
UAA, this is called a shared or common UAA.

Shared UAA means that if you have a Proficy product installed that uses UAA, additional Proficy
products installed after that initial product can also share that existing, already configured UAA
architecture.

Proficy UAA can additionally be configured to use an external identity provider. This includes
identity providers which use Lightweight Directory Access Protocol (LDAP) or Security Assertion
Markup Language (SAML). When you integrate Proficy UAA with an external identity provider, you

https://www.ge.com/digital/documentation/uaa/c_uaa_about_uaa_groups.html
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can provide the users and groups from that identity provider with access to Proficy products and their
features.

For more information on UAA, please refer to the Proficy UAA documentation.

Proficy UAA Install and Components

This topic describes the components required for installing Proficy UAA.

To use Proficy UAA, you must install one of the products which bundles Proficy UAA, such as
Historian, Plant Applications, or Operations Hub. At the time of install, you can choose from the
following options:

• Creating a new instance of UAA: Use this option if you are not currently using another UAA
instance. For instance, use this option if you are installing your first Proficy product, or if the
product you are installing is a stand-alone instance which does not need to share users and
groups with another Proficy product.

• Using an existing UAA: Use this option if you are currently using an instance of Proficy UAA
which contains users and groups that you want to reuse. For instance, use this option if you are
already using Historian and you want to install Plant Applications and Operations Hub, and you
want your existing Historian users to have access to Plant Applications and Operations Hub. To
use an existing instance of UAA, you must provide the details while installing Proficy UAA.

Important:  The decision of whether to share a UAA must be made at the time of product install;
there is currently no post-install option to change what UAA a product is using, nor is there a utility
to migrate users from one instance of UAA into another.

As part of install, a basic UI for configuring UAA is provided along with the instance of UAA. This
includes a number of required services and other components. You can see the associated services
when you open the services pane. These will start automatically after install.

Note:  Proficy UAA supports UAA version 4.30.0 or later.

Map Existing UAA Groups With Proficy UAA

This topic describes the process to map existing UAA groups with Proficy UAA groups.

1. Double-click  on your desktop.

https://www.ge.com/digital/documentation/uaa/
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The icon appears on your desktop after you install Proficy UAA.

2. Select the Identity Providers tab.
The UAA/LDAP/SAML Connectivity Tool appears.

3. Select the Map Existing UAA Groups check box.

4. In the UAA Connection section, provide values as specified in the following table.

Important:  The values that you provide in this step must match the values that you
provided while installing your Proficy product. These values are required to connect to Proficy
UAA.

Field Description

URL This information is read-only. The authorization server URL of the Proficy UAA server is populated by
default. This is the UAA Base URL that you specified during installation .

Client
ID

Enter the client ID of the Proficy UAA server that you specified for Admin Client ID during installation.

Client
Secret

Enter the client secret configured for the OAuth client that you specified for Admin Client Secret during
installation.

5. Select Test.
If connection to the UAA server is established, a message appears, confirming the same.

6. Select Continue.
In the UAA Mapping section, the drop-down list box contains a list of groups in Proficy UAA.
In the Filter box, a list of groups in the existing UAA instance appear.

7. In the drop-down list box, select the Proficy UAA group to which you want to map the existing
UAA groups.
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8. In the Filter box, select the check boxes corresponding to the existing UAA groups that you
want to map.

Note:  If a group is already mapped to the Proficy UAA group that you have selected, the
check box is already selected.

Tip:  Clear the check boxes corresponding to the UAA groups for which you want to
remove the mappings.

9. Select Map Members.
A message appears, confirming that the Proficy UAA group is mapped to the existing UAA
groups that you have selected.

10. Repeat steps 7-9 for all the Proficy UAA groups that you want to map.

The existing UAA groups are mapped with the Proficy UAA groups.

Map LDAP Groups With Proficy UAA

If you want LDAP users to use Proficy UAA, you must map the corresponding LDAP groups with
the Proficy UAA group created during the Proficy product installation.

1. Double-click  on your desktop.
The icon appears on your desktop after you install Proficy UAA.

2. Select the Identity Providers tab.
The UAA/LDAP/SAML Connectivity Tool appears.

3. Select the Map Existing LDAP Groups check box.

4. In the UAA Connection section, provide values as specified in the following table.

Important:  The values that you provide in this step must match the values that you
provided while installing your Proficy product. These values are required to connect to the
Proficy UAA. Proficy UAA works only with a single instance of UAA, which is specified
during Proficy UAA installation. After installation, you cannot change the instance of UAA that
Proficy UAA will use.

Field Description

URL This information is read-only. The authorization server URL of the Proficy UAA server is populated by
default. This is the UAA Base URL that you specified during installation .
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Field Description

Client
ID

Enter the client ID of the Proficy UAA server that you specified for Admin Client ID during installation.

Client
Secret

Enter the client secret configured for the OAuth client that you specified for Admin Client Secret during
installation.

5. Select Test.
If connection to the UAA server is established, a message appears, confirming the same.

Note:  Currently, the Test Button displays a successful connection for LDAP even when no
security certificate or a bad certificate is found.

6. In the LDAP Connection section, provide values as specified in the following table.

Field Description

URL Enter the base URL of the LDAP server (for example, https://localhost).

Bind User
DN

Enter the distinguished name of the bind user (for example, cn=admin,ou=Users,dc=test,dc=com).

Password Enter the password for the LDAP user ID that searches the LDAP tree for user information.

Skip SSL
Verification
(UAA
restart
required)

Select this check box if you do not have the certificate to access the LDAP server. Messages are
still encrypted, but the certificate is not verified for correctness. Do not select this option if you are
not confident of the direct connection to the LDAP server; it could result in redirected traffic outside
of your controlled network.

User Search
Filter

Enter the subdirectories to include in the search (for example, cn={0}).

User Search
Base

Enter the starting point for the LDAP user search in the directory tree (for example,
dc=developers,dc=com).

Group
Search
Base

Enter the starting point for the LDAP group search in the directory tree (for example,
ou=scopes,dc=developers,dc=com).

Max Group
Search
Depth

Enter a value to define the maximum depth for searching LDAP groups. (This may impact
performance for very large systems.) By default this value is 10.

Group
Search
Filter

Enter the subdirectories to include in the search (for example, member={0}).

https://localhost
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7. Select Test, and then select Submit.
If connection to the LDAP server is established, a message appears, confirming the same.

8. Select Test again, and then select Continue.
In the LDAP Mapping section, the drop-down list box contains a list of groups in Proficy
UAA.

9. In the drop-down list box, select the Proficy UAA group to which you want to map LDAP
groups. You can also search for a group in the LDAP Groups Search Filter  box. When
searching, be sure to use the standard LDAP query language for your search.
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Note:  If a group is already mapped to the Proficy UAA group that you have selected, the
check box is already selected.

10. Select Map Groups.
A message appears, confirming that the LDAP groups are mapped to the Proficy UAA group.

11. Repeat steps 8-10 for all the Proficy UAA groups that you want to map.

The LDAP groups are mapped with the Proficy UAA groups.

Warning:  Any change in the configured details for LDAP impacts its connectivity. Make sure to
update the connectivity screens to reflect the changes.

Map SAML Groups With Proficy UAA

If you want SAML users to use Proficy UAA, you must map the corresponding SAML groups with
the Proficy UAA group created during the Proficy product installation.

1. Double-click  on your desktop.
The icon appears on your desktop after you install Proficy UAA.

2. Select the Identity Providers tab.
The UAA/LDAP/SAML Connectivity Tool appears.

3. Select the Map Existing SAML Groups check box.

4. In the UAA Connection section, provide values as specified in the following table.

Important:  The values that you provide in this step must match the values that you
provided while installing your Proficy product. These values are required to connect to the
Proficy UAA. Proficy UAA works only with a single instance of UAA, which is specified
during installation. After installation, you cannot change the instance of UAA that Proficy UAA
will use.

Field Description

URL This information is read-only. The authorization server URL of the Proficy UAA server is populated by
default. This is the UAA Base URL that you specified during installation .

Client
ID

Enter the client ID of the Proficy UAA server that you specified for Admin Client ID during installation.
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Field Description

Client
Secret

Enter the client secret configured for the OAuth client that you specified for Admin Client Secret during
installation.

5. Select Test.

If connection to the UAA server is established, a message appears, confirming the same.

6. In the Existing SAML Identity Provider section, select the Identity Provider.

7. Click Show IDP Details, or Create New IDP and provide values as specified in the following
table.

Item Description

Metadata
Location

Specify the SAML Metadata – either an XML string or a URL that will deliver XML content.
Optionally, you can select Instead Upload Metadata Xml to enter the metadata location using a file
you downloaded from your SAML Identity Provider.

Name Specify the name of your SAML provider.

Origin Key Specify the unique alias for the SAML provider.

SAML
Group
Attribute
Names

Specify the names of the attributes that contain the group membership information about a user in a
SAML assertion.

NameID Optionally, enter a SAML Name ID and associated fields that you want to use in a Link Test.

Link Text Specify the text you want to appear in a link test.

Enable
SAML Link

Select this check box to enable the SAML Link; clear to disable.
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Note:  It is recommended to use the same Name and Origin Key (not mandatory).

8. Select Add or Update to save your changes.

Tip:  Click Delete IDP to remove the existing IDP, and instead create a new one (using the
Create New IDP button).

The SAML Mapping screen appears.

9. In the drop-down list box, select the Proficy UAA group to which you want to map SAML
groups.

10. Enter a SAML Group and click Add Group. Repeat this step for each SAML group you want
to add.
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11. When finished adding SAML groups, click Map Groups.

12. Next, select Continue to complete.
A message appears, confirming that the SAML groups are mapped to the Proficy UAA group.

Change Password

UAA local users can log in to their accounts and change password.

You must know your current password to log in to UAA and change it.

1. Log in to UAA on a web browser.

2. Go to your Account Settings screen.

3. Select Change Password.

4. Provide the following information:

Current password Enter the password that is currently used for UAA login.

New password Enter a new password to replace the current password.

Confirm new password Enter the new password again for confirmation.

5. Select CHANGE PASSWORD.

The password is changed successfully.

Reset Password for a User

Administrators can reset the password for UAA users.
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You must have administrator access to log in to the application.

1. Double-click  on your desktop.
The icon appears on your desktop after you install Operations Hub.

2. Log in to UAA using admin account.

3. Select the Users tab.
The list of all UAA users appears.

4. Select  for the username you want to reset the password.
The pencil icon to edit the respective user is available under the Action column.

5. Select Reset Password.
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6. Enter a new password for the user and confirm the new password.

7. Select RESET PASSWORD.

The password for the user is reset successfully.

Certificate Management

About the Certificate Management Tool

The Certificate Management tool allows you to manage external certificates and renew expired
certificates.
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The tool is installed automatically when you install Operations Hub. Using the Certificate
Management tool, you can manage the following types of certificates:

• Server certificates, which include local certificates and imported certificates.
• Issuer certificates, which include certificates that are trusted by Operations Hub. This is required

to connect to an external UAA instance. If you want to connect to LDAP, use the LDAP service
to generate the certificate. Typically, you will only require the root CA certificate.

Using the Certificate Management tool, you can perform the following tasks:

• Access a certificate (page 61).
• Renew a local certificate (page 63).
• Import a server certificate or an issuer certificate (page 61).
• Remove a server certificate or an issuer certificate (page 63).
• View log messages (page 63) that are generated while managing the certificates.

Access a Certificate

Using the Certificate Management tool, you can access server certificates and issuer certificates.

1. Double-click  on your desktop.

The icon appears on your desktop after you install Proficy Operations Hub.

The GE Operations Hub Certificate Management Tool page appears, displaying the Server
Certificate section.

2. Depending on the type of certificate that you want to access, perform one of the following tasks:
• If you want to access a server certificate, select View in the Local Certificate or the

Imported Certificate subsection.
• If you want to access an issuer certificate, select External Trust, and then select View.

The certificate appears.

Import a Certificate

Using the Certificate Management tool, you can import the following types of certificates:

• Server certificates: You can import a certificate (chain) file of the PEM, PFX, or P12 format. To
import a certificate of the PFX or a P12 format, you must enter a password.
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• Issuer certificates: You can import a certificate file of the PEM format that contains only one
certificate for the root CA. If you are currently using a certificate for the external UAA instance,
it is replaced by the imported certificate.

1. Double-click  on your desktop.

The icon appears on your desktop after you install Proficy Operations Hub.

The GE Operations Hub Certificate Management Tool page appears, displaying the Server
Certificate section.

2. If you want to import a server certificate, perform the following steps:

a. In the Imported Certificate subsection, next to the Certificate File box, select Select.

b. Navigate to and select the certificate file, and then select Open.

c. Next to the Key File box, select Select.

d. Navigate to and select the key file, and then select Open.

e. If you have selected a PFX or a P12 file, enter the password in the Password box.

f. Select Import.
A message appears, asking you to confirm that you want to import a certificate.

g. Select Yes.

The certificate is imported.

3. If you want to import an issuer certificate, perform the following steps:

a. In the External Trust subsection, next to the Certificate File box, select Select.

b. Navigate to and select the certificate file, and then select Open.

c. Select Import.
A message appears, asking you to confirm that you want to import a certificate.

d. Select Yes.

The certificate is imported and replaces the currently used certificate for the external UAA, if
any.
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Renew a Certificate

Using the Certificate Management tool, you can renew local certificates that have expired.

1. Double-click  on your desktop.

The icon appears on your desktop after you install Proficy Operations Hub.

The GE Operations Hub Certificate Management Tool page appears, displaying the Server
Certificate section.

2. Select the local certificate that you want to renew, and then select Renew.
A message appears, specifying that the certificate has been renewed.

Remove a Certificate

Using the Certificate Management tool, you can remove a server certificate or an issuer certificate.
When you do so, the local certificate is used by Operations Hub.

1. Double-click  on your desktop.

The icon appears on your desktop after you install Proficy Operations Hub.

The GE Operations Hub Certificate Management Tool page appears, displaying the Server
Certificate section.

2. Depending on the type of the certificate that you want to remove, perform one of the following
tasks:

• If you want to remove a server certificate, in the Imported Certificate subsection, select
Remove.

• If you want to remove an issuer certificate, select External Trust, and then select Remove.
A message appears, asking you to confirm that you want to remove the certificate.

3. Select Yes.
The certificate is removed, and the local certificate is used by Operations Hub.

View Log Messages

Using the Certificate Management tool, you can view the log messages that are generated while
managing certificates.
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1. Double-click  on your desktop.

The icon appears on your desktop after you install Proficy Operations Hub.

The GE Operations Hub Certificate Management Tool page appears, displaying the Server
Certificate section.

2. Select Messages.
The Messages section appears, displaying the log messages.

Integrating with Historian

Integrating Operations Hub and Historian

A trend chart allows you to trend data from Historian.

You can choose to trend data from an asset model or directly from Historian. To do so, you must
integrate Historian and Operations Hub.

Access the Trend Chart with Asset Model

1. Create a data source to connect to the Historian server.
For instructions, refer to the Data Sources section of the User Guide.

2. Set up the Historian server.
For instructions, refer to the Administration section of the User Guide.

3. Import the model to Operations Hub.
For instructions, refer to the Administration section of the User Guide.

4. For the model that you have imported, enable the trendable properties by performing the
following properties:

a. In the Admin workspace, select Visualizations > Designer.
b. For each data variable that is trendable, select the check box in the Trendable check box.

5. Access the Historian Analysis application.
For instructions, refer to the Applications section of the User Guide.

When you navigate to the model, the trend chart plots data based on the selected context.
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Access the Trend Chart without Asset Model

You can access the trend chart without the asset model (that is, by browsing through the Historian
data source directly for use in the trend chart).

1. Create a data source to connect to the Historian server.
For instructions, refer to the Data Sources section of the User Guide.

2. Set up the Historian server.
For instructions, refer to the Administration section of the User Guide.

3. Access the Historian Analysis application.
For instructions, refer to the Applications section of the User Guide.

4. Access the trend chart configuration to select the tags that you want to plot on the trend chart.
For instructions, refer to the Widgets section of the User Guide.

Data for the selected tags is plotted on the trend chart.

Uninstalling Operations Hub

Uninstall Operations Hub on Windows

1. If you want to uninstall Operations Hub automatically, open Command Prompt, and enter
the following command: <Installation folder path of Operations Hub>\OpHub-
Windows_Installer>ophub_bundle -uninstall

2. If you want to uninstall Operations Hub manually, perform the following steps:

a. On the machine on which you want to uninstall Operations Hub, select Control Panel >
Uninstall a Program.
A list of programs that you can uninstall appears.

b. Right-click Operations Hub, and then select Uninstall.
The Uninstall Options page appears.



Operations Hub for Windows | 2 - Getting Started in Windows | 66

c. In addition to uninstalling Operations Hub, if you want to delete all the related data and
applications, select the Purge databases during uninstall check box.

d. Select Next.
The You are ready to uninstall page appears.
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e. Select Uninstall.

Operations Hub is uninstalled from the Windows machine.

Getting Started with Proficy Historian

Get Started with Proficy Historian and Operations Hub
This topic guides you through how to get started integrating Proficy Historian and Operations Hub.

Before You Begin

Before beginning, make a note of the following:

• Ensure the Historian Web Clients are installed on the Historian machine; this is very important
if you will be using the Historian REST API in Operations Hub.

• Ensure that you can access Historian Web Trending Client from a remote machine or from the
Operations Hub machine.
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• Ensure that certificates are trusted for both Operations Hub and Historian (not strictly necessary
if you use option to ignore TLS/SSL, but a good idea).

Steps

The following sections walk you through:

1. Configuring a Historian data source (System API or REST API) in Operations Hub. See
Configure Historian Data Sources for Operations Hub (page 68).

2. Creating a Model. See Create a Model for Operations Hub to use with Historian (page 70).
3. Using the Trend widget to trend model-based Historian data or trend data directly from a

Historian. See Use the Trend Widget for Historian Data Source (page 72).
4. Creating a Historian REST query. See Create Historian REST Query for Operations Hub (page

75).
5. Using the Query in the page designer. See Use the Historian Query in the Operations Hub Page

Designer (page 76).

Configure Historian Data Sources for Operations Hub

Overview

Look at the following examples for configuring a data source for Historian 7.x and Historian 8.x.

• Historian 7.x requires entry of port used – in this instance, port 8443.
• The Auth Client ID is the admin (case sensitive) for Historian 7.x.
• Historian 8.x does not require any port to be specified.
• The Auth Client ID for Historian 8.x must be in the form of MachineName.admin, where

MachineName is case sensitive.
• For both Historian 7.x and 8.x, ensure Data source URL and Client ID are in the right format.

Note:

• The System API connection is necessary for Trending Historian data in the Trend widget.
• The REST API connection is necessary for creating REST queries against the Historian REST

API. These queries can then be bound to widgets like gauges, grids, etc to visualize this data
• When configuring a REST data source, be sure to provide all necessary parts to the Base URL,

including any required ports. (Example: https://<HistorianServerName>:8443)

Refer to Add Historian or Custom REST Data Source (page 246).
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Configuring Historian 7.x in Operations Hub
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Configuring Historian 8.x in Operations Hub

Note:  The Auth Client ID field is case sensitive. For example, if the Historian server name is
hist8Server, the user must use hist8Server.admin and not HIST8Server.admin or Hist8Server.admin,
otherwise REST authentication will fail. If your rest connection fails, make sure you can login to the
Historian Web trend client (https://webhmitaco/historian-visualization/hwa) Once successful, use the
same user name and password for the client id in the REST configuration in Operations Hub.

Create a Model for Operations Hub to use with Historian
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Create an Object Type

Create an Object based on the New Type

Tie the properties of the Data variables to the Historian data source.

Refer to Set Up the Model Structure (page 232) and Define Objects (page 232).
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Use the Trend Widget for Historian Data Source

When using Operations Hub with Historian use the following guidelines to successfully get data
flowing in the Trend widget.

Use the Trend Widget with an Asset Model

1. Create a Historian data source (page 246).

2. Import the model from the Admin > Import/Export option.

3. After the model is successfully imported, go the Visualizations > Designer section and enable
the Trendable properties and save.
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4. Switch to the Apps section.

5. Choose the Historian Analysis app.

6. Select the  button to open the app.

7. At run time, navigate through the model and the Trend chart will display data based on the
context selected.
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Use the Trend Widget without an Asset Model (Browsing Data Source Directly for Trend
Widget)

1. Create a data source to historian via the Data Sources section.

2. Make sure the test passes.

3. In the Admin, make sure the Historian server is also setup via the Setup area.

4. Switch to the Apps section.

5. Choose the Historian Analysis App

6. Select the  button to open the app.

7. At run time, open the Trend chart configuration via the  button, then select Add Tags for
Trend to browse Historian and add tags to the chart for trending.



Operations Hub for Windows | 2 - Getting Started in Windows | 75

Create Historian REST Query for Operations Hub

1. Make sure the data source for Historian REST API is configured as described in the Configure
Historian Data Sources for Operations Hub (page 68) section.
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2. Create a query for Current value.

Refer to Create a REST Query (page 170).

Use the Historian Query in the Operations Hub Page Designer

1. Go to Apps > Pages and then Add a New Page from within the App.
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2. Within Page > Page Data, select Query > REST, next to Get Current Value, click Add to add
the “Current Value Query” to Page.
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3. Add widgets to the Page, by first adding three containers to the page. From Layouts, select and
drag Containers.

4. Add an Input > Input widget and a button into the first container, Display > Gauge into the
second container, and Display > Table into the third container.

5. Now we need to bind the query parameters to each of the widgets: For the Input widget set the
target data to the “GetCurrentValue” > TagNames. For the Source you can put in a manual entry
of a known Historian tag name.
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6. For the Gauge widget, set the style to “Arc Meter” and set the Data > Source > Get Current
Value > historian_data.Data.Samples.Value.
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7. Set the color and start position numbers based on the data source High and Low as shown in the
following figure.
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8. For the Table widget, set the Flow->Get Current Value. Now add fields, and set the value for
each of the fields.

9. Alternatively, you can drag and drop the output parameters from the query onto the grid.
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10. Bind the Submit Action on button to the query as shown in the following figure:

11. Save the App.

12. Open the App.

13. In the End app, click the Submit Button.

14. To update the gauge and the table with the current value of the specified Historian tag, enter a
different Historian tag name and click on the Submit button.
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Getting Started with the Relational Database Connector

Get Started with Relational Database Connector
This topic guides you through how to get started integrating the Relational Database Connector and
Operations Hub.

Before You Begin

Before beginning with your relational database connector, be aware of the following:

• This release of Operations Hub supports fetching data via stored procedures from Microsoft
SQL Server only.

• Be sure to confirm that you can to successfully connect to the SQL Database:

◦ Test that you can connect to SQL Server with another client (for example: SSMS, UDL
files), using the SQL account you want to use in Operations Hub.

◦ Confirm that the TCP/IP Protocol is enabled on the SQL Server. You will not be able to
connect from Operations Hub until you enable TCP/IP using the SQL Server Configuration
Manager.

• Ensure that you have a working SQL Database, and that the selected database has stored
procedures.

Steps

The following sections walk you through:

1. Create a data source of type Relational Database. Refer to the Add Relational Database Data
Source (page 244) section.

2. Provide the details to the external database. Refer to the Create a Query to a Relational Database
(page 84) section.

3. Create a Query of type Relational Database, and specify the expected inputs and outputs of a
Stored Procedure. Refer to the Create a Query to a Relational Database (page 84) section.

4. Map the query in the page designer to use the query to fetch the data from the external database.
Refer to the Use the Relational Database Query in the Designer (page 88) section.

5. View the page in the end app. For an example, see Example of Adding Relational Database
Queries to a Page (page 91).

Create a Query to a Relational Database
This topic describes how to create a SQL query.
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In order to proceed you must have a working SQL database, and the selected database must have
stored procedures. You must also have created a data source for the relational database in Operations
Hub. See Create a SQL Data Source (page 256).

1. From the main navigation menu, select QUERIES.
The QUERIES workspace appears.

2. Select Add new query.
The Create Query window appears.

3. In the Name field, enter a name, and then select Create. The name must contain at least one
uppercase or lowercase letter.
The available options for creating the query appear.

4. In the Description field, enter a description for the query.

5. In the Type field, select Relational Database .

6. In the Data Source field, select the name of the data source from the list.

7. In the Query Type field, observe that the field defaults to ‘Stored Procedure’ when you select
‘Relational Database’ as the Type.

8. In the Schema field, select the database schema that you want to use. All the database schemas
will be loaded for the selected data source. The default selection is dbo.

9. In the Stored Procedure field, select the Stored Procedure that you want to use from the
selected schema.

After you selects all the required fields, the list of input parameters will be loaded if there are
any, for the selected stored procedure.
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The value for the input parameters can be configured either while creating the query or while
consuming the query in the page builder page.

10. To assign the value for an input parameter while creating the query, select the type drop-down
in the input parameter list. It has two options:

• Fixed Value: If this option is selected, the value given will be taken as the input to the
Stored Procedure. The input parameter will not be shown in the page builder page.

• Input Field: If this option is selected, the value given will be taken as the default input to
the Stored Procedure. The input parameter will be shown in the page builder page and if
there is any input provided to while execution, the default value will be overridden.

11. After the default values for input parameters are provided, click the Execute button under the
Test category. You will then be presented with the various fields in Result Sets and Output
Parameters sent out of the Stored Procedure.

Note:  Currently we do not support dynamic responses from the Stored Procedures.
Meaning, the fields that we see while building the query after clicking the Execute button,
should match the fields returned by the stored procedure while using the application.

12. Add the required fields.

The following figure displays an example:



Operations Hub for Windows | 2 - Getting Started in Windows | 87

13. Select Save or Save And Exit.
The query is created.
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Use the Relational Database Query in the Designer

1. From the main navigation menu, select APPS.
The APPS workspace appears, displaying a list of applications created in Operations Hub.

2. In the Name column, select the application in which you want to create a page.
The PAGES workspace appears.
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3. Select Add new page.
The Create Page window appears.

4. Enter or select values as described in the following table.

Field Description

Page name Enter a name for the page. The name must contain at
least one uppercase or lowercase letter.

Page description Enter a description for the page.

Include in app navigation Select this check box if you want this page to be
included in the application navigation. By default, this
check box is selected.

5. Select Create.
The page is created, and the page designer appears.
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6. Select Page Data.

7. To add a Relational Database Query to the page, do the following:
• Select the flow type as Query
• Select the Data source type as Relational Database
• Select the required data source
• Select the required Query
• Select a result set
• Click Add

The Query with sub-selected result set will be added to the page. The naming convention will be
QueryName - ResultSetName.

Assigning Inputs and Outputs to components will be exactly like that of REST and Entity pages.

Note:
• If a stored procedure has multiple result sets configured, the user must add each result set

as an independent query in the page designer by choosing the result set.
• If a stored procedure contains output parameters, then all the output parameters are treated

as an additional result set.
• In the case when there are multiple result sets for the query, and when the user adds them

to the page, then the inputs and query execution option check boxes will be shown for the
first result set, but internally they will be reflected to all the result sets for a query.

• If the query has single result set, the user can add it multiple times in the page builder. But,
if the same query output is changed to contain multiple result sets at a later point, then the
user has to remove the second instance of the query before adding the new result set.
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• As of Operations Hub 1.7, The inbuilt pagination and infinite scrolling for Grid and Table
components will not work with Relational Database Queries. The pagination must be
handled using the input and output parameters of the stored procedure.

8. Select Save App.

An example is shown in the following figure.

The changes made to the page are saved.

Note:  View the Page in the End app, by clicking Open App button.

Example of Adding Relational Database Queries to a Page

In the following example, the query has two result sets. One is the result from the stored procedure
and the other is from the output parameters. It also has inputs PageNumber and PageSize. The steps
that follow describe how this page was created.
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1. Add two buttons and two input boxes to the page as shown in the following figure, and make the
input controls disabled.

2. Map the input parameters of the query to the input controls.

3. Create two custom globals for page number and page size and provide default values as shown
in the following figure.
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4. Select each button and set the action to set the global value using a formula as show in the
screenshot (+ for next, - for previous).
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5. Select each button and set the display condition as shown in the following figures.
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6. Select Save App.
The final page displays as shown in the first figure.

Getting Started with OPC UA

Get Started with OPC UA and Operations Hub
This topic guides you on how to configure an OPC UA data source, and build visualization.

Steps

The following sections walk you through:

1. Create a data source with OPC UA configuration in Operations Hub (page 250).
2. Build an asset model for OPC UA data sources in this order:

• Create object types (page 232) with Proficy iFIX, Proficy CIMPLICITY, and IGS data
variables.

• For the object types, create object instances (page 232).
3. Build an asset hierarchy to specify the hierarchical relationships of assets. Operators navigate

through this hierarchy to select the equipment context for a given layout at runtime. Refer to Set
Up Runtime Navigation (page 235).
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4. Use the Trend Widget for OPC UA Data Sources (page 96).
5. To enable write operations in Proficy CIMPLICITY for Operations Hub, refer to Configure

Proficy CIMPLICITY for Writes (page 98).
6. To enable write operations in Proficy iFIX for Operations Hub, refer to Configure Proficy iFIX

for Writes (page 100).

Use the Trend Widget for OPC UA Data Sources
Data visualization with trend widget for OPC UA data sources.

Use the following guidelines to successfully get data flowing in the Trend widget. Refer to
Configuring a Trend Chart (page 382).

Use the Trend Widget with an Asset Model

• Create a data source with OPC UA configuration in Operations Hub (page 250).
• Build an asset model for OPC UA data sources.

1. In the main navigation menu, select APPS.
The Apps workspace appears, displaying a list of applications.

2. Open the application.

3. Select .
The Trend Configuration pane appears.

4. Select Add Tags for Trend.
The Add Sources window appears.
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5. Select Asset Model from the drop-down.
A list of assets appear.

6. Browse and select the check box for the properties you want to add to the trend chart.
Refer to Browse Data Sources (page 255).
The live data from the data source starts displaying in a trend chart.

Use the Trend Widget without an Asset Model

• Create a data source with OPC UA configuration in Operations Hub (page 250).

1. In the main navigation menu, select APPS.
The Apps workspace appears, displaying a list of applications.

2. Open the application.

3. Select .
The Trend Configuration pane appears.

4. Select Add Tags for Trend.
The Add Sources window appears.
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5. Select iFIX, CIMPLICITY, or OPC UA from the drop-down, then select the server.
The address space for the selected data source appears in a tree structure.

6. Browse and select the check box for the tags you want to add to the trend chart.
Refer to Browse Data Sources (page 255).
The live data from the data source starts displaying in a trend chart.

Configure Proficy CIMPLICITY for Writes
This topic describes how to configure Proficy CIMPLICITY to enable write operations.

1. Log in to Proficy CIMPLICITY.

2. From the main menu, go to Project > Properties.
The Project Properties window appears.

3. Select Operations Hub tab.

4. Provide these details to set up the connection to Operations Hub.
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Field Description

Server name Operations Hub machine name

Port Port number for the machine

User name Enter the user name for logging in to the machine.
Select Test Connection to verify the Operations Hub
machine details for establishing a connection.

Require trusted connection Select the check box to enable SSL security for the
connection. If the security appears as (Not Trusted),
you must trust it. To do so, select View Certificate for
instructions on where to copy the issuer certificate on
your CIMPLICITY machine.

OK Save the details and close the window.

5. To verify the write operations, log in to Operations Hub.

6. Create a data source with OPC UA configuration (page 250) in Operations Hub.
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7. Set up an extension query (page 175) for CIMPLICITY with these details:

Method WRITE

Tag Source OPC UA

Tag inputs and outputs As required

8. Create an application page and bind the extension query with widgets.

9. Log in to the end application, and perform the write operations in runtime.

Configure Proficy iFIX for Writes
This topic describes how to configure Proficy iFIX to enable write operations.

1. Log in to Proficy iFIX.

2. Go to C:\Program Files (x86)\GE\iFIX and open the secmgr.clr.dll.config file in a
notepad.

3. Save the dll file after verifying and updating these details:
Ensure that uaa_oauthHost points to the UAA server that provides the authentication services.
If default UAA server is installed with Operations Hub, this will generally be the hostname
(short or FQDN) used during Operations Hub installation.
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4. To verify the write operations, log in to Operations Hub.

5. Create a data source with OPC UA configuration (page 250) in Operations Hub.

6. Set up an extension query (page 175) for iFIX with these details:

Method WRITE

Tag Source OPC UA

Tag inputs and outputs As required

7. Create an application page and bind the extension query with widgets.

8. Log in to the end application, and perform the write operations in runtime.

Get Started with Proficy Plant Applications
This topic guides you through how to get started integrating Proficy Plant Applications and Proficy
Operations Hub.
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Ensure that system requirements for Plant Applications and Operations Hub are met.

Overview

1. Install Proficy Operations Hub.
2. To install Proficy Plant Applications, choose your installation type:

• Standard Edition (page 102)
• Enterprise Edition (page 102)

3. Work with Web Client applications (page 102).
4. (Optional) Refer to the API documentation to customize applications.

Steps for Installing Standard Web Client

1. Configuring Apache CouchDB Settings
2. Standard Edition Web Client Requirements
3. Install Plant Applications Standard Web Client
4. Run Message Bridge Configuration Utility
5. Run Operations Hub Posting Utility
6. Verify the Installation

Steps for Installing Enterprise Web Client

1. Configuring Apache CouchDB Settings
2. Enterprise Edition Web Client Requirements
3. Review the files provided by GE
4. Pre-Installation Checklist
5. Install Enterprise Edition Web Client
6. Run Message Bridge Configuration Utility
7. Run Operations Hub Posting Utility
8. Verify the Installation

Work with Web Client Applications

Note:  These applications appear based on user privileges.

• Unit Operations
• Non Conformance
• Work Order Manager
• Route Editor
• Work Queue
• Time Booking
• Property Definition
• Security
• Configuration

https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_ppa_software_requirements.html
https://www.ge.com/digital/documentation/opshub/windows/windows/r_system_req_windows.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/index_api_endpoint.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/t_configuring_apache_couchdb_settings.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_install_pa_uc_prerequisites.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/t_install_pa_uc.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/t_install_pa_wc_messagebridge_update.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/t_install_pa_uc_ophubpostingutility.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/t_test_the_installed_application.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/t_configuring_apache_couchdb_settings.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_enterprise_software_requirements.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_files_provided.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/t_%20pre_installation_steps.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/t_installation.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/t_install_pa_wc_messagebridge_update.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/t_install_pa_uc_ophubpostingutility.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/t_test_the_installed_application.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_op_overview_of_operations.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_ncm_overview.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_om_overview.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_rm_overview.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_wq_overview.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_pa_tb_time_booking_overview.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_pd_about_property_definition_app.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_sm_about_the_security_management_app.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_cm_about_configuration.html
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• Approval Cockpit
• Downtime
• OEE Dashboard
• Reports
• My Machines
• My Machines
• Analysis
• OEE Aggregation Store
• Activities
• Process Orders
• Alarm Event Notification
• Waste
• Receiving Inspection
• BOM Editor
• Genealogy

Data Binding to Widgets

Use these options to provide input values to your queries in a quick and simple manner.

Attention:  In case you modified the data source alias (machine name), then all references to the
data source (Historian or OPC UA) server are lost. You will have to browse and select all over again
to build input queries.

Tag Browser

A list of out-of-the-box (OOTB) queries of 'Extension' type are available with the tag browser.

1. Select the OOTB query that you want to apply to the widget.
2. Browse the data source and select tags (page 255).
3. Drag and drop the query on your widgets. This automatically populates the data fields for the

query under PAGE DATA.
4. Save the page with the default data from the query, (OR) modify the data fields to your

requirement.

Refer to:

• Create an Extension Query (page 175)
• About Queries (page 151)

https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_ac_overview.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_dos_about_operator_screens.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_about_equipment.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_about_oee_reports.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_about_my_machines.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_about_my_machines.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_about_analysis.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_pa_about_oee_aggregation.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_about_an_activity.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_pa_about_production_scheduler.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_about_an_alert_event.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_pa_wm_about_waste_management.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_ri_overview.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_pa_about_bom_editor.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version82/c_pa_about_genealogy.html
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Inputs

Queries have input values. On drag and drop from tag browser, these inputs are bound to the widget,
and appear under PAGE DATA.

Each input has these options that are populated with default values as per the query:

• Manual: Allows to use a variety of components to provide manual values for query inputs - text,
number, date, time, datetime, browser, combo box, and boolean.

• Global
• UI

Note:  At any point in time, ensure that only one binding exists for the query inputs. For
example, there should be no manual or global binding if you have already bound the query input to
UI through a widget or plugin. To remove a binding from the query input, select the unlink icon next
to the binding.

Link to Access the Query

If you changed the Asset Context for the page, access a direct link to the query to update or modify
it.

On selecting the widget, a link to the associated query appears under the widget properties. Select the
link to directly jump to the query on the PAGE DATA tab.



Operations Hub for Windows | 2 - Getting Started in Windows | 105

Drag and Drop Data

You can drag and drop the data from selected tags or properties onto the widgets. You can also select
Add to add the query to the page.

Refer to Sample Page with Historical Data (page 451).

HMI

Work with Alarms

• Configure iFIX for Alarms (page 399)
• Configure CIMPLICITY for Alarms (page 401)
• Alarm Card (page 396)
• Alarm Count (page 406)
• Apply Filters to View Alarms (page 403)
• Acknowledge Alarms (page 405)

Related reference
Work with Mimics (page 105)

Work with Mimics
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• Configure iFIX for Mimics (page 408)
• Configure CIMPLICITY for Mimics (page 414)
• Import Mimics (page 240)
• Assign Mimics to Assets (page 241)
• Override an Assigned Mimic (page 241)
• Set Up Mimic Target Zones (page 242)
• Mimic Card (page 406)

Related reference
Work with Alarms (page 105)



Chapter 3. User Guide

Overview

Overview of Operations Hub
Operations Hub is an end-to-end solution for developing, managing, and delivering applications to
leverage the capabilities of big data analytics and the internet of things.

Using Operations Hub, you can create applications that will collect and analyze data from a machine
or a server, and trigger actions based on certain events.

Operations Hub provides you with a user-friendly interface to create components of an application
such as queries (page 151), database tables (page 129) (called entities), events (page 192),
email templates (page 201), users (page 211), and so on without the need to use your
programming skills. You can also design pages and dashboards using these components.

Advantages of using Operations Hub:

• Operations Hub is quick, easy, and cost-effective. You do not need programming skills to
develop an application.

• The Operations Hub applications use HTML5 and CSS3, and hence, they are platform-
independent.

• You can access an application using a computer or a mobile device.
• You can provide controlled access to an application and data based on user roles.
• You can create entities and queries for a relational database.

Note:  If you have installed only the Operations Hub add-on for Historian, you cannot create,
modify, or delete an application or a component of an application. You can only access the Historian
analysis application.

Refresh Session Timeout
Refresh the session to reset its expiration time.

Operations Hub login session expires based on the configured timeout settings (page 47). When the
session is close to expiration, an alert appears requesting to save your work.

Select Refresh to reset the session timeout settings, and continue with your work.
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The session expires if the warning is left unacknowledged. You must log back in to Operations Hub
to start a new session, and resume your work. Any unsaved work prior to a session timeout will be
lost.

Applications

About Applications
Operations Hub provides a user-friendly interface to create application components such as database
tables (called entities), queries, events, email templates, users, and so on, without the need to write
code.

You can then develop applications using these components. To develop an application, you will
perform the following tasks:

1. Create all the components that are required for the application.
2. Create the pages and dashboards for the application.
3. Apply themes, define the navigation details.
4. Access and test the application.
5. Provide users access to the application.

Note:  If you have installed only the Operations Hub add-on for Historian, you cannot create an
application or components of an application. You can only access the Historian analysis application.

Suppose you want to create an application that will send an email notification if the temperature
recorded by a sensor exceeds 40 degrees Celsius. In this case, you will perform the following tasks:

1. Create an email template, which will contain the text and event parameters that you want to send
in the email.

2. Create an event that will be triggered when the temperature recorded by the sensor exceeds 40
degrees Celsius.

3. Add an action to the event to define the recipients and send an email using the email template
that you have created.

4. Create a page to display the sensor data. You can display the data using components such as
text, gauges, or historical trend charts.
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5. Add an event settings component to the page to allow application users to turn the event on or
off.

Grant Access to an Application for an Individual User

By default, all the developers can access all the applications that they have developed. Application
users, however, can access only the applications to which they are granted access. This topic
describes how to grant access to an application for individual users. You can also grant access to a
role (page 109)

Note:  A user must be a member of the iqp.user group in order to be assigned to an App.

1. From the main navigation menu, select APPS.
The APPS workspace appears.

2. In the Name column, select the application to which you want to grant access.
The PAGES workspace appears.
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3. From the main navigation menu, select APP USERS.
The APP USERS workspace appears, displaying a list of application users created in the site.

4. In each row containing an application user to whom you want to grant access, select the check
box, and then select Submit changes.
The selected users can now access the application.

Grant Access to an Application for a Group

By default, all the developers can access all the applications that they have developed. Application
users, however, can access only the applications to which they are granted access. This topic
describes how to grant access to an application for user groups. You can also grant access to a role.

Note:  A user must be a member of the iqp.user group in order to be assigned to an App.
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1. From the main navigation menu, select APPS.
The APPS workspace appears.

2. In the Name column, select the application to which you want to grant access.
The PAGES workspace appears.
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3. From the main navigation menu, select APP GROUPS.
The APP GROUPS workspace appears, displaying the list of UAA groups for the UAA
connected to this instance Operations Hub.

4. In each row containing an application user to whom you want to grant access, select the check
box, and then select Submit changes.
The selected groups can now access the application.

Access an Application

1. From the main navigation menu, select APPS.
The APPS workspace appears.
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2. In the row containing the application that you want to access, select .

3. If you want to access the application in a web browser, select Open. If, however, you want to
access the application on a mobile device, scan the QR code using the device.
The application appears in a new browser tab or on your mobile device.

If upgrading to Operations Hub 2.0, please note that every application can be referenced by an URL.
All hardcoded links to applications must be updated with the new URLs.

Access a Recently Created Application

1. From the main navigation menu, select APPS.
The APPS workspace appears.
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2. Select RECENTLY CREATED.
A list appears with the ten most recently created applications.
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Access a Recently Modified Application

1. From the main navigation menu, select APPS.
The APPS workspace appears.
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2. Select RECENTLY MODIFIED.
A list appears with the ten most recently modified applications.
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Create an Application

This topic describes how to create an application. You can also copy an application (page 119).

1. From the main navigation menu, select APPS.
The APPS workspace appears.
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2. Select Add new app.
The Create App window

appears.

3. In the App name and Description boxes, enter values, and then select Create. The name must
contain at least one uppercase or lowercase letter.
The application is created.
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Create a page (page 262).

Copy an Application

This topic describes how to copy an application. You can also create an application (page 117).

You can copy an application only if it was created in the same site. If, however, you want to copy
an application that was created in a different site, you must export the application (page 120), and
then import (page 122) it.

1. From the main navigation menu, select APPS.
The APPS workspace appears.

2. In the rows containing the applications that you want to copy, select the check boxes.

3. In the workspace heading, select , and then select Duplicate apps.
A message appears, asking you to confirm that you want to duplicate the applications.
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Tip:  Alternatively, in the row containing each application that you want to copy, select ,
and then select Duplicate app.

4. Select OK.
The Create App window appears. The App name box contains the name of the application
that you want to copy, along with a system-generated value. The Description box contains the
description of the application that you want to copy.

5. For each application that you have selected, modify values in the App name and Description
boxes as needed, and then select Create.
The applications are copied. The Pages workspace for the first application that you have copied
appears, displaying a list of pages copied from the original application.

Export an Application
Export and save applications to your local system.

If you want to use or copy an application that was created using a different site, you must export the
application, and then import (page 122) it.

Tip:  If you want to export multiple applications that use the same entities and queries, export
them together (instead of exporting them individually).

Default applications are excluded from the export operation. To export a default application,
duplicate (page 119) and export it.

1. From the main navigation menu, select APPS.
The APPS workspace appears.
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2. In the rows containing the applications that you want to export, select the check boxes.

3. In the workspace heading, select , and then select Export apps.
A message appears, indicating that the application will be saved in the default download
location of the browser.

Tip:  Alternatively, in the row containing each application that you want to export, select ,
and then select Export app.

4. Select OK.
The Select Datasources screen appears, if the application being exported contains queries that
work with multiple data sources.

5. Select the compatible data sources, then select Export.
Each application is exported as a .zip file, which contains:

• a .zip file for each plug-in used in the application.
• an .xml file for the rest of the components used in the application.
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Important:  To avoid system related errors, do not modify original exported zip files and
repackage them for import.

Import the application (page 122).

Import an Application
Import and save applications to Operations Hub.

When you import an application, a copy of the application and its components (that is, plug-ins,
pages, entities, queries, events, themes, and settings) is created. If an application or a component with
the same name exists in the current site, then a system-generated number is appended to the name of
the imported application or component. However, if a plug-in with the same name exists, the plug-in
is not imported. Instead, the plug-in that already exists in the site is used in the application.

Export the application (page 120) that you want to import. Default applications are excluded from
the import operation.

1. From the main navigation menu, select APPS.
The APPS workspace appears.
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2. Select Import App.
A message appears, indicating that if there is already an application or a component with the
same name, the imported application or component will contain a new name.

3. Proceed to import the application.

4. Navigate to the application (stored as a .zip file) that you want to import, then select Open.

Important:  To avoid system related errors, do not modify original exported zip files and
repackage them for import.

5. If the application being imported already exists in Operations Hub with the same name, select
one of the following:

Option Description

Duplicate Creates a duplicate copy of the application and imports
to Operations Hub.

Replace Deletes the existing application in Operations Hub and
replaces with the one from the import file.
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If duplicate data source records are found, you may be asked to confirm before importing the
file to Operations Hub. Refer to Handling Duplicate OPC UA Data Sources (page 124).

6. If the system detects that the imported application has widgets/plug-ins eligible for upgrades,
then they are automatically updated to their latest versions. See Configure Plug-in Upgrades
(page 125).

A copy of the selected application is created. The Pages workspace appears, displaying a list of
pages copied from the original application.

Handling Duplicate OPC UA Data Sources

OPC UA data sources are identified as duplicates if they contain identical server endpoint values.

If duplicate OPC UA data sources are detected during application import, select one of the following:

Option Description

Use Existing Maintains the data source record that currently exists in Operations Hub.
Does not import the duplicate from the file.

Replace Deletes the data source record that currently exists in Operations Hub.
Imports the duplicate from the file to replace the deleted record.

Note:  This option is enabled only for duplicate data source records
sharing the same name and endpoint connection value (URI). Details such
as security policy, authentication, etc. may vary in these records.

Duplicate Apps in Operations Hub: During import conflict, if you opt for duplicating the
application, the relevant data sources are also duplicated.

To resolve any OPC UA data source server endpoint (URI) conflict when duplicating apps:

• Select Use Existing to avoid deleting the existing OPC UA record in Operations Hub. This
record will not be imported from the file.

• Select Replace, to replace the existing OPC UA record in Operations Hub with the record from
the import file.

The data source records that do not have a conflict get duplicated.

Replace Apps in Operations Hub: During import conflict, if you opt for replacing the application,
Operations Hub data source records having the same name as the imported records, are deleted
before being replaced with the imported ones.

Note:  Any OPC UA data source record in Operations Hub that shares the same name with a
record from the import file will get replaced in this scenario. Such records are not considered to be
duplicates.

To resolve any OPC UA data source server endpoint (URI) conflict when replacing apps:
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• Select Use Existing to avoid deleting the existing OPC UA record in Operations Hub. This
record will not be imported from the file.

• Select Replace, to replace the existing OPC UA record in Operations Hub with the record from
the import file.

The data source records that do not have a conflict get replaced.

Note:  Duplicate OPC UA data sources that existed in older versions are not removed after
upgrading to 2.1 or later. It is recommended to manually delete such duplicate records, or modify
them to use a unique server endpoint connection.

Configure Plug-in Upgrades

A pre-requisite for successful custom plug-in upgrade in Operations Hub.

Plug-in developers can choose to write a specification, or use any transformation mechanism to get
an EXE, JAR, or BAT file.

1. Prepare a data transformation for plug-in upgrade using any of these methods:

Transformation File Type Description

Jolt Open-source JSON-to-JSON transformation library
written in Java.

For more information, refer to https://github.com/
bazaarvoice/jolt#Documentation

For Jolt spec, you can use http://jolt-
demo.appspot.com/ as a playground to test your
transformation.

JAR Java output using JSON transformation library such
as https://mvnrepository.com/artifact/net.minidev/json-
smart/2.4.7.

For JAR, the plug-in upgrade infrastructure looks
for the class to load. For example, public class
GEBreadcrumb_3_0_0to3_0_1 wherein,

• GEBreadcrumb is the plug-in name
• 3_0_0 is the breadcrumb plug-in old version. The

dot is replaced with an underscore.
• 3_0_1 is the breadcrumb plug-in new version. The

dot is replaced with an underscore.

A transform instance is created for the class by
invoking its static transform method: public static
String transform(String inputJSON)

https://github.com/bazaarvoice/jolt#Documentation
https://github.com/bazaarvoice/jolt#Documentation
http://jolt-demo.appspot.com/
http://jolt-demo.appspot.com/
https://mvnrepository.com/artifact/net.minidev/json-smart/2.4.7
https://mvnrepository.com/artifact/net.minidev/json-smart/2.4.7
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Transformation File Type Description

.EXE Windows® executable file. Create a transformation
project with your choice of library (C++, Node, Python,
etc.), which prints the transformed output json to
console.

For this executable,
• 'FromVersion' schema input json is passed as

command line argument
• 'ToVersion' response JSON is read from its

console output produced by the executable

Note:  Naming convention for the transformation file is <PluginName>-<FromVersion>-
<ToVersion>-spec.json. For example GETrendCard-3.0.1-3.0.2-spec.json|jar|exe|
bat.

2. Log in to the machine where Operations Hub is installed.

3. Place the plug-in transformation files in this location folder ..\ProgramData\GE\Operations
Hub\iqp-config\plugin-transform-spec

When Operations Hub administrator imports applications with old plug-ins, they are successfully
upgraded to their latest versions.

• The transformation engine looks for an incremental path of intermediatory transformation
that can migrate a plug-in from a specific version to a desired version. For instance,
GETrendCard-3.0.1-3.0.2-spec.json GETrendCard-3.0.2-3.0.4-spec.json
GETrendCard-3.0.4-3.0.5-spec.json are used consecutively to upgrade plug-ins.

• If incremental upgrades were not performed between Operations Hub versions, then the plug-in
version may not remain subsequent for upgrade. For example, consider:

◦ Operations Hub 1.7 has 3.0.1 version of GETrendCard
◦ Operation Hub 2.5 has 3.0.5 version of GETrendcard

The GETrendCard-3.0.1-3.0.5-spec.json file may not be available for upgrading plug-ins.
In such cases, plug-in upgrades are not performed in Operations Hub.

Delete an Application
Delete applications from Operations Hub.

• When you delete an application, only the application is deleted from Operations Hub. The
components used by the application are not deleted.

• You cannot delete an application if it is locked.
• You cannot delete Operations Hub default applications.

1. From the main navigation menu, select APPS.
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The APPS workspace appears.

2. In each row containing an application that you want to delete, select the check box.

3. In the workspace heading, select , and then select Delete apps.
A message appears, asking you to confirm that you want to delete the applications.

Tip:  Alternatively, in the row containing each application that you want to delete, select ,
and then select Delete app.

4. Select OK.
The applications are deleted.

Upgrade an Application
Analyzes applications and updates app plug-ins, if required.

See also Configure Plug-in Upgrades (page 125).
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As a best-practice, always upgrade your applications after upgrading to a SIM version. This allows
the existing plug-ins in applications to work properly.

1. From the main navigation menu, select APPS.
The APPS workspace appears.

2. In each row containing an application that you want to upgrade, select the check box.

3. In the workspace heading, select , and then select Upgrade apps.
A message appears to confirm whether to check if the selected applications require plug-in
upgrades.

Tip:  Alternatively, in the row containing each application that you want to upgrade, select

, and then select Upgrade app.

4. Select OK to analyze and update the application plug-ins, if necessary.
A message appears to confirm the upgrade.
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5. Optional:  Select Show Details in the message to review a summary of application plug-in
upgrades.

Entities

About Entities
An entity is a database table, which you can use to store data.

You can create queries to retrieve and manage data stored in entities. You can create events to trigger
actions when data in an entity is changed. The following list provides a few examples on using
entities:

• Enhance data that is used in an asset monitoring application
• Create applications related to customer relationship management
• Manage the workflow of an event-handling or a parts-ordering application
• Sort data retrieved from a maintenance or an issue-reporting application
• Store contact details of employees

Operations Hub provides a few baseline entities that you can use to manage your assets or collect
machine data. You cannot modify or delete these entities; you can use them in your application
directly. For baseline entities, the LAST UPDATED column is blank in the ENTITIES workspace.

When you create an entity, you must perform the following steps:

1. Define the entity structure. To do so, add fields (page 137) and specify their data types (for
example, Boolean, Number, String, and so on).

2. Add rows, and specify field values. To do so, enter values manually (page 139) or import data
from a Microsoft Excel workbook (page 141).

Pivot Entity

A pivot entity is used to automatically collect data from multiple sensors that belong to selected
devices and groups of devices. You can use a pivot entity in a query, and plot it as a trend graph in
your application.

For a pivot entity, one of the following icons appears in the ENTITIES workspace:

• : Indicates that the pivot entity is receiving data. If you want to stop collecting data in the
pivot entity, you must deactivate the pivot entity. To do so, access the pivot entity, and then

select .
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• : Indicates that the pivot entity is not receiving data. If you want to start collecting data in the
pivot entity, you must activate the pivot entity. To do so, access the pivot entity, and then select

.

Important:  If you add or remove a device from a device type or group that is used in a pivot
entity, you must deactivate the pivot entity, and then reactivate it for the changes to be applied.

Suppose 50 sensors are connected to a device type and 100 devices of that type send data to your
application. Suppose you want to monitor the data from only five of the sensors and only 10 of the
devices, which belong to a device group named EV group. You can create a pivot entity to collect
data from only the selected sensors and the selected devices that belong to the EV group. This makes
it easier to plot trend graphs or create tables with multiple sensor values in your application and
improves performance when retrieving the data.

Relationship Between Entities

If you want to retrieve data from two or more entities in a single query, you must create a
relationship (or a join) between them. When you create a relationship between entities, the two
entities are joined by an inner join in SQL. The entity from which you create a relationship is called
the source entity. The entity to which you create a relationship is called the target entity.

A single entity can be used both as a source entity and a target entity. A single entity can be used
as a source entity in multiple relationships. A relationship can be bidirectional (that is, if there is a
relationship from entity 1 to entity 2, you can also create a relationship from entity 2 to entity 1).

After you create a relationship, when you create a query, if you select the source entity in the Entity
box, you can retrieve data from fields in both the source and target entities. If, however, you select
the target entity, you can retrieve data only from the target entity.

Important:  You cannot use a baseline entity or a pivot entity as a source entity; you can only
use it as a target entity.

Access an Entity

1. From the main navigation menu, select ENTITIES.
The ENTITIES workspace appears.
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2. In the row containing the entity that you want to access, in the Name column, select the link.
The entity appears, displaying a list of fields in the entity.
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Tip:  You can modify values in the available fields, and then select Save or Save and Exit
to save your changes.

Create an Entity

This topic describes how to create an entity. You can also copy an entity (page 136).

1. From the main navigation menu, select ENTITIES.
The ENTITIES workspace appears.

2. Select Add new entity.
The Create Entity window appears.



Operations Hub for Windows | 3 - User Guide | 133

3. In the Entity name box, enter a name, and then select Create.

4. Select Edit Entity Structure.
A list of fields in the entity appears.

5. Select Add Field.
A field is created in the entity. By default, the name of the field is Field_1 and the type is String.
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6. Next to the field name, select , and then modify the name of the field. The name must contain
at least one uppercase or lowercase letter.

7. In the drop-down list box in the Type column, modify the type of the field if needed.

8. Select Save or Save and Exit.
The entity is created.

Add a row (page 139) or, if needed, import data in to the entity (page 141).

Create a Pivot Entity

Register the device details and metrics that you want to use in the pivot entity using baseline entities.

1. Register the device types and metrics using the supported_device_gateway and the
metrics_device_type entities, respectively.

2. Register the device groups for the device type using the M2M_groups entity. The group must
belong to a device type that you want to use in the pivot entity.

3. Register the devices in a group that you created for their device type.

1. From the main navigation menu, select ENTITIES.
The ENTITIES workspace appears.
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2. Select Add new pivot entity.
The Create Pivot Entity window appears.

3. In the Pivot entity name box, enter a name, and then select Create. The name must contain at
least one uppercase or lowercase letter.
The pivot entity is created. By default, a few fields such as timestamp, device_id,
instance_name, and other fields are added to the pivot entity. You cannot modify or delete them.
You can, however, add more fields for the metrics that you want to record in the pivot entity.

4. If you want to collect data from a specific device type:
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a. In the Get Data By box, select Device type.
A drop-down list box appears next to the Device type box, displaying a list of device types
that you have registered using the supported_device_gateway entity.

b. Select the device type from which you want to collect data in the pivot entity.

5. If you want to collect data from a specific device group:

a. In the Get Data By box, select Device group.
A drop-down list box appears next to the Device group box, displaying a list of device
groups that you have registered using the M2M_groups entity.

b. Select the device group from which you want to send data to the pivot entity.

6. Create a field (page 137) for each metric that you want to record (for example, pressure,
temperature, and other metrics). The field name must match the metric name that you have
registered using the metrics_device_type entity and the metric name that the device uses to send
data. This name is case-sensitive.

7. As needed, create additional fields in the pivot entity, and then select Save or Save And Exit.
The changes made to the pivot entity are saved.

In the ENTITIES workspace,  appears in the row containing the pivot entity that you have
created.

Select  to start collecting data in the pivot entity.

Copy an Entity

This topic describes how to copy an entity. You can also create a new entity (page 132).

1. From the main navigation menu, select ENTITIES.
The ENTITIES workspace appears.
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2. Select the entity that you want to copy.

3. Select Edit Entity Structure.

4. As needed, add or remove fields.

Tip:  You can also modify the type of a field by selecting a value in the TYPE column.

5. Select Save As New.
The Please enter new name window appears, displaying the name of the entity that you have
selected, appended with a system-generated value.

6. As needed, modify the name of the entity, and then select OK.
The selected entity is copied.

Create a Field in an Entity

1. From the main navigation menu, select ENTITIES.
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The ENTITIES workspace appears.

2. Select the entity in which you want to create a field.
A list of fields in the entity appears, along with the data in each field.

3. Select Edit Entity Structure.
A list of fields in the entity appears.
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4. Select Add Field.
A field is created in the entity. By default, the name of the field is Field_1 and the type is String.

5. Next to the field name, select , and then modify the name of the field. The name must contain
at least one uppercase or lowercase letter.

6. In the drop-down list box in the Type column, modify the type of the field if needed.

7. Select Save or Save and Exit.
The field is created in the entity.

Add a row (page 139) or import data in to the entity (page 141).

Add a Row to an Entity

As needed, add fields to the entity (page 137).
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This topic describes how to add a row and enter data manually in an entity. You can also import data
(page 141) from a Microsoft Excel workbook. You cannot, however, add data to baseline entities
or pivot entities manually. You can only insert data into these entities using an insert query in an
application.

1. From the main navigation menu, select ENTITIES.
The ENTITIES workspace appears.

2. Select the entity in which you want to add a row.

3. Select Add row.
A blank row appears in the table.

Tip:  You can add multiple rows together by selecting Add row multiple times.

4. Enter values in the blank row, and then select Save Changes.
The values that you have entered in the row are saved.
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Tip:  If you have entered values in multiple rows, but want to save values only for a single

row, select  in the row.

Import Data in to an Entity

This topic describes how to import data in to an entity from a Microsoft Excel workbook. You can
also add a row manually in the entity (page 139).

1. From the main navigation menu, select ENTITIES.
The ENTITIES workspace appears.

2. Select the entity in to which you want to import data.

3. Select Import Excel, navigate to and select the workbook that you want to import, and then
select Open.
The Set Column Mapping window appears.
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4. If you want to use the names in one of the rows of the workbook as field names:

a. Select Use Header Row Names.
The Header Row Number box appears.

b. Enter the row number in the workbook that you want to specify as the header row. By
default, this box contains the value 1, which indicates that the first row is used as the
header row.

5. In the Import data from row and to row boxes, enter the first and the last row numbers in
the workbook that you want to import. For example, if you want to import data from rows 3
through 6, enter 3 and 6 respectively. By default, the Import data from row box contains the
row number that is immediately next to the header row that you have specified.

6. If the entity already contains data and you want to add to it, select Append to existing data. If,
however, you want to delete existing data before importing, select Overwrite existing data.

7. Select Next.
A list of fields in the entity appears. Next to each field, a text box appears in the Column Name
in Spreadsheet column.
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8. For each field, specify the column name in the header row in the workbook that you want to
map, and then select Import.
A message appears, stating that the process is irreversible and asking you to confirm that you
want to import data.

9. Select OK.
A message appears, indicating that the data has been imported successfully.

10. Select OK.
The data is imported.

Create a Relationship Between Entities

You cannot use a baseline entity or a pivot entity as a source entity. You can, however, use it as a
target entity.

1. From the main navigation menu, select ENTITIES.
The ENTITIES workspace appears.
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2. Optional: Select the check boxes of the entities for which you want to create a relationship.

3. Select DESIGNER.
The DESIGNER section appears, displaying all the entities created in the site. If, however, you
have selected entities in the previous step, only the selected entities appear. If a relationship
exists between two entities, a line connecting them appears.

Tip:  You can arrange the entities in an order, minimize all entities, maximize all entities,
or maximize only the entities in a relationship by selecting Auto Arrange, Minimize All,
Maximize All, or Maximize linked Entities respectively.

4. Next to each entity for which you want to create a relationship, select .
A list of fields in each entity appears.

5. Select Add Relationship, and then select a field from the source entity and then the target
entity.
A relationship is created between the entities. A line connecting both the entities appears.

Delete a Relationship

1. From the main navigation menu, select ENTITIES.
The ENTITIES workspace appears.
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2. Select DESIGNER.
The DESIGNER section appears, displaying all the entities created in the site. If a relationship
exists between two entities, a line connecting them appears.
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3. On the line connecting the two entities whose relationship you want to delete, select .
A message appears, asking you to confirm that you want to delete the relationship.

4. Select OK.
The relationship is deleted.

Delete a Row from an Entity

You cannot delete a row manually from a baseline entity or a pivot entity; you can delete rows only
using a query in an application.

1. From the main navigation menu, select ENTITIES.
The ENTITIES workspace appears.
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2. Select the entity from which you want to delete a row.

3. In the row that you want to delete, select .
A message appears, asking you to confirm that you want to delete the row.

4. Select OK.
The row is deleted.

Delete a Field

An entity must contain at least one field. Therefore, if an entity contains only one field, you cannot
delete it.

1. From the main navigation menu, select ENTITIES.
The ENTITIES workspace appears.
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2. Select the entity from which you want to delete a field.

3. Select Edit Entity Structure.
A list of fields in the entity appears.
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4. In the row containing the field that you want to delete, select .
The field is deleted.

Delete an Entity

You cannot delete a baseline entity, an entity that is locked, or an entity that is used in a query.

Note:  In order to unlock an entity, you need to select the entity, click Edit Entity Structure,
and then click the lock icon (in the upper right corner) of the Edit Entity Structure page. After you
complete that task, you can go to entity list page to delete it.

1. From the main navigation menu, select ENTITIES.
The ENTITIES workspace appears.
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2. In the rows containing the entities that you want to delete, select the check boxes.

3. In the workspace heading, select , and then select Delete entities.
A message appears, asking you to confirm that you want to delete the entities.

Tip:  Alternatively, in the row containing each entity that you want to delete, select , and
then select Delete entity.

4. Select OK.
The entities are deleted.
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Queries

About Queries

Using Operations Hub, you can create queries to access and manage data stored in Operations Hub,
as well as data stored externally.

You can create the following types of queries:

• Entity Queries: Used to view and modify data stored in Operations Hub entities. Refer to Get
(page 153), Update (page 158), Insert (page 162), and Delete (page 164).

• SQL (page 167) Queries: Used to view and modify data stored in an external SQL database
by executing existing stored procedures for that database.

• REST (page 170) Queries: Used to view and modify data stored in external sources by
accessing their exposed REST APIs, such as Historian.

• Extension (page 175) Queries: Can be used with Historian, OPC UA, and data from asset
models.

On installing Operations Hub, you also get a list of out-of-the-box (OOTB) queries for use. These are
system queries and cannot be unlocked, modified, or deleted. You can duplicate such queries (page
179) to modify and use them.

To access the list of OOTB queries, select QUERIES in the main navigation menu.

• Current Value: Use this query to retrieve the current values against Proficy Historian, Proficy
iFIX, Proficy CIMPLICITY, and OPC UA data sources.

• Historical By Count: Use this query to retrieve historical values (by count) against a Proficy
Historian data source.
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• Historical By Interval: Use this query to retrieve historical values (by interval) against a Proficy
Historian data source.

• Historian Write Comment: Use this query to write comments to a Proficy Historian data source.
• Historian Read Comment: Use this query to read comments from a Proficy Historian data

source.
• OPC UA Write: Use this query to perform write operations to Proficy iFIX and Proficy

CIMPLICITY data sources.
• Historical By Interval-Calculated Mode: Use this query to retrieve historical values (calculated

mode) against a Proficy Historian data source.

To troubleshoot errors returned for OOTB queries, refer to Error Codes (page 479).

Grant Group Access to Execute a Query

1. From the main navigation menu, select QUERIES.
The QUERIES workspace appears, including a column summarizing the current query
permissions. By default, newly created queries display “All users”, indicating all users have the
ability to execute the query.

2. In the Permissions column, select the query to which you want to grant query execution
permissions.
The Query Permissions dialog box appears.

3. In the Query Permissions dialog box, if you want to grant query execution permissions to
select groups only, select the “Selected Groups” option.

4. In the groups field, select the group or groups you would like to grant query execution
permissions to and then select Submit changes.
The selected groups can now execute the query.

Note:  It is possible to create a circular reference by nesting a parent group into its child. If
there are circular references, the child groups will not display in the permissions dialog box.

Access a Query

1. From the main navigation menu, select QUERIES.
The QUERIES workspace appears.
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2. In the row containing the query that you want to access, in the Name column, select the link.
The query appears, displaying a list of fields in the query.

Tip:  You can modify values in the available fields, and then select Save or Save and Exit
to save your changes.

Create a Get Query

This topic describes how to create a Get query. You can also copy a query (page 179).

1. From the main navigation menu, select QUERIES.
The QUERIES workspace appears.

2. Select Add new query.
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The Create Query window appears.

3. In the Query name box, enter a name, and then select Create. The name must contain at least
one uppercase or lowercase letter.
The available options for creating the query appear.

4. In the Description box, enter a value.

5. In the Query Type box, select Get.

6. In the Entity box, select an entity from which you want to get results.
The Output Data, Conditions, Role Conditions, and Advanced sections appear.
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7. In the Output Data section, select Add field.
The FIELD, FUNCTION, and ACCESS boxes appear.

Tip:  If you want to get values from all the fields in the query, select Add all fields.

8. Enter or select values as specified in the following table.

Field Description

FIELD Select the field whose values you want to get using the
query.

Tip:  If the entity that you have specified in the
Entity box is a source entity in a relationship, you can
select from fields in the source and target entities.

FUNCTION Specify whether you want to get the maximum,
minimum, average, sum, or count of the values in the
field. By default, the value in this box is None, which
indicates that the exact values will appear in the query
results.

ACCESS If you want to provide access to the data in the
field only to users assigned to specific roles, select
Permitted roles. By default, this box contains the value
All users, which indicates that all users, regardless
of the roles assigned to them, can access the query
results. In the PERMITTED ROLES box that appears,
navigate through the hierarchy of roles, and then select
the roles assigned to users who can access the data in
this field.

9. In the Conditions section, select Add, and then enter or select values as specified in the
following table.

Field Description

Required or Optional Select one of the following values:
• Required: Select this value if the field must always

contain a value. For example, suppose you are
creating a query to display account details based
on the account number. If you select Required,
when you run the query, if you have not specified
an account number, no records appear.

• Optional: Select this value if the field need not
contain a value. For example, suppose you are
creating a query to display account details based
on the account number. If you select Optional,
when you run the query, if you have not specified
an account number, all the records appear.

Field Select the entity field based on which you want to
create a condition.

Operator Select the conditional operator that you want to use to
compare the value in the selected field.
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Field Description

Compare with Select one of the following values:
• Input field: Select this value if you want to allow

application users to specify a value that you want
to compare with the entity field value. After you
select this value, enter a name for the input field in
the text box that appears. For example, suppose
you want to create a query to display a list of
devices in a specific site, and you want to allow the
user to specify the site name. In this case:

a. Select Input field, and then enter Site Name.
b. Modify the page in the application that

contains the query to include an input
component that allows the user to enter or
select the site name.

c. Map the input component in the page with the
input in the Page Data section.

When the user enters a value in the Site
Name field in the application, the query results
are filtered accordingly.

• Fixed Value: Select this value if you want to
specify the value that you want to compare with the
entity field value. After you select this value, enter
a value in the text box that appears. For example,
if you want to get data received from a device if the
temperature exceeds 40 degrees Celsius:

◦ In the Field box, select the field that stores
temperature.

◦ In the Operator box, select >.
◦ Select Fixed Value, and then enter 40 in the

text box.
• Query: Select this value to specify a query whose

output you want to compare with the field values
in the specified entity. After you select this value,
a drop-down list box appears in which you can
select a query. For example, if there is a query
that returns the maximum temperature recorded
by a device, you can create a query to get a list of
devices that record a temperature higher than the
maximum temperature.

10. In the Role Conditions section, select Add role condition, and then enter or select values as
specified in the following table.
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Field Description

Apply conditions to Select one of the following values:
• Specific Roles: Select this value if you want

to apply the condition only to users assigned to
specific roles. After you select this value, navigate
through the hierarchy of roles, and select the roles.

• All roles: Select this value if you want to apply the
condition to all or most users. After you select this
value, the Exclude check box appears. Select this
check box if you do not want to apply the condition
to users assigned to specific roles. After you select
this check box, navigate through the hierarchy of
roles, and select the roles.

For example, suppose the query returns sales
data, and you want to apply the following
conditions on who can access the query results:

◦ Users can access only the data that is related
to their region.

◦ Regional officers can access data related to
all regions.

In this case, select the Exclude check box, and
then select the Regional Officer role.

Row visibility Select one of the following values:
• Filter rows: Select this value if you want to filter

rows based on a condition, and then specify the
condition in the Entity field and In user's role
tree boxes. For example, if the query returns sales
data, and you want users to access only the data
that is related to their region, then:

◦ In the Entity field box, select the entity field
that stores the sales region data.

◦ In the In user's role tree box, select the
category that stores the region roles.

• Show all rows: Select this value if you want users
belonging to specific roles to access all the field
values.

Entity field Select the entity field that contains the value that you
want to compare with the value in the In user's role
tree box. This box appears only if the value in the Row
visibility box is Filter rows.

In user's role tree Select the group or category of users that will be used
to filter data. This box appears only if the value in the
Row visibility box is Filter rows.

11. In the Advanced section, enter or select values as specified in the following table:

Field Description

Distinct Select this check box if you do not want the query
results to display duplicate field values. For example,
suppose a query returns a list of countries that
users belong to, and you want to view only the list of
countries, you can select this check box so that each
country appears only once.
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Field Description

Order By Select Add, and then select the entity field and the
order in which the field values should be arranged in the
query results.

Group By Select Add, and then select the entity field that you
want to use to group the query results.

If the query results contain a list of users and the country that each user belongs to, and if
you want to group the users based on their country and sort them alphabetically, perform the
following steps:

a. In the Order By box, select the entity field that stores the user name, and then select Asc.
b. In the Group By box, select the entity field that stores the country.

12. Select Save or Save And Exit.
The query is created.

Create an Update Query

This topic describes how to create an Update query. You can also copy a query (page 179).

1. From the main navigation menu, select QUERIES.
The QUERIES workspace appears.

2. Select Add new query.
The Create Query window appears.
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3. In the Query name box, enter a name, and then select Create. The name must contain at least
one uppercase or lowercase letter.
The available options for creating the query appear.

4. In the Description box, enter a value.

5. In the Query Type box, select Update.

6. In the Entity box, select an entity from which you want to update results.
The Conditions and Set Data sections appear.
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7. In the Conditions section, select Add, and then enter or select values as specified in the
following table.

Field Description

Entity Field Select one of the following values:
• Required: Select this value if the field must always

contain a value. For example, suppose you are
creating a query to update account details based
on the account number. If you select Required,
when the query is run from an application, if an
account number is not specified, then a message
appears, stating that the field is required.

• Optional: Select this value if the field need not
contain a value. For example, suppose you are
creating a query to update account details based
on the account number. If you select Optional,
when the query is run from an application, if an
account number is not specified, then all the fields
will be updated. Therefore, use caution when
selecting this value.

Important:  Exercise extreme caution while
selecting Optional. If used incorrectly, it can
corrupt the data.

Field Select the entity field based on which you want to
create a condition.

Operator Select the operator that you want to use to compare the
value in the text box if Input Field is selected.
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Field Description

Compare with Select one of the following values:
• Input field: Select this value if you want to allow

application users to specify a value that you want
to compare with the entity field value. After you
select this value, enter a name for the input field in
the text box that appears. For example, suppose
you want to create a query to update all devices
in a specific site, and you want to allow the user to
specify the site name. In this case:

a. Select Input Type, and then enter Site Name.
b. Modify the page in the application that

contains the query to include the query to add
an input control that allows the user to specify
or select the Site Name field. Using the drag-
and-drop method, map the Site Name field in
the query with the site name control.

When the user enters or selects a value in the
Site Name field in the application, and runs
the query, all the devices with the selected site
name are updated.

• Fixed Value: Select this value if you want to
specify the value that you want to compare with the
entity field value. After you select this value, enter
a value in the text box that appears. For example,
if you want to update the status of all devices if the
temperature exceeds 40 degrees Celsius:

◦ In the Field box, select the field that stores
temperature.

◦ In the Operator box, select >.
◦ Select Fixed Value, and then enter 40 in the

text box.
• Query: Select this value to specify a query whose

output you want to compare with the field values
in the specified entity. After you select this value, a
drop-down list box appears in which you can select
a query. For example, if you want the query to
update the status of devices when the temperature
recorded by them exceeds a specified maximum
temperature, you must create a query to get the
maximum temperature, and select that query in this
field.

8. In the Set Data section, select Add, and then enter or select values as described in the following
table.

Field Description

Entity field Select the entity field whose values you want to update
using the query.
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Field Description

Value Select one of the following values:
• Input field: Select this value if you want to update

values specified by application users, and then
enter a name in the Input Data Name box. Add
an input control for the field in the application, and
map it to the input field in the query.

• Fixed value: Select this value if you want to insert
a fixed value, and then enter the value in the Name
box.

Input Data Name This field appears only if you select Input field in the
Value box. Enter the name of the field that you will add
in the application. Application users can then provide
the value by accessing the application.

Name This field appears only if you select Fixed value in the
Value box. Enter the value that you want to update
using the query.

9. Select Save or Save And Exit.
The query is created.

Create an Insert Query

This topic describes how to create an Insert query. You can also copy a query (page 179).

1. From the main navigation menu, select QUERIES.
The QUERIES workspace appears.

2. Select Add new query.
The Create Query window appears.
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3. In the Query name box, enter a name, and then select Create. The name must contain at least
one uppercase or lowercase letter.
The available options for creating the query appear.

4. In the Description box, enter a value.

5. In the Query Type box, select Insert.

6. In the Entity box, select an entity in which you want to insert results.
The Set Data section appears.

7. In the Set Data section, select Add, and then enter or select values as described in the following
table.

Field Description

Entity field Select the entity field whose values you want to insert
using the query.
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Field Description

Value Select one of the following values:
• Input field: Select this value if you want to insert

values specified by application users, and then
enter a name in the Input Data Name box. Add an
input control for the field in the application and map
it to the input field in the query.

• Fixed value: Select this value if you want to insert
a fixed value, and then enter the value in the Name
box.

Input Data Name This field appears only if you select Input field in the
Value box. Enter the name of the field that you will add
in the application. Application users can then provide
the value by accessing the application.

Name This field appears only if you select Fixed value in the
Value box. Enter the value that you want to insert using
the query.

8. Select Save or Save And Exit.
The query is created.

Create a Delete Query

1. From the main navigation menu, select QUERIES.
The QUERIES workspace appears.

2. Select Add new query.



Operations Hub for Windows | 3 - User Guide | 165

The Create Query window

appears.

3. In the Query name box, enter a name, and then select Create. The name must contain at least
one uppercase or lowercase letter.
The available options for creating the query appear.

4. In the Description box, enter a value.

5. In the Query Type box, select Delete.

6. In the Entity box, select an entity from which you want to delete results.
The Conditions section appears.

7. In the Conditions section, select Add, and then enter or select values as specified in the
following table.
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Field Description

Required or Optional Select one of the following values:
• Required: Select this value if the field must always

contain a value. For example, suppose you are
creating a query to delete account details based on
the account number. If you select Required, when
the query is run from an application, if an account
number is not specified, a message appears,
stating that the field is required.

• Optional: Select this value if the field need not
contain a value. For example, suppose you are
creating a query to delete account details based on
the account number. If you select Optional, when
the query is run from an application, if an account
number is not specified, the all the records are
deleted.

Important:  Exercise extreme caution while
selecting Optional for a delete query. If the user
does not specify a value, all the data in the entity
will be deleted.

Field Select the entity field based on which you want to
create a condition.

Operator Select the operator that you want to use to compare the
value in the text box if Input field is selected.
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Field Description

Compare with Select one of the following values:
• Input field: Select this value if you want to allow

application users to specify a value that you want
to compare with the entity field value. After you
select this value, enter a name for the input field in
the text box that appears. For example, suppose
you want to create a query to delete devices in
a specific site, and you want to allow the user to
specify the site name. In this case:

a. Select Input Type, and then enter Site Name.
b. Modify the page in the application that

contains the query to add an input control that
allows users to specify the site name. Using
the drag-and-drop method, map the input
control in the query with the Site Name field.

When the user enters a value in the Site
Name field in the application, and runs the
query, all the devices with the specified site
name are deleted.

• Fixed Value: Select this value if you want to
specify the value that you want to compare with the
entity field value. After you select this value, enter
a value in the text box that appears. For example,
if you want to delete data received from a device if
the temperature exceeds 40 degrees Celsius:

◦ In the Field box, select the field that stores
temperature.

◦ In the Operator box, select >.
◦ Select Fixed Value, and then enter 40 in the

text box.
• Query: Select this value to specify a query whose

output you want to compare with the field values
in the specified entity. After you select this value,
a drop-down list box appears in which you can
select a query. For example, if there is a query that
returns the maximum temperature recorded by a
device, you can create a query to delete all the
devices that record a temperature higher than the
maximum temperature.

8. Select Save or Save And Exit.
The query is created.

Create a SQL Query

This topic describes how to create a SQL query. To use a relational database in an Operations Hub
application, you must:

• Create a Data Source (page 244) with a Relational Database type and provide the details of
the external database.

• Create a SQL Query, and specify the expected inputs and outputs of a Stored Procedure.
(Described in this topic in the following steps.)
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• Map the query in the page designer to use the query to fetch the data from the external database.
See Use the Relational Database Query in the Designer (page 88).

In order to proceed you must have a working SQL database, and the selected database must have
stored procedures. You must also have created a data source for the relational database in Operations
Hub.

1. From the main navigation menu, select QUERIES.
The QUERIES workspace appears.

2. Select Add new query.
The Create Query window appears.

3. In the Name field, enter a name, and then select Create. The name must contain at least one
uppercase or lowercase letter.
The available options for creating the query appear.

4. In the Description field, enter a description for the query.

5. In the Type field, select Relational Database .

6. In the Data Source field, select the name of the data source from the list.

7. In the Query Type field, observe that the field defaults to ‘Stored Procedure’ when you select
‘Relational Database’ as the Type.

8. In the Schema field, select the database schema that you want to use. All the database schemas
will be loaded for the selected data source. The default selection is dbo.

9. In the Stored Procedure field, select the Stored Procedure that you want to use from the
selected schema.
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After you selects all the required fields, the list of input parameters will be loaded if there are
any, for the selected stored procedure.

The value for the input parameters can be configured either while creating the query or while
consuming the query in the page builder page.

To assign the value for an input parameter while creating the query, select the type drop-down
in the input parameter list. It has two options:

• Fixed Value: If this option is selected, the value given will be taken as the input to the
Stored Procedure. The input parameter will not be shown in the page builder page.

• Input Field: If this option is selected, the value given will be taken as the default input to
the Stored Procedure. The input parameter will be shown in the page builder page and if
there is any input provided to while execution, the default value will be overridden.

After the default values for input parameters are provided, click the Execute button under the
Test category. You will then be presented with the various fields in Result Sets and Output
Parameters sent out of the Stored Procedure.

Note:  Currently we do not support dynamic responses from the Stored Procedures.
Meaning, the fields that we see while building the query after clicking the Execute button,
should match the fields returned by the stored procedure while using the application.

10. Add the required fields.

The following figure displays an example:
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11. Select Save or Save And Exit.
The query is created.

Create a REST Query
You can create a REST query for the GET, PUT, POST, and DELETE methods.
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• Create the data source (page 244) that you want to use in the query.
• Create an entity (page 132) to specify the query response. The entity fields that you want to

map with the query output parameters must contain the same names as the parameters.
• It is recommended that you add the environment variable, no_proxy, to the System Variables.

You should also add references to localhost as well as nodes which are targets of REST Queries
to the System Variables. Be aware that the case of the environment variables for the a data
source target in Operations Hub should match the case of the ones used by the Historian Server;
environment variables are case-sensitive.

Note:  REST query will run even when system variable has no port number. A bad port leads to
an error.

1. In the module navigation menu, select QUERIES.
The QUERIES workspace appears.

2. Select Add new query.
The Create Query window appears.

3. In the Query name box, enter a name, and then select Create. The name must contain at least
one uppercase or lowercase letter.
The available options for creating the query appear.

4. Provide values in the available boxes as specified in the following table.

Box Description

Description Enter a description for the query.

Type Select REST.

Method Select the method of the API you want to use in the
query. Supported methods are GET, PUT, POST, and
DELETE.

Entity Select the entity that will specify the query response
fields.

Note:  When using a Historian data source, the
Entity field will auto-populate with the entity associated
with the Available API selected.

Data Source Select the data source that you want to use for the
query.
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Box Description

Available API Select the API that you want to use in the query. This
box contains a list of APIs that are available in the data
source that you have selected.

The list of available APIs will be filtered based on the
method selected.

Note:  Pre-existing APIs are available only for
Historian data sources. For more information see: the
Historian API help.

Note:  The Base URL and Query URL boxes are populated with the base portion (that is,
the host name or IP address of the data source server) and the remaining portion of the URL.
The values in these boxes together identify the complete URL endpoint. The Base URL box
is always disabled. The Query URL box is disabled if you select an API for a Historian data
source. If, however, you are using a custom data source, you can enter a value in the Query
URL box.

5. In the Parameters section, please create parameters as needed for the API you are querying.
Each parameter will require a default or test value if you wish to run the query with the Execute
button.

Type of Parameter Description Example

Path parameters Identify the parameters in the path
of the endpoint. These appear
before the query string if query
parameters are present.

For the endpoint https://
jsonplaceholder.typicode.com/

users/1/posts, the parameter
between users and posts, which is
the user ID, is the path parameter.
The value for this parameter is 1.

Query parameters Identify the parameters in the path
of the endpoint that appear after the
question mark (?).

For the endpoint https://
jsonplaceholder.typicode.com/

posts?userId=1, userId is the
query parameter. The value for this
parameter is 1.

Header parameters Identify the parameters that you
want to include in the request
header. Typically, these parameters
are related to authorization.

https://www.ge.com/digital/documentation/historian/version80/c_historian_apis_overview.html
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Type of Parameter Description Example

Body parameters Identify the parameters in the
body of the request. Typically
these will be required for PUT and
POST methods, although they are
sometimes required for DELETE as
well.

Body parameters can be supplied in
Operations Hub as a URL encoded
format, raw JSON, or raw XML.
In case JSON or XML is selected,
the first parameter should be used
to supply the full JSON body.
Subsequent parameters can be
used for dynamic substitution into
that JSON body.

• JSON: If selected, the
subsequent parameters should
be JSON keys found in the
body. The corresponding JSON
values will be substituted.

• XML: If selected, the
subsequent parameters
should be strings found in
the body. These strings will
be substituted. You can also
supply curly braces to delineate
the parameters from text
within the body. For example,
{{STRING_TO_SUBSTITUTE}}

Additionally, you have the option to
preview the substitution for XML.

Be aware that the following Historian REST queries require the multi-select input to be enabled
on the EndApp page for output data to be displayed:

• Get > Raw Data
• Get > Calculated Data
• Get > Interpolated Data
• Post > Raw Data
• Post > Calculated Data
• Post > Interpolated Data

6. In the Query Outputs section, provide values as specified in the following table.

Box Description

Raw Response Select this check box if you want to get either the
entire JSON response or XML response mapped to a
single entity field. You can then access the response
by referencing that entity field while designing an
application. If you clear this check box, individual
components of the response are mapped to individual
entity fields.
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Box Description

Entity Select the entity that will specify the query response
fields.

Output fields Select the entity fields that you want to map to the
query response. If the Raw JSON check box is
selected, only the first field that you select will be
mapped to the query response, regardless of the field
name. If the Raw JSON check box is cleared, the
JSON response components are mapped to the entity
fields with matching names. In the case of nested
responses, dot notation is used to map to inner fields.

Note:  All REST queries must have a defined response. You can save the query only if you
specify at least one output. This is true even for Delete REST API calls which do not normally
return a response. In this case, please select any entity and entity field, regardless of name.

7. In the Execute section, select Run Request.
The query output fields, as well as the query appear in the Results box.

Important:  Provide sample values leading to a successful response in order to properly test
the REST endpoint. We strongly recommend using values you know will return a representative
set of data; otherwise, an error occurs or the response may not return the field data that you
need. For example: for Historian data queries, if the set of requested tags is different from the
returned set of data (that is, if one or more tags does not have data), the call will fail. The user
should modify the inputs to include only the tags for which they are confident there will be data
in the response. For PUT/POST/DELETE, this action is not a test but an actual request which
can change your data.

8. If required, select Create Entity from Results. This will create an entity with the appropriate
output fields generated from the previous Run Request.

9. Select Save or Save and Exit.
The query is created.

Note:  While Operations Hub handles many response formats, there are some responses
which it has difficulty mapping to output fields. In particular, embedded lists may be returned as
strings rather than lists of objects.

Important:  When you have a large number of users (greater than 100) and each using
an end app with multiple REST requests, coupled with a slow REST response, you can get
into a situation where the server is waiting for a long time for the previous responses to return,
and is therefore unable to process new requests. To avoid this situation, reduce the number of
REST calls in your App. Alternatively, you may adjust the Operations Hub timeout setting in
the settings.conf file in the following folder: C:\ProgramData\GE\Operations Hub\iqp-
config\IQP\app. Use the following command so that the slower REST requests do not hold
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up the Operations Hub server. You can change the seconds value to increase the timeout setting
further:

#REST client timeout (seconds) 
rest_timeout=30

Create an Extension Query
Extension type queries work with multiple data sources.

1. In the main navigation menu, select QUERIES.
The QUERIES workspace appears.

2. Select Add new query.
The New Query window appears.

3. Provide these details:

Field Description

Name Enter a name that contains at least one uppercase or
lowercase letter.

Description Enter a brief description for the query.

Type Select Extension.

Method Select the type of query you want to create from these
options:

• Read
• Write
• Add Comment

The Query Parameters and Output Data are loaded
based on the method selected for the query.

4. Provide the query parameter (page 176) values for the required fields.
• Fixed Value: If this option is selected, the provided value is considered as a fixed value for

the field. Fixed value fields are not shown in the application page builder.
• Input Field: If this option is selected, the provided value appears as a default value for

the field in the page builder. Any value provided before executing the query overrides the
default value.

5. Select  next to the parameters you do not want to include in your query.
To retrieve deleted query parameters and output data, select +Add All Query Params and
+Add All Outputs respectively.

6. Save the query.



Operations Hub for Windows | 3 - User Guide | 176

The extension query is created.

The saved query appears in the application page builder under PAGE DATA > Query > Entities.

Go to the application page builder to apply and execute the query.

Extension Query Parameters

Use these parameters in your extension query.

Parameter Description

Tag Source Specify a tag source.

Tag Allows to browse and select a tag.

Tag Display Format Select a display format for the tag name.

Sampling Mode Select a sampling mode for retrieving data.

Calculated Mode If the sampling mode is Calculated, specify the calculation mode.

Start Time Select the calendar icon to set a start time.

Duration Enter the duration.

End Time Select the calendar icon to set an end time.

Sampling Time Enter the sampling time.

Sampling Count Enter the sampling count.

Sampling Direction Direction of sampling, whether forward or backward.

Note:  This parameter is used only when the sampling mode is
RawByNumber. You must also specify the sampling count for this parameter.

Show Comments Select/Clear the check box to show/hide comments.
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Parameter Description

Sort By Defines how a Data Distributor extension query result-set should be
sorted. You must enter the syntax, which is a comma-separated list of
Data Distributor extension query fields. The result set is sorted by the fields
specified in the list, in the given order.

Examples:

• timestamp,name means to sort by timestamp first, then by name.
• name,timestamp means to sort by name first, and then by timestamp.

Each field in the syntax can optionally have a suffix of a plus (+) or
minus (-) sign to indicate the sorting order for that field. For example,
"timestamp-,name+" means sorting by timestamp in descending order, and
then by name in ascending order. By default, timestamp's sorting order is
descending, and rest of the fields are ascending.

Example:

• timestamp-,name+ means to sort by timestamp first in a descending order,
then by name in an ascending order.

Each field in the syntax can be denoted either by its full output field name, or
a built-in one letter identifier. For example,

• t for timestamp
• n for tag name
• v for value
• q for quality

If you do not enter a syntax, or left this field blank, then the behavior is to sort
by timestamp descending.

Currently, for auto sync queries, the sorting order only applies to the initial
result set and not any subsequent new rows to the result set.

Update Preloaded REST Queries after Import

REST queries from the previous version of Operations Hub are supported. The upgrade process
imports these queries to the latest version of the proloaded API. The queries will work with no
need for interaction. The display fields need to be manually updated, however. The following steps
describe how to update your display fields for a REST query using the Historian GET request.

1. From the main navigation menu, select QUERIES.
The QUERIES workspace appears.



Operations Hub for Windows | 3 - User Guide | 178

2. In the row containing the query you want to access, in the Name column, select the link.
The query appears, displaying a list of fields in the query.

3. In the API Name field, select the appropriate API from the drop-down list (the list will already
be populated). Use the following tables as a guide on the renamed APIs.

v1.5 API Name v1.6 API Name

1.5 1.6

Get Tag Properties Tag Properties

Get Tags Tags

Get Tags List Tag List

Get Raw Data Raw Data

Get Interpolated Data Interpolated Data

Get Current Value Current Value

Get Calculated Value Calculated Value

Get Sampled Data Sampled Data

Get Trend Data Trend Data

4. Select Save or Save and Exit to resave the query.
The query display field is updated.
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Update Entity Display Fields After an Import

Entities defined in the previous version of Operations Hub are supported, and imported to the latest
version. They will work with no need for interaction. The display fields need to be manually updated,
however. The following steps describe how to update your display fields for entities.

1. From the main navigation menu, select QUERIES.
The QUERIES workspace appears.

2. In the row containing the query you want to access, in the Name column, select the link.
The query appears, displaying a list of fields in the query.

3. In the Entity Name field, select the appropriate Entity from the drop-down list (the list will
already be populated). Use the following tables as a guide on the renamed Entities.

v1.5 Entity Name v1.6 Entity Name

1.5 1.6

historian_gettagproperties historian_tagproperties

4. Select Save or Save and Exit to save your changes.
The entity display field is updated.

Copy a Query
Creates a duplicate copy of a query.

This topic describes how to copy a query. You can also create a query (page 153).
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1. From the main navigation menu, select QUERIES.
The QUERIES workspace appears.

2. In the row containing the query that you want to copy, select , then select Duplicate query.
The Please enter new name screen appears, displaying the name of the query that you have
selected, appended with a system-generated value.

3. As needed, modify the name of the query, and select OK.
The name must contain at least one uppercase or lowercase letter.
The selected query is copied.

Delete a Query

• You cannot delete a query if it is locked or used in an application.
• You cannot delete a preconfigured query that came with the system installation.

1. From the main navigation menu, select QUERIES.
The QUERIES workspace appears.
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2. In the rows containing the queries that you want to delete, select the check boxes.

3. In the workspace heading, select , and then select Delete queries.
A message appears, asking you to confirm that you want to delete the selected queries.

Tip:  Alternatively, in the row containing the query that you want to delete, select , and
then select Delete query.

4. Select Delete.
The queries are deleted.

Plug-Ins

About Plug-Ins

A plug-in is a widget that you can configure to work with the components of an application (such as
entities and queries), and then use it in an application. You can thus add additional functionality to
Operations Hub.

Using Operations Hub, you can embed plug-ins in an application. You can use plug-ins stored on
your local machine or imported from a different site.

Note:  When configuring input targets for plugins, ensure that no other binding exists for the
target query input. To remove a binding from the query input, select the unlink icon next to the
binding.

To create a custom plug-in, refer to Custom Plug-In structure (page 187)



Operations Hub for Windows | 3 - User Guide | 182

Pump Temperature Plug-In

Suppose there is a plug-in that shows the trend graph of the highest temperature recorded in a pump.

Suppose you want to create an application that monitors the energy efficiency of the pump. In
addition to the other parameters that you want to display in the application, you can use the plug-in to
show the highest temperature recorded in the pump (instead of creating a trend graph from scratch).

Access a Plug-in
This topic describes how to access custom plug-ins.

From the main navigation menu, select PLUGINS.
The PLUGINS workspace appears, displaying a list of plug-ins that are imported.

Tip:  You can access the information related to a plug-in by selecting  in the corresponding
row.

Import a Plug-in
This topic describes how to import custom plug-ins.

Follow these steps to import each custom plug-in to Operations Hub. Plug-ins also get imported
when they are used in an application that you import to Operations Hub.

Note:  In case you imported a newer version of an existing plugin, you need to revisit the
application pages (designer) wherever the old version was in use.

1. Delete the old plugin version from the container. All plugin configuration settings are lost when
you delete the old version.
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2. Add the new plugin version to replace the deleted one. Reconfigure the settings for the new
version.

You can also use a third party client (for example, Postman) to import plug-ins. Send a post request
to https://enter your machine name/site/ajax/plugin

1. From the main navigation menu, select PLUGINS.
The PLUGINS workspace appears.

2. Select Import.

3. Navigate to and select the plug-in that you want to import, and then select Open.
The plug-in is imported.

In the page designer of an application, the imported plug-in appears in the CUSTOM section.

Use the plug-in in an application (page 183).

Use a Plug-in in an Application

Import the plug-in (page 182) that you want to use in an application.

1. From the main navigation menu, select APPS.
The APPS workspace appears.
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2. In the Name column, select the application in which you want to use the plug-in.
The PAGES workspace appears, displaying a list of pages created in the application.
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3. In the Name column, select the page in which you want to include the plug-in.
The page designer appears, displaying the elements in each container in the page. The plug-ins
that are available in the site appear in the CUSTOM section.

4. From the list of plug-ins in the CUSTOM section, drag the plug-in to the container in which
you want to include the plug-in.

5. Select Save App.
The plug-in is used in the application.

Download a Plug-In
This topic describes how to download a plug-in.

1. From the main navigation menu, select PLUGINS.
The PLUGINS workspace appears.
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2. In the row containing the plug-in that you want to download, select .
The plug-in is downloaded as a .zip file.

Delete a Plug-in
This topic describes how to delete a plug-in.

1. From the main navigation menu, select PLUGINS.
The PLUGINS workspace appears, displaying a list of plug-ins that are imported.

2. In each row containing the plug-in that you want to delete, select .
A message appears, asking you to confirm that you want to delete the plug-in.

3. Select OK.
The plug-in is deleted.
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Custom Plug-In structure
This topic describes how to use plug-in components.

A plug-in must contain the following components:

• index.html (page 188): Contains the plug-in html code.
• main.js (page 191): Contains the plug-in javascript code.
• manifest.json (page 188): Contains the plug-in configuration details.
• style.css: Contains the plug-in stylesheet details.
• The scripts folder: Contains external scripts.

Get started with the sample templates to build your own plug-in.

Template Type How to Use

Download the sample template for simple plug-in

Includes examples using data source.

Use this template to build a simple plug-in.

1. Unzip the downloaded file. The unzipped file contains
a folder called template with components to build a
simple plug-in.

2. Modify the plug-in components.
3. Rename the template folder to match with the

typeName (plug-in name) in manifest.json.
4. Create a zip file of your modified folder (do not zip

only plug-in components). The zip filename should
also be the plug-in name.

For example, if your plug-in name is table, then the
zip file and the folder within should also be named as
table.

5. Import (page 182) the modified zip file to Operations
Hub to load as a plug-in.

https://www.ge.com/digital/documentation/opshub/windows/pdf/file_downloads/template.zip
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Template Type How to Use

Download the sample template for advanced plug-in

• Includes examples using data source and data target.
• Loads external scripts (tools.zip) imported using

webpack.
• Loads DevExtreme using manifest (scripts element).
• tools.js contains color conversion script and

connecting to datasources for manual, global, query,
or formula.

Use this template to build an advanced plug-in.

1. Unzip the downloaded file.
2. Perform npm install in the root folder to download

dependencies.
3. Modify the plug-in components.
4. To generate a zip file of the modified template:

• Perform npm run build to generate a
development package.

• Perform npm run buildProd to generate a
production package (minified).

5. The generated zip file is saved to the dist folder in
the project folder.

6. Import (page 182) the zip file to Operations Hub to
load as a plug-in.

The index.html file

Each plug-in must contain an index.html file in the root folder of the plug-in.

Note:  If html code is not required, create a blank file.

The markup defined in the index.html file is included in the body of a page in an application.
Therefore, tags such as html, head, meta will be omitted.

Important:  Do not use the script tag because of the asynchronous behavior of the tag outside of
the html head.

JavaScript Dependencies

The easiest way to add external javascript dependencies is to place them in the scripts folder (in the
root folder) and reference this dependency in the manifest.json file.

Important:  When using this method, all javascript dependencies are included in the global
scope of the application, which can create conflicts between different plug-ins. Therefore, we
recommend that you use a build tool like Webpack to manage dependencies of plug-ins.

The manifest.json file

Every plug-in must contain a manifest.json file in the root folder of the plug-in. This file provides the
essential information about the plug-in to Operations Hub.

The following table provides the parameters that you must include in the manifest.json file.

https://www.ge.com/digital/documentation/opshub/windows/pdf/file_downloads/template-adv.zip
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Parameter Description

typeName [String] The unique name of the plug-in.

pluginId [String] The unique ID of the plug-in. The value for this parameter
must be a long, random one.

Type [String] The type of the plug-in.

category [String] The category of the plug-in.

description [String] The description of the plug-in. This value appears in
Operations Hub when you design an application to include
the plug-in.

info The following information about the plug-in:

• version
• update
• size
• developer

scripts [Array] The array for the scripts that you want to use in the plug-
in.

customIcon [String] The icon that will appear next to the name of the plug-in in
Operations Hub when designing an application to include
the plug-in.

origin [String] The origin of the plug-in. Provide the value custom for this
parameter.

placeholder [String] A placeholder for the plug-in, which will appear in
Operations Hub when designing an application to include
the plug-in.

preview [String] The picture preview of the plug-in that will appear in
Operations Hub when designing an application to include
the plug-in.

fieldsDescription [Object] The plug-in description for informational messages.

isNotAllowToAddFields [Boolean] Indicates whether to allow the user to add more data fields
when designing an application to include the plug-in. If you
do not want the user to add data fields, enter true.

schema{} An array of the following types of schema:

• JSONSchema{}
• UISchema{}

Schema

The schema is based on JSON. It is used in the manifest.json file to specify the plug-in input and
output.
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• Input: The input for a plug-in can be static or dynamic. Static data is available in any of the
following JSON schema types:

◦ string
◦ number
◦ integer
◦ boolean
◦ null
◦ object
◦ array

The dynamic data is available in an Operations Hub component such as a query, global variable,
or manual entry of data.

• Output: The output of a plug-in is defined in the Operations Hub target, such as a query with
inputs or a global variable.

The schema defined in the manifest.json is presented in Operations Hub in the html format. This
format is implemented using the react-jsonschema-form library, which introduces the concept of UI
schema to provide the information about the form behavior and to give an extensive API for the form
customization. Customization is typically done using custom fields and widgets that become part of
the default form registry. The library renders all form fields leveraging the Bootstrap semantics, so
that it can be styled with bootstrap themes or custom CSS.

Tip:  The following websites provide information on creating plug-ins:

• React-JSON-Schema Documentation
• React-JSON-Scheme Playground

Supported Widgets

The following table provides the supported widgets for each field type.

Field Type Supported Widgets

Boolean
• Check box
• Radio button
• Select

String
• Text
• Password
• Email
• URI
• Radio button
• Select
• Text area
• Datetime
• Color

https://react-jsonschema-form.readthedocs.io
https://mozilla-services.github.io/react-jsonschema-form/
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Field Type Supported Widgets

Number
• Text
• Select
• Range
• Radio button

The main.js file

The plug-in API is exposed through the global object EMBED. You can access this object when the
plug-in source code is included in Operations Hub. The following table provides the methods used in
EMBED.

Method Description

EMBED.getRootElement() Returns the jqLite element, which must be used as the
mounting point of the root element of the plug-in.

EMBED.onChangeData(callback) This method is a general data change listener. callback -
function, which is invoked with one argument every time
when data change event is triggered.

EMBED.getData() Returns existing page data.

The following table provides the four main methods to work with the Data Source and Data Target
fields.

Method Description

EMBED.subscribeFieldToQueryChange(field, callback) Field object: Data Source

Callback: Function that is invoked when query change
event received. Callback is invoked with one argument,
which is a data selection as per field configuration.

EMBED.subscribeFieldToGlobalChange(field, callback) Field object: Data Source

Callback: Function that is invoked when global change
event received. Callback is invoked with one argument,
which is a global data as per field configuration.

EMBED.subscribeFieldToDataChange(field, callback) Field object: Data Source

Callback: Function that is invoked when global or query
change event received.

EMBED.submitTarget(field, value) Field object: Data Target

Value: javascript primitives or Object/Array

This method targets the input of a query or a global
variable, as per field configuration.
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Events

About Events

In Operations Hub, you can create events that will trigger actions when specific conditions are
satisfied. To create an event, you must create a trigger and then create an action.

• Trigger: When you create a trigger, you define the set of conditions that must be satisfied for the
event to happen. You can create a trigger based on conditions on values added or updated in an
entity or values received from a device.

• Action: When you create an action, you define what should happen if the conditions specified in
the trigger are satisfied (that is, when the event is triggered). You can create one or more of the
following actions:

◦ Send an email: You can create an action to send an email when the event is triggered. You
can enter the email addresses manually, fetch them from a query, or allow application users
to specify the email addresses.

◦ Run a query: You can create an action to run a query when the event is triggered.
◦ Send a command to a device: You can create an action to send a command to a device

when the event is triggered. Before you do so, you must configure IQP MQTT to
communicate with the device to which you want to send a command.

Creating an event in the event editor only creates a template for the event. It does not activate the
event. The event is activated when a notifier is added and turned on in an event settings widget in an
application.

Access an Event

1. From the main navigation menu, select EVENTS.
The EVENTS workspace appears.
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2. In the row containing the event that you want to access, in the Name column, select the link.
The event appears, displaying a list of fields in the event.

Tip:  You can modify values in the available fields, and then select Save or Save And Exit.

Create a Trigger Based on an Entity

This topic describes how to create a trigger based on conditions on values stored in an entity. You
can also create a trigger based on conditions on values received from a device (page 193).

1. Access the event (page 192) for which you want to create a trigger.

2. Select Add Entity Condition.
The Entity and Condition sections

appear.

3. In the Entity Name box, select the entity based on which you want to create a trigger.
In the Entity Field box, a list of fields in the selected entity appears.
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4. In the Entity Field, Operator, and Value boxes, select values that you want to use in the
trigger.
If you want to create a trigger if the temperature recorded in the entity exceeds 40 degrees
Celsius, then in the Entity Field, Operator, and Value boxes, select or enter Temperature, >,
and 40, respectively.

5. If you want to allow the end user to set the value manually, then select the Allow End User to
set value check box, and then enter a value in the Input Name box.
If you want to create a trigger when the temperature stored in the entity field reaches a certain
limit, and you want application users to specify that limit, then:

a. In the Input Name box, enter Maximum Temperature.
b. In the application, add an event settings widget, and then select the event that you have

created.

In the application, the widget contains an input field labeled Maximum Temperature,
which allows the user to change the value that you have specified in the event.

6. If there is more than one condition, and if you want to create a trigger only if all the conditions
are satisfied, select Meet ALL of the conditions. By default, this option is selected. If,
however, you want to create a trigger if at least one of the conditions is satisfied, select Meet
ANY of the conditions.

Create an action (page 193).

Create a Trigger Based on a Device

Register the device details and metrics that you want to use in the trigger, using baseline entities.

1. Register at least one device type and metric using the supported_device_gateway and the
metrics_device_type entities, respectively.

2. Register at least one device group and device for the device type using the M2M_groups and
device_gateway entities, respectively.

This topic describes how to create a trigger based on conditions on values received from a device.
You can, however, create a trigger that will cover only a single device, a group of devices, or all the
devices of a given type.

You can also create a trigger based on conditions on values stored in an entity (page 193).

1. Access the event (page 192) for which you want to create a trigger.

2. Select Add Device Condition.
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The Device Gateway and Condition sections

appear.

3. In the Device Type, Device Group, and Device Units boxes, select the type, group, and unit of
the device, respectively.
The following table provides values that you can select in these boxes, and which devices will
be filtered accordingly.

Device Type Device Group Device Units Result

MyDeviceType Any Any All devices of the type MyDeviceType.

MyDeviceType MyGroup Any All devices in the group MyGroup.

MyDeviceType MyGroup MyDevice The device named MyDevice.

In the Metric box, a list of metrics registered for the device type appears.

4. In the Metric, Operator, Input Source, and Value boxes, select or enter the metric, operator,
input source, and value, respectively.
If you want to create a trigger when the temperature recorded by the device exceeds 40 degrees
Celsius, in the Metric, Operator, Input Source, and Value boxes, select or enter Temperature,
>, Fixed Value, and 40, respectively.

5. If you want to allow the end user to set the value manually, select the Allow End User to set
value check box, and then enter a value in the Input Name box.
If you want to create a trigger when the temperature stored in the entity field reaches a certain
limit, and you want application users to specify that limit:

a. In the Input Name box, enter Maximum Temperature.
b. In the application, add an event settings widget, and then select the event that you have

created.

In the application, the widget contains an input field labeled Maximum Temperature,
which allows the user to change the value that you have specified in the event.

6. If there is more than one condition, and if you want to create a trigger only if all the conditions
are satisfied, select Meet ALL of the conditions. By default, this option is selected. If,
however, you want to create a trigger if at least one of the conditions is satisfied, select Meet
ANY of the conditions.

Create an action (page 194).
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Create an Action to Send an Email

This topic describes how to create an action to send an email. You can also create an action to
perform the following steps:

• Run a query (page 197)
• Send a command to a device (page 199)

Create a trigger based on an entity condition (page 193) or a device condition (page 194).

1. Access the event (page 192) for which you want to create an action.

2. Select Send e-mail.
The Send an E-mail section

appears.

3. Enter or select values as specified in the following table.

Field Description

Recipient's address Enter the email address of the user who will receive
an email when the event is triggered. You can enter
multiple email addresses separated by commas.

Allow End User to set e-mail address Select this check box if you want to allow application
users to provide the email addresses of the users who
will receive an email, and then enter the name of the
input field that you will add in the application.

Add Query Recipients Select this button if you want to add email addresses
of the recipients using a query. When you select this
button, the Query Name box appears, displaying a list
of Get queries created in the site.



Operations Hub for Windows | 3 - User Guide | 197

Field Description

Query Name Select the query that returns a list of email addresses
to which you want to send the email. If the query that
you have selected requires input values, then the
corresponding fields appear. If that happens, enter
values in the fields.

Email template Select the email template that you want to use. If,
however, you want to create an email template (page
202), select Create Email Template, enter values as
needed, and then select Save and Return.

Scheduler
Select one of the following options:

• Take action only on initial trigger: Select this
option if you want to run the query after switching
from the state of not meeting the condition to
meeting the condition. By default, this option is
selected. For example, suppose you have created
an action to send an email when the temperature
recorded by a device exceeds 40 degrees Celsius.
Suppose the temperature recorded by the device is
as follows: 35, 38, 41, 45, 39, 42. In this scenario,
the email is sent when the temperature is 41 and
42.

• Take action on every trigger: Select this option if
you want to send an email every time the event is
triggered. For example, suppose you have created
an action to send an email when the temperature
recorded by a device exceeds 40 degrees Celsius.
Suppose the temperature recorded by the device is
as follows: 35, 38, 41, 45, 39, 42. In this scenario,
the email is sent when the temperature is 41, 45,
and 42.

4. Select Save or Save and Exit.
The event template is created.

When the event is triggered, an email is sent to the email addresses that you have specified.

Note:  Gmail integration is possible on allowing access to less secure apps for the account.
Alternatively, you can enable a 2-Step verification for the account and use the Google account “App
passwords” feature. This will generate a password to use in conjunction with the email address to
configure email server in Operations Hub Admin Console.

Create an Action to Run a Query

This topic describes how to create an action to run a query. You can also create an action to:

• Send an email (page 196)
• Send a command to a device (page 199)
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Create a trigger based on an entity condition (page 193) or a device condition (page 194).

1. Access the event (page 192) for which you want to create an action.

2. Select Run a Query.
The Run a Query section appears.

3. Enter or select values as described in the following table.

Field Description

Query Select the query that you want to run when the event is
triggered. If the query that you have selected requires
input values, the corresponding fields appear. If that
happens, enter values in the available fields.

Scheduler
Select one of the following options:

• Take action only on initial trigger: Select this
option if you want to run the query after switching
from the state of not meeting the condition to
meeting the condition. By default, this option is
selected. For example, suppose you have created
an action to run a query when the temperature
recorded by a device exceeds 40 degrees Celsius.
Suppose the temperature recorded by the device is
as follows: 35, 38, 41, 45, 39, 42. In this scenario,
the query is run when the temperature is 41 and
42.

• Take action on every trigger: Select this option if
you want to run the query every time the event is
triggered. For example, suppose you have created
an action to run a query when the temperature
recorded by a device exceeds 40 degrees Celsius.
Suppose the temperature recorded by the device is
as follows: 35, 38, 41, 45, 39, 42. In this scenario,
the query is run when the temperature is 41, 45,
and 42.

4. Select Save or Save and Exit.
The event template is created.



Operations Hub for Windows | 3 - User Guide | 199

When the event is triggered, the query that you have specified is run.

Create an Action to Send a Command to a Device

This topic describes how to create an action to send a command to a device. You can also create an
action to:

• Run a query (page 197)
• Send an email (page 196)

1. Configure IQP MQTT to communicate with the device to which you want to send a command.
2. Create a trigger based on an entity condition (page 193) or a device condition (page 194).

1. Access the event (page 192) for which you want to create an action.

2. Select Send Command to Device.
The Send a command to a device section

appears.

3. Enter or select values as described in the following table.

Option Description

Function Select Send_MQTT_Command to send a command to
a device that is configured with IQP MQTT. The Input
Source and Value boxes appear for topic and payload.

Input Source Select Fixed value if you want to send a fixed value to
the device when the event is triggered.

Value Enter the fixed value that you want to send to the
device when the event is triggered.

Allow End User to set value Select this check box if you want application users to
set the value, and then enter a name in the Input Name
box that appears.
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Option Description

Scheduler Select one of the following options:
• Take action only on initial trigger: Select

this option if you want to send the command
after switching from the state of not meeting the
condition to meeting the condition. By default, this
option is selected. For example, suppose you have
created an action to send the command when
the temperature recorded by a device exceeds
40 degrees Celsius. Suppose the temperature
recorded by the device is as follows: 35, 38, 41, 45,
39, 42. In this scenario, the command is sent when
the temperature is 41 and 42.

• Take action on every trigger: Select this option
if you want to send the command every time the
event is triggered. For example, suppose you
have created an action to send a command when
the temperature recorded by a device exceeds
40 degrees Celsius. Suppose the temperature
recorded by the device is as follows: 35, 38, 41, 45,
39, 42. In this scenario, the command is sent when
the temperature is 41, 45, and 42.

4. Select Save or Save and Exit.
The event template is created.

When the event is triggered, the command is sent to the MQTT broker.

Delete an Event

You cannot delete an event if it is locked or used in an application or a parameter.

1. From the main navigation menu, select EVENTS.
The EVENTS workspace appears.

2. In the rows containing the events that you want to delete, select the check boxes.
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3. In the workspace heading, select , and then select Delete Events.
A message appears, asking you to confirm that you want to delete the event.

Tip:  Alternatively, in the row containing each event that you want to delete, select , and
then select Delete event.

4. Select Delete.
The events are deleted.

Email Templates

About Email Templates

Email templates store information about the default content and structure of an automated email,
which can be sent when an event is triggered. The template allows you to include fixed or dynamic
content so that the email is customized to the event that triggered it. You can define the default
structure for the following sections in an email template:

• Subject
• Body
• URL

Access an Email Template

1. From the main navigation menu, select EMAILS.
The EMAILS workspace appears.

2. In the row containing the email template that you want to access, in the Name column, select
the link.
The email template appears, displaying the Subject, Body, and URL sections.
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Tip:  If needed, modify the email template, and then select Save or Save and Exit.

Create an Email Template

This topic describes how to create an email template. You can also copy an email template (page
203).

1. From the main navigation menu, select EMAILS.
The EMAILS workspace appears.

2. Select Add new email template.
The Create Email Template window appears.
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3. Enter a value in the Email Template Name box, and then select Create. The name must
contain at least one uppercase or lowercase letter.
The Subject, Body, and URL sections of the email template appear.

4. In the Subject, Body, and URL sections, select the options for which you want to add details.

Option Description

Add Text When you select Add Text, a text box appears in the
corresponding section. You can enter the text that you
want to include in the email template.

Add Parameter Parameters (page 205) allow you to add dynamic
content to the email based on values from the event.
When you select Add Parameter, a drop-down list box
appears in the corresponding section. You can select
the parameter that you want to include in the email
template.

Add Paragraph When you select Add Paragraph, a resizeable text box
appears in the corresponding section. You can enter
the text that you want to include in the email template.
You can add a paragraph only in the Body section.

Add Newline When you select Add Newline, a line appears after the
current element.

5. As needed, in the URL section, enter a URL that you want to include in the email template.

6. Select Save or Save And Exit.
The email template is created.

Copy an Email Template

This topic describes how to copy an email template. You can also create an email template (page
202).

1. From the main navigation menu, select EMAILS.
The EMAILS workspace appears.
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2. In the row containing the email template that you want to copy, select the link.
The email template appears.

3. Modify the email template as needed, and then select Save As New.
A window appears, asking you to enter a name for the email template. By default, the name
contains the name of the original email template, appended with a system-generated value.
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4. Modify the default name, and then select OK.
The email template is copied.

Delete an Email Template

You cannot delete an email template if it is used in an event.

1. From the main navigation menu, select EMAILS.
The EMAILS workspace appears.

2. In the workspace heading, select , and then select Delete email templates.
A message appears, asking you to confirm that you want to delete the email templates.

Tip:  Alternatively, in the row containing each email template that you want to delete, select

, and then select Delete email template.

3. Select Delete.
The email template is deleted.

Parameters

About Parameters

Parameters store values that you can use in an email template. These values can be fixed or generated
at runtime. You can create one of the following types of parameters:

• Fixed: Stores a fixed value that you specify when you create the parameter.
• Event Variable: Stores event time values from an entity field or a device field that is used in an

event condition.
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• From Query: Stores the results of a Get query with inputs from event time values. This allows
you to retrieve additional data about the device or entity that triggered the event from another
entity on the system.

Suppose you want to send an automated email when the temperature recorded by a device exceeds
40 degrees Celsius. In the email, you want to include the temperature, date, and time recorded by the
device. In this case:

1. Create an event as follows:
• Create a condition such that the event is triggered when the temperature recorded by the

device exceeds 40 degrees Celsius.
• Create an action such that an email is sent when the event is triggered.

2. Create a parameter to store the temperature recorded by the device.
3. Create another parameter to store the date and time recorded by the device.
4. Create an email template, and include both the parameters in the template.
5. Use the email template in the event that you have created in step 1.

Access a Parameter

1. From the main navigation menu, select PARAMETERS.
The PARAMETERS workspace appears.

2. In the row containing the parameter that you want to access, in the Name column, select the
link.
The parameter appears.
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Tip:  If needed, you can modify values in the available fields, and then select Save or Save
and Exit.

Create a Parameter

This topic describes how to create a parameter. You can also copy a parameter (page 209).

1. From the main navigation menu, select PARAMETERS.
The PARAMETERS workspace appears.

2. Select Add new parameter.
The Create Parameter window appears.
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3. Enter a name in the Parameter name box, and then select Create. The name must contain at
least one uppercase or lowercase letter.
The parameter appears.

4. Enter or select values as described in the following table.

Option Description

Fixed Select this option if you want to create a parameter with
a fixed value, and then enter the value. By default, this
option is selected.
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Option Description

Event Variable Select this option if you want to create a parameter
using an event variable, and then select values in the
Select Event, Event Condition, and Condition Value
boxes that appear.

• Select Event: Select the event whose variable you
want to use while creating the parameter. After you
select the event, the Event Condition box contains
sequential numbers of conditions in the event. For
example, if there are three conditions in the event,
the Event Condition box contains the values 1, 2,
and 3.

• Event Condition: Select the sequential number of
the condition that you want to use. If you select a
number, the Condition Value box contains a list of
entity fields or device fields depending on whether
you have selected an event condition or a device
condition.

• Condition Value: Select the entity field or device
field whose values you want to store in the
parameter.

From Query Select this option if you want to create a parameter
using a query, and then select the query in the Select
Query box that appears. It contains a list of Get queries
in the site. If the query that you have selected requires
input values, the corresponding fields appear. If that
happens, enter values as needed.

Note:  The query that you want to use in a
parameter should return only a single value.

5. Select Save or Save And Exit.
The parameter is created.

Copy a Parameter

This topic describes how to copy a parameter. You can also create a parameter (page 209).

1. From the main navigation menu, select PARAMETERS.
The PARAMETERS workspace appears.
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2. In the row containing the parameter that you want to copy, select the link.
The workspace for the parameter appears.

3. As needed, modify values in the available fields, and then select Save As New.
A window appears, asking you to enter a name for the parameter. By default, the name contains
the name of the original parameter, appended with a system-generated value.

4. Modify the name of the parameter, and then select OK.
The parameter is copied.

Delete a Parameter

1. From the main navigation menu, select PARAMETERS.
The PARAMETERS workspace appears.
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2. In the rows containing the parameters that you want to delete, select the check boxes.

3. In the workspace heading, select , and then select Delete parameters.
A message appears, asking you to confirm that you want to delete the selected parameters.

Tip:  Alternatively, in the row containing each parameter that you want to delete, select ,
and then select Delete parameter.

4. Select Delete or Delete All.
The parameters are deleted.

Users

About Users

Using Operations Hub, you can create the following types of users:

• Developers: Users who will develop an application. These users can access the pages for
creating an application. When you create a developer, an application user is also created for the
developer with the same credentials.

• Application users: Users who will use an application. These users can only access applications
to which they have been granted access. They cannot access the pages for creating an
application.

Access a User

1. From the main navigation menu, select MANAGE.
The Developers workspace appears, displaying a list of users who are developers.
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2. If you want to access an application user, in the module navigation menu, select App Users.
The App Users workspace appears, displaying a list of application users.

3. In the row containing the user that you want to access, in the Username column, select the link.
The Account <user name> window appears, displaying the details of the user.
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Tip:  If needed, you can modify the first and last names of your user account, and then
select Save to save your changes. You cannot, however, modify the first and last names of any
other user account.

Create a User

Only a tenant administrator can create and manage developers.

1. From the main navigation menu, select MANAGE, and then select Developers or App Users.

2. Select Add new user.
The New Account window appears.
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3. Enter values in the available fields as described in the following table.

Field Description

Username
Enter the user name that the user will use to log in to
Operations Hub. The value must be unique.

E-mail Enter the email ID of the user. The value must be
unique.

First Name Enter the first name of the user.

Last Name Enter the last name of the user.

Password Enter a password that the user will use to log in to
Operations Hub. The password must meet the following
criteria:

• Must contain between 8 and 15 characters
• Must include at least one number
• Must include at least one uppercase or lowercase

letter

Repeat Password Enter the password that you have entered in the
Password field.

Only GE Groups Select this check box if you only want to view groups
associated with GE products in the Groups list box.

Groups Select the UAA group that you want to assign to this
user.

4. Select Create.
The user is created. If you have created a developer, an application user is also created.

If you have created an application user, provide access to one or more applications to the user.

Grant Access to a Role

This topic describes how to grant access to a role. You can also grant access to an application (page
109).

1. From the main navigation menu, select MANAGE, and then select App Users.
The App Users workspace appears, displaying a list of application users.
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2. In the row containing the user to whom you want to grant access, in the Username column,
select the link.
The Account <user name> window appears, displaying the details of the user.

3. In the Apps box, select the applications to which you want to grant access to the user.

4. In the Role Groups box, select the check boxes corresponding to the categories and groups to
which you want to grant access to the user.

Tip:  When you select a category or a group, all the underlying groups in the hierarchy are
selected. You can clear the check box corresponding to a category or a group if you do not want
to grant access to it.

5. Select Save.
The user can now access the selected applications, categories, and groups.
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Revoke Access to an Application

1. From the main navigation menu, select APPS.
The APPS workspace appears.

2. In the Name column, select the application for which you want to revoke access.
The PAGES workspace appears.
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3. From the main navigation menu, select APP USERS.
The APP USERS workspace appears, displaying a list of application users created in the site.

4. In each row containing a user whose access you want to revoke, clear the check box, and then
select Submit changes.
Access to the application is revoked for the selected users.

Delete a User

You cannot delete your user account.

1. From the main navigation menu, select MANAGE, and then select App Users.
The App Users workspace appears.
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2. In the row containing the user that you want to delete, select the link in the USERNAME
column.
The Account <user name> window appears, displaying the details of the user.

3. Select Delete.
A message appears, asking you to confirm that you want to delete the user.
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4. Select OK.
The user is deleted.

Change Your Password
If a user wants to change his or her password in Operations Hub, use the following steps to do so.

1. Log out of all instances of Operations Hub, and close your browser.

2. Reopen your browser, and go to this page: https://machineName/uaa/login.
The following screen appears.

3. In the upper right-hand corner of the screen, click Account Settings.
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The following screen appears.

4. Select the Change Password link.
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The next screen appears.

5. In the Current Password field, enter the existing password.

6. In the New Password field, enter the new password that you want to use to log in to Operations
Hub.
The password must meet the following criteria:

• Must contain between 8 and 15 characters

Note:  For the 2.0 release, the password cannot be 15 characters long.

This rule applies only when setting up the password for the first time for the first user
account (OphubAdmin). After the completion of iqp-provisioner, the initial password
for OphubAdmin can also be updated to a password of 15 characters length. Subsequent
user accounts (including LDAP, external IDP accounts) can have a password length of 15
characters.

• Must include at least one number
• Must include at least one uppercase or lowercase letter

7. In the Confirm New Password field, enter the new password again.

8. Click Change Password to proceed.
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Roles

About Roles

You can create roles to define which users can access specific information. When you create a role,
you create a category and a group within that category. You can create multiple categories containing
multiple levels of groups.

Managing Access to Data Fields
Suppose you have created an application that provides the following details of users, and you want
only the Finance personnel to view the salary details:

• User name
• User ID
• Joining date
• Salary

In this case, you will perform the following tasks:

1. Create a category named Department.
2. In the Department category, create a group named Finance.
3. Modify the Roles Conditions section of the query that fetches the user account details as

follows:
a. In the Entity field box, select the field that stores the salary details.
b. In the Access box, select Permitted Roles.
c. In the Roles box, expand the Department category, and select the check box corresponding

to the Finance group.
d. Save the query.

When the query is run, the user name, user ID, and joining date details are returned to
all users. However, users who belong to the Finance department will also see the salary
details.

Managing Access to Data Rows
Suppose you have created an application that provides the following details of users, and you want
all users to only see rows from their location:

• User name
• User ID
• Joining date
• Salary
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• Location

In this case, you will perform the following tasks:

1. Create a category named Locations.
2. In the Location category, create groups for each location.
3. Modify the Roles Conditions section of the query that fetches the user account details as

follows:
a. In the Apply conditions to section, select All roles.
b. In the Row visibility box, select Filter rows.
c. In the Entity field box, select the field that stores the location of the user.
d. In the In user’s role tree box, select the Locations category.
e. Save the query.

When the query is run, users will only see records where the Location field matches the
Location role that has been allocated to them.

Access a Category or a Group

1. From the main navigation menu, select MANAGE, and then select Roles.
The Roles workspace appears, displaying a list of categories and groups.
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2. In the row containing the category that you want to access, select .
The category expands, displaying a hierarchical view of groups.

Tip:  You can select Expand All to expand all categories and groups.

3. If you want to access a group, navigate to the group in the hierarchy.

Tip:  If needed, you can modify the name of a category or a group by selecting  next to
the name.

Create a Category

1. From the main navigation menu, select MANAGE, and then select Roles.
The Roles workspace appears, displaying a list of categories.
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2. Select Add New Category.
A window appears, asking you to enter a name for the category.

3. Enter a name, and then select OK. The name must contain at least one uppercase or lowercase
letter.
The category is created.

Create a group (page 224).
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Create a Group

Create a category (page 224).

1. From the main navigation menu, select Roles.
The Roles workspace appears, displaying a list of categories.

2. In the row containing the category in which you want to create a group, select Add New Group.
A window appears, asking you to enter a name for the group.
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3. Enter a name, and then select OK. The name must contain at least one uppercase or lowercase
letter.
The group is created.

Delete a Category or a Group

1. From the main navigation menu, select MANAGE, and then select Roles.
The Roles workspace appears.
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2. In the row containing the category or group that you want to delete, select .
A message appears, asking you to confirm that you want to delete the category or group.

Tip:  To access a list of groups in a category, select  in the row containing the category.

3. Select OK.
The category or group is deleted.

Administration

Runtime Model
You create a model to build the runtime structure and content. You set up the types of equipment to
use, the instances of equipment to appear in the runtime context, the information to display about the
equipment, and the data sources for supplying for supplying data.
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The Model Editor user interface helps you create and modify your model. You can also use the
model template to manually build and modify your model structure and then import it.

Model Editor
Use the Model Editor to create and modify asset object types and asset objects in your model.

To begin building a model, follow these tasks:

• Create Data sources (page 244)
• Configure Data Distributor Settings (page 231)
• Set Up the Data Model Structure (page 232)
• Define Objects (page 232)
• Set Up Runtime Navigation (page 235)

Supported Characters for the Model
Before creating object types, objects and data variables, review the following tables to see which
characters are supported as well as restricted.

Supported Characters

Character Description

! Exclamation Point

@ At sign

^ Caret

$ Dollar Sign

() Parentheses

| Pipe

. Period

` Grave Accent

~ Tilde

- Hyphen

_ Underscore

Note:  A single space is allowed but a succession of spaces is not.

Unsupported Characters
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Character Description

# Number Sign

% Percent Sign

\ Backslash

, Comma

? Question Mark

; Semicolon

+ Plus Sign

: Colon

" Quotation Marks

' Apostrophe

< > Greater than/Less than Symbols

{} Braces

/ Slash

= Equal Sign

* Asterisk

& Ampersand

Manage Data Source Servers
Access the details for the data source servers that are used to populate data in your model.

This is a view-only section in Operations Hub.

To access the data source server details:

1. In the Administration environment, select Set Up and then Server.
2. The Server Details Management screen appears with a list of servers set up in your system

along with their details:

Column Description

Name The server name.

Connection Type The connection type, whether OPC UA or Historian.

Datasource Name The data source name associated to the server.

Refresh Rate (Seconds) The time set for refreshing the application, for example,
every 5 seconds.
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To configure data sources for Historian and OPC UA, refer to Create a Data Source (page 244).

Configure Data Distributor Settings

Create a Data Source (page 244).

Data distributor is a component in Operations Hub that communicates with the Historian servers
configured with Operations Hub. It performs the following tasks:

• Fetches a list of Historian tags.
• Fetches Historian data based on the parameters that you have specified.
• Reads and updates notes.
• Subscribes for updates on Historian tag value changes.

Using the data distributor settings, you can specify the log level of the data distributor. For example,
you can choose a verbose log level to help you troubleshoot issues with fetching data from the
Historian server.

1. In the administrative environment, select Set Up > Data Distributor.

2. In the Logging level box, select one of the following log levels:
• Info
• Error
• Warn
• Debug
• Verbose

The data distributor settings are configured.
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Set Up the Model Structure
Object types define the structure of the equipment pieces within your model. For each object type,
such as a StorageTank, you set up all the data variable names, such as TankLevel, that any asset
object associated with this type can reuse in its own definition.

Using the Contained Types area, you set up the parent/child relationship of asset object types
in the model. For example, StorageTank1 and SuctionValve2 are the children that comprise the
FinishedWaterPumpStation. In Runtime, the children appear under the parent in the navigational
context.

1. In the Administration environment, navigate to Assets > Object Types > New.
The Object Type Information screen appears.

2. Enter a unique name for the new object type and provide a description.

3. Select Save.

4. Select Data Variables to add variable names whose data will come from the data sources.

5. To add a variable name for this object type, do the following:
a. Select + above the table.
b. In Variable, enter the name of the data variable, such as Pressure.
c. In Data Type, select the type of data this variable stores: Boolean, String, or Number.
d. In Description, explain the purpose of the data variable.

6. Repeat the above steps for each new object type.

7. To define an asset object type as a parent of other types, do the following:
a. Select Contained Types.
b. Choose the parent by selecting an object type on the left panel.
c. Select + above the table to add children to the parent.
d. Select the object type to become a child and provide an alias name.

8. Select Save.

Define Objects
Asset objects are the instances of equipment pieces, such as StorageTank1, to appear in the model.
For each object, you determine which data variables derived from its object type to reuse, and then
define them accordingly.

• Objects appear alphabetically.
• Always use a unique object name.
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1. In the Administration environment, navigate to Assets > Objects.
If objects are already defined, the left panel lists them.

2. To add a new object, select New.
The New Object screen appears.

3. Select the object type for this object.
The children of the object type appear under Contained Objects if defined. The system
automatically generates a contained object name from the alias and appends an instance number
to it, such as DPump1_1. The next time another asset object reuses the object type with this
contained object, the instance number is increased by one, which in this example is DPump1_2.

4. Type a unique name for the new object and provide a description.

5. Select Save.
The new object appears with the data variables of its object type.

6. Define each data variable that you want to use for this object by doing the following:

Column Description

RealTime Data Alias You receive real time data from data sources such as
iFIX, CIMPLICITY, IGS, or any other third party OPC
UA server.

Select  to choose a data source from the list of
available data sources.

RealTime Data Source

Select  to browse the data source and select
items that feed live data to this variable, which can
appear in the trend chart or a widget that is configured
with this model property.

Refer to Browse Data Sources (page 255).
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Column Description

Historical Data Alias You receive historical data from the Historian data
source.

Select  to choose a data source from the list of
available Historian data sources.

Historical Data Source

Select  to select Historian tags that feed Proficy
Historian data to this variable, which can appear in
the trend chart or a widget that is configured with this
model property.

Refer to Browse Data Sources (page 255).

7. Select Save.

Duplicate Objects
When an object uses similar data variables and contained objects as a configured object, you can
duplicate the configured object to create new objects for your model.

1. In the Administration environment, navigate to Assets > Objects.

2. Select Duplicate.
The duplicated object appears highlighted in the left panel with Copy appended to its name.

3. Change the name in the Name field and select Save.
The renamed asset object appears in the left panel. You cannot rename the asset after selecting
Save.

4. To duplicate more instances of the same object, continue to select Duplicate and repeat step 3.
The duplicated objects appear highlighted in the left panel with Copy and a number appended to
their names, such as pump1_copy(1), pump1_copy(2), and so on.
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Set Up Runtime Navigation
Use the Navigation app to visually structure the runtime hierarchy of objects.

Changing the root of an existing runtime navigation hierarchy requires that you clear the entire
hierarchy and then rebuild it.

1. In the Administration environment, navigate to Visualizations > Navigation.
All objects appear in the left panel with check boxes.

2. Select the parent check box and then select + at the top of the left panel.
The parent object instance appears in the app area. The following shows the
FinishedWaterPumpStation parent.

3. Select the parent object in the app area, select its children in the left panel and select +.

4. In the app area, expand the parent object to show its children by selecting its filled circle.
In this example, the FinishedWaterPumpStation has three DisplacementPump

children.

5. To add object instances to a child, select the child in the app area and select its descendants in
the left panel.
In this example, SpindleA1, B1, C1 are descendants of MC460A, B, C.

6. You can also drag and drop objects within the hierarchy to change their order, as shown in this
example. SunctionValveA is now a child of FinishedWaterPumpStation.
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7. Optional: To delete an object from the hierarchy, select its check box and then - at the top of
the left panel.

8. Optional: At any time, you can remove the hierarchy and start with a blank app area by
selecting Clear Hierarchy.

9. To save the runtime hierarchy that you created, select Save.

Modify Object Types
You can remove an asset object type and delete and modify its data variable names but you cannot
change the name of an object type. All changes made to an object type are reflected in its object
instances.

You cannot delete an asset object type that has existing objects using its data structure.

1. In the Administration environment, navigate to Assets > Object Types.
The Object Type Information screen appears listing the object types.

2. In the left panel, select the object type to modify.

3. Make changes as needed and select Save.

4. To remove an object type, select it in the left panel, select Delete, and confirm the delete.

Remove Contained Types
When you delete a child from an asset object type, it is also removed from all objects using it.

1. In the Administration environment, navigate to Assets > Object Types.
The Object Type Information screen appears listing all the asset object types.

2. In the left panel, select the asset object type whose children you want to modify.

3. Select the Contained Types tab.

4. To remove children from a parent, select the check box next to each child you want to remove,
and select - above the table.
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5. Select Save.

Replace Contained Objects
You can quickly replace contained objects by browsing through a list of similar objects that are
assigned to the same object type.

1. In the Administration environment, navigate to Assets > Objects.

2. Select the object type.

3. Select Contained Objects.

4. Select the arrow next to the contained object that you want to replace. A list appears with
similar objects that are associated with the selected object type, as shown in the following
image:

5. Select the object to replace the contained object. This selected object is now a contained object
for the object type.

6. Optional: To view the details of a contained object, such as its data variables, select its hyper-
linked name in the Name column.

7. Select Save.
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Modify Objects
You can remove an asset object as well as change its data sources.

If an object has contained objects, you can change their auto-generated names but not their aliases.

1. In the Administration environment, navigate to Assets > Objects.
The Object screen appears.

2. In the left panel, select the object to modify.

3. Make the changes as needed and select Save.
You cannot modify data variables.

4. To remove an object, select it in the left panel, select Delete, and confirm the delete.

Export the Model

Model configuration is exported and saved to a CSV format for later use.

1. Go to ADMIN > Import/Export.

2. Provide a file name for the model you want to export.

3. Select Export.
The model data is exported to a .csv file.

Note:  The data source connectivity information in the model is not preserved during export.
As an alternative, export the application (page 120).

4. Retrieve the model file from the Windows Downloads folder.

Import a Model

If you want to replace an existing model, you must first delete (page 240) the old one before
importing the new one. You can also merge the new model with the existing model during import.
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Note:  Data source connectivity information is not preserved in the model you import to your
system. After importing the model, reconfigure the data source properties in the model.

1. Go to ADMIN > Import/Export.

2. Select Browse to navigate to the .csv model file, and then select Import.

Note:  Always import files that are of size 13 MB or less at a time. If the CSV is larger than
13 MB, split the file into multiple smaller files and import them one by one to Operations Hub.
You can use a free .csv splitter tool to break the large file into smaller files.

3. Follow these instructions to view and download the log file in these browsers:

Option Description

Chrome • To view the log file, right-click [log] to open it in a
new tab.

• To download and then view the log file, click [log].
You can view the file in the Downloads folder.

Microsoft Edge • To view the log file, click [log], and then Open.
• To download and view the log file, click [log],

and then Save. You can then view the log file by
selecting View downloads.

4. To view the model in runtime, select Runtime from the user icon drop-down list at the top right
of the screen.
By default, the highest asset point in the model hierarchy appears.

5. To navigate through the asset objects in the hierarchy model, select the Asset Context Selector,
.

The model displays the relevant data in context to each asset object selected in the navigation
scheme.

Define Trend Data
You can view trend-line analysis of variable data for a selected time frame in Historian. You select
which historical variables to view.

1. In the Administration environment, navigate to Visualizations > Designer.
2. Select Types.
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3. In the left pane, select the asset object type containing the data variables to display in trend
lines.

4. Select Trend Card.
5. Select the check box next to each variable containing the data to use as a trend point.
6. Select Save.

Delete a Model

If importing a model fails or you want to replace a model with a new one, you may choose to delete
the model. Before deleting the model, we recommend that you export (page 238) it for a backup.
You can then import it again or import a new model.

1. In the main navigation menu, select ADMIN.
The ADMIN workspace appears.

2. Select Delete Model.
A message appears, asking you to confirm that you want to delete the model.

3. Select Delete.
The model is deleted.

Import Mimics
HMI graphics are imported as mimics to Operations Hub.

Verify iFIX pictures or CimEdit screens were exported as JSON files.

• In Proficy iFIX, go to Tools > Publish Picture to export pictures.
• In Proficy CIMPLICITY, export CimEdit screens.

Process diagrams created in an HMI/SCADA system are imported and used as mimics in Operations
Hub.

1. Go to ADMIN > Visualizations > Mimic Management.

2. Select Import.

3. In the Import Mimics screen, browse and select the JSON zip file you want to import to
Operations Hub, then select Import.
The zip files contain exported iFIX pictures or CimEdit screens.

4. Repeat the steps to import more files.

All the imported files are listed on the Mimic Management screen.
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Assign Mimics to Assets
Assign a mimic to object types and objects.

Import Mimics (page 240).

When you assign a mimic to an object type, the mimic is assigned to all the objects that belong to the
object type.

1. Go to ADMIN > Visualizations > Designer.

2. Select an item under the Object Types tab and perform these tasks:

Details tab a. Select a Mimic from the drop-down list to associate with this object type.
b. Select Save.

Mimic Card tab Mimic fields represent animation sources within a mimic. For example, @Flow@
and @OpenClose@ are mimic fields for displaying data for the Suction Value
object type.

Choose any of these:

• On the Mimic Binding tab, for each Mimic Field, select a Data Variable
from the drop-down list.

• Select Autobind tab to allow automatic binding of data by matching the
data variables to the mimic fields.

For example, the TPump object type with Flow variable is auto binded to
a picture representing a pump with the @Flow@ animation.

3. Repeat the steps to assign a mimic to another object type.

The selected mimic is assigned to the object type and their objects. You can choose to override and
assign a different mimic (page 241) for a particular object.

Override an Assigned Mimic
Assigning a new mimic to an object overrides the mimic assigned at the object type level.

A mimic is already assigned at the object type level, which applies to all the objects belonging to that
type.

At runtime, the newly assigned mimic appears for the object instead of the mimic assigned for the
object type.

1. Go to ADMIN > Visualizations > Designer.
2. Under Objects, select the object for which you want to modify the assigned mimic.
3. On the Details tab, for the Mimic field, select a different mimic from the drop-down list.
4. Select Save.
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A new mimic is assigned to the object. The original mimic appears in the list with 'default' before its
name, such as Default - FWPS, Pump.

Set Up Mimic Target Zones
Target zones represent areas on a mimic that were set as selectable in the HMI/SCADA system. You
set the navigation of these target zones for an operator.

You define a target zone to navigate to any asset in the model and view historical data.

Note:  These steps are also applicable for mimics bound at the asset level.

• In iFIX, set regions on a picture as Is Selectable to appear as clickable targets on the Mimic
Card.

• In CIMPLICITY, only groups with the mouse-up or mouse-down event show as selectable
targets on the Mimic Card. When defining a mouse-up or mouse-down event for a group, you
must specify the script action, and then create an empty script.

• Assign the mimic to an asset type.

1. Go to ADMIN > Visualizations > Designer.

2. Under Object Types, select an object type.

3. For the selected item, go to Mimic Card > Click Target Binding.

4. To enable an operator to navigate to a particular asset object in the model, do the following:

a. In the Referenced Object column and next to the target name, select or search for the asset
object in the model hierarchy tree. You can do a partial search, such as Sto, and Operations
Hub highlights all assets containing Sto, as shown in this example.
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b. Select the related Action field and then Navigate.

In Runtime, the background of a target zone changes to blue when an operator hovers over it.
After an operator selects a target on the mimic card, the target asset becomes the active one,
changing the mimic and content in the trend and alarm cards accordingly.

5. Select Save.

Data Sources

About Data Sources

To create applications in Operations Hub, you can fetch data from the following sources:

• Data stored in Operations Hub: This data is created and stored in entities, which are database
tables. To create data, you can:

◦ Manually enter the data in an entity.
◦ Import data using a Microsoft Excel spreadsheet.
◦ Insert data into entities using insert queries, which you can create using Operations Hub.
◦ Send data from an MQTT client to an M2M entity. In addition, you can also use pivot

tables to send data dynamically.
◦ Create an API that will work with the Operations Hub APIs to send data to an entity.

• Data stored externally: This data is stored in an external database, such as a Historian server.
You can use this data in an Operations Hub application. To do so:

1. Create a data source to provide the details of the external database whose data you want to
use.

2. Create a REST or SQL query to specify the expected inputs and outputs of a REST
endpoint (as defined in the REST API) .

3. Run the query to fetch the data from the external database.

Note:  The data will still be stored only in the external database; it will not be stored in
Operations Hub.

Access a Data Source

1. From the main navigation menu, select DATASOURCES.
The DATASOURCES workspace appears, displaying a list of data sources.

2. Select the data source that you want to access.
The data source appears.
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Create a Data Source

1. From the main navigation menu, select DATASOURCES.
The DATASOURCES workspace appears, displaying a list of data sources.

2. Select Add New Data Source, and then enter values as specified in the following table.

Field Description

Name Enter a unique name for the data source.

Product Select one these products for the data source:
• Proficy CIMPLICITY
• Proficy Historian
• Proficy iFIX
• OPC UA
• Relational Database
• REST API

Description Enter a brief description of the new data source.

3. For relational database, refer to Add Relational Database Data Source (page 244).

4. For Historian and REST API, refer to Add Historian or Custom REST Data Source (page
246).

5. For CIMPLICITY, iFIX, and OPC UA, refer to Add a Data Source with OPC UA Configuration
(page 250).

6. Save the data source.

Option Description

Save Select to save the data source details and remain on
the screen.

Save As New Select to copy the details and save as a new data
source.

Save And Exit Select to save the data source details and exit the
screen.

Add Relational Database Data Source

Creates a relational database data source.

Provide a name, product, and description for your data source (page 244).

1. Select the check box for Enable Relational Database Connection and enter these details:
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Field Description

Database
Type

Currently, Microsoft SQL Server is the only supported database type.

Host Enter the IP address or host name of database server. For example: 10.181.213.211 or
databaseserver01.

Note:  If using a SQL named instance, enter the host name in the format ServerName
\InstanceName. For example: databaseserver01\SQLEXPRESS.

Port Enter the port number to connect to the SQL Server.

Note:  If using a SQL named instance, enter the exact port of the SQL named instance.

Database Enter the database name to connect.

Certificate
Required

Select the check box if connecting to the data source requires SSL certificates.

Select Choose Certificate to browse to your system and add certificates.

2. Provide SQL server authentication details:

Field Description

User
Name

Enter the user name for the database you want to access.

Password Enter the password of the user configured in the database.

Test
Select to check whether the database connection is established using the server and authentication
details.

A message confirms on a successful connection to the database.

If test fails, the message provides more details on the failure.
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A successful SQL Database

connection.

3. Select Save.

Add Historian or Custom REST Data Source

Creates a Historian or Custom REST data source.

Provide a name, product, and description for your data source (page 244).

1. Select the check box for Enable System Connection and provide these details to authenticate
the Historian system API:

Field Description

Hostname Enter the hostname of the Historian data source.

Authentication
Required

Select the check box if connecting to the data source requires authentication.

Enter the Username and

Password of the user who can access the APIs.

Test Select to verify the authentication details. A message appears, confirming whether
connection to the system API is established.

2. Select the check box for Enable REST Connection and provide these details:

Field Description

Base URL Enter the URL of the data source in the following format: https://<host name or IP address of the
data source>:<port number>

Note:  The port number should not be used if your data source is Historian 8.x.
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Field Description

REST
Authentication
Required

Select the check box if authentication to a REST API is required. If selected, Operations Hub
sends authorization details along with a request while connecting to a data source.

Auth Type Appears when the REST Authentication Required check box is selected.

Select one of the following types of authentication:
• Basic Auth: Sends a verified user name and password along with the request.
• Bearer Token: Sends an access key along with the request.
• OAuth: Retrieves an access key to access an API, and then uses the key to authenticate

future requests.

Important:  For connecting to a Custom REST data source such as eAndon, select OAuth
for authentication.

Depending on the authentication type you select, a few boxes appear.

Auth Token Appears when the Bearer Token authentication type is selected.

Enter the access key required to authenticate the APIs. The access key is included in the
request header.

Auth Grant
Type

Appears when the OAuth authentication type is selected.

Select one of the following types of granting the authentication:
• client_credentials
• password

Auth URL Enter the URL for the endpoint of the authentication server. This value is used to exchange the
authorization code for an access token.

Auth Client Id Appears when the OAuth authentication type is selected.

The client identifier issued to the client during the application registration process.

Auth Client
Secret

Appears when the OAuth authentication type is selected.

The client secret issued to the client during the application registration process.

Ignore TLS/
SSL

Select the check box if verifying SSL certification can be ignored. Normally, this check box
is cleared when using the data source in a production environment, which implies that SSL
certification will be verified while connecting to the data source. If, however, you want to
troubleshoot issues with connecting to a data source, you may select this check box to isolate
certification issues.

Certificate
Required

Select the check box if connecting to the data source requires SSL certificates.

Select Choose Certificate to browse to your system and add certificates.

Auth
Certificate

If you want to provide a certificate for authentication, select Choose Certificate and navigate
to the certificate. Alternatively, you can select the Use Datasource Certificate check box if you
want to use the same certificate that is used by the data source.

Note:  You can use certificates only in the base-64-encoded format. A DER-encoded
certificate is not supported.
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Field Description

Test Select to test the connection. A message appears, confirming whether token from the OAuth
data source is retrieved. The connection is tested using the authentication details of the REST
APIs, including the authentication URL; the data source base URL is not used.

Note:  You can create multiple data sources with the same URL. After you restart the
services, the Data Distributor service uses the most recently saved System API authentication
settings for the URL. Therefore, if the most recently saved credentials do not work, you
cannot connect to the data source. To fix this issue, modify the data source to specify working
credentials, and then test the data source. We recommend that you do not save the data
sources that do not pass the test or data sources with the same URL.

3. Select Save.

Look at the following examples for configuring a data source for Historian 7.x and Historian
8.x.

Historian 7.x requires entry of port used – in this instance, port 8443 – whereas Historian 8.x
does not require any port to be specified.

The Auth Client ID is admin for Historian 7.x, whereas Historian 8.x requires the Auth Client
ID to be of the form MachineName.admin, where MachineName is case sensitive.

Example of Historian 7.2 Data Source:
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Example of Historian 8 Data Source:
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Note:  The Auth Client ID field is case sensitive. For example, if the Historian server name
is hist8Server, the user must use hist8Server.admin and not HIST8Server.admin or
Hist8Server.admin, otherwise REST authentication will fail.

Add a Data Source with OPC UA Configuration

Creates a data source with OPC UA configuration.

Provide a name, product, and description for your data source (page 244).

You cannot add multiple data sources to use the same database connection. Make sure that the
Endpoint URL and Application URI configuration is unique to every data source.

1. If you selected Proficy iFIX, Proficy CIMPLICITY, or OPC UA as the product, provide these
details to Enable OPC UA Connection.
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Field Description

Endpoint
URL

Enter the machine name and port number to connect to an OPC UA server. For example:
opc.tcp://MyServer:51400.

In iFIX, you can copy the URL from here:
• Applications > OPC UA Configuration screen.

In CIMPLICITY, you can copy the URL from here:
• Project > Properties screen.

Discover
policies

Select to discover and display all the security profiles supported by the OPC UA server to establish
a secure connection. The display list is based on the entered endpoint URL; the security modes and
policies supported by either iFIX, CIMPLICITY, or IGS.

From the discovered list for the endpoint URL, select the security profile you want to use for this
connection, then select Apply.

Application
URI

This field is auto populated after defining a security profile for the OPC UA server.

Security
Mode

This field is auto populated after defining a security profile for the OPC UA server.

Note:  If security mode is None, the connection is not secured. This is acceptable if you simply
want to test a connection. Make sure to change this setting later to ensure that you have adequate
security enabled for your connections.

Security
Policy

This field is auto populated after defining a security profile for the OPC UA server.
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Field Description

View
Certificate

For a secured connection, security certificates must be exchanged between Operations Hub and
the OPC UA server.

Select to view the OPC UA server certificate, and if Untrusted, select Trust.

The server certificate gets added to the C:\ProgramData\GE\Operations Hub\pki\trusted\certs
folder in your machine running Operations Hub.

The certificate status now appears as Trusted.

Select Cancel to close the trusted server certificate screen.

Important:  Operations Hub client certificate must also be trusted on the OPC UA server (iFIX,
CIMPLICITY, IGS) to establish a secured connection.

• To trust the certificate on the CIMPLICITY server,
a. Start the CIMPLICITY project.
b. Attempt to connect via the Data source dialog box.
c. Trust the certificate on the Data source dialog box.
d. Go to the CIMPLICITY project's \pki\rejected\certs folder, and copy the rejected

certificate to the \pki\trusted\certs folder.
e. Test the connection again; it should now work.

• To trust the certificate on the iFIX server,
a. Access the iFIX OPC UA Server Configuration Tool dialog box.
b. On the Trust List tab, select the failed entry and trust it.

The failed entry appears when you attempt to test the connection in Operations Hub client.

Another option is to directly copy the Operations Hub certificate from the client location (C:
\ProgramData\GE\Operations Hub\pki\own\certs) to server location (\pki\trusted\certs).

Ensure that you modify the certificate file name if you plan to copy more than one Operations Hub
certificate to the CIMPLICITY trusted folder, to avoid replacing the already trusted clients.
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2. Select the authentication type to access the database as Anonymous or with a Username/
Password.

It is recommended that you select Username/Password to provide the highest level of
encryption. Anonymous does not provide any protection for accessing data or login.

Field Description

Username Enter the user name to connect to the OPC UA server (iFIX, CIMPLICITY, IGS).

Password Enter the password for the user name to connect to the OPC UA server.

Test
Connection

Select to test the OPC UA connection. If the details provided to establish the connection are
correct, a message appears confirming the successful connection.

To troubleshoot connection related issues, refer to Error Messages (page 491).

3. Select Save.
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Rename a Data source
Data source aliasing is necessary for renaming a data source.

• After upgrading from Operations Hub 2.0, resave all the queries and their respective pages.
This practice directs them to use the data source aliasing instead of the machine name. This also
ensures that the queries and pages created in 2.0 are compatible with renaming data sources in
the current version.

• If importing an application (page 122) that was exported from version 2.0, resave all the
queries and pages after importing to the upgraded version of Operations Hub.

1. From the main navigation menu, select DATASOURCES.
The DATASOURCES workspace appears, displaying a list of data sources.

2. Select the data source that you want to rename.
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The data source appears.

3. Enter the new name for the data source in the Name text box.
The new name must be a unique name.

4. Select Save.

The data source is successfully renamed.

In case you want to export an application (page 120) after renaming a data source, save all
the associated queries and pages before application export. The application and the queries have
references to the renamed data source.

Delete a Data Source

1. From the main navigation menu, select DATASOURCES.
The DATASOURCES workspace appears.

2. Select , and then select Delete.
A message appears, asking you to confirm that you want to delete the data source.

3. Select Delete.

The data source is deleted.

Browse Data Sources
Allows to browse a data source and select the properties or tags.

1. From the select drop-down, select a server alias and its data source to browse through the server
properties and tag IDs.

Option Description

Assets / Objects This is the asset model configured in the system. You
can browse through the asset hierarchy, and add
properties to the trend chart from any hierarchy level.
You can add or remove data variables of the asset from
the trend chart.

Historian The Historian servers configured in the system. You
can browse through the servers for tags that you want
to add to the widgets.

Proficy iFIX The iFIX servers configured in the system. You can
browse through the servers for tags that you want to
add to the widgets.
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Option Description

Proficy Cimplicity The Cimplicity servers configured in the system. You
can browse through the servers for tags that you want
to add to the widgets.

OPC UA The OPC UA servers configured in the system. You
can browse through the servers for tags that you want
to add to the widgets.

A list of server nodes appear in a tree structure. For the Historian data source, a list of native
tags from the data source appear.

2. Expand the tree structure and select the check box for only value  to pull data from the data
source.
The tree structure is made up of nodes, each with a unique NodeID.

Icon Description

Objects are assets from a data source.

The Alarms folder contains alarm area nodes.

Servers

Data arrays

The Tags folder provides access to the tag types and
fields. Each tag has a value node, which represents the
current value of the tag.

3. For Historian, you can search and select (page 258) from the list of native tags.

4. Save or close the screen.

The selected properties or tags are applied.

Create a SQL Data Source

1. From the main navigation menu, select DATASOURCES.
The DATASOURCES workspace appears, displaying a list of data sources.

2. Select Add New Data Source, and then enter values as specified in the following table.

Item Description

Name Enter the unique name of the data source.

Description Enter the description of the data source.
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Item Description

Datasource Type Select Relational Database.

Database Type Observe that this field defaults to Microsoft SQL
Server, currently the only supported database type.

Host Enter the IP address or host name of database server.
For example: 10.181.213.211 or databaseserver01.

This field only appears if you select Relational
Database as the Datasource Type.

Port Enter the port you want to use to connect to the SQL
Server.

This field only appears if you select Relational
Database as the Datasource Type.

Database Enter the database name that you want to connect to.

This field only appears if you select Relational
Database as the Datasource Type.

Certificates Required Select the check box if connecting to the data source
requires SSL certificates. If you select this check box,
the Choose Certificate button appears, allowing you to
select the certificate.

User Name In the SQL Authentication section, provide the user
name for the database you want to access.

Password In the SQL Authentication section, provide the
password of the user configured in the database.

Test button
After the required fields are filled in, click the Test
button.

On a successful connection check, a message is
shown beside the Test button as "Successfully
connected to the Database” indicating that test
connection to database can be established using the
above details.

If it fails, it reads: “Failed to connect to the Database.
More Details.” Click the “More Details ”link to view
detailed reason in a popup.

3. Select the Test button.

The following example shows a successful SQL Database connection.
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If it fails, a message appears stating: Failed to connect to the Database. Click on More Details
link to view detailed reason in a popup.

4. Select Save.

Search for Tags
Allows to search for tags by tag name and description.

1. Enter a keyword in Search and select .

Tip:  You can also perform a wild card search by entering *.

By default, only tags that match the keyword in their name and description are displayed.

2. To streamline your search, use these options:

Field Description

Tag name This is the default search filter. Select the check box to
match the keyword only to tag names.

Additionally, to view the description for tags returned in

keyword search, select  next to Description.
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Field Description

Description Select the check box to match the keyword only to tag
descriptions.

Additionally, to view the names of tags returned in

keyword search, select  next to Tag name.

Both Select the check box to match the keyword with tag
name or description, and return results.

Pages

About Pages

Using Operations Hub, using the application editor, you can create pages that appear in an
application. You can use pages in multiple ways, such as:

• Display information to users in the application. Information can be displayed in plain text or
using multiple components, such as tables, images, graphs, and other components.

• Display a form to allow application users to enter or modify data. Forms can include items such
as text, numbers, dates, times, and uploaded images from a mobile device.

• Allow application users to control assets by sending commands via MQTT or REST services.

Grant Group Access to Page within an Application

1. From the main navigation menu, select APPS.
The APPS workspace appears.
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2. In the Name column, select the application to which you want to grant access.
The PAGES workspace appears, including a column summarizing the current page permissions.
By default, newly created pages display “All users”, indicating all users who have access to the
application will have access to the page.

3. In the Permissions column, select the page to which you wish to grant access.
The page permission dialog appears.

4. In the Manage Page Permissions dialog box, if you wish to grant visibility to select groups
only, select the “Selected Groups” option.

5. In the groups field, select the group or groups you would like to grant access to this page and
then select Submit changes.
The selected groups can now access the page. Please note these users must already have the
ability to access the app.

6. In each row containing an application user to whom you want to grant access, select the check
box, and then select Submit changes.
The selected users can now access the application.
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Note:  It is possible to create a circular reference by nesting a parent group into its child. If
there are circular references, the child groups will not display in the permissions dialog box.

Access a Page

1. From the main navigation menu, select APPS.
The APPS workspace appears, displaying a list of applications created in the site.

2. In the Name column, select the application that contains the page that you want to access.
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The PAGES workspace appears, displaying a list of pages created in the

application.

3. In the Name column, select the page that you want to access.
The page designer appears, displaying the elements in each container in the page.

Tip:  If needed, you can add or remove components from a container in the page, or modify
the properties of a container (page 445), and then select Save App to save your changes.

Create a Page

1. From the main navigation menu, select APPS.
The APPS workspace appears, displaying a list of applications created in the site.
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2. In the Name column, select the application in which you want to create a page.
The PAGES workspace appears.
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3. Select Add new page.
The Create Page window appears.

4. Provide values as described in the following table.

Field Description

Page name Enter a name for the page. The name must contain at
least one uppercase or lowercase letter.

Page description Enter a description for the page.

Include in app navigation Select this check box if you want this page to be
included in the application navigation. By default, this
check box is selected.

5. Select Create.
The page is created, and the page designer appears.

The container and the left/right panels on the page designer are flexible to use.
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• Drag the left/right sides of the container to resize for a wider view.

• Select  and  to show or hide left/right panels.

6. As needed, add components to the page (page 445).

7. As needed, add queries to the page. Set options for the query, including query submission
options.

Several queries require the multi-select parameter to be selected on the App Page, otherwise no
output data will be displayed.

The following Historian REST queries require the multi-select input to be enabled on the
EndApp page for output data to be displayed:

• Get > Raw Data
• Get > Calculated Data
• Get > Sampled Data
• Post > Calculated Data
• Post > Interpolated Data

8. Bind the inputs and outputs of widgets to page data, such as manually entered values, queries,
formulas, and globals.

9. Select Save App.
The changes made to the page are saved.

Note:  At any point in time, if you attempt to navigate away from the page, a confirmation
message appears to confirm whether you want to stay on the page, and finish your work.

Copy a Page

1. From the main navigation menu, select APPS.
The APPS workspace appears.
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2. In the Name column, select the application that contains the page that you want to copy.
The PAGES workspace appears.
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3. Select the check box for the page you want to copy and choose one of these options.

Option Description

Copy a single page
Select  in the row, then select Duplicate page.

Copy multiple pages
Select  in the header, then select Duplicate Pages.

A confirmation message appears.

4. Select OK to proceed to duplicate the page/s.
Select an Application screen appears.

5. From the drop down, select the application to copy this page.
You can copy page/s from one application to another, and also within the same application.

6. Provide a name for the page.

Option Description

Copy a single page Enter a name for the duplicate page. The name must
contain at least one uppercase or lowercase letter.

Copy multiple pages By default, unique names are assigned to each
duplicate page.

7. Copying page/s from one application to another requests for handling globals.
• Duplicate Globals: Creates page globals with a different name. Recommended when

globals have the same name but are of different types.
• Attempt to reuse Globals: Reuses the page globals. Does not create new globals with the

same or duplicate name.

8. Select OK.
The pages, along with the UI components, queries, and global variables used in them, are
copied.

Delete a Page

When you delete a page, the global variables used in the page are also deleted.

1. From the main navigation menu, select APPS.
The APPS workspace appears.
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2. In the Name column, select the application that contains the page that you want to delete.
The PAGES workspace appears.
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3. In the workspace heading, select , and then select Delete Pages.
A message appears, stating that the global variables used in the page will also be deleted.

Tip:  Alternatively, in each row containing a page that you want to delete, select , and then
select Delete page.

4. Select OK.
The pages are deleted.

Navigation

About Navigation

Using navigation, you can configure the navigation menu of an application by performing the
following tasks:

• Add a page to the navigation menu of the application.
• Remove a page from the navigation menu of the application.
• Specify the name of the page that should appear in the navigation menu of the application.
• Specify the sequence of the pages that should appear in the navigation menu of the application.
• Select the icon that should appear for each page in the navigation menu of the application. By

default,  is selected.

When you access the application, a list of pages that you have added appear in the navigation menu
of the application, displaying the icon that you have specified for each page. You can expand the

navigation menu of the application by selecting . It will then display the name of each page along
with the icon.

Using navigation, you can configure the navigation menu of an application by performing the
following tasks:

• Add a page to the navigation menu of the application.
• Remove a page from the navigation menu of the application.
• Specify the name of the page that should appear in the navigation menu of the application.
• Specify the sequence of the pages that should appear in the navigation menu of the application.
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Add a Page to the Navigation Menu of an Application

By default, when you create a page, it is included in the navigation menu of the application. This
topic describes how to add a page to the navigation menu of an application in case it has been
removed from the navigation menu.

1. From the main navigation menu, select APPS.
The APPS workspace appears, displaying a list of applications in the site.

2. In the Name column, select the application for which you want to add a page to the navigation
menu.
The PAGES workspace appears.
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3. From the main navigation menu, select NAVIGATION.
The NAVIGATION workspace appears, displaying a list of pages that have been added to the
navigation menu of the application.

4. Select Add Pages.
The Add Pages window appears, displaying a list of pages that have been created in the
application, but have not been added to the navigation menu.

5. Select each check box that corresponds to a page that you want to add to the navigation menu of
the application, and then select Add.
The selected pages are added to the navigation menu of the application.
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Tip:

• You can modify the display name of a page by selecting  in the DISPLAY NAME
column.

• You can modify the name of a page by selecting  in the Page Name column.
• You can select the icon that should appear for the page in the navigation menu of the

application by selecting an icon in the Page Icon column.
• You can change the sequence of pages in the navigation menu of the application by

dragging each page to the required location.
• You can preview the application by selecting Preview App.

Remove a Page from the Application Navigation Menu

1. From the main navigation menu, select APPS.
The APPS workspace appears, displaying a list of applications in the site.

2. In the Name column, select the application in which you want to change the application
navigation menu.
The PAGES workspace appears.
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3. From the main navigation menu, select NAVIGATION.
The NAVIGATION workspace appears, displaying a list of pages that have already been added
to the application navigation menu.

4. In the row containing the page that you want to remove, select .
The page is removed from the application navigation menu.

Note:  The page is removed only from the application navigation menu; it is not deleted.
You can still access it in the application by performing an action such as selecting a button or an
image.
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Explorer

About Explorer

Explorer provides a hierarchical view of the following items:

• Containers and UI elements used in each page in the application, which appear in the Pages
hierarchy.

• Variables defined in the application, which appear in the Globals hierarchy.

Using Explorer, you can view the links between variables and UI elements on application pages,
which will help you follow the application structure.

The variables defined in an application are classified as follows:

• System
• Output
• UI
• Custom
• URL

When you expand a variable in the hierarchy, one of the following options appears:

• app global: true: Indicates that the variable is visible in every page of the application.
• app global: false: Indicates that the variable is visible only in the page where it is defined.

If a variable contains an initial value, that value also appears in the hierarchy.

Themes

About Themes

Themes are used to specify the default background color, font color and type, border color, style,
width, and other attributes. These attributes are used in the headings, tables, containers, and other
elements in an application. Themes help you create a common look and feel across all the pages in
your application.

Operations Hub contains a few baseline themes. You cannot modify or delete them. You can,
however, copy them.
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Access a Theme

1. From the main navigation menu, select APPS.
The APPS workspace appears.

2. In the Name column, select an application.
The PAGES workspace appears.
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3. From the main navigation menu, select THEME.
The THEME workspace appears, displaying a list of themes. The theme that is applied to the

application is indicated by .

4. In the row containing the theme that you want to access, select .
The workspace for the theme appears, displaying the settings for each attribute.
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Tip:  If needed, modify the settings, and then select Save theme to save your changes. You
cannot, however, modify a baseline theme.

Create a Theme
When you create a theme, it is automatically used in the application that you have selected. You can,
however, use a different theme in the application.

1. From the main navigation menu, select APPS.
The APPS workspace appears.
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2. In the Name column, select an application.
The PAGES workspace appears.
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3. From the main navigation menu, select THEME.
The THEME workspace

appears.

4. Select Create new theme.
The Create new theme window appears.

5. Enter a name for the theme, and then select Save. The name must contain at least one uppercase
or lowercase letter.
The workspace for the theme appears, displaying the default settings for each attribute.

6. As needed, modify the settings, and then select Save theme.
A message appears, asking you to confirm that you want to use the theme for the application.
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7. Select Yes.
The theme is created and used in the application.

Copy a Theme

1. From the main navigation menu, select APPS.
The APPS workspace appears.

2. In the Name column, select an application.
The PAGES workspace appears.
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3. From the main navigation menu, select THEME.
The THEME workspace appears.
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4. In the row containing the theme that you want to copy, select , and then select Duplicate
theme.
The Create new theme window appears, asking you to enter a name for the theme that you
want to copy.

5. Enter a name for the theme, and then select Save. The name must contain at least one uppercase
or lowercase letter.
The theme is copied.

Delete a Theme
You cannot delete a baseline theme or a theme that is used in an application.

1. From the main navigation menu, select APPS.
The APPS workspace appears.
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2. In the Name column, select an application.
The PAGES workspace appears.
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3. From the main navigation menu, select THEME.
The THEME workspace appears.

4. In each row containing a theme that you want to delete, select the check box.

5. In the workspace heading, select , and then select Delete themes.
A message appears, asking you to confirm that you want to delete the themes. If, however, a
theme is used in an application, a list of applications that use the theme appears, and you cannot
delete the theme.

Tip:  Alternatively, in each row containing a theme that you want to delete, select , and
then select Delete theme.

6. Select Delete.
The themes are deleted.
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Settings

About Settings

You can configure the following settings for an application:

• Display brief or detailed error information in the error messages
• Display or hide a button for accessing trace information
• Display or hide a busy indicator to indicate that a page is loading data from a query
• Display or hide the title of the application
• Display or hide the user pages, which are used to change the password of the user and access

user settings from the application
• Automatically close error pop ups without manual intervention

Modify Settings

1. From the main navigation menu, select APPS.
The APPS workspace appears.
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2. In the Name column, select the application whose settings you want to modify.
The PAGES workspace appears.



Operations Hub for Windows | 3 - User Guide | 287

3. From the main navigation menu, select SETTINGS.
The SETTINGS workspace appears.

4. As needed, modify values as described in the following table.

Field Description

Show extended error information Select this check box if you want detailed error
information to appear in error messages. You can
use this information to troubleshoot issues in the
application.

Show trace button Select this check box if you want to display a button that
allows you to access information on the data retrieved
from queries, functions, and global variables that are
used in the application. It also includes data that is
inserted or updated using queries. When you select this
check box (and save your changes), a Trace appears
in the application. You can select this button to view the
trace information.

Hide loading in application Select this check box if you do not want to display a
busy indicator to indicate that a page is loading data
from a query.

Hide application title Select this check box if you do not want the title of the
application to appear when you access the application.

Show User Pages Select this check box if you want to display user pages
in the application navigation menu. These pages are
used to change the password of the user and access
user settings using the application. If you select this
check box, the option to access the user pages appears
in the application title. If, however, the Hide application
title check box is selected, the option is moved to the
navigation menu of the application.
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Field Description

Auto-dismiss errors after 10 seconds Select this check box to automatically dismiss error
messages after 10 seconds if they pop up in the
end application. Recommended for hands-free
environments.

Show navigation icons for application history Select this check box to show  navigation icons
on the banner of your application. The back/forward
navigation icons work within the scope of an individual
application.

Use the navigation icons to Go to previous page or Go
to next page. The icons are activated based on the
entries for the current application session history.

5. Select Save.
The settings are modified.

Widgets

About Widgets

When you design a page for an application, you can add widgets to the page to display the required
information. This article provides information on using the following widgets available in Operations
Hub.

Native Widgets

• Inputs:
◦ Check Box (page 290)
◦ Radio Button (page 291)
◦ Dropdown (page 292)
◦ Input (page 294)
◦ Slider (page 296)
◦ Toggle (page 297)
◦ Button (page 298)
◦ Camera (page 299)
◦ Text Area (page 300)

• Display:
◦ Text (page 301)
◦ Header (page 302)
◦ Image (page 302)
◦ Graph (page 303)
◦ Visualization (page 305)
◦ Big Data (page 309)
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◦ Grid (page 312)
◦ Map (page 314)
◦ Table (page 317)
◦ List (page 319)
◦ Gauge (page 319)
◦ Html (page 323)
◦ Interactive Map (page 332)

• Layouts:
◦ New Line (page 334)
◦ Separator (page 334)
◦ Container (page 334)
◦ Repeater (page 335)

• Tools:
◦ Event Settings (page 350)
◦ Upload Excel (page 351)
◦ Upload Devices (page 353)

Integration Widgets

• CIMPLICITY HMI Webspace (page 354)
• Date Picker (page 372)
• Breadcrumb (page 374)
• Trend Card (page 377)
• Task Client (page 388)
• Indicator (page 393)
• Alarm Card (page 396)
• Alarm Count (page 406)
• Mimic Card (page 406)
• Solid Gauge (page 420)
• Timeline (page 422)
• Sparkline (page 426)
• Value Display (page 429)
• iFrame (page 433)
• Pareto Chart (page 427)
• DataGrid (page 435)
• Dropdown (page 439)
• Pivot Grid (page 441)

Custom Widgets

Custom widgets can be added to Operations Hub through use of the Plug-in infrastructure. To learn
more about plug-ins, refer to the About Plug-Ins (page 181) section.
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Native Widgets

Inputs

Check Box

A check box widget is used to allow application users to choose between two mutually exclusive
options. For example, you can use a check box to allow the application user to specify whether the
user has read the license agreement. You can also use a check box to display or hide other widgets on
the page.

Check Box Settings

When you use a check box widget, in addition to providing values for the default fields for a widget,
you must define the following settings:

Type
of the

Setting
Description

Target Data If this check box only represents input to a single query, you can select the target input from the list of
inputs to the queries that have been added in the Page Data section.

Source Identifies the source of the check box value. You can specify one of the following types of sources:

• Data: Select the source of data from the list of outputs from the queries that have been added in
the Page Data section.

• Manual: Select this option if you want to set true and false as the check box options.

Using a Check Box to Display or Hide a Camera Button

To use a check box widget to display or hide a Camera button, perform the following steps:

1. Add the check box and camera widgets to the page.
2. In the CHECKBOX PROPERTIES section, enter values in the Label and Id boxes, and then

select the Global Data check box.
3. In the CAMERA PROPERTIES section, select Add conditions.
4. In the Camera Conditions window, select Add condition, and then enter or select values as

shown in the following image.
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Note:  In this case, CB was the ID specified for the check box widget.

5. Select Done, and then save the application.

In the application, the Camera button appears only if you select the check box.

Radio Button

A radio button is a graphical user interface element that allows a user to select one option out of a
set of predefined options. Unlike check boxes, which allow multiple selections, radio buttons require
that only one option is selected.

Table 5. Radio Button Properties

Property Description

Target Data The target data defines where the information will be sent.

Options Radio buttons require multiple options that are mutually
exclusive. Use these available options to create items for
each radio button:

• Select Hard Coded to manually create items for radio
buttons.

1. Select + Add Option.
2. Enter Option text.
3. Enter Option value.

• Select Dynamic to create items using queries.
1. Select a Value from the database.
2. Select the Displaytext.

Data Select this option if you want to provide data by means of
a query output or a global parameter.

Manual Select this option if you want to manually provide data.

Submit on change Select the check box if you want to submit the query
whenever the input value is updated.

Possible Uses

Radio buttons require only one selection out of multiple options. If there are only two options, a
radio button is unlikely to be the best widget choice. One example could be selecting an answer on a
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questionnaire where the choices are: Agree, Neutral, and Disagree. Only one of these answers can be
selected, because they are mutually exclusive.

Example

1. Add a radio button and a header on a page.
2. Specify the name in the Id box.
3. Select the Global Data check box to set the selected value to global.
4. In the Options box, select Hard Coded.
5. Select + Add Option three times, and enter Agree, Neutral, and Disagree, and the

corresponding values of 1, 2, 3.
6. For the header, in the Data box, select the global value of RB that was set in step 3.
7. Save the application, and preview it.

The corresponding values appear in the header.

Dropdown

Allows to use standard features of a dropdown.

A dropdown is a graphical user interface element that allows a user to select one option out of a set
of predefined options. Dropdowns are characterized by a wider set of options than that of a radio
button. Radio buttons rarely have more than three options, while dropdowns can contain many more
options. For advanced features, use the multi-feature Dropdown (page 439).

Table 6. Dropdown Properties

Property Description

Required Select the check box to send the input to the query.

Target Data The target data defines where the information will be sent.

Options Dropdowns require multiple options that are mutually
exclusive. Use these available options to populate
dropdown list items:

• Select Hard Coded to manually enter and fill items for
the dropdown.

1. Select + Add Option.
2. Enter Option text.
3. Enter Option value.

• Select Dynamic to populate dropdown list items using
queries.

1. Select a Value from the database.
2. Select the Display text.

Data Select this option if you want to provide data by means of
a query output or a global parameter.

Manual Select this option if you want to manually provide data.

Submit on change Select the check box if you want to submit the query
whenever the input value is updated.
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Property Description

First Option By default, the first option in a dropdown is blank. It is
recommended to manually enter option text such as
please select, instead of a dropdown that appears empty.
Enter its option value to be none.

Possible Uses

Dropdowns are similar in nature to radio buttons in that they require a mutually exclusive selection.
However, while radio buttons are generally used for options between only a few choices, dropdowns
can include hundreds of choices. One example of a drop-down list box could be selecting a country
of residence. Every country in the world will take up too much space if displayed as radio buttons,
while in a drop-down list box, the information can be more elegantly contained. The information
selected could be converted to other information depending on the target data. For example, the
country could be changed to a telephone prefix by setting the value to be telephone prefix and the
display as the country name.

Example: An entity named Wiki has been already defined to store the prefecture names in Japan.
The direct option value entering of 47 prefecture names is not productive. This entity value usage
is productive. The necessary steps are just to specify this entity in the property after allocating
dropdown on a page. In this sample, an entity field called PREF is specified both for Display and
Value, where the prefecture names are stored.

1. Drag-and-drop the dropdown widget to a container.
2. Select the dropdown widget in the container to access the DROPDOWN PROPERTIES tab
3. Under the GENERAL section, provide the details as specified in the table:

Field Description

Label Enter Select an option.

4. Under the DATA section, provide the details as specified in the table:

Field Description

Target Data Select a query.

Options Select Dynamic.

Value Select PREF.

Display Select PREF.

Submit on change Select the check box.

In the practical application, a query can be executed based on the option selection in dropdown and
the facility or company status in the prefecture can be displayed on a map as markers.
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Input

The input widget is a graphical user interface element that contains a text box.

The input widget differs from a standard text box in that its purpose is to allow the end user to insert
information into a database.

Properties

• Type: There are several options for the type of data that can be added via an input widget.
Depending on the data type set, the system will automatically validate and confirm specific data
sets. For example, while a Text type can be anything written in the input, an email address may
have specific requirements such as the use of an at sign character (@). If the data type is set
for email, the user must include an at sign character (@). If not, an error message appears. The
following options are available:

◦ Text
◦ Password
◦ Number
◦ Hidden
◦ Date
◦ Time
◦ DateTime
◦ URL
◦ E-mail

Note:  This DateTime output is not compatible with Historian queries. Use Date Picker
(page 372) instead.

• Target Data: Check boxes can alter information in an entity via a query. Target Data indicates
where this information will change and how depending on which query inputs are attached.

• Source: The data source can be selected based on which queries have been added in the Page
Data section. It is also possible to manually insert the data source or to use a formula.

• Required: Specify if an input must be sent to the query.
• Disabled: If selected, the data input is not allowed.

Possible Uses

The input has a wide variety of uses. One basic example is that of a login or registration form. Such a
form requires specific information to be stored in a database including data such as an email address,
name, birthday, password, and other information. The input allows an end user to enter information
in various forms in to a database.

In this example, we will create a simple input form using an entity and a query.

1. Add two input widgets to a page for address and name.
2. Add a button to indicate to add the information entered by the input widgets.
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3. Create an entity named Wiki Form, and add the following entity fields: ADDR and NAME (data
type: string).

4. Create an Insert query named Wiki Form Add to insert data into the entity, as shown in the
following image.

5. Add the query to the application in the Data Page section, as shown in the following image.

6. Drag and drop the query input fields to the connect them to the input widgets.
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7. In the Button Properties section for the button widget, specify the action to execute the insert
query, as shown in the following image.

8. Save the application, and preview it.

In the application, when you enter values and submit, the information is stored in the entity.

Slider

A slider is a graphical user interface element that is used to indicate an amount or value by means of
an indication hash marker that can move on a horizontal plane that has a value indication.

Slider Settings

• Source: The data source can be based on which queries have been added in the Page Data
section. It is also possible to manually insert the data source or to use a formula.

• Required: Specify if an input must be sent to the query.
• Submit on Charge: If selected, changing the value of the input submits the query to which this

input is assigned.
• Step: The spacing between variables on the horizontal plane of the slider.
• Minimum: Sets the minimum variable on the horizontal plane of the slider. This number

appears on the left side of the plane.
• Maximum: Sets the maximum variable on the horizontal plane of the slider. This number

appears on the right side of the plane.
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Possible Uses

A slider can be used for any of the following purposes:

• To provide a number selector.
• To indicate the volume on an audio recorder or a maximum/minimum price.
• To allow a user to select a price they would be willing to pay as part of a filter system for search

results.

Toggle

A toggle button contains two opposing, binary states based on Boolean logic. On/Off is the default
for the button, because this is the most common use.

Toggle Settings

When you use a check box widget, in addition to providing values for the default fields for a widget,
you must define the following settings.

Setting Description

Source The data source can be based on which queries have been added in the Page Data section. It is also
possible to manually insert the data.

Required Specify if an input must be sent to the query.

Submit on
Change

If selected, changing the value of the input submits the query to which this input is assigned.

True Label There are two states on a toggle button. The True Label setting refers to the label of the active state.

False Label There are two states on a toggle button. The False Label setting refers to the label of the inactive state.

Width The width of the toggle button.

Possible Uses

Toggle buttons are generally used for on/off actions. For example, if a setting or feature is active/
inactive, this can be controlled with a toggle button.

This example describes the device on/off switching using a Toggle button.

Note:  Without an actual device or a simulator, the real action result cannot be seen.

1. In the page designer, add a toggle widget and two input widgets.
2. In Page Data section, add a function to the page, such as IQAW Set Immobilizer State.
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3. Drag the function parameters to connect to the input widgets and the toggle widget. Note that
function (command) itself (IQAW Set Immobilizer State) should be connected to the toggle
widget.

Button

Buttons are used to start any action. By default, the text Submit appears on a button. It indicates that
it is used to submit information that an application user provides using other widgets.

Button Settings

Buttons can perform a variety of actions, and can even perform multiple actions. Each specific action
has its own choices. For example, if the action of selecting a button is to go to a specific page, that
page can be selected after the action is selected in the same grey box.

In addition, you can arrange actions in a sequence. For example, if the selecting a button will both
hide a component and submit data entered by a user, the action can first hide the component, and
then submit the data, or vice versa.

You can configure the following actions for a button widget.

Action Description

Submit Sends information to an entity.

Go to page Redirects to a different page in the application (for
example, from the home page to a different page in the
navigation).

Go to previous page Redirects to one page back in history based on the entries
created for the current application session.

In the absence of previous session entries, the button
does not redirect to any page.

Go to next page Redirects to one page forward in history based on the
entries created for the current application session.

In the absence of forward (next) session entries, the
button does not redirect to any page.

URL Redirects a user to a URL outside the application.

Set global value If selected, the data here will be available globally. Global
data means that an entity changed in one part of the
application will change across the application.

Show Component Displays a hidden component.

Hide Component Hides a component.

Toggle Show/Hide Some widgets are marked as shown or hidden and the
Toggle Show/Hide action will switch between hidden and
shown views of a component.
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Visual

Button types are design presets that can help create a better hierarchy and a better look and feel for
an application. It is recommended to use button types to fit a button to its use. For example, a delete
button might be a Negative type. The following button types are available:

• Primary
• Secondary
• Positive
• Negative
• Link

Possible Uses

Buttons can be used for a variety of purposes. In general, buttons are used in conjunction with other
widgets. For example, if a user makes a series of selections with drop-down list boxes, check boxes,
and radio buttons, they can then select a Submit button that will record the user’s choices in an
entity. Buttons can also be used to refresh a page, send a user to another page, set a global value, or
show/hide content depending on how the button is configured.

This example shows how to create a window.

1. Add a button widget in the page designer.
2. Add a container below the button widget, and provide an ID for the container.
3. In the container, add several input widgets, and set the display condition of the container to

Hidden.
4. In the Button Properties section of the button, set the action of Show Component, and specify

the container ID.
5. Save the application, and preview it.

In the application, if you select the button, the container appears.

Camera

The camera widget is a button that will open a default camera based on the device used by the
application user. If a camera does not exist, you can select an image. For example, if you use an
iPhone to access the application, and they select the camera button, the default iPhone camera
options page appears. After you capture an image with the default camera, the image is held in the
local memory of the application until you perform an action (such as linking the image display so the
image appears in the application).

Camera Settings

When you use a camera widget, in addition to the default settings, the following settings are
available.
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Setting Description

Max Width The maximum width of the uploaded image in pixels. This setting is optional.

Max Height The maximum height of the uploaded image in pixels. This setting is optional.

Possible Uses

You can use the camera widget to allow an application user to add images to an application or
database. Example:

• If an application deals with selling goods, a user can upload an image of the goods that they
want to sell.

• If an application deals with car rentals, a user can capture a photo to report a car accident, and
then save it to the database. The rental agency can then view the image.

Text Area

The text area widget allows a user to provide large amount of text using an application. This widget
contains a scroll bar.

Text Area Settings

To use a text area widget, in addition to the default settings, the following settings are available.

Setting Description

Source The source of data based on which queries have been added in the Page Data section. You can also
enter the data source manually or use a formula.

Required Identifies if an input must be sent to the query.

Submit on
Charge

If selected, changing the value of the input submits the query to which this input is assigned.

Possible Uses

A standard text box can handle large amounts of text, but it may not be user-friendly because not all
of the text can be seen or edited at once. If a user wants to submit a comment, for example, a text
area allows them to write several sentences and view the text as a paragraph (for example, license
agreement or privacy policy, which usually contains a large amount of text).
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Display

Text

The text widget allows you to display text in an application. An application user can read the text, but
cannot modify it.

Text Settings

To use a text area widget, in addition to the default settings, the following settings are available.

Setting Description

Source The source of data based on which queries have been added in the Page Data section. You can also enter
the data source manually or use a formula.

Format You can select one of the following values:

• Text
• DateTime
• Date
• Time

The default value is Text.

Possible Uses

Since this widget can be connected to a query in the Page Data section, updated information can be
displayed in the application. For example, if the application is used to display sports scores, the text
box can be connected to an entity via a query that will display the score in a sport. The user can read
the text, but cannot modify it.

Using a Text Widget to Display the Current Date and Time

1. In the Page Data section, select Global.
2. In the System Globals section, select Date time (Local), and then select Add. System globals

are provided as standard functions.
3. Add a text widget, and enter an label.
4. Drag the system global that you have added to connect to the text widget. Or, select the system

global in the Data box.
5. Save the application, and preview it.

The application displays the current date and time.
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Header

Headers are generally larger amounts of text that are used to create titles to divide an application in to
different areas depending on their content.

Header Settings

To use a header widget, in addition to the default settings, the following settings are available.

Setting Description

Type You can create three different sizes of headers: Header 1 (largest) to Header 3 (smallest) so that a
hierarchy can be created based on text size.

Format You can select one of the following values:

• Text
• DateTime
• Date
• Time

The default value is Text.

Possible Uses

If an application has several different areas, you can use a header to create order and hierarchy.

For example, a food application for a grocery store may divide food in to several categories such as
dairy, meat, and produce. These larger topics (Header 1) can then be divided in to smaller parts. For
example, the produce header can contain two smaller headers (Header 2) underneath for fruits and
vegetables. Within the category of vegetables, there may be an additional category of root vegetables
that may have a smaller sized header (Header 3) with a list of different root vegetables underneath.

Image

Using the image widget, you can insert an image in to an application. Application users can see the
image, but cannot manipulate it, since it is display-only. Images can be attached to the entities via
queries and then shown to application users.

Image Settings

When you use an image widget, in addition to the default settings, the following setting is available:

• Source: The data source can be based on which queries have been added in the Page Data
section. It is also possible to provide a URL or select a file from the local machine.
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Possible Uses

You can add an image gallery in an application by adding several image widgets. Additionally, if
application users use the camera widget, they can take an image, and then upload the image in to
their application with a button. The button can send the image to an entity, and a query of that entity
can use the image widget to display the picture.

Suppose you want to insert an image in an application, and want to direct the user to the home page
when the image is selected. In that case, perform the following steps:

1. In the page designer, add an image widget to a page other than the home page.
2. Select the File option, and select Choose File.
3. Select the image that you want to insert in the application.
4. In the Image Properties section, in the Actions box, select the action to go to the home page.
5. Save the application, and preview it.

When you select the image, the home page appears.

Graph

Graphs are data visualizations that you can add to display data in an application.

Note:  You need external Internet access to use the graph widget.

Graph Settings

To use a graph widget, in addition to the default settings, you must specify one of the following types
of graphs.

Type of
Graph

Description

Bars Bar graphs show comparison among categories vertically. Specify the following settings for a bar graph:

Setting Description

X-axis
Label

Displayed below the graph horizontally.

Y-axis
Data

The data source for the bars.

Y-axis
Label

Displayed on the left side of the bar graph.

Add All
Fields

This will add all the columns from the chosen entity. Each column can be labeled
independently.

Sort By Since an entity can contain several different types of data, it is possible to sort the data
depending on the data in an entity.
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Type of
Graph

Description

Columns Column graphs are similar to bar graphs but are shown vertically instead of horizontally. Specify the
following settings for a column graph:

Setting Description

X-axis Label Displayed below the graph horizontally.

X-axis Data The data source for the columns.

Y-axis Label Displayed on the left side of the graph.

Add All
Fields

This will add all the columns from the chosen entity. Each column can be labeled independently.

Sort By Since an entity can contain several different types of data, it is possible to sort the data depending on the data in an
entity.

Lines Line graphs show how data changes over specific intervals of time. Specify the following settings for a
line graph:

Setting Description

X-axis Label Displayed below the graph horizontally.

X-axis Data The data source for the lines.

Y-axis Label Displayed on the left side of the graph.

Add All
Fields

This will add all the columns from the chosen entity. Each column can be labeled independently.

Sort By Since an entity can contain several different types of data, it is possible to sort the data depending on the data in an
entity.

Pie In a pie graph, rather than axis points, there is a value that can be set to a query to post data on the pie
graph. Specify the following settings for a pie graph:

Setting Description

Value The data source for the pie graph.

Title The title of the graph.

Y-axis
Label

Displayed on the left side of the bar graph.

Sort By Depending on the data, sorting may be necessary in order to highlight certain information. Once the sort feature has been
selected, it is possible to select ascending or descending order.
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Possible Uses

Graphs are a way to show data visually. For example, if 50 students enrolled for a course, you can
use a graph widget to show how their grades have changed over time or it may be beneficial to show
what grades the students received by percent.

When you plot the data stored in the M2M Entities using a graph widget, timestamp values are
displayed in the following format: hh:mm

Downloading Data from a Graph

You can download data from an entity in a Microsoft Excel worksheet using a graph widget. To do
so, in the Graph Properties section, select the Allow Download check box. The download button
appears in the upper-right corner of the widget in the application.

Note:

• Downloading occurs based on the query last executed as shown in the graph.
• If the query is executed for the specific date range using Input boxes, for example, data is

downloaded based on the condition specified.
• The entity data connected to the graph is downloaded, not the graph itself.
• If multiple queries are connected to the graph, a separate Microsoft Excel worksheet is

generated for each query, and it is downloaded in a single worksheet.
• In the time_stamp related fields of the M2M_data Entity, the values of milliseconds are also

stored. However, only hour, minute, and second values can be displayed when you use the graph
widget.

Visualization

A visualization widget is a graph with additional features. The following features are available in a
visualization widget:
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• Line chart
• Area chart
• Bar chart
• Stacked bar chart
• Donut chart
• Multiple charts
• Additional y-axis
• Zooming in or out
• Grid lines
• Rotation
• Support of negative values
• Improved look and feel of tooltips
• Ability to focus on a specific field on the chart
• Grouping using a query field

Important:  Due to the format of the data returned by Historian REST calls, the Visualization
widget cannot display data from Historian sources.

Visualization Settings

When you use a visualization widget, in addition to the default settings of a widget, the following
settings are available.

Setting Description

Flow Select the query (from the ones added in the PAGE DATA
section) that should be used to retrieve information in the
graph.

Switch Row/Column Select this check box if you want to switch the x-axis and
y-axis data.

X-axis Provide values in the following boxes for x-axis settings:

• Data: Select the query field whose data should be
plotted on the x-axis.

• Label: Enter a label for the x-axis.
• Rotate Ticks: Select this check box.
• Grid lines: Select this check box if you want to show

grid lines.

Y-axis Provides values in the following boxes for y-axis settings:

• Label: Enter a label for the y-axis.
• Grid Lines: Select this check box if you want to show

grid lines.
• Range: Select whether the range of the y-axis

should be set automatically or manually. If you select
Manual, the Min and Max boxes appear, in which you
must enter values.
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Setting Description

Data Provide values in the following boxes for the data settings:

• Name: Enter the name of the graph.
• Type: Select the type of the graph: Bars, Lines, Area,

or Donut.
• Data: Select the data source of the graph.
• Stacked: Select this check box if the graph should be

plotted as a stacked bar chart. This option is available
only for a bar chart.

• Color: Select whether the color of the graph should
be selected automatically or manually.

Add Field Select this button if you want to plot another field on the
graph.

Add All Fields Select this button if you want to plot all the entity fields.

Using a Visualization Widget

Suppose you want to plot the following information on a graph:

• Sales amount for two branches - Tokyo and Tel Aviv, plotted as a line chart and an area chart,
respectively.

• Sales amount for two products - V26 and V27, plotted as a stacked bar chart.
• Breakdown of sales amount per branch - plotted as a donut chart.

To do so, perform the following steps:
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1. Create an entity to store the sales amount for the two branches and the two products.
2. Create a Get query to retrieve the sales amount.
3. In the page designer, in the PAGE DATA section of the container, add the query.
4. Add two visualization widgets to the container.
5. Add the following headers for the visualization widgets:

• Lines/Area and Stacked
• Donut

6. For the Lines/Area and Stacked chart, provide values as described in the following table for the
x-axis.

Setting Description

Flow Select the query that you have created.

Data Select the daily field of the query.

Rotate Ticks Select the check box.

Grid Lines Select the check box.

7. Select Add Field.

An additional Data section appears for the other y-axis.

8. Provide values as specified in the following table for the two y-axes.

Setting
Description for
the First Y-Axis

Description for
the Second Y-Axis

Label Enter Amount. Enter Product.

Grid Lines Select the check box. Not applicable

Type Select Lines. Select Area.

Data Select the field that stores the sales
amount for the Tokyo branch.

Select the field that stores the sales
amount for the Tel Aviv branch.

Y-axis side Select Left. Select Left.

9. Select Add Field twice. Two additional Data sections appear for the two y-axes.
10. Provide values as specified in the following table for the two y-axes.

Setting
Description for
the First Y-Axis

Description for
the Second Y-Axis

Type Select Bars. Select Bars.

Data Select the field that stores the sales
amount for the product V27.

Select the field that stores the sales
amount for the product V26.

Stacked Select the check box. Select the check box.

Y-axis side Select Right. Select Right.
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11. For the Donut chart, select Add Field twice, and provide values as specified in the following
table.

Setting Description

Flow Select the query that you have created.

Donut Title Enter Breakdown Per Branch.

Type Select Donut for both the boxes.

Data Select the field that stores the sales amount for V26
and V27, respectively.

12. Save the application, and preview it. The first graph displays a line chart and an area chart for
the sales amount of Tokyo and Tel Aviv, respectively. It also displays a stacked bar chart for the
sales amount of the two products, V26 and V27. The second graph displays a donut chart for the
sales amount of V26 and V27.

Big Data

The bid data widget is a visualization widget that supports big data. Compared to the visualization
widget, the big data widget allows you to specify the range more accurately.

Note:  You cannot plot a donut chart or change the format of a date-time variable on x-axis for a
big data widget.

Important:  Due to the format of the data returned by Historian REST calls, the Big Data widget
cannot display data from Historian sources.

Big Data Settings

When you use a big data widget, in addition to the default settings of a widget, the following settings
are available.
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For instructions on configuring these settings, refer to Visualization (page 305).

About Zooming In and Zooming Out

Since the data displayed using a big data widget is huge, you can zoom in a selected area on the
graph. To do so, you must specify the area precisely by dragging the mouse pointer on the area.

You can drag the mouse pointer in horizontal, vertical, or diagonal directions.

• If you drag the mouse pointer in a horizontal direction, the zoom-in area is set for only the x-
axis.

• If you drag the mouse pointer in a vertical direction, the zoom-in area is set for only the y-axis.
• If you drag the mouse pointer in a diagonal direction, the zoom-in area is set for both x-axis and

y-axis.

You can perform the following actions to zoom in or zoom out the widget:

• Zoom in a selected area by selecting .

• Pan across the widget by selecting .
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• Zoom in from the center of the widget by selecting .

• Zoom out from the center of the widget by selecting .

• View the complete range of the graph by selecting .

• Reset the zoom level by selecting .

Grid

A grid widget functions similar to a table widget. In addition, you can perform the following tasks:

• Change the width of a grid dynamically.
• Rearrange or remove the columns of a grid from an application.
• Export the data displayed in a grid to a .csv file. In addition, you can export data from selected

columns.
• Sort the data displayed in a grid.
• View the data in a tree structure.
• Scroll till the end of the grid regardless of the number of rows the grid contains.

Grid Settings

When you use a grid widget, in addition to the default settings of a widget, the following settings are
available.

Setting Description

Allow Export Select this check box if you want to provide an option to
application users to export the data in the grid to a .csv
file.

Note:  This option is not available on iOS.

Tooltips Select this check box if you want tooltips to appear in the
application.

Flow Select the query that should be used to retrieve
information in the grid.

Tree View Select this check box if you want to display data in a
hierarchical view. When you select this check box, the
Nested flow box appears, allowing you to select the query
that fetches the data for the child level in the hierarchy.

Name Enter the name of the grid column.

Data Select this option if you want data in the column to be
retrieved from an entity field using a column, and then
select the field in the drop-down list box.
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Setting Description

Formula Select this option if you want data in the column to
be displayed based on a formula. For example, if an
entity stores the marks scored by students for individual
courses, you can create a formula to display the
aggregate marks scored by each student.

Show <number> rows at a time Identifies the number of rows that should appear by
default in the grid. By default, the value in this box is 10.
After you enter a value, the following options are available:

• Load all: If you select this option, the grid will contain
all the rows on the same page. However, if you
access the application on a mobile device, each
page in the grid will contain the number of rows that
you specify. You can navigate to the other pages to
access the rest of the rows.

• Infinite scroll: If you select this option, the grid will
contain all the rows on the same page.

• Paging: If you select this option, each page in the grid
will contain the number of rows that you specify. You
can navigate to the other pages to access the rest of
the rows.

Using a Grid

Suppose you want to use a grid to display a list of managers in an organization and the employees
reporting to each manager. To do so, perform the following steps:

1. Create an entity named Wiki Manager, add the fields Manager ID and Manager Name, and add
the IDs and names of managers.

2. Create a Get query named Wiki Get All Managers to get all the records from the Wiki Manager
entity.

3. Create an entity named Wiki Employee, add the fields Manager ID, Employee ID, and
Employee Name, and add the respective details.

4. Create a Get query named Wiki Get Employee by Manager ID with settings as specified in the
following image:

5. Create an application, and add a grid using the page designer.
6. In the PAGE DATA section, add the Wiki Get All Managers query, and connect all the fields to

the grid.
7. Select the Auto submit (as soon as data is available) check box.
8. In the GRID PROPERTIES section, select the Tree View check box.
9. In the Nested flow box, select the Wiki Get All Employee by Manager ID query. Two boxes

named Row Limit and Manager ID appear.
10. In the Manager ID box, select Wiki Get All Manager.Manager ID.
11. In the Flow box, select Wiki Get All Managers.
12. In the Name box, enter Manager Name.
13. In the Data box, select the field that stores the names of managers.
14. Select Add Field, and then provide values as specified in the following table.
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Box Description

Name Enter Manager ID.

Data Select this option, and then select Wiki Manager in the
drop-down list box that appears.

Mapping Select Wiki Employee.

15. Save the application, and preview it. A grid appears, displaying two sections. The first section
contains a list of IDs and names of managers. The second section contains a list of employees
that report to each manager.

Map

A map widget is used to display a map in an application. It uses the Google Maps feature. You can
use the map widget to display the location of a place on a map (for example, the location of each site
of a company).

To display asset locations on the map, you must access the API key generated by Google (page 47).

Map Settings

When you use a map widget, in addition to providing values for the default fields for a widget, you
must define the following settings.

Setting Description

Label Identifies the title of the map.

Display Identifies the type of the map. You can select one of the
following values:

• Roadmap: Displays the streets of an area. By default,
this value is selected.

• Satellite: Displays a satellite view of the Earth.
• Terrain: Displays the geographical features of an

area.

Layers Identifies the layer that you want to display on the map.
You can select one of the following values:

• Transit: Displays the public transit network of an
area.

• Traffic: Displays real-time traffic information on the
map.

• Bicycling: Displays the bicycling paths of an area.
• None: Does not display any layer.
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Setting Description

CENTER Identifies the center point of the map. You can specify the
center point using one of the following sources:

• Data: Select a query output or a global parameter
whose value is the center point of the map.

• Manual: Enter the address or the latitude and
longitude details of the center point manually,
separated by a comma (for example, 35.681168,
139.767059).

• User Location: Select this option to specify that
the location of the device used by the application
user is the center point of the map. If you select this
option, the Update Center check box appears. If you
select this check box, the map center is automatically
updated when the user moves.

Note:  If you select the User Location option,
when you access the map for the first time in the
application, a message appears, asking you to allow
the application to access your location.

• Automatic by Markers: Select this option to specify
that the center point of the map is positioned such
that all the markers are visible on the map. This
option is enabled only after you add a marker.

Note:  The Zoom box contains a value that
determines the zoom level of the map. This box is
disabled when you select the Automatic by Markers
option.
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Setting Description

MARKERS Identifies the markers that should appear on the map.
Select Add Marker, and then enter or select values in the
following sections or boxes that appear.

Section Description

Position Select one of the following options:

• Data: Select this option if you want
to specify the position of the marker
by means of a query or a global
parameter.

• Manual: Select this option if you want
to specify the position of the marker
manually, and then enter the address
or the latitude and longitude details.

Label Select one of the following options:

• Data: Select this option if you want
to specify the label of the marker
by means of a query or a global
parameter. This option is enabled
only if you select Data in the Position
section.

• Manual: Select this option if you want
to specify the label of the marker
manually, and then enter the label.

Marker
Icon

Select the icon and color of the marker.

Condition Select Add conditions, and then specify
the conditions for displaying the marker.

Tip:  You can add multiple markers.
For example, if you want one marker
to represent sites whose overall plant
efficiency is above 95 percent and another
marker to represent sites below 95 percent,
you can add the two markers with the same
position data, and specify the conditions
appropriately on each one.

Actions Select Add Action, and then specify the
action that should be triggered when the
marker is selected (for example, display
more details about the location).
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Setting Description

SHAPES Identifies the circle that covers the area of a location. For
example, if the map displays the locations of sensors that
capture the radio signals within a radius of 1 km, you can
add a shape to each marker to indicate the area covered
by each sensor.

Select Add Shape, and then enter or select values in the
following sections or boxes that appear.

Section Description

Position Select one of the following options:

• Data: Select this option if you want to specify the position
of the shape by means of a query or a global parameter.

• Manual: Select this option if you want to specify the
position of the shape manually, and then enter the
address or the latitude and longitude details.

Radius Select one of the following options:

• Data: Select this option if you want to specify the radius of
the shape by means of a query or a global parameter.

• Manual: Select this option if you want to specify the radius
of the shape manually, and then enter the radius in km.

Note:  The radius can also be used as a visual indicator
of other parameters, such as signal strength.

Color Select the color of the shape. You can also specify the opacity.

Condition Select Add conditions, and then specify the conditions.
For example, if you want the marker to represent the signal
strength received by a sensor, you can add multiple shapes
with different colors and the same position data, and then
specify different signal strength conditions on each shape.

Table

A table displays information, which can include text, links, and/or images. Each column in the table
represents an entity field. The information that appears in a table cell is defined by selecting a query
output or by using a formula.

Table Settings

When you use a table widget, in addition to the default settings for a widget, the following settings
are available.

Setting Description

Allow Download Select this check box if you want to provide an option to
application users to download the data displayed in the
table.

Note:  The download feature is available only for
entity data.
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Setting Description

Flow Select the query or function that should be used to retrieve
information for the table. Without a flow, a table will not
display any data.

Name Enter the name of the table column.

Data Select this option if you want data in the column to be
displayed from an output field of the selected flow, and
then select the field in the drop-down list box.

Formula Select this option if you want data in the column to be
displayed based on a formula. For example, if the data
retrieved by a query represents a test score, you can use
a formula to display the score as a percentage of the total
score.

Output data type Select the data type of the data displayed in the column.

Add Action Select this button if you want an action to be performed
when a user selects a cell in this column.

Add Field Select this button if you want to add another column to the
table.

Add All Fields Select this button if you want to add columns for all the
output fields from the selected flow.

Load <number> rows at a time Identifies the number of rows that should appear in the
table. By default, the table displays all the rows retrieved
by the query. If you select this check box, the Paging and
"Load more" button options appear to allow the user to
view more data.

• Paging: If you select this option, each page in the
table will contain the number of rows that you specify.
You can navigate to the other pages to access the
rest of the rows.

• "Load more" button: If you select this option, the
table will initially contain the number of rows that
you specify. A Load more button appears in the
application, which allows the application user to
retrieve additional rows in the same page.

Possible Uses

Tables are a way to display information in an organized way. For example, if application users fill
in their name and phone number in an application, a table can display the information in an easily
understandable format. A more advanced example may be that employees in a company with a
hundred employees enter the time they arrive and the time they leave each day. Each employee has
a name, entry time, exit time, and ID in an entity. Using a table, you can display each employee's
attendance record.
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List

A list is a representation of data in bulleted points.

List Settings

When you use a list widget, in addition to the default settings of a widget, the following setting is
available.

Setting Description

Source Identifies the source of the list values. You can specify one
of the following types of sources:

• Hard Coded: Select this option to enter the list items
manually.

• Dynamic: Select this option to generate the list items
dynamically from a query output field.

Possible Uses

You can use a hard-coded list to display prerequisites to perform a task. You can use a dynamic list
to display a list of asset IDs returned by a query.

Using a List

Suppose you want to display a list of features available in an application by dynamically fetching the
list from an entity. To do so, perform the following steps:

1. Create an entity named Features to store the list of features.
2. Create a query to get the list of features from the entity.
3. In the page designer, add a List widget.
4. In the PAGE DATA section, add the query that you have created.
5. In the LIST PROPERTIES section, in the Source box, select Dynamic.
6. In the Value box that appears, select the query output that fetches the list of features.
7. Save the application, and preview it.

The list of features stored in the entity appear in the application.

Gauge

Using a gauge widget, you can plot data on a visual display. Some of the gauge widgets use a color-
coded scale. The color of the reading indicates the risk level associated with the value.
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Types of Gauge Widgets

The following types of gauge widgets are available:

• Battery: In this gauge type, the value is plotted on a horizontal scale. This is the default gauge
type. For example, the following image can represent a gauge that plots the speed of a vehicle in
kph. The color-coded scale highlights whether the speed of the vehicle is safe or risky.

• Meter - Arc: In this gauge type, the value is plotted on a curved scale. For example, the
following image can represent the percentage of unplanned power outage events out of the total
number of power outage events. The color in which the plotted value appears indicates whether
the percentage is acceptable.

• Meter - Radial: In this gauge type, the value is plotted on a circular scale. The gauge can be an
internal radial or an external radial depending on whether the scale appears inside the radial or
outside. For example, the following image represents an external radial meter gauge that plots
the temperature inside an engine combustion chamber.
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The following image represents an internal radial meter gauge that plots the pressure inside an
engine combustion chamber.

• Tank: In this gauge type, the value is plotted on a vertical scale. For example, the following
image can represent the amount of remaining lubricant in a tank with a capacity 300 liters. The
color in which the plotted value appears indicates whether the lubricant level is safe or risky.
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Gauge Settings

When you use a gauge widget, in addition to providing values for the default fields for a widget, you
must define the following settings:

Type
of the

Setting

Applicable
Gauge
Types

Description

Type All gauges Identifies the type of the gauge. You can select Battery, Meter, or Tank.

Style Meter Identifies the meter style. You can select one of the following values:

• Internal radial: This is the default option. If you select this style, the markings appear
on the dial.

• External radial: If you select this style, the markings appear outside the dial.
• Arc Meter: If you select this style, the meter appears as a color-coded semi-circle

(instead of a dial). In addition, the Scale and Needle settings appear.

Source All gauges Identifies the source of the values plotted on the gauge. You can specify one of the
following types of sources:

• Data: Select a query or a global parameter whose output you want to plot on the
gauge.

• Manual: Enter a value manually that you want to plot on the gauge.
• Formula: Enter a formula to calculate the value that you want to plot on the gauge.

Sector Battery, Tank,
Meter - Arc

Identifies the start position, color, and range for each sector in the gauge. For example,
suppose you want to plot the speed of a vehicle. You want to categorize the speed range
as follows:

Speed Range (in kph) Category

0 - 100 Acceptable

101 - 160 Slightly risky

161 - 200 Risky

200 - 260 Highly risky

In this case, you will create four sectors and define the following settings:

Sector number Start position Color Label

1 0 Green Acceptable

2 101 Yellow Slightly risky

3 161 Orange Risky

4 200 Red Highly risky

Tip:  In the Color box, you can enter a color name or the hexadecimal code of the
color.
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Type
of the

Setting

Applicable
Gauge
Types

Description

Range All gauges Identifies the minimum and maximum values of the widget range, and units of measure of
the gauge. You can also specify the color for the first sector of the gauge. In the previous
example, you will enter the values 0, 200, kph, and green in the Minimum, Maximum,
Units, and Default Color boxes, respectively.

Scale Meter - Arc Indicates whether you want to show the marking for each sector or just the minimum and
maximum markings of the gauge. In the Scale settings, select one of the following options:

• Full: Select this option if you want to show the markings for each sector of the gauge.
By default, this option is selected. In the previous example, if you select Full, the
following markings appears: 0, 101, 161, 200

• Min/Max: Select this option if you want to show only the minimum and maximum
markings of the gauge. In the previous example, if you select Min/Max, the following
markings appear: 0, 200

Needle Meter - Arc Indicates whether you want to show or hide the needle for the reading. By default, this
check box is selected.

Visual All gauges Identifies the color for the markings and the background of the widget. The following
settings are available:

• Custom Colors: Select this check box if you want to use custom colors for
the markings and the background. If you select this check box, the Color and
Background Color boxes appear.

• Color: Select the color for the markings.
• Background color: Select the background color of the widget.
• Palette: Select the background color of the dial of the radial meter gauge. This box

appears only if you want to use a meter gauge.

Html

The html widget is used to provide html code to create an application. For example, to add a drop-
down list box to an application, instead of using the dropdown (page 292) widget, you can use
html code, along with css code, to create the drop-down list box with a customized look and feel.

Note:  The interaction of the html code can change based on how the responsive design works for
some elements.

When you use the html widget, in addition to the default properties of a widget, the following
properties are available.

Table 7. Html Properties
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Property Description

Flow Select the query (page 151) that should be used to
retrieve information for the widget. Without a flow, the
widget will not display any data.

To populate values here, bind the html widget to a query
on its PAGE DATA tab.

Select Data Select an entity field (page 137). Values in this drop-
down list are populated based on the entities (page 129)
available in the selected query. Using these fields, you can
connect data to components that you create using the html
widget.

Next, select + Add Field to add the selected entity field to
the application for which you can add the html code.

Tip:  You can select + Add All Fields to add all the
entity fields at once.

Name Provide a name for the added entity field.

Data Select this option if you want to retrieve information from
an output field.

Next, select the output field from Output data type. This
drop-down list contains the output fields available in your
selected query.

Note:  Select Data value must be set to single to
update the output fields.

Manual Select this option if you want to provide manual values to
retrieve information. Enter the value.

Formula Select this option if you want to retrieve information based
on a formula. Build a formula.

Edit Code Select this button to access a code editor for html, css,
and javascript. You can enter the custom code in the code
editor.

Tip:  The javascript code editor contains instructions
on how to use the javascript API.

Scoped css? Indicates whether the css code must be applied only to the
html widget or globally.

• If you want the css code to be applied only to the
elements in the html widget, select this check box.

• If you want the css code to be applied globally, clear
this check box.
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Using the Html Widget

Example 1: Suppose you want to stream videos from YouTube based on values selected in a drop-
down list box. To do so, perform the following steps:

1. When designing application pages (page 262), drag-and-drop the html and dropdown widgets
to a container.

2. Select the dropdown (page 292) widget in the container to access the DROPDOWN
PROPERTIES tab.

a. Under the GENERAL section, provide the details as specified in the table:

Field Description

Label Enter Select an option.

Id Enter ytID.

Global Data Select the check box.

3. Select the html widget in the container to access the HTML PROPERTIES tab.
a. Under the DATA section, provide the details as specified in the table:

Field Description

Flow Select a query.

Select Data Select an entity field from the query, and do the
following:

• Name: Enter ytID.
• Select Data.
• Output data type: Select the global variable

(ytID) that stores the drop-down list box values.

A relationship is created between the dropdown and html widgets as shown in the following image.
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Example 2: Suppose you want to create an application with the following pages:

• Compass: Displays a compass with the needle indicating the angle that an application user
enters.

• Stylish Header: Displays text in a header with special effects.
• Tiles: Displays tiles of various colors.
• Marquee: Displays text that moves from one end to the other of the page.

To do so create the application pages (page 262) for compass, stylish header, tiles, and marquee.
Design the page layout for each as follows:

For Compass:

1. Add an input (page 294) widget to a container, and provide INPUT PROPERTIES as
specified in the table:

Field Description

General > Label Enter Enter Angle:
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Field Description

General > Id Enter direction

General > Global Data Select the check box.

2. Add a html widget below the input widget, add a field, and provide values as shown in the
image.

Field Description

General > Id Enter compass

Data > Name Enter angle

Data > Select Data Select compass - direction from the list.

Data > Output data type Select Text field from the list.

3. Select Edit Code to access the code editor, and save these lines of code:

Html Enter these lines of code as shown in the following image:

<div class="compass">
  <div class="compass-inner">
    <div class="north">N</div>
    <div class="east">E</div>
    <div class="west">W</div>
    <div class="south">S</div>
    <div class="main-arrow">
      <div class="arrow-up"></div>
      <div class="arrow-down"></div>
    </div>
   </div>
  </div>
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Css Enter the following lines of code:

compass {

 width: 150px;
 height: 150px;
 font-size: 10px;
 background-color: transparent;
 border-radius: 100%;
 position: relative;
 margin: 0 auto;
 font-family: 'Lobster Two', Comic Sans MS;
 color: #2d2d2d;
} .compass-inner {

 width: 85%;
 height: 85%;
 background-color: transparent;
 border-radius: 100%;
 position: relative;
 left: 6.9%; 
 top: 6.9%;
 border: 2px solid #2d2d2d;
} .main-arrow {

 height: 100%;
 width: 7.5%;   
 left: 46%;
 position: relative;
 padding-top: 3%;
 box-sizing:border-box;
 -webkit-transform: rotate(50deg);
 -moz-transform : rotate(50deg);
 -o-transform: rotate(50deg);
 -ms-transform: rotate(50deg);
 transform: rotate(50deg);
} .arrow-up, .arrow-down {

 width: 0; 
 height: 0;
 border-bottom: 57px solid red;
 border-left: 4px solid transparent;
 border-right: 4px solid transparent;
 position: relative;
} .arrow-down {

 border-bottom-color: #2d2d2d;
 -webkit-transform: rotate(180deg);
 -moz-transform : rotate(180deg); 
 -o-transform: rotate(180deg);
 -ms-transform: rotate(180deg);
} .north {

 position: absolute;
 left: 45%;
 top: 2.5%;
} .east { position: absolute;

 left: 88%;
 top: 44%;
} .west {

 position: absolute;
 left: 7%;
 top: 44%;
} .south {

 position: absolute;
 left: 45%;
 top: 82%;
} @media (max-width: 600px) {

 .compass {
   width: 150px;
   height: 150px;
   font-size: 11px;
 }
.arrow-up, .arrow-down {

 border-bottom: 57px solid red;
 border-left: 4px solid transparent;
 border-right: 4px solid transparent;
} .arrow-down {

 border-bottom-color: #2d2d2d;
} } @media (max-width: 769px) {

 .compass {
   width: 150px;
   height: 150px;
   font-size: 11px;
 }
.arrow-up, .arrow-down {

 border-bottom: 57px solid red;
 border-left: 4px solid transparent;
 border-right: 4px solid transparent;
} .arrow-down {

 border-bottom-color: #2d2d2d;
} } @media (max-width: 400px) {

 .compass {
   width: 100px;
   height: 100px;
   font-size: 11px;
 }
.arrow-up, .arrow-down {

 border-bottom: 38px solid red;
 border-left: 3px solid transparent;
 border-right: 3px solid transparent;
} .arrow-down {

 border-bottom-color: #2d2d2d;
} }
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Javascript Enter the lines of code as shown in the following image:

4. Save the compass page.

For Stylish Header:

1. Add a html widget, select Edit Code, and save these lines of code:

Html Enter the following lines of code:

<h1>3d text effect</h1>

Css Enter the following lines of code:

body{
  text-align:center;
  background:#dfdfdf;
}
h1{
  text-transform:uppercase;
  font-size:72px;
  font-family:'Verdana';
  padding:30px;
}
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Javascript Enter the following lines of code:

jQuery(document).ready(function(){
   $('h1').mousemove(function(e){
     var rXP = (e.pageX - this.offsetLeft-$(this).width()/2);
     var rYP = (e.pageY - this.offsetTop-$(this).height()/2);
     $('h1').css('text-shadow', +rYP/10+'px '+rXP/80+'px
 rgba(227,6,19,.8), '+rYP/8+'px '+rXP/60+'px rgba(255,237,0,1),
 '+rXP/70+'px '+rYP/12+'px rgba(0,159,227,.7)');
   });
});

2. Save the stylish header page.

For Tiles:

1. Add a html widget, select Edit Code, and save these lines of code:

Html Enter the following lines of code:

 <div class="tile"></div>

Css Enter the lines of code as shown in the following image:

2. Save the tiles page.

For Marquee:

1. Add a html widget, select Edit Code, and save these lines of code:
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Html Enter the lines of code as shown in the following image:

Css Enter the lines of code as shown in the following image:
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2. Save the marquee page.

Save and preview the application. The application has four pages built using a html widget.

Interactive Map

An interactive map widget is used to display interactive markers or icons on a static background (for
example, an image representing an asset or a static map). The position of a marker on the image is
defined by the offset from the top and left borders.

Note:  You need external Internet access to use the map widget.

In addition, using an interactive map, you can create an application that will:

• Provide an overview of the current state of an asset.
• Allow you to access a page to view more information.
• Send a command to control the asset.

Interactive Map Settings

To configure settings for an interactive map, you must add an image, and then configure the settings
for each marker. To do so:

1. In the page designer, add the interactive map widget to the page.
2. Select Upload Image, and then select the background image file.

Note:
• If you want to change the background image, you can upload a new image without

affecting any markers that you have added.
• Background image filename must not exceed 40 characters.

3. Double-click the image where you want to add a marker.

A marker is created at the position at which you clicked.

4. Select the marker.

The settings for the marker appear in the INTERACTIVE MAP PROPERTIES section. The
coordinates are populated automatically; they identify the position of the marker.

Tip:  To fine-tune the position of the marker, you can drag the marker to the required
position or modify the coordinates manually.

5. Select Add Marker, and then enter values as specified in the following table.
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Setting Description

Marker Type Identifies the type of the marker. You can select one of
the following options:

• Shape: If you select this option, you can select one
of the predefined shapes available in Operations
Hub. By default, this option is selected.

• Image: If you select this option, you can upload an
image for the marker.

Color Identifies the color of the marker. This setting appears
only if you have selected Shape in the Marker Type
setting.

Shape Identifies the shape of the marker. This setting appears
only if you have selected Shape in the Marker Type
setting. You can select one of the following options:

• Round
• Square

Image Identifies the image for the marker. This setting
appears only if you have selected Image in the Marker
Type setting.

For example, if the marker identifies the position of a
radiator fan, you can upload the image of a fan instead
of using a predefined round or square shape for the
marker.

Size Identifies the multiplier for the marker shape or image
size. For example, if you enter 2, the marker size is
double the default size. By default, the value in this box
is 1.

Label Identifies the text for the marker label if you want to
display the label.

Label Color Identifies the color of the label as it appears in the
application.

Data Label Identifies the data that is associated with the marker.

For example, suppose the interactive map plots the
temperature of various components of a car. For a
marker that identifies the position of a radiator fan in a
car, you can map the data label with the output of the
query that retrieves the temperature of the fan. When
you access the application, the temperature value
retrieved from the query is displayed for the radiator
fan.

You can select one of the following types of data labels:
• Data: Select this option if you want to display the

data retrieved by a query, and then select the
query output that want to display.

• Manual: Select this option if you want to enter the
data manually, and then enter the value.

Data Label Color Identifies the color and opacity of the data label.



Operations Hub for Windows | 3 - User Guide | 334

Setting Description

Conditions Identifies the condition to show or hide the marker. For
example, you can add a condition to show the marker
only if the temperature of the component reaches 50
degrees Celsius.

Actions Identifies the actions to be performed when the marker
is selected.

Note:  You can add multiple markers to a single position. Each marker can have a different
shape, icon, or color to indicate different conditions. For example, if the temperature of a
radiator fan in a car exceeds a certain limit, the green marker can be replaced with a red marker
to indicate that the temperature is high. You can also configure a set of actions for each marker
when selected.

Layouts

New Line

A new line widget is used to add a line to separate the components of a page.

Possible Uses

If widgets are placed too close to one another, adding a new line creates a blank space between the
widgets to enhance readability.

Separator

A separator widget is used to add a line between widgets, thus creating a better or clearer order
between the widgets.

Possible Uses

If an application displays a questionnaire, you can use a separator to divide the individual questions.
This will arrange and group the questions together.

Container

A container widget is a layout element that creates a specific area for widgets within an application.
A container is similar to the div element used in html. It is used as a box (invisible in the application)
that helps organize the widgets in the application.

Container Settings

When you use a container widget, in addition to the default settings of a widget, the following
settings are available.
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Setting Description

Show/Hide You can show or hide a container from the application for
each of the following device types:

• Mobile
• Tablet
• Desktop

Conditions When you specify conditions to a container, they are
applied to all the widgets added to that container. For
example, you can add a check box to the application to
allow application users to show or hide the container.

Performance By default, this check box is cleared, indicating that data
within the container is loaded only when the container is
shown in the application. If you select the check box, the
data within the container is loaded, regardless of whether
the container is shown or hidden. Selecting this check box
can reduce the performance of the application.

Possible Uses

Container are used for the following purposes:

• Organization of content: You can use containers to organize widgets in rows and columns.
You can then set information on varying planes to indicate the importance or sequence of
information provided by the individual widgets in the container.

For example, suppose you want to create an application to allow application users to enter
their user account details. In that case, add a container with two columns. The first column
can contain fields for the user's first name, last name, and phone number, whereas, the second
column can contain fields for the user's email address and personal website address, along with
a Submit button.

• Conditional content: You can use container to apply conditions to all the widgets in the
container.

Repeater

A repeater is a widget that is used to repeat the content layout for each item in a list returned by a
query. For example, if a query returns a list of assets, the repeater can display the state of multiple
parameters associated with each asset type using a combination of different widgets.

Using a repeater has the following advantages.

• You can create a dashboard-type application that monitors multiple assets at the same time.
• You can use different layouts and styles for each widget in the repeater to match the data type of

an asset parameters and to enhance visibility.
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• The layout of the content only needs to be defined once in the designer and it will be repeated
for each item in the list that you want to monitor.

• The content that is repeated is automatically updated when the underlying query is updated
(for example, new assets are added or the list of assets is updated by means of conditions in the
query).

For example, if an entity stores the temperature recorded by assets, you can use a repeater to display
not only the temperature recorded by each device, but also a gauge to indicate whether each value is
in the acceptable range, as shown in the following image.

Repeater Settings

When you use a repeater, in addition to providing values to the default fields for a widget, you must
define the following settings.

Setting Description

Flow Identifies the query to use to fetch data displayed in the
repeater.

Multi-select This setting is used in combination with a map or a graph
widget. If you select this check box, a check box appears
in each row of the repeater in the application, allowing the
user to select which items should appear on the map or
the graph. By default, this check box is cleared.

Checked If you have configured the Multi-select setting, this setting
indicates the initial state of the check box in each row of
the repeater in the application. By default, this check box
is cleared. If you select this check box, all the check boxes
in the application are selected.
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Setting Description

Action Identifies the action that should be performed when the
repeater is selected. For example, suppose you want
to allow the application users to select an asset, and
then retrieve more information about the asset. In that
case, select Set global value, and then select the global
variable that stores the asset ID. The value set in this
global variable is then used as an input to another query to
retrieve data about the asset.

You can add multiple actions.

Load <number> rows at a time Identifies the number of rows that should appear by
default in the repeater. By default, the value in this box is
10. If you select this check box, the Paging and "Load
more" button options appear.

• Paging: If you select this option, each page in the
repeater will contain the number of rows that you
specify. You can navigate to the other pages to
access the rest of the rows.

• "Load more" button: If you select this option, the
repeater will initially contain the number of rows
that you specify. A Load more button appears in
the application, which allows the application user to
retrieve additional rows in the same page.

Item Horizontal Alignment Identifies the number of repeater instances that will appear
horizontally next to one another before moving to the next
row.

For example, suppose you want to display the following
information in the repeater.

Device ID Latest Time Stamp

Device 1 2019/12/22 8:04:37:037

Device 2 2019/12/22 22:14:31:545

Device 3 2019/12/22 8:04:40:040

Device 4 2019/12/21 5:28:59:059

If you enter 2 in this box, the table is split as follows in the
repeater.

Device
ID

Latest Time Stamp
Device

ID
Latest Time

Stamp

Device 1 2019/12/22
8:04:37:037

Device 2 2019/12/22
22:14:31.545

Device 3 2019/12/22
8:04:40:040

Device 4 2019/12/21 5:28:59:059

Using a Repeater for a Basic Operation

Suppose you want to use a repeater to display temperature recorded by multiple sensors, which
is stored in the M2M_data entity. In addition to displaying the temperature, you can use a gauge
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widget in the repeater to highlight whether the temperature is in the acceptable range, as shown in the
following image.

To do so, perform the following steps:

1. Create the following queries:
• GetDistinctDeviceIDs: To fetch a distinct list of device IDs from the M2M_data entity.

Enter or select values as shown in the following image.
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• GetLastDeviceTemperature: To fetch the measurement time (that is, time stamp) and the
measured value of the temperature for each device. Enter or select values as shown in the
following image.



Operations Hub for Windows | 3 - User Guide | 340

2. Create an application, and then add a page.
3. Add a container to the page for the heading row, and perform the following steps:

a. Split the container into four columns.
b. In each column, add a header widget to contain the column headings.
c. Specify the following column headings:

• Device ID
• Last Reading
• Temperature
• Gauge

d. In the Visual section for each heading, select the Custom Colors check box, and in the
Color box, select the white color.
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4. In the Visual section, select the Custom Colors check box, and in the Background Color box,
select the dark blue color.

5. Add a repeater for the data rows, and perform the following tasks:
a. Split the repeater into four columns.
b. In the first column, add a text widget and an input widget.
c. In the second column, add a text widget.
d. In the third column, add two text widgets.
e. In the fourth column, add a gauge widget.

The widget appears as shown in the following image.

6. Select PAGE DATA, and then perform the following steps:
a. Add the two queries that you have created.
b. For the GetDistinctDeviceIDs query, configure the settings as shown in the following

image.

c. For the GetLatestDeviceTemperature query, configure the settings as shown in the
following image.
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7. In the REPEATER PROPERTIES section, in the Flow box, select the query
GetDistinctDeviceIDs.

8. In the PAGE DATA section, from the the GetDIstinctDeviceIDs query, drag
M2M_data.device_id to the text widget and the input widget in the first column of the repeater.

9. In the INPUT WIDGET PROPERTIES section, select the Disabled and Hidden check boxes.
10. In the PAGE DATA section, from the GetLastDeviceTemperature query:

• Drag DeviceID to the input widget in the first column of the repeater.
• Drag M2M_data.timestamp to the text widget in the second column of the repeater.
• Drag M2M_data.data to the two text widgets in the third column and the gauge widget in

the fourth column of the repeater.
11. Select the text widget in the second column, and in the TEXT PROPERTIES section, in the

Format box, select DateTime.
12. Select the first text widget in the third column, and in the TEXT PROPERTIES section, select

Add Conditions, and then specify values as shown in the following image.

13. Select the second text widget in the third column of the repeater, and in the TEXT
PROPERTIES section, perform the following steps:

a. In the Visual section, select the Custom Colors check box, and then in the Color box,
select red.

b. Select Add Conditions, and then specify values as shown in the following image.
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14. Select the gauge widget in the repeater, and in the GAUGE PROPERTIES section, perform
the following steps:

a. Delete two of the color sections.
b. In the Start Position and Label boxes for the remaining color section, enter 50.
c. In the Maximum box, enter 100.
d. In the Units box, enter degrees Celsius.

Tip:  If you want to enter °C, you can copy it from a Microsoft Word document.

The repeater widget appears as shown in the following image.

15. Save the application, and preview it.

The application appears as shown in the following image.
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Using a Repeater for a Multi-Select Operation

Suppose you want to use a repeater to plot a trend graph of temperature recorded by selected devices.
You want to allow application users to select the devices whose temperature you want to plot in real
time, as shown in the following image.

To do so, perform the following steps:

1. Create the following queries:
• GetDistinctDeviceIDs: To fetch a distinct list of device IDs from the M2M_data entity.

Enter or select values as shown in the following image.
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• GetLatestDeviceTemperature: To fetch the measurement time (that is, time stamp) and the
measured value of the temperature for each device. Enter or select values as shown in the
following image.
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2. Create an application, and then add a page.
3. Add a container with six columns.
4. Except for the first column, merge the other five columns.
5. Add a repeater and a graph widget to the container, and add a header widget to the repeater, as

shown in the following image.
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• The repeater provides a list of devices that the application users can select.
• The graph plots the temperature recorded by the selected devices.

6. Select PAGE DATA, and perform the following steps:
a. Add the two queries that you have created.
b. For the GetDistinctDeviceIDs query, configure the settings as shown in the following

image.

c. For the GetLatestDeviceTemperature query, configure the settings as shown in the
following image.
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7. In the REPEATER PROPERTIES section, in the Flow box, select the query
GetDistinctDeviceIDs, and then select the Multi-select and Checked check boxes.

8. In the GRAPH PROPERTIES section:
• In the Type box, select Lines.
• In the X-axis Data box, select M2M_data.timestamp from the

GetLatestDeviceTemperature query.
• In the X-axis Label box, enter Time.
• In the Y-axis Label box, enter Temperature.
• In the Data box, select M2M_data.data from the GetLatestDeviceTemperature query.
• In the Label box, select M2M_data.device_id from the GetLatestDeviceTemperature

query.
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9. In the GRAPH PROPERTIES section, in the Responsive subsection, set the height to 50
percent.

10. Select the header widget, and then in the HEADER PROPERTIES section, select Data, and
then select M2M_data.device_id from the GetDistinctDeviceIDs query.

11. Select PAGE DATA, and then perform the following steps:
a. For the GetDistinctDeviceIDs query, point to the row containing M2M_data.device_id, and

then select . This will create a global variable for the ID.
b. For the GetLatestDeviceTemperature query, drag the input DeviceID to the global variable

that you have created.
12. Save the application, and preview it.

The application appears as shown in the following image. You can use the check boxes to
display or hide the temperature curve for each device.



Operations Hub for Windows | 3 - User Guide | 350

Tools

Event Settings

An event settings widget is used to allow users to turn on or off event notifications using the
application.

Using the Event Settings Widget to Control an Event

Suppose you want to trigger an event to send email notifications when the temperature recorded by a
device reaches a certain limit, and you want users to specify the limit using the application. To do so,
perform the following steps:

1. Create an email template named Temperature_Warning, which you will use to send email
notifications.

2. Create an event named Temperature_Warning. In the event:
• Create a trigger based on a device.
• Create an action to send an email using the email template that you have created.

Tip:  For information on creating an event, refer to the Events (page 192) section of the
documentation.

3. Using the page designer, add the event settings widget to the relevant page of the application.
4. In the EVENT SETTINGS PROPERTIES section, in the Event box, select the event

High_Temperature.
5. Save the application, and then access it.

The event settings widget appears in the application.

6. Select Add new notifier to add an instance of the event.

The Event notifier section appears, displaying the settings that you have configured.
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7. Change the settings as needed, switch the ON toggle, and then select Create.

The event is now active and will be triggered when the temperature reaches the specified limit.

Upload Excel

The upload excel widget is used to upload data from a Microsoft Excel workbook. This data is used
to update an entity that has been created in Operations Hub.

Upload Excel Settings

When you use an upload excel widget, in addition to providing values for the default fields for a
widget, you must define the following settings.

Important:  Only workbooks with a single worksheet are supported in the upload excel widget.

Setting Description

Label Identifies the name of the button that users will select
in the application to upload data (for example, Upload
Employee Data). By default, the value in this box is
Upload Excel.

Entity Identifies the entity to be updated with the data from the
Microsoft Excel workbook. When you select the entity,
the entity fields appear along with a check box next to
each field. These check boxes are selected by default,
indicating that the data for the corresponding fields will be
included in the Microsoft Excel workbook. If you do not
want to include data for a field, clear the corresponding
check box.

Actions Identifies the actions to be performed after the data
is uploaded. For example, you can add a table to the
application to display the data that has been uploaded,
and then use a submit query action to update the table.
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Updating Data of Sales Representatives

Suppose you want to update the data of sales representatives that is stored in the SalesRep entity. It
contains the following fields:

• Rep_Code
• Rep_Name
• Department
• Car_No

To update the entity using the upload excel widget, perform the following steps:

1. Create a Microsoft Excel workbook with the data that you want to update. It is recommended
that the column names match the field names in the entity.

2. Using page designer, add the upload excel widget to the application.
3. In the Upload Excel Properties section:

a. In the Label box, enter Upload Sales Rep Data.
b. In the Entity box, select SalesRep.

4. Save the application, and preview it.

A button labeled Upload Sales Rep Data appears in the application.

5. Select Upload Sales Rep Data, and then select the workbook that you created.

The Select Column Mapping window appears.

6. Enter or select values as specified in the following table.

Setting Description

Use Header
Row Names

Select this check box if you want to use the names specified in the heading row in the
workbook. When you select this check box, the Header Row Number box appears.

Header Row
Number

Enter the row number that contains the column names. Suppose the column names appear in
the first row of the workbook. In that case, enter 1.

Import data
from row
<number> to
row <number>

Enter the starting and ending rows in the workbook whose data you want to upload. Suppose
the data for the four fields that you want to upload appears in the first four rows in the workbook.
In that case, enter 1 and 4.

Tip:  If you want to import data in all the rows in the workbook, leave the to row box blank.

Append Data
to existing
data

Select this option if you want data from the workbook to be appended to the existing data in the
entity. By default, this option is selected.

Overwrite
existing data

Select this option if you want data from the workbook to overwrite the existing data in the entity.
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Setting Description

Specify
Column
Mappings

For each field in the entity, select the column name in the workbook that you want to map.
Suppose you want to map the Rep_Name field in the entity with the Representative Name
column in the workbook. In that case, select Representative Name in the box that appears
next to Rep_Name.

7. Select Import.

The SalesRep entity is updated with the data from the workbook.

Upload Devices

Using the upload devices widget, you can upload a list of assets to Operations Hub. This data is
stored in the baseline M2M entities.

Using the Upload Devices Widget

To use an upload devices widget, save the asset data in a CSV file with the following columns.

Column
Heading

Purpose Usage Mapped to Entity
Mapped to
Entity Field

device_gateway
device_iddevice_unique_name Identifies the unique ID

of the device gateway
or asset. This is the
ID that the device will
use when sending data
using REST APIs or
MQTT APIs.

This column is
required.

M2M_groups_device_thing gateway_thing_id

device_gateway device_typedevice_type Identifies the type of
the device gateway or
asset.

This column is
required.

supported_device_gateway device_type

unique_address Identifies the unique
address of the device
gateway (for example,
imei number, mac
address, unit ID).

If there is no unique
address, enter
None. This column
is required if the url
column is blank.

device_gateway unique_address

url Identifies the URL for
the device gateway.

If there is no URL,
enter None. This
column is required if
the unique_address
column is blank.

device_gateway url

thing_unique_name This parameter is
obsolete.

This column is
required and must
be blank.

thing_type This parameter is
obsolete.

This column is
required and must
be blank.
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Column
Heading

Purpose Usage Mapped to Entity
Mapped to
Entity Field

M2M_groups group_namegroup_name Identifies the name of
the device group. If the
group does not exist in
Operations Hub, it will
be created.

This column is
required. If devices
are not grouped,
we recommend
that you enter the
same value as in the
device_type column.

M2M_groups_device_thing group_name

group_type Identifies the group
type. The supported
group type is gateway.

This column is
required.

M2M_groups group_type

In addition, the CSV file can contain the following columns:

• Columns mapped to the device_gateway entity:
◦ device_location
◦ device_altitude
◦ device_latitude
◦ device_longitude
◦ device_latlong
◦ device_username
◦ device_password
◦ device_firmware_ver
◦ device_description
◦ device_generic_1
◦ device_generic_2

• Columns mapped to the supported_device_gateway entity:
◦ supported_description
◦ supported_manufactor
◦ supported_product_code
◦ supported_generic_1
◦ supported_generic_2

• Columns mapped to the M2M_groups entity:
◦ group_generic_1
◦ group_generic_2
◦ group_description

Integration Widgets

CIMPLICITY HMI Webspace

Use the widget to access CIMPLICITY CimView screens.
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Employ the Webspace widget with other Operations Hub widgets for better consolidation and
visualization of data. This provides you with an end-to-end solution for better data analysis,
visualization and monitoring. Refer to Integrating Webspace with Operations Hub (page 356).

The Webspace widget is available under Integration > HMI. When designing application pages
(page 262), drag-and-drop the widget to a container, and configure its properties.

Note:  Only a single instance of the CIMPLICITY HMI Webspace widget per app is supported.
If using multiple instances of webspace widgets across multiple pages, you may encounter access
error messages when navigating between pages that contain webspace instances. After confirming
the message, the widget loads as expected.

Table 8. Webspace Properties

Property Description

Webspace server Specify the machine that has CIMPLICITY Webspace
running on it.

CIMPLICITY screen path Specify the path to the CimView screen to load. This path
is where the file resides on the Webspace system (C:
\ProjectsFolder\screens\ScreenName.cim).

Port for the Webspace Session Manager 9443 is the default port setting.

CIMPLICITY HMI Webspace at Runtime

The first time a strong encrypted session is loaded, a message appears stating that the Proficy
Webspace Strong Encryption license has been updated and needs a restart. If this error occurs, then
restart these services in the following order (on the Webspace node):

1. Proficy WebSpace License Manager
2. Proficy WebSpace Application Publishing Service
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3. Webspace Session Manager Microservice

Integrating Webspace with Operations Hub

This topic describes the setup and configuration of Operations Hub with CIMPLICITY WebSpace.

Install the following applications:

• CIMPLICITY 11.1
• WebSpace 6.0 (with update 6.0.3, and Strong Encryption License)
• Operations Hub 2.0 (with SIM 4)
• Google Chrome (installed on each node)

You must have the following account information:

• Operations Hub secret (from installation)
• Operations Hub Administration Username/Password (default usually ‘ophubadmin’)

1. Add Operations Hub root certificate to the root certificate store on Operations Hub machine
(page 37).

2. Enable the encrypted transport for communications via the Webspace server (page 356).
3. Set up the IIS to listen on port 443 (page 357).
4. Configure the Windows firewall (page 360).
5. Export the CIMPLICITY self-signed certificate (page 361).
6. Import the CIMPLICITY self-signed certificate to Operations Hub (page 365).
7. Set up CIMPLICITY project properties (page 368).
8. Set up CIMPLICITY project user security (page 369).
9. Configure CIMPLICITY options (page 369).

Webspace - Enable Encrypted Transport

You must enable the encrypted transport for communications via the WebSpace server.

1. Open the WebSpace Administrator on the server running WebSpace.

2. Go to Tools > Host Options > Security.

3. For Transport, select Encrypted.

4. Browse to the CIMPLICITY installation\ScadaConfigPki folder, then select the
server_cert.crt file.
For a default installation, the certificate location would be: C:\Program Files
(x86)\Proficy\Proficy CIMPLICITY\ScadaConfigPki\server_cert.crt
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5. Select OK to save and close Host Options.

IIS Configuration - Set up HTTPS Binding for port 443

You must set up the Microsoft Internet Information Services to listen on port 443 so that it can be
used for https requests, which are necessary for the Operations Hub integration.

1. Log in to the CIMPLICITY/Webspace machine.

2. Go to Start > Control Panel > Administrative Tools.

3. Open Internet Information Services (IIS) Manager.

4. On the left-hand pane, select the root of the IIS Server, usually listed as the computer name.

5. Select Server Certificates.
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6. On the right-hand pane, select Create Self-Signed Certificate.

7. Enter name as ProficyWebspace, and select Personal as the certificate store.

8. Select OK to save.
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9. On the left-hand pane, select the root of the IIS Server, usually listed as the computer name.

10. On the left-hand pane, select Default Web Site.

11. On the right-hand pane, go to Edit Site > Bindings.

12. Select Add to open Edit Site Binding.

13. Select https as type.

14. Select All Unassigned as the IP address.

15. Enter 443 for port.

16. Enter the computer name of the Webspace system as host name.

17. Select ProficyWebspace as the SSL Certificate.
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18. Select OK.

19. On the Site Bindings dialog, select Close.

20. On the left-hand pane, select the root of the IIS Server, usually listed as the computer name.

21. On the right-hand pane, select Restart to restart the IIS Server.

Configure Windows Firewall

Open the Windows Firewall ports on each system so that the two nodes (WebSpace/Operations Hub)
can communicate properly.

Open Windows Powershell as an administrator to run the commands.
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1. On the Operations Hub system, run the following commands to open the firewall ports.

a. Open Operations Hub port 443 (Operations Hub reverse proxy port):

New-NetFirewallRule -DisplayName "my_port_443" -Direction Inbound
-Action Allow -Protocol TCP -LocalPort 443

2. On the CIMPLICITY/WebSpace system, run the following commands to open the firewall
ports.

a. Open CIMPLICITY port 9443 (Public external REST port for NGINX):

New-NetFirewallRule -DisplayName "my_port_9443" -Direction
Inbound -Action Allow -Protocol TCP -LocalPort 9443

b. Open CIMPLICITY port 443 (the WebSpace/IIS port):

New-NetFirewallRule -DisplayName "my_port_443" -Direction Inbound
-Action Allow -Protocol TCP -LocalPort 443

c. Open CIMPLICITY port 491 (the WebSpace server port):

New-NetFirewallRule -DisplayName "my_port_491" -Direction Inbound
-Action Allow -Protocol TCP -LocalPort 491

Export CIMPLICITY Self-Signed Certificate

Export this certificate that was created when CIMPLICITY was installed on the system.

The certificate is exported and then imported into the Trusted Certificate store on the Operations Hub
computer.

1. Open Windows Run, and enter certmgr.msc.
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2. Go to Trusted Root Certification Authorities > Certificates.

3. Select the certificate named
CIMPLICITY<computer_name><datetime>@SelfsignedRootCA.

4. Right-click CIMPLICITY self-signed certificate, then select All Tasks > Export.
The Certificate Export Wizard appears.

5. Select Next.

6. When prompted for the Export File Format, select DER encoded binary X.509 (.CER).
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7. Select Next.

8. Select Browse, enter file name of CIMPLICITY_Self_Signed and choose to save on the
Desktop.
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9. Select Next.

10. Select Finish.
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Import CIMPLICITY Self-Signed Certificate

Import the CIMPLICITY self-signed certificate to the Operations Hub computer.

Export CIMPLICITY Self-Signed Certificate (page 361).

1. Copy the exported certificate on the Operations Hub computer.

2. Right-click the certificate, and select Install Certificate.
The Certificate Import Wizard appears.

3. Select Local Machine, then select Next.
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4. Select Place all certificates in the following store.
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5. Select Browse to access the Select Certificate Store.

6. Select Trusted Root Certification Authorities at the store, then select OK.

7. Select Next in the import wizard.

8. Select Finish.

The certificate is imported successfully.
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Set up CIMPLICITY Project Properties

Configure CIMPLICITY to interact with the Webspace widget in Operations Hub.

1. Open the CIMPLICITY project that you have access via Operations Hub, in the CIMPLICITY
workbench.

2. Go to Project > Properties
The Project Properties dialog appears.

3. Select the Operations Hub tab, and provide these details:

Field Description

Server name Enter the computer name of the Operations Hub
server.

Port Enter 443.

User name Enter the administrator account for the Operations Hub
Server, i.e. OpHubAdmin.
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Field Description

SSL Security If (Not Trusted), follow these steps:
a. Select the check box for Require trusted

connection.
b. Select View Certificate. The certificate fields

should be populated.

Note:  The certificate retrieved from the
Operations Hub server is placed in the <project>/
data/WebHMIPki/server_certs folder.

c. Go to <project>/data/WebHMIPki/server_certs/
folder, and copy the certificate called <opshub
servername> Root CA <datetime>.cert

d. Paste the certificate in <project>/data/WebHMIPki/
trusted_issuers/ folder.

e. Verify if SSL Security is updated to (Trusted).

Test Connection After updating all the details, test the connection.

Connected successfully to the Operations Hub server.

Set up CIMPLICITY Project User Security

To avoid having to login on the Webspace container to the project, for each user that is configured in
Operations Hub, a matching user must be configured in the CIMPLICITY project.

1. Open the CIMPLICITY Project in the CIMPLICITY Workbench.

2. Go to Security > Users.

3. For each user in the Operations Hub configuration, create a CIMPLICITY user of the same
name with a security type of CIMPLICITY.

Note:  The passwords for the user between Operations Hub and the CIMPLICITY project
do not need to match.

Configure CIMPLICITY Options

Set up CIMPLICITY options to ensure that sessions are properly created.

1. On the CIMPLICITY/WebSpace node open CIMPLICITY Options.

2. Select the Webspace tab.

3. On the left pane, select General.

4. Select the check box for Autostart Webspace Session Manager.

5. Verify the port is 4957, then select Apply.
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A message appears to restart the Webspace Session Manager service.

6. Select Yes to restart the service.

7. On the left pane, select Server.
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8. Provide these details:

Field Description

Windows Server Credentials a. Enter a valid User name and Password for the
Webspace system.

Note:  The user must be authorized to launch
CimView.exe, as well as access the screens
directory for the screens that are accessed via the
Webspace widget.

b. Select Test. If successful,
• Trust UAA appears as Untrusted
• Generate UAA Client appears as Not

generated
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Field Description

Operations Hub UAA/OAuth2 Setup a. Enter the Server URL for the Operations Hub
server. For example, https://opshubsystem:443/
uaa.

b. Test for a successful connection.
c. Select Trust UAA to change its status from

untrusted to trusted.

Note:  When trusted, the UAA certificates
are copied to the <CIMPLICITY installation>
\webspace-session-manager\pki\trusted directory.

d. Select Generate UAA Client to enter the
credentials for UAA Administrator.

i. Client Id: admin
ii. Client Secret: Enter the Operations Hub

secret, which was entered during installing
Operations Hub.

iii. Select Generate.

The status changes to Generated on successful
generation of the UAA Client.

Single/Relay Server Provide the session manager credentials, and select
Apply.

• WSM Admin User: Enter a user name (example:
Administrator)

• Admin Password: Enter a password (example:
pass1234)

• Confirm Password: Enter the same password to
confirm.

Note:  This can be any user name/password and
does not have to match any specific windows user
name or password.

A message appears to restart the Webspace Session Manager service.

9. Select Yes to restart the service.

Date Picker

With the DatePicker plugin, you can add a calendar to display date and time in a variety of formats.

The calendar allows you to select specific date and time to use with queries and other data in the end
application. All time related queries can make use of the date and time selection.

https://opshubsystem:443/uaa
https://opshubsystem:443/uaa
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To use the plugin in the page designer, drag  from Integration > General to a container
in the page.

Specify these plugin properties:

Note:  When configuring input targets for plugins, ensure that no other binding exists for the
target query input. To remove a binding from the query input, select the unlink icon next to the
binding.

Item Description

Title Provide the text that appears as a label above the plugin in the end application.

Type Select from these options for display in the end application:

• date: displays only date
• time: displays only time
• datetime: displays both date and time

Display
Format

Select the format for the date and time display.

Timezone Select the timezone as local or UTC.

Note:  For Historian sources, use 'local' for timezone.
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Item Description

Source
Input
Value

Set this value to allow the plugin to start displaying a specific date and/or time when it loads in the end
application.

Input
Target

This is the value the plugin provides as an output in the end application. For example, you can choose a
date/time/datetime that is passed to the query, which requires a date time.

Breadcrumb

With the GEBreadcrumb plugin, you can navigate through the asset model.

The purpose of a breadcrumb is to allow you to access an asset's information located anywhere in
the asset model hierarchy. A breadcrumb navigation also defines the relationship between different
assets in a model.

The breadcrumb navigation is available for all the widgets in Operations Hub. You can navigate in
the trend card using breadcrumb.

In the end application UI, to access the breadcrumb, select  and browse your model.
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To use the plugin in the page designer, drag  from Integration > General to a container
in the page.

You must specify these breadcrumb properties:

Note:  When configuring input targets for plugins, ensure that no other binding exists for the
target query input. To remove a binding from the query input, select the unlink icon next to the
binding.

Item Description

Source Asset
Context

Select the source (asset name) for an asset context. The selected context appears as a default
breadcrumb view in the end application. This asset name must exist in your asset model (page
232).
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Item Description

Target Asset
Context

Select the target for an asset context. This target defines where that output goes on selecting an
asset in a breadcrumb, so that it can be fed either to a query or a global.

Target
Extension
Query for
Asset Context
Properties

Select the target for an extension query. This is a formatted string with a list of properties that defines
the hierarchy of the breadcrumb in the end application. For example, consider these crumbs in a
hierarchy - first is ‘pump’, second is ‘pump pressure’, ‘pump frequency’, ‘pump vibration’, or ‘pump
flow’.

The breadcrumb is customizable, enabling you to add conditions for display navigation. Refer to
Page Components (page 445) for common widget properties.

Trend Card

Use the trend card widget to build trend charts (page 377) in your application.

The trend card widget is available under Integration > General. When designing application pages

(page 262), drag-and-drop  to a container.

Table 9. Trend Card Properties

Property Description

Asset Name (Optional Override) Select an asset name.

Select Favorite Contains a list of saved favorites. Select a favorite chart
view from the drop-down list. The selected view loads by
default when you launch the trend chart at runtime.

Default Sampling Mode Select a sampling mode. This mode is set as default, and
loaded at runtime for historical sources on both Live and
Historical trends.
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Property Description

Height Sets the height of the widget.

Show Trend Legend Select to show legend on a trend chart.

Show Favorites Select to show favorites on a trend chart.

Trend Chart Overview

The trend chart allows you to plot real time data from OPC UA servers and historical data from
Historian servers. You can plot the data using the context of a model or browse for a Historian or
OPC UA server. You can then add tags to the chart.

The model contains asset types and assets. The assets have properties associated with them, which
are, in turn, associated with tags defined in Historian or OPC UA.

The following image shows an example of a trend chart.

The following table describes the tasks that you can perform on a trend chart.

Task Procedure

Access the properties used in a trend
chart.

The properties used in a trend chart appear in the Legend section.
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Task Procedure

Remove a property from a trend chart.
To delete a property from the trend chart, select the property, then select .

Increase the area of a trend chart.

• Hide the toolbar by selecting .

• Hide the Legend section by selecting .

Pause the data flow of a trend chart. This option is available only for the live mode.

• On the toolbar, select  to pause trending.

• You can resume the data flow by selecting .

View the delta value between two data
points.

The delta values for the trend is displayed in the Legend section.

On the toolbar, select , and select the two data points whose delta value
you want to view.
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Task Procedure

Drill down a trend chart.

On the toolbar, select  to drill down or zoom into a trend chart for more

granular information. To zoom out, select .

If you want to zoom in or zoom out a single axis, select the axis in the drop-

down list box next to .

If you want to enlarge an area on the chart, select , and then select the
area on the chart.

Data is refetched only in historical mode when zoomed in/out (changes chart
start time/duration) of a chart. For example, consider trending 500 samples
from 1-2pm, then zoom in to 1:00 -1:10pm to request 500 samples data for
that 10 minute span.

Pan across a trend chart. You must zoom in/out of a chart to be able to pan across a trend chart. The
pan icon is enabled when you perform the zoom operation.

The pan icon is visible only in the Live mode.

• Zoom in/out of a chart (page 379).

• On the toolbar, select , and then drag the icon to the area on the
chart that you want to view.

• Move the icon left/right to pan across the x-axis.
• Move the icon up/down to pan across the y-axis.

In Historical mode:

• Zoom in/out of a chart (page 379).
• Use the scroll icons (page 381) for Shift Left/Right to move horizontally

on the x-axis.
• Use the scroll icons (page 381) for Shift Up/Down to move vertically on

the y-axis.
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Task Procedure

Mark a trend chart view as favorite. It is
an easy way to view the trend chart for
commonly used configuration settings.

On the toolbar, select , enter a name for the view, and then select Add.

Important:  Do not include these special characters in your favorite
name as they are not supported.

? / \ # ; %

To load a favorite view, select the view from the drop-down list box next to

.

You can also access the list of saved favorites while creating application
pages (page 262) in Operation Hub. Under Trend Card widget properties,
select a favorite chart view from Select Favorite drop-down list. The
selected view loads by default when you launch the trend chart at runtime.

View the statistics of tags plotted on a
trend chart.

The statistical data for the Historian tags used in the trend chart appear
below the chart.

• On the toolbar, select  to show the statistical data.

• To hide statistics, select  again.

In historical mode, tag statistics are refetched on zooming in/out (changes
chart start time/duration) of a chart.

Export the trend chart data. The trend chart data is exported and saved as a CSV file.

On the toolbar, select , then select  to export data.
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Task Procedure

Print a trend chart.
On the toolbar, select , then select .

You have the option to provide a title that appears above the trend chart.

Reset the trend chart options.
On the toolbar, select , then select . Any changes you have made to
the duration, start time, axis preferences, and properties are reverted.

Scroll through the historical data.
Select  and  to move back and forth in the chart, and access
historical data. Scrolling back and forth changes the start time for the chart.

For example, if you are currently viewing trends during 1-2pm, you can scroll
back in time to view 12:45-1:45pm, then return to current view.

Recommendations While Using a Trend Chart

When you create a trend chart, we recommend that you apply the following guidelines:

• When you add a trend chart to a page using the page designer, use separate containers for the
breadcrumb and the chart. For the trend chart, set the height to 100%.

• When accessing a trend chart on a mobile device:
◦ Use a device with medium to high resolution.
◦ Use the device in landscape mode.
◦ To print a trend chart using an Android device, use the screen capture feature rather than

selecting .
◦ Configure the trend chart using a desktop rather than an Android device. This is because

when you attempt to search for an asset or a Historian tag on an Android device, the in-
built keyboard of the device appears, which may not allow you to enter the search criteria.

◦ When you view the delta between two data points, the value may not be clearly readable on
a mobile device with low to medium resolution. Therefore, we recommend that you view
the delta value on a desktop or a mobile device with high resolution.

◦ When you view statistical data, the trend chart area may be limited. To avoid this issue,
plot up to two properties on the trend chart.

◦ To pan across the trend chart or drill down the trend chart on an iPad, use the Zoom feature

of the iPad rather than selecting , , or , respectively.
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Configuring a Trend Chart

Use the trend configuration settings to create or modify your charts.

Create a Data Source (page 244) for Historian or OPC UA.

For information on building trend charts, refer to these topics:

• Use the Trend Widget for OPC UA Data Sources (page 96)
• Use the Trend Widget for Historian Data Source (page 72)

1. Access the trend chart whose settings you want to configure.

2. In the toolbar of the chart, select .
The Trend Configuration window appears.

3. Modify the trend chart settings as specified in the following table.
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Setting Description

Mode Select the mode of the trend chart. The following
options are available:

• Live: Plots real-time data from a Historian server
and/or OPC UA server.

• Historical: Plots historical data from a Historian
server.

Note:  Changes made to Live affect Historical as
well. For example, if you add/delete properties from the
chart in the Live mode, these changes reflect when you
move to the Historical mode as well.

Duration Select a duration for which you want to plot the data.
The selected duration is subtracted from the End
time to deliver past trends. You can go back in time in
minutes, hours, or provide a customized duration.

• 1, 5, or 30 minutes
• 1, 2, 4, 8, or 24 hours
• Choose Custom and enter a different duration in

the time format text box.

End Allows to set an end date and time for trending
historical data.

Select  to update a specific date and
time.

• If you have set a date and time in the past, select
Done to apply.

• If you want to set the current date and time, select
Now to apply. The current time can also be set by
enabling the toggle switch.

Now Allows to update the End time to your current system
time. The toggle is enabled by default when you enter
the Historical mode for the first time. Choosing a
different date and time automatically disables the
toggle.

• Select  to refresh ‘Now’ configured charts.
Use this option to instantly update the end time to
current time if the chart is already configured for
‘Now’.

• You can also save a 'Now' configured chart as
your favorite. When you reload such charts from
favorites, the end time is set to the current system
time, and trends are displayed.

Note:  After upgrading to 2.1, values
from previously saved favorites are updated to
represent the range for end time instead of the
start time. The ‘Now’ toggle remains disabled for
old favorites.
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Setting Description

Sampling Increment Select whether you want to increment the sampling
data based on time or count, and then specify the time
or count, respectively.

Note:  The sampling increment may not always be
honored. The maximum number of data points plotted
on the trend chart is 3000 when sampling by time, and
8000 when sampling by count. You can zoom in to view
more accurate data.

Notes You can add notes only to historical trends, and not for
OPC UA based trends.

Switch the toggle to enable viewing or adding a note on
the trend chart.

On the trend chart:
• To add a note for the first time for a specific data

point, select the data point, and then select .

• To access a note, select .

Note:  You cannot modify or delete a note;
if you want to augment a note, you can add
additional notes.

• To add an additional note for a data point, select

.

• To navigate through multiple notes, use  and

.

When you access an existing note, the timestamp and
tag values that appear during the initial loading of the
note correspond to the x-axis and y-axis values for the
data point, respectively. If you select each individual
note, the actual raw and timestamp values to which the
comment was added in the Historian archive appear.

If you add a note to an interpolated value, it is added to
the nearest raw value. Due to this, the value displayed
in the note may not always match the value plotted on
the chart.
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Setting Description

Sources Data can be plotted to the trend chart using properties
from an asset model. In the absence of an asset model,
you can also directly browse the data source address
space and select tags for the trend chart.

Select Add Tags for Trend to select the properties
or tags that you want to add to the trend chart (page
255).

Tags marked as  are from the Historian data

source. Tags marked as  are from the real time
data sources such as iFIX, CIMPLICITY, and any other
OPC UA server.

Note:  Nodes only work for plotting historical data.
They do not work in Live mode.
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Setting Description

SAMPLING MODE For each tag SOURCE, you can add multiple sampling
modes. This option is available only for the historical
mode.

Select [Add Sampling Mode] to add additional
sampling modes for a tag. For example, you can have
3 different sampling modes for a single tag in the trend
chart. Highlight each mode with a different line color,
style, and thickness.

These are the modes available to plot data:

• Trend To Raw
• Minimum
• Maximum
• Average
• Total
• Standard Deviation
• Interpolated
• Lab
• Lab To Raw

You can trend each tag-sampling mode combination
only once. For example, if Trend To Raw mode is
applied to Water Temp tag, this mode becomes
inactive for this tag. The other modes are available to
use.

To delete a plotted sampling mode, select  next to
the tag.
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Setting Description

Specification Limits Select to define upper, lower, and targeted limits to
monitor the process performance.

Enter values for all or any of the limits to plot these
lines on the trend chart. You can highlight each plotted
line with a unique line color, thickness, and/or style.

You can set the specification limits for both live and
historical mode, and save the chart to favorites.

COLOR Select to color code each trend line for unique
identification.

LINE WEIGHT Select to highlight each trend line with a unique line
width.

LINE STYLE Select to highlight each trend line with a unique line
style.
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Setting Description

Chart Y Axis Configuration Allows to compare two or more tags/sources by having
a common Y-axis on the trend chart.

• Individual Y Axis for each source: Select this
option to include an individual Y-axis for each
source on a trend chart. For example, if you have
multiple tags trending on your chart, each tag has
its own Y-axis.

• Single Y Axis for all sources: Select this option
to include a common Y-axis for all the sources on
a trend chart. For example, if you have multiple
tags trending on your chart, all the tags share only
a single Y-axis.

SHOW Y-AXIS Select the toggle to switch between showing or hiding
the y-axis on a trend chart. This option is available
under each tag/source if you selected individual y-axis
for each source.

AUTOFETCH LIMITS By default, the toggle is always turned on, to
automatically fetch minimum (Low) and maximum
(High) limits. Turn off the toggle if you want to provide
manual limits for the chart. Enter values for AXIS LOW
and AXIS HIGH to trend the data accordingly. In case
you do not enter High and Low limits when the toggle is
off, the values are auto scaled.

For Individual Y-axis, the option to set limits is available
under each tag/source.

For Single Y-axis, you can browse and select the tag/
source, and set custom limits. Turn on the toggle to be
able to browse tag/source.

Task Client

Configure the Task Client

This topic describes how to enable the task client widget to operate in the Operations Hub web server
environment.

Install the Workflow and the Operations Hub applications on different servers.

To configure the task client widget, equipment models from the Workflow application are exported
to a .csv file, and imported into the Operations Hub application.

1. In the Workflow server, do the following:

a. Select an equipment model you want to export, and then select Generate Operations Hub
Model.

b. Provide a location to save the exported file, and select Generate.
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The equipment model data is exported to a .csv file format, and saved in the specified
location.

2. In the Operations Hub server, do the following:

a. Import the .csv file created in step 1 to Operations Hub. For steps, refer to the Import
Equipment Model (page 390) topic.

b. In the main navigation menu, select APPS, and then select Workflow Tasklist application.
The Pages workspace appears.

c. Select Tasklist View.
The pages associated to the task list appear in a container. TASK LIST, and TASK
COUNT are system widgets that cannot be deleted.

d. Select the Task List page in the container.
The GETASKLIST PROPERTIES tab settings appears on the right pane.

e. Provide DATA settings as specified in the table below:

Note:  Scroll down in the settings section to find the data settings after the general and
display settings.

Parameter Selection Description

WorkflowServer Manual Enter the URL address of the
Workflow server to connect.

RefreshRate Manual Enter the time in seconds at
which rate the task client will
refresh to get the latest data from
the Workflow server (for example,
5).
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Parameter Selection Description

Height Manual Enter the preferred height of the
task client widget (for example,
600).

f. Select Save App.
The application settings are saved.

Log in to the Operations Hub web client to connect and work with the task client widget. Refer to the
Access the Task Client (page 390) topic.

Import Equipment Model

By importing the Workflow equipment models, you can manage the tasks assigned to you from
within the Operations Hub application.

Ensure that the Workflow equipment models are exported to a Web HMI model .csv file.

An equipment model is configured in the Workflow application. For more information, refer to the
Equipment Model topic in the Resource Information and Configuration section of the complete
Workflow user guide.

1. Access Operations Hub.

2. In the main navigation menu, select ADMIN.

3. In the Admin workspace, select Import/Export.
The Model Import/Export page appears.

Tip:  Select  to hide the navigation pane that overlaps the page.

4. To import, browse and select the exported .csv file from Workflow, and select Import.

The imported information is visible under Objects and Object Types in the Admin workspace.

Access the Task Client

Use the Task Client widget to display task lists from the Workflow application in Operations Hub.

Create identical user accounts for the Operations Hub web server and the Workflow server. You
must be able to log in to both the servers using the same username and password combination. Refer
to the Configure the Task Client (page 388) topic.
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The Workflow Task List is integrated with Operations Hub. You do not have to log in to the
Workflow application to manage your tasks. You can log in to the Operations Hub application, and
connect to Workflow with the help of the task client widget to manage tasks.

1. Log in to the Operations Hub web client.
The login page to connect to the Workflow server appears.

2. Enter the details as specified in the following table:

Field Description

Username The account username that has permission to access
the Workflow application.

Password The password for the username you entered in the
Username box.

Server Address The URL address to connect to the Workflow server.
This URL is populated based on the properties
provided for the Task Client widget in Operations Hub.

3. Select Log On.
The task count icon indicates the status of your workflow connection.

Status Description

Indicates that the Workflow server is disconnected due
to either of these reasons:

• You are not logged in to the server.
• Internet connection is lost.
• Workflow server is down.

Note:  All tasks in Operations Hub remain disabled
until a connection is established.

Indicates that the Workflow server is connected.

Once connected, the task count shows the number of
workflow tasks. If the count is 0, it means there are no
workflows.

The user login credentials are encrypted and stored under ENTITIES in Operations Hub. You
will not be prompted for login details again for the saved user accounts.
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Note:  Whenever the Workflow server is down, or if there is no internet, the lost connection
status is indicated in red. All tasks in Operations Hub remain disabled until a connection is
established.

4. Select  to show the workflow equipment context navigation.
For more information, refer to the Equipment Context topic in the Operator Task List in the
Workflow Client section of the complete Workflow user guide.

5. Select  or  to navigate and select any of these equipment contexts: Big Enterprise, Big
Unit, or Big Area.
The equipment context set up shown in Operations Hub is created in the Workflow application.
The list of tasks for the selected equipment context appears. Based on the list of tasks, the task

count number  also gets updated.

Note:  Logged in users in Operations Hub can view only the tasks that are assigned to them
in the Workflow application.

6. Use these options to work with the tasks:

Icon Description

Select to filter tasks or task steps by task name,
priority, personnel assignment, step state, and expiry
values. For more information, refer to the Task List
Filtering topic in the Operator Task List in the Workflow
Client section of the complete Workflow user guide.

Select the Tasks for Equipment toggle to show or
hide the tasks associated to the equipment location
only.

Select to start and run scheduled tasks. For more
information, refer to the Start Task topic in the Operator
Task List in the Workflow Client section of the complete
Workflow user guide.

Select to manually start a specific task step.

Select to view and save a copy of the linked
documents. For more information, refer to the
Document(s) topic in the Operator Task List in the
Proficy Client section of the complete Workflow user
guide.

Select to view the instructions to complete a task or
task step. This option is available only when there are
work instructions defined for the task or task steps.
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Icon Description

Select to access the following menus, and perform task
related actions:

• Set Priority: You can set a priority number for the
task to run.

• Jump to Task Step: You can skip some steps and
jump to a specific task step in a scheduled flow.

• Enter Expiry Comment: You can enter a reason
for the task delay. The option to add a comment
is available only after the task or task step has
expired.

• Cancel Task: You can cancel running a specific
task or task step.

• Reassign Personnel: You can reassign specific
task steps to a different person or equipment
location.

• Acquire: You can acquire a specific task step if it
is available.

• Release: You can only release those steps that
you have acquired. When you release a task step,
it is available for other operators to acquire.

For more information, refer to the complete Workflow
user guide.

Select to access the forms attached to a task step,
and update them. For more information, refer to the
Forms and User Displays Authoring Guide section of
the complete Workflow user guide.

Note:  You can load only HTML forms in the
Operations Hub Task Client. Windows presentation
framework (WPF), Silverlight, and .NET rich client
forms are not supported.

Note:  For added security, electronic signatures are configured in Workflow for specific
tasks, task steps, or forms. In such cases, a dialog box appears requesting you to sign in for
verification before accomplishing any task related action.

Indicator

Use the indicator widget to monitor and interpret the status of your industrial systems.

You can apply different colors and introduce gif animations to communicate a value or state
effectively. The indicator widget helps to draw attention towards the changing status of a system and
the indication to take corrective actions, if necessary.

The indicator widget is available under Integration > General. When designing application pages

(page 262), drag-and-drop  to a container.
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Bind the widget to a query and set the properties to appear at runtime. You can define unique
properties for values within specific ranges, and also for values that are outside of any range.

Important:  This rule applies if you have upgraded to a SIM version. Make sure to upgrade your
applications (page 127) before attempting to modify them in Operations Hub.

Table 10. Indicator Properties

Property Description

Multistate Indicator Value The value is populated when you bind the indicator widget
to a query.

Indicator Mode Select to display output in any of these modes:

• Analog: In this mode, the widget provides analog
values as output. You can choose to add a
background image, and use several other options to
indicate the current status.

• Status: In this mode, the widget functions as a simple
indicator status. It provides a push button to indicate
the change in current status. You can also choose to
show the analog values.

• Image: In this mode, you can provide a background
image to indicate the change in current status. You
can also choose to show the analog values along with
the image.

Display Value? Select the check box to display the analog value.
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Property Description

Repeat Background Image Analog indicator mode:

Select the check box to apply the background image
repeatedly to provide a continuous background across the
widget.

Width Analog indicator mode:

By default, the indicator widget occupies the width of its
container. Reset the width in percentage or pixels.

Height Analog indicator mode:

By default, the indicator widget occupies the height of its
container. Reset the height in percentage or pixels.

Size Image and Status indicator modes:

For the image mode, enter the image size in pixels.

For the status mode, enter the size to set the diameter of
the indicator button.

Decimal Precision (Whole Number Only) Enter the number of significant digits after the decimal
point to consider for formatting large numbers (for
example 2, 3, 4). Based on the significant digits, the
displayed value is rounded off to the nearest whole
number.

Insert Commas Select the check box to use comma as a thousands
separator. A comma is inserted for every three digits.

Prefix Units Enter the unit of measurement to appear as a prefix for the
value.

Suffix Units Enter the unit of measurement to appear as a suffix for the
value.

Label Above Enter the text to appear above the value.

Label Below Enter the text to appear below the value.

Font Size Enter the size of the font for the label text.

Font Family Select a font family for the label text.

Font Color Select a font color (page 452) for the label text.

Background Color Select a color (page 452) to fill in the background for
labels and values.
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Property Description

Background Image Allows to set a background image for the widget.

You can:

• Enter the file name of the image if copied to
this location on the server C:\Program Files\GE
\Operations Hub\iqp-endapp\public\custom\Images

(OR)
• Enter the complete URL address for the image from a

different server.

Note:  For background image visibility, make sure
that your background color has the alpha channel set to
include some transparency. You can even apply a partial
transparency to tint the image.

Border Type/Style Select a border style for the widget.

Border Width Enter the width size if the widget has a border.

Border Radius Enter the radius size to style the corners of a border.

Border Color Select a color (page 452) for the border.

+Add Item Select to customize settings for values within a specific
range. Create an input range and highlight with unique
colors and style.

Input Range Low (Greater than or Equal) Enter the lowest value to create an input range.

Input Range High (Less than) Enter the highest value to create an input range.

About Custom Range Settings

You can add several custom ranges to the widget; each with a different input range. The custom
ranges are implemented in the specified order, from first to last. If the input ranges overlap with each
other, the custom range setting at the top of the order is applicable. Arrange the custom ranges in the
order you want them to be implemented.

• Select  for the custom range to move upwards in a list.

• Select  for the custom range to move downwards in a list.

• Select  for the custom range to remove from the list. These inputs are deleted.

Alarm Card

Use the alarm card to monitor your industrial assets. Get information from the HMI/SCADA system
on alarms generated by their severity levels.

The alarm card widget is available under Integration > HMI. When designing application pages

(page 262), drag and drop  to a container.
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Table 11. Alarm Card Properties

Property Description

View All Alarms by default (Disabling this option will
display context based alarms)

This is a default setting to show all alarms irrespective of
context when the page loads at runtime.

If using the bread crumb widget along with the alarm card,
then alarms are displayed according to the context.

If an alarm contains an OPC UA tag that is not associated
with a model property, then the source server of the tag is
displayed in the alarm grid.

Asset Name (Optional Override) Select your own asset to display alarms. The selected
asset overrides the default asset name at runtime.

Data Source (default data source used to filter alarms on
page load)

Select a data source to set as default for filtering alarms
on page load at runtime.

Page Size - Number of alarms to display per page Enter a number to specify the number of alarms that
appear on a page at runtime. The maximum number of
alarms you can display per page is 100.

Auto Hide Columns Select to automatically hide the table columns if screen
space is a constraint.

Note:  This option is enabled by default. To hide any
of the other columns at runtime, you must clear the check
box for this option.

Hide Acknowledge Column Select to hide the Ack. column at runtime. This column
contains the status to indicate whether the alarm is
acknowledged in the HMI/SCADA system or not. A
check mark in this column indicates that the alarm is
acknowledged.

Hide Severity Column Select to hide the Severity column at runtime. This
column contains the icon that indicates the alarm severity
status.

Hide Start Time Column Select to hide the Start Time column at runtime. This
column contains the start time and date for the alarm.

Hide Source Column Select to hide the Source column at runtime. This column
contains the tag associated to the alarm.

Hide Current Value Column Select to hide the Current Value column at runtime. This
column contains the query value such as whether the
alarm is running or stopped.

Hide Asset Column Select to hide the Asset column at runtime. This column
contains the asset name associated to the alarm.

Hide Property Column Select to hide the Property column at runtime.

Hide Description Column Select to hide the Description column at runtime.

Hide State Column Select to hide the State column at runtime. This column
contains the alarm's current status.
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Alarm Card at Runtime

To acknowledge alarms (page 405), you must have the permission to do so in the supporting HMI/
SCADA system.

Select  to filter alarms (page 403) based on specific conditions.

Each icon has a corresponding number to indicate the number of alarms currently active for that
severity level. The alarm count (page 406) in the banner shows the number of alarms per severity
level for all assets in the model, whereas the alarm card displays the number of alarms per severity
level for the selected context.

The severity of an alarm is based on the priorities set in the HMI/SCADA system (iFIX or
CIMPLICITY). Each alarm icon is color-coded and contains a specific number of dots to indicate its
severity level, as shown in this table.

Note:  The alarm severity ranges are hard-coded in the application. Access the
application.properties file to modify alarm severity ranges.

You can modify the property rank.ranks in C:\Program Files\GE\Operations Hub\webhmi-
tomcat\webapps\alarm-microservice\WEB-INF\classes\application.properties and
restart webHMI tomcat service.

Icon Description

Alarm is critical.

Alarm is high priority.

Alarm is medium priority.

Alarm is low priority.

Alarm information is not displayed if data sources are disconnected. Select  to get more
information.
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Note:  Currently, if a data source is deleted from Operations Hub, the alarms configured to the
deleted data source are still displayed at runtime. To clear such alarms, restart the data distributor
service.

Configure iFIX for Alarms

When using the iFIX HMI/SCADA system as your data source, follow this quick walkthrough to
successfully get data and alarms flowing for the first time into Operations Hub.

First install iFIX, and then install Operations Hub on the same server.

1. Start the iFIX application.

2. Log in to iFIX with a default/guest account.

3. Go to Applications > Security > Security Configuration Utility.

Security is available in the System & Security group.

4. On the Security toolbox, select User Account.

5. Select Add to create a user account.
The User Profile dialog appears.

6. Provide iFIX security for the user account:

Field Description

Full name Enter a name for the new user account.

Login name Enter a login name for the user account.

Password Enter a password for the user account.

Group Membership Select Modify to add any/all available groups to the
user account, then select OK.

Security Areas Select Modify to add any/all security areas to the user
account, then select OK.

Application Features Select Modify to add any/all application features to the
user account, then select OK.

7. Select OK to save the user profile.
The Password Confirmation dialog appears.

8. Enter the password again and select OK.
The user account is saved with the credentials and added to the Current Users list.

9. On the Security toolbox, select Configuration and select Enabled.

10. Go to Applications > OPC UA Configuration.
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The iFIX OPC UA Server Configuration Tool screen appears.

11. On the Server tab, select the check box for Server Enabled.

12. On the Alarms tab, select the check box for Alarms Enabled.

13. Select Save and Exit to save the selections, and close the screen.

14. Go to Applications > Database Manager.
The iFIX Database Manager spreadsheet appears.

15. Open an existing database, or select Create New on the spreadsheet toolbar to save a new
database.

16. On the spreadsheet toolbar, select Add to add blocks to your database.
The Select a block type screen appears.

17. Select any block type, then select OK.
The selected block type screen appears.

18. On the Basic tab:
a. Enter Tag Name.
b. Enter I/O Address.
c. Select Save.

19. On the Alarm tab:

a. Select the check box for Enable Alarming.

b. In the Alarm Options table, enter the alarm values.
For example:

High High 60

High 40

Low 20

Low Low 10

c. Select Save.

20. On the Advanced tab:
a. Select the check box for Enable Output.
b. Select Save.

The tag name configured with an alarm is added to the spreadsheet.

21. Repeat steps 8-12 to add more blocks to your database.

• Create a data source with OPC UA configuration (page 250) in Operations Hub.

https://www.ge.com/digital/documentation/ifix/version65/index.html#opc-ua-server/opcua_opc_ua_server_configuration_tool.htm
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• Use the alarm card (page 396) and alarm count (page 406) widgets in your application.
• Acknowledge Alarms (page 405).
• Apply Filters to View Alarms (page 403).
• Configure CIMPLICITY for Alarms (page 401).

Related tasks
Configure iFIX for Mimics (page 408)

Configure CIMPLICITY for Alarms

When using the CIMPLICITY HMI/SCADA system as your data source, follow this quick
walkthrough to successfully get data and alarms flowing for the first time into Operations Hub.

• Install the latest versions of CIMPLICITY and Operations Hub on different servers or on the
same server.

• Create an administrative user that you can use for both CIMPLICITY and Operations Hub. The
user IDs must match in order to connect and manage communications and operations between
the two systems, but the passwords must be different.

1. Start the CIMPLICITY Workbench application.

2. From the Workbench toolbar, go to File > New > Project.
The Create User for New Project dialog appears.

3. Provide these details for the new user account:

Field Description

Username Enter the user name for the new account.

Password Enter a password.

Confirm password Enter the password again to confirm.

Note:  You will use the credentials to establish a secure connection with authentication for
the CIMPLICITY data source in Operations Hub.

4. Select Next.
The Create As dialog appears.

5. Enter the name and location for the new project.

Note:  For write operations to work, the project name and the CIMPLICITY data source
name in Operations Hub should be the same.

6. Select product options and protocols that will be included in the project.
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7. Select Create.

8. After creating the project, go to Project > Properties.
The Project Properties screen appears.

9. On the OPC UA Server tab, perform these steps.
a. Select the check box for Enable Server.
b. Select Security Configuration, then select the check box for all the security options you

want to enable for the OPC UA server.

10. On the Operations Hub tab, perform these steps.

a. Provide the following details:

Field Description

Server name Enter the name of the Operations Hub server to
connect.

Port Enter the port number for Operations Hub UAA. For
example, 443.

User name Enter the account username that is used to log in to
the Operations Hub application.

b. Select the check box for Require trusted connection.

c. If (Not Trusted), go to the CIMPLICITY project's \data\WebHMIpki\server_certs
folder and copy the root certificates.

d. Paste the copied certificates in the CIMPLICITY project's \data\WebHMIpki
\trusted_issuers folder.

e. On the Operations Hub tab, select Test Connection.
A success message appears updating the connection status as (Trusted).

11. From the CIMPLICITY Workbench project directory, right-click Points > New, to create a new
device point.

12. Provide the following information for the new point and select OK.

Field Description

Point ID Provide a unique name that identifies the CIMPLICITY
point.

Type Select Virtual.

Class Select Analog.

The Point Properties screen appears.
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13. On the Virtual tab, provide these details:

Field Description

Initialization Select Initialized.

Initial value Enter 0.

Calculation Select Equation and build an expression. For more
information on calculation types, refer to the Configure
Virtual Calculations topic in the CIMPLICITY help
guide.

14. On the Alarm tab, provide these details:

Field Description

Alarm message Select Point ID. For more information on alarm
message variables, refer to the Enter an Alarm
Definition topic in the CIMPLICITY help guide.

Alarm limits Enter the alarm limits. For example:
• HiHi: 60
• Hi: 40
• Lo: 20
• LoLo: 10

15. Select OK to save and close the Point Properties screen.

16. Repeat steps 6-10 to create more device points.

17. Run the CIMPLICITY project.

• Create a data source with OPC UA configuration (page 250) in Operations Hub.
• Use the alarm card (page 396) and alarm count (page 406) widgets in your application.
• Acknowledge Alarms (page 405).
• Apply Filters to View Alarms (page 403).
• Configure iFIX for Alarms (page 399).

Related tasks
Configure CIMPLICITY for Mimics (page 414)

Apply Filters to View Alarms

Apply conditions to filter and display alarms.

You can use filters to narrow down your search for the exact alarm information you want to view.

https://www.ge.com/digital/documentation/cimplicity/version111/oxy_ex-2/project_setup/topics/g_cimplicity_project_setup_step32_configure_virtual_calculations.html
https://www.ge.com/digital/documentation/cimplicity/version111/oxy_ex-2/project_setup/topics/g_cimplicity_project_setup_step32_configure_virtual_calculations.html
https://www.ge.com/digital/documentation/cimplicity/version111/oxy_ex-2/project_setup/topics/g_cimplicity_project_setup_step411_enteran_alarm_definition.html
https://www.ge.com/digital/documentation/cimplicity/version111/oxy_ex-2/project_setup/topics/g_cimplicity_project_setup_step411_enteran_alarm_definition.html
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Table 12. Filter Criteria for Alarms

Field Description

View Alarms By Use the toggle to switch between these states:

• Set to All if you do not have an asset model. You can
filter alarms from all the available data sources.

• Set to Context if you have an asset model. From the
breadcrumb, navigate to your asset context to filter
respective alarms.

Condition Select any of these conditions to filter and display alarms:

• Acknowledged: Displays only the list of acknowledged
alarms.

• Severity: Displays alarms based on a selected
severity value - critical, high, medium, or low.

• Start Time: Displays alarms based on a selected date
and time.

• Source: Displays only alarms from the selected tag/
source.

• Data Source: Displays only alarms from the selected
data source.

Operator Select an operator to describe the relationship between
the condition and the value. Based on the selected
condition, the following operators are available: Equal,
NotEqual, GreaterThan, GreaterOrEqual, LessThan,
LessOrEqual, Contains, NotContains, etc.
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Field Description

Value Select the value you want to filter. Values for filtering
alarms are populated based on the selected condition and
operator.

If condition is data source, it takes about 30 seconds to
initially populate the list of available OPC UA data sources
in your system. In case you deleted a data source from
your system, the deleted data source still appears in the
Value drop-down list. To clear deleted data sources,
restart these services in the following order:

1. GE Operations Hub WebHMI Tomcat Web Server
2. GE OpHub Data Distributor

+ Add Filter Select to insert a new filter criteria. Use the And, Or
operators to describe the relationship between two or
more filter criteria.

Reset Select to clear all the filters. To clear individual filters,

select  next to the filter you want to delete.

Apply Select to apply the filters and display only alarms that
match the filter criteria.

Acknowledge Alarms

Alarms are acknowledged in the HMI/SCADA system.

Alarms are displayed based on the applied filter conditions (page 403). You have the option to
acknowledge,

• all the alarms at once
• only the specific number of alarms listed per page
• only the selected alarms

Configure iFIX (page 399) or CIMPLICITY (page 401) to be able to acknowledge alarms.

1. To acknowledge only selected alarms:

a. Select the rows for the alarms in the table.
To unselect, select the row again.

b. Select Acknowledge Selected.
A confirm dialog appears.

c. Select Acknowledge to confirm.

2. To acknowledge all the alarms listed on a page:

a. Select Acknowledge Page.
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A confirm dialog appears.

b. Select Acknowledge to confirm.
Only alarms on the specific page are acknowledged.

3. To acknowledge all the alarms at once:

a. Select Acknowledge All.
A confirm dialog appears.

b. Select Acknowledge to confirm.
All the displayed alarms for the applied filter condition are acknowledged.

A check mark  appears for the acknowledged alarm in its Ack column. The alarm severity icon

also indicates a check mark  if successfully acknowledged in the HMI/SCADA system.

Alarm Count

This widget provides only the count of alarms per severity level for all the assets in a model.

You can use the alarm count widget when you want to provide only a summary of alarms in your
application.

The alarm count widget is available under Integration > HMI. When designing application pages

(page 262), drag and drop  to a container. The alarm count is displayed as a banner at
runtime with the number of alarms currently active for the severity level.

Mimic Card

A mimic card provides a specific view of a process diagram associated with an asset. This allows you
to monitor and control production equipment and processes.

The mimic card widget is available under Integration > HMI. When designing application pages

(page 262), drag and drop  to a container.
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The mimic card also allows you to update values during runtime (page 418), and get results
immediately.

You can use the mimic card with or without a model. When not using a model, create pages and
assign direct tags.

Table 13. Mimic Card Properties

Property Description

Asset Name (Optional Override) Provide the asset name for which you want to replace its
currently assigned mimic.

Note:  You can opt to override either an asset name
or a mimic name. If you attempt to override both, only the
asset name is considered.

Mimic Name (Optional Override) Provide the mimic name to replace the currently assigned
mimic. The new mimic must use only direct tags (not
model-based) for its data sources. Also, the new mimic
cannot use click-target navigation as the mimic has no
context for navigation when loaded in this manner.

Note:  If you do not specify an override for both
the asset name or mimic name, then the mimic from the
selected asset context in a breadcrumb is considered.
When not using the breadcrumb in an application, it is
mandatory to provide an override either for the asset
name or the mimic name.

Height Allows to set the height of the widget at runtime. You can
set the values in percent or pixels. For example, 100%,
50%, 300, etc.
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Configure iFIX for Mimics

When using the iFIX HMI/SCADA system as your data source, follow this quick walkthrough to
successfully get mimics into Operations Hub.

Install iFIX and Operations Hub on different servers or on the same server.

Note:  You can display booleans and enumerations as strings in your mimics. When creating the
mimic, use the A_CV attribute on your data sources. If you use F_CV, numeric values are rendered.
For inline edits, only booleans currently support selecting a value via a dropdown box.

1. Log in to Proficy iFIX and perform these tasks:

a. Go to C:\Program Files (x86)\GE\iFIX and open the secmgr.clr.dll.config file
in a notepad.

b. Save the dll file after verifying and updating these details:
Ensure that uaa_oauthHost points to the UAA server that provides the authentication
services. If default UAA server is installed with Operations Hub, this will generally be the
hostname (short or FQDN) used during Operations Hub installation.
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c. Create pictures supporting the Operations Hub objects. To make an object a click target in
a Operations Hub mimic, set its is selectable property to true.

d. To enable an operator to update an iFIX data source tag on a picture and answer an update
confirmation question, access the Datalink screen and select the source tag. In the Data
Entry section, select In-Place in the Type field, and then select the Confirm check box, as
shown below.

e. In the iFIX Tools Ribbon, select Publish to Operations Hub to export selected pictures
in GRF format in to a Picture folder as shown below. These GRF files are exported in to
JSON ZIP files. These pictures become mimics (process diagrams) that you associate with
asset object types in Operations Hub.

f. Verify the values in the Advanced section of the Configure iFIX OPC AE Server
screen conform to the OPC A&E specification guidelines and use the Operations Hub
default dividing point values to separate the alarm severity ranges, as explained in Alarm
Microservice.
The following provides a sample Configure iFIX OPC AE Server screen.

https://www.ge.com/digital/documentation/webhmi/r_wh_alarm_microservice.html
https://www.ge.com/digital/documentation/webhmi/r_wh_alarm_microservice.html
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2. Log in to Operations Hub.

3. Create a data source with OPC UA configuration (page 250) in Operations Hub.

Note:  The datasource name should match the iFIX node name.

4. Import the mimic (page 240).

5. Create an application (page 117).

6. Create application pages (page 262) for Alarm card (page 396) and Mimic Card (page
406).

7. Run the application and check to see if mimics are working.

Related concepts
Reference a Model Property in an Animation (page 410)
Using the Operations Hub Toolbox (page 411)
Controlling Data Sources in a Picture by Group Selection (page 411)
Automatically Binding Child Assets to Click Zones using Group Names (page 412)

Reference a Model Property in an Animation

You can reference a model property within an animation.
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To reference a model property in an animation, you must type @ (at sign) at the beginning and at the
end of the property name. This allows the Operations Hub software to differentiate the property name
from ordinary text.

Example:

To enter a reference in an animation to the pump1.speed property in the model:

1. Enter the following in the Fill Expert as the Fill Data Source: @pump1.speed@
2. Export the picture using the Export Web HMI Picture utility. The following line appears in the

JSON file: "tag": "@pump1.speed@"

Using the Operations Hub Toolbox

The Operations Hub Toolbox contains buttons for objects and picture composition tools that allow
you to quickly create high performance HMI pictures. You can click and drag the Operations Hub
Toolbox to a position anywhere on your picture, or click and drag one of its edges to resize it.

The Operations Hub Toolbox automatically appears by default when high performance HMI graphics
are enabled under User Preferences > General.

You can disable the Operations Hub Toolbox by toggling the Toolbox button on the Tools tab in the
Operations Hub group of the WorkSpace ribbon.

The following table lists the names of the Operations Hub Toolbox buttons. The layout of the cells
in this table mimics the layout of the corresponding buttons in the Operations Hub Toolbox. A
description of each button can be found in the Creating Pictures ebook.

Pointer
Selection

Cut Copy Paste Rectangle Rounded
Rectangle

Oval Chord Polygon Pie

Arc Line Polyline Line
Connector

Right
Line
Connector

Text Datalink
Stamper

Bitmap Set Color Toggle
Grid

Space
Evenly
Vertical

Space
Evenly
Horizontal

Align Top Align Left Align
Bottom

Align
Right

Align
Horizontal
Center

Align
Vertical
Center

Group Ungroup

Bring to
Front

Send to
Back

Set Layer Display
Layer

Fill
Expert

Rotate
Expert

Foreground
Color
Expert

Visibility
Expert

Undo --

Controlling Data Sources in a Picture by Group Selection

Operations Hub allows you to write to tag values associated with an asset’s properties in the Asset
Model. It is possible to define a group of objects in a picture that can be selected at runtime, resulting
in a control card appearing in which the operator can write to controllable properties of a given asset.

https://www.ge.com/digital/documentation/ifix/version65/index.html#creating-pictures/drwcover.htm?TocPath=Creating%2520Pictures%257C_____0
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This is accomplished with the IsSelectable property in the exported picture JSON file, which is
only exported for iFIX Group objects that have Enable Select enabled in iFIX pictures.

With traditional iFIX pictures, selecting the Enable Select property allows an object to be selected in
the runtime environment.

With iFIX pictures that are intended for export to Operations Hub, selecting the Enable Select
property of a group designates that group as a "click zone" in that picture. A click zone allows
properties of a certain asset to be controlled or modified by writing to the associated iFIX tags. When
you click on a selectable group that has an asset associated with it, a control card opens to show the
current values for a specified set of properties for that asset. Both controllable and non-controllable
properties display, based on the configuration of the properties. (Controllable properties are indicated
with a gear icon.) Clicking on the control card changes it to Edit view. Edit view allows you to enter
new values for those properties. The new values are written to the iFIX database tags when the
Confirm button is selected.

Automatically Binding Child Assets to Click Zones using Group Names

When creating the iFIX picture for a certain asset type, specifying a selectable group’s name in a
certain way results in the click zone being automatically associated with a child asset without further
configuration once the exported iFIX picture is associated with an asset type.

In order to take advantage of this automatic click zone binding, the group name must be the same as
the child asset’s property name in the GE Operations Hub Asset Model. Each child asset in the model
hierarchy is represented as a property of a parent asset. In order for the automatic binding to associate
a click zone with a certain child asset, the group name must exactly match the name of the desired
child asset property and the exported iFIX picture must be associated with the parent asset.
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Example:

For example, say you have an asset type named StorageTank, which has two child asset properties
defined in the model, – InletPump and OutflowPump, of asset type Pump. When creating an iFIX
picture for the StorageTank asset type to use with GE Operations Hub, you can automatically enable
the control card for each of these child assets by:

1. Creating a selectable group of objects within the iFIX picture for each of the child assets.
2. Naming these groups InletPump and OutflowPump. These are the child asset property names

as defined in the asset model, (not the child asset instance names for a certain instance of
StorageTank).

3. Exporting the iFIX picture from WorkSpace.
4. Importing the exported picture to GE Operations Hub and associating it with the StorageTank

asset type (assuming that the asset model has already been created/imported).

After doing this, navigating to any StorageTank in GE Operations Hub at runtime and viewing the
HMI display allows an operator to click on either of these groups of objects to display the control
card for that child asset – without the need to navigate to that child asset. This allows control of child
assets while in the context of a parent asset.

Rules for Automatic Binding of Group Names

• You must name the group the same as the child asset property of an asset type.
• Only child or other descendant assets of a given asset type can be bound to a click zone in a

picture associated with that asset type.
• You can access the control card for grandchild assets and below by using double underscores

(__) in the group name to separate each asset level. For example, if the above Pump asset type
had a child asset property named RestrictionValve, a click zone could be auto-bound to this
grandchild asset from the StorageTank picture by defining a selectable group with the name
InletPump__RestrictionValve or OutflowPump__RestrictionValve. This shows the control card
for one of these RestrictionValves, depending upon which name you used.

• You can display the control card for the asset type that is associated with the IFIX picture,
rather than one of its descendants, by naming the selectable group the same as the asset type.
In the previous example, naming a selectable group StorageTank would result in the click zone
displaying the control card for the StorageTank itself when that group is selected at runtime.

Note:  It is not necessary to name the selectable groups in a certain way for them to be
able to show the control card for an asset. It is only necessary in order to take advantage of the
automatic binding feature. If you do not name them in this way, the click zones will still be
selectable at runtime in GE Web HMI, but will require further configuration in GE Operations Hub
Administration in order to associate them with the desired assets for control at runtime.
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Configure CIMPLICITY for Mimics

When using the CIMPLICITY HMI/SCADA system as your data source, follow this quick
walkthrough to successfully get mimics into Operations Hub.

• Install the latest versions of CIMPLICITY and Operations Hub on different servers or on the
same server.

• Create an administrative user that you can use for both CIMPLICITY and Operations Hub. The
user IDs must match in order to connect and manage communications and operations between
the two systems, but the passwords must be different.

By integrating Operations Hub and CIMPLICITY, you can view CIMPLICITY data in Operations
Hub using screens called mimics that were created in CimEdit.

Note:  You can display booleans and enumerations as strings in your mimics. When creating the
mimic, use the .Value attribute on your data sources. If you use .$RAW_VALUE, numeric values are
rendered. For inline edits, both booleans and enumerations display a dropdown box with the possible
values.

1. Start the CIMPLICITY Workbench application.

2. From the Workbench toolbar, go to File > New > Project and create a new project.

3. After creating the project, go to Project > Properties.
The Project Properties screen appears.

4. On the OPC UA Server tab, perform these steps.
a. Select the check box for Enable Server.
b. Select Security Configuration, then select the check box for all the security options you

want to enable for the OPC UA server.

5. On the Operations Hub tab, perform these steps.

a. Provide the following details:

Field Description

Server name Enter the name of the Operations Hub server to
connect.

Port Enter the port number for Operations Hub UAA. For
example, 443.

User name Enter the account username that has permission to
access the Operations Hub application.

b. Select the check box for Require trusted connection.

c. Select View Certificate and if Untrusted, select Trust.

https://www.ge.com/digital/documentation/cimplicity/version111/oxy_ex-2/project_setup/topics/g_cimplicity_project_setup_createa_new_project.html
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The certificate gets added to the CIMPLICITY project's \data\WebHMIpki
\server_certs folder. The certificate status now appears as Trusted.

d. Copy the certificate files from the CIMPLICITY project's \data\WebHMIpki
\server_certs folder, and paste them to the project's \data\WebHMIpki
\trusted_issuers folder.

6. In the CIMPLICITY project, create a TPump class with an alarm enabled.

7. Create a Pump01 object that corresponds to the class.

8. Create a visual representation (PumpMimic) of the TPump on the CimEdit screen.

9. On Properties, enter $Object in the Variable column. CIMPLICITY uses this value to
reference the context in the Operations Hub model, which is the TPump in this example.

10. On Text, type ($Object).OnOff in the Display value Expression field. This value represents
the OnOff value on the TPump object type in the Operations Hub model.
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11. To export or publish the mimic, right-click on the CIMPLICITY screen and select Publish to
Operations Hub.

12. In Operations Hub, do the following:
a. Create a data source with OPC UA configuration (page 250) in Operations Hub.
b. Import the mimic (page 240).
c. Associate the mimic to the TPump object type (page 241).
d. Create an application (page 117).
e. Create application pages (page 262) for Alarm card (page 396) and Mimic Card (page

406).
f. Run the application and check to see if mimics are working.

Related reference
Referencing Data in CimEdit Screen Animations (page 416)

Referencing Data in CimEdit Screen Animations

You can use the following two methods to reference data in CimEdit screens that will work in
Operations Hub mimics.

Important:  The CIMPLICITY OPC UA Server does not support enterprise points; therefore,
they are not supported in exports for Operations Hub.  If you use enterprise points in your
CIMPLICITY screens, they will not be available in the imported Operations Hub mimic.
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Method Description

Method 1 Continue to directly reference your CIMPLICITY point database in your animations – This
method retrieves data directly from CIMPLICITY and shows the values of the points in the
database. This is often useful when referencing data that is global to or outside of the model
context you build in Operations Hub. For example, OverallPartCount.

Method 2 Reference model context-based data that resolves in accordance with the model context
you are in when you display the mimic in Operations Hub. This is the most powerful way
to use Operations Hub mimics because it allows you to create screens as templates using
CIMPLICITY’s existing local variable mechanisms that resolve at Operations Hub runtime.
For example, if you have created a Operations Hub object type to represent a pump and
created 2 pumps objects from that type, you can build one screen in Operations Hub to
represent the pump object type, and then have the data resolve and appear in that screen/
mimic based on the Pump instance that is selected.

You can reference both direct CIMPLICITY database points and context references in the same
screen.     

Use the $OBJECT local variable to reference context-based data. You must define this variable at the
screen level and leave the value blank when you export the screen as a mimic for Operations Hub.
You can use this local variable to represent the model context with which this screen is displayed.
For example, a pump screen is shown when in the Pump01 or Pump02 context.

Note:  You should build the model in Operations Hub before you build Operations Hub mimics
in CimEdit. If you reference model object variables using the same names, Operations Hub can
automatically map your model context references in your animations to the model when you import
the mimic into Operations Hub.

Example 1: Referencing Contained/Child Model Object Variables

When in the Inlet pump context, the animation shown below displays the value of Inlet Pump’s flow.
If on the Outflow Pump context, this same screen will show Outflow Pump’s flow.

$Object.Flow
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Example 2: Referencing Contained/Child Model Object Variables

You can also reference contained object properties in your Operations Hub mimics that will be
exported from CimEdit.  For example, if I want to build an overview screen to show two pumps in
my pump station, then I  can build a CimEdit screen where the $Object  represents PumpStation01
and I reference my animations to show the individual pump values as follows:

{$Object}.InletPump.Flow

{$Object}.OutflowPump.Flow

Example 3: Referencing CIMPLICITY Point Attributes in Operations Hub
Example

You can continue to reference CIMPLICITY attributes like engineering units, description, alarm
limits, and so forth, in Operations Hub screens on direct point references and model context
references as follows:

{$Object}.Flow.Description or

{$Object}.InletPump.Flow.EU_LABEL

Using Linked Objects to Generate Operations Hub Screens

In order to build Operations Hub screens using linked objects, any Linked Object local variables that
are used to reference Operations Hub Object variables must eventually resolve back to the screen
$Object variable in which they are placed. When you create the source of a linked object, you create
a public “$Object” local variable in your source group object. Use this $Object local variable to
reference Operations Hub model variables.

For example:

{$Object}.Flow

When you create a linked object from this source group object, you set the value of the inherited
$Object local variable to point to the screen $Object defined in the screen in which you created the
linked object using local variable syntax like  {..\$Object} or {..\$Object}.InletTank”

Update Values on Mimic Cards

When configured, you can modify values in the HMI/SCADA data source directly on mimic cards.
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You must have permissions in the HMI/SCADA data source to perform this task.

1. Hover over the value you want to update on the mimic card.
If the background of the value changes to blue, you can update the value.

2. Enter the new value in its entirety and press Enter or select the value from a drop-down list.
If you specify an invalid value in any entry box on the mimic card, the box becomes outlined in
red.

3. Optional: For mobile devices:

a. Select the entry field whose value you want to update. If its background changes to blue,
you can edit this value, as shown below:

b. Select the entry field again and specify the new value or select it from a drop-down list.

c. Optional: Click outside the field if you do not want to update the current value.

d. If an update confirmation window appears, answer accordingly.

4. If an update confirmation window appears, answer accordingly.
An error can occur when you are not connected to the data source, you do not have permissions
to write to your data source, or you entered a numeric value not within the acceptable minimum
and maximum range for that value.
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Solid Gauge

Use the widget to insert circular charts and monitor the status of industrial systems.

You can use both thin and thick gauges of these types:

• Half
• Three-fourths
• Full

The solid gauge widget is available under Integration > Display. When designing application pages

(page 262), drag-and-drop  to a container.

Table 14. Solid Gauge Properties

Property Description

Title Enter a title to help identify the solid gauge at runtime.

Engineering Unit Enter the unit of measurement for the values on the
gauge.

Width (px) (0 equals Dynamic) Enter a width for the solid gauge. If set to 0, the widget
occupies 100% of its container, and fills the area in the
application.

Background Color Select a background color (page 452) to fill the widget.

Font Color Select a font color (page 452) for the widget text.

Font Size (px) (0 equals Dynamic) Specify a font size in pixels for the solid gauge display
text. If set to 0, the font resizes to match with the width of
the widget.

Min Enter the minimum value for the solid gauge scale.

Max Enter the maximum value for the solid gauge scale.

Number of decimals Enter the number of decimal places to format values.

Sparkline The sparkline data is created based on the query applied
to the widget. We can see a sparkline only if the query
returns multiple records from the data source. The
sparkline is not displayed for a single record even if it is
enabled.

Select the check box to enable the sparkline for the
selected Gauge Variant at runtime.

Gauge Variant List of different types of guages you can use in your
application.
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Property Description

Text position Select a position to display text for the solid gauge at
runtime.

• Top Left is the default position.
• You can choose to position the text at the Center of

the gauge.

Range(s) You can specify one or more ranges to display in different
colors.

1. Select +Add Item.
2. Enter a value for limit. At runtime, the gauge is

displayed in the selected color on reaching this value.
3. Select a color (page 452) for the range limit.

4. Use  and  to reorder ranges. The ranges are
implemented in the specified order.

5. Select  to delete a range.

Alert Limit(s) You can add one or more alerts on a gauge, each with
unique values.

1. Select +Add Item.
2. Enter a value for limit. At runtime, a line alert is

displayed on the gauge on reaching this value.
3. Select a color (page 452) to identify the line alert.

4. Use  and  to reorder alerts. The alerts are
implemented in the specified order.

5. Select  to delete an alert.

Value To get values for the widget from a data source, use any
of these options:

• Select a query output.
• Select a global parameter.
• Enter source data manually.
• Add a formula.

Result Set Index This property is applicable for REST queries only. It allows
to define which index of the result set the widget should
use as input data. Default is 0.

For example, consider a Historian REST query that
returns data for three tags.

• If you want the widget to use the first tag data from
the query result set, then set the index value as 0.

• To direct the widget to use the second tag data, enter
the index value as 1.

• Similarly, you can set index values as 2, 3, 4, etc.
based on the data to provide as input to the widget.
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Property Description

Reverse Order This property helps to reverse the query result set.

Select the check box to provide the bottom record value
as input to the widget.

Clear the check box to provide the top record value as
input to the widget.

When you apply this property to REST queries that return
more than one record for each input tag, the records of the
selected tag (use Result Set Index to select the tag) are
reversed.

For example, consider a Historian REST query with
two input tags (tag1 and tag2); each with 100 records
as result. Set the Result Set Index as 0 and verify the
following:

• If you selected the Reverse Order check box, then
the 100th record (last) value of tag1 is displayed on
the gauge.

• If you cleared the Reverse Order check box, then the
first record value of tag1 is displayed on the gauge.

Solid Gauge at Runtime

The change in values are indicated with changing colors.

Timeline

Use the timeline widget to visually monitor the progress of your events.

Generally used for time-based events, the timeline widget can monitor the status of a machine and
update the events that occurred over a time period. It can capture data on how long a machine was
running, or remained in an idle state. To visualize multiple events against a single time period, add
multiple timelines aligned to the same X-axis on a chart.
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The timeline widget is available under Integration > Charts. When designing application pages

(page 262), drag-and-drop  to a container.

The following list of properties are specific to this widget. For common properties, refer to Page
Components (page 445).

Table 15. Timeline Properties

Property Description

BEHAVIOR > Event Selected Trigger actions on the timeline selected event.

Title Enter a title to help identify the timeline at runtime.

Font Color Select a font color (page 452) for the widget text.

Show Border Select the check box to add a border to the timeline
widget. A border frames the widget and provides a clean
look.

Border Color Select a color (page 452) for the border.

Show X-axis Labels Select the check box to show the X-axis ticks on the
widget at runtime. Clear the check box to hide the ticks.

Width Enter a width for the timeline widget.

Height Enter a height for the timeline widget.

Event Table Datasource The event table helps to match the colors and labels. It
enables the widget to assign a specific color and label to
an incoming event.

When a value from the result set (page 424) matches a
value from the event table, then the configured color and
label applies to that entry. You can configure an event
table either manually (page 424), or get data from a data
source.

Select the output fields in this order:

• Value
• Label
• Color

Use any of these options to get data from a data source:

• Select a query output.
• Select a global parameter.
• Enter source data manually.
• Add a formula.

Note:  Currently, we only support the option to use a
query output to retrieve data.

Point Primary Color Serves as the first color in the zebra striped color pattern.
Select a primary color (page 452) to apply to the timeline
event table if not retrieving values from a datasource.
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Property Description

Point Secondary Color Serves as the second color in the zebra striped color
pattern. Select a secondary color (page 452) to apply
to the timeline event table if not retrieving values from a
datasource.

Event Table Manual You can create event table entries manually. In the
absence of an Event Table Datasource, these entries are
used for retrieving data for the timeline events.

• Select +Add Item to create an event table entry.
• For each event table entry, enter these details:

◦ Value
◦ Label
◦ Color

Events that do not match an entry from the event table are
assigned the Point Primary Color or Point Secondary
Color.

Datasource Values Configure one or more data sources to get values for the
timeline widget. When you add multiple data sources, you
get a single view for multiple timelines all aligned to the
same X-axis. It allows you to compare data at different
time intervals. To configure a data source:

1. Select +Add Item.

Note:  You must add an item even if you want to
drag and drop the data to bind to the widget.

2. Enter a Name to identify the data source at runtime.

The name is shown next to the timeline and on the
tooltip. If you do not provide a name for the data
source, the query name appears on the tooltip.

3. Use any of these options to get data from a data
source:

• Select a query output.
• Select a global parameter.
• Enter source data manually.
• Add a formula.

You must select timestamp as the first value followed
by other values. Select the output fields in this order:

• Datetime
• Value

Note:  Currently, we only support the option to use a
query output to retrieve data.

Input Datetime Format Select from local or UTC.

Start Sample Select the Enable check box to insert an event at the start
of the timeline. Then, specify the start timestamp.
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Property Description

Datasource Start Timestamp Use any of these options to provide start timestamp values
from a data source:

• Select a query output.
• Select a global parameter.
• Enter source data manually.
• Add a formula.

Datasource Start Value Use any of these options to provide event value at the
start (after timestamp) from a data source:

• Select a query output.
• Select a global parameter.
• Enter source data manually.
• Add a formula.

End Sample Select the Enable check box to insert an end time for
the last event on the timeline. Then specify the end
timestamp.

Datasource End Timestamp This is the final timestamp for the last event in the query.
It is required to specify an end timestamp to get all the
values from last queried batch on display.

Use any of these options to provide end timestamp values
from a data source:

• Select a query output.
• Select a global parameter.
• Enter source data manually.
• Add a formula.

Output Targets You can configure output targets for a selected event.
At runtime, these targets trigger only on selecting the
respective event.

• Select +Add Item to configure an output target.
• Select an Output Value. The available values are

Start Local Time, Start Local Time ISO, Start UTC
Time, Start UTC Time ISO, End Local Time, End
Local Time ISO, End UTC Time, End UTC Time ISO,
Value, and Label.

• To specify a target source/tag, use a query or global.

You can add one or more output targets for an event.

• Use  and  to reorder output targets. The output
targets are implemented in the specified order.

• Select  to delete an output target.
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Timeline at Runtime

Sparkline

Generate simple sparkline charts to visualize data trends.

Use the sparkline widget to create compact and easy to understand line charts. Configure
sparkline properties to insert inline lightweight charts. The sparkline widget is available under
INTEGRATION > CHARTS. When designing application pages (page 262), drag-and-drop
GESparkline to a container.

The following list of properties are specific to this widget. For common properties, refer to Page
Components (page 445).

Table 16. Sparkline Properties

Property Description

Title Enter a title name for the sparkline. This name helps to
identify the sparkline chart at runtime.

Engineering Unit Enter the engineering unit of measurement for values.

Height - 0 equals 100% Set the height in pixels. If set to 0, the sparkline chart
occupies 100% of its container.

Font Color Select a font color for the title name, current value, and
engineering unit.

Font Size (px) (0 equals Dynamic) Set the font size in pixels. If set to 0, the font size
becomes dynamic, which means the font is resized based
on the height of the widget.

Line Color Select a color for the line.

Line Width Enter a value in pixels that defines the thickness of the line
in the chart.

Number of decimals Enter the number of decimal places to format values.

For 1 decimal place, the value is rounded off to the
nearest tenths; for 2 decimal places, the value is rounded
off to the nearest hundredths, so on.
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Property Description

Source - Value Use any of these options to provide values for sparkline.
The only output field should be Value.

• Select the Query tab to choose from queries that
return Value as output.

• Select the Global tab to choose from output fields
available as global parameters.

• Select the Manual tab, and enter the value in the text
field.

• Select the Formula tab to add a formula that returns
an Value as output.

Result Set Index This property is applicable for Historian REST queries
only. It allows to define which index of the result set the
widget should use as input data. Default is 0.

For example, consider a Historian REST query that
returns data for three tags.

• If you want the widget to use the first tag data from
the query result set, then set the index value as 0.

• To direct the widget to use the second tag data, enter
the index value as 1.

• Similarly, you can set index values as 2, 3, 4, etc.
based on the data to provide as input to the widget.

Reverse Sorting Order This property is applicable for Historian REST queries
only. It helps to reverse the query result set.

Select the check box to provide the bottom record value
as input to the widget.

Clear the check box to provide the top record value as
input to the widget.

When you apply this property to REST queries that return
more than one record for each input tag, the records of the
selected tag (use Result Set Index to select the tag) are
reversed.

For example, consider a Historian REST query with
two input tags (tag1 and tag2); each with 100 records
as result. Set the Result Set Index as 0 and verify the
following:

• If you selected the Reverse Order check box, then
the 100th record (last) value of tag1 is displayed on
the sparkline.

• If you cleared the Reverse Order check box, then the
first record value of tag1 is displayed on the sparkline.

Pareto Chart

Plot a pareto chart for qualitative analysis of your data.
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You can use this widget to run a pareto analysis on your data. A pareto chart is a combination
of colums/bars and a line graph. The colums/bars represent individual values, and are arranged
in a descending order. The pareto line represents the cumulative total of the values. This visual
arrangement helps to identify the most important factors in a given dataset in order to make critical
decisions.

The pareto chart widget is available under INTEGRATION > CHARTS. When designing
application pages (page 262), drag-and-drop GEParetoChart to a container.

The following list of properties are specific to this widget. For common properties, refer to Page
Components (page 445).

Table 17. Pareto Chart Properties

Property Description

Title Configuration

Name Enter a title name for the pareto chart. This name helps to
identify the pareto chart at runtime.

Font Size (px) Set the font size for the title text in pixels.

Font Color Select a font color for the pareto chart text.

Width (px) - 0 equals dynamic If set to 0, the pareto chart occupies 100% of its container.

Height (px) Set a height for the pareto chart in pixels.

Label Configuration

Y-Axis Label Enter a label name for the Y-axis, which is displayed at
runtime.

Axis Label Font Size (px) Set the font size for the y-axis label name text in pixels.

Line Configuration

Width (px) Enter a value that defines the thickness of the pareto line
in the chart.

Color Select a color for the pareto line.

Series Configuration

Variant Both variants are used to compare two or more values,
wherein the length of the column/bar is proportional to the
data value. Select between:

• Column: Inserts vertical columns to represent data in
the chart. Use this variant for larger data sets.

• Bar: Inserts horizontal bars to represent data in the
chart. Use this variant if your chart titles are long.

Color Select a color for the columns/bars in the chart.
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Property Description

Source - Data Source To provide values for the pareto chart, select the Query
tab to choose from queries that return output fields for the
x-axis and y-axis data:

1. Reason (String)
2. Frequency/Occurrence (number)

Note:  Currently you can pass values to the widget
using a query only.

Value Display

Use this widget to display any type of data value.

The value display widget is available under INTEGRATION > DISPLAY. When designing
application pages (page 262), drag-and-drop GEValueDisplay to a container.

The following list of properties are specific to this widget. For common properties, refer to Page
Components (page 445).

Table 18. Value Display Properties

Property Description

Title Enter a title for the widget, which is displayed at runtime.

Engineering Unit Enter the engineering unit of measurement for the values,
which is displayed at runtime.

Height Set a height for the value display widget in pixels.

Width Set a width for the value display widget in pixels.
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Property Description

Padding Enter a value that defines the space between the content
and the widget's borders.

Background Configuration

Options Choose from:

• Select Transparent to apply a transparent
background for the widget.

• Select Color to apply a colored background for the
widget.

Color If you opted for a colored background, specify a color for
the background.

Border Configuration

Width 0 implies that the widget has no border.

1 implies that the widget has a border. With every
increasing value, the thickness of the widget's border is
determined.

Radius 0 implies that the widget has no round corners.

1 implies that the widget has a round corner. With every
increasing value, the curve at the corners are determined.

Color Applies a color to the widget's border.

Font Size Enter a font size for the widget's Title and Current value
and EGU.

Font Color Select a font color for the widget's Title and Current value
and EGU.

Font Style Select a font style for Title and Current value and EGU,
whether normal, bold, or italic.

Rotate Allows to rotate the widget based on the selected degree
of rotation.

Align

Text Allows to align the text left, right, or center within the
widget.

Horizontal Allows to align the widget left, right, or center within its
container.

Vertical Allows to align the text either at the top, middle, or bottom
of the widget.
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Property Description

State Configuration You can configure how the widget should appear
whenever there is a change in its status. Use any of these
options:

• Select the Query tab to specify a query, which returns
output values that indicate the status change. The
query should include these output fields - value,
operator, textColor, borderColor, background,
backgroundColor, and blinking.

• Select the Global tab to choose from values that are
available as global parameters.

• Select the Manual tab, and enter the values for all
fields in the text field. However, if you are manually
entering values, then it is recommended to use the
Manual State property.

• Select the Formula tab to add a formula that returns
output values to indicate the status change.

◦ Select Add Formula > Add text.
◦ Enter the values for all fields in the text field.
◦ Select Done to save and add the formula to the

value display widget.

Example: For Global, Manual, and Formula, you can
paste the following sample code in the text field:

[
   {
      "value": "130000",
      "operator": ">=",
      "textColor": "red",
      "borderColor": "green",   
      "background": "color",
      "backgroundColor": "blue",
      "blinking": true
   }
]



Operations Hub for Windows | 3 - User Guide | 432

Property Description

Manual State You can manually configure each field (instead of applying
a query) how the widget should appear on reaching a
specified value. Select +Add Item and provide these field
values that help to indicate the change:

• Enter a threshold Value, and select an Operator for
comparison. For example, consider the value is 100
and operator is =. It means that when the widget value
is equal to 100, the following changes apply to the
widget.

• Selected Text Color and Border Color are applied.
• Background, if not transparent applies the selected

Background Color.
• If selected, applies Blinking animation on the widget

when the value is equal to 100.

You can configure several manual states using +Add
Item.

• Use  and  to reorder manual states.

• Select  to delete a configured manual state.

Value Configuration You can configure the values on how they should appear
at runtime.

• Select a Format for the value, whether the value
should be a number or string.

• If value is a number, specify the Number of decimals
for the value. If value is a string, decimals do not
apply.

Value Use any of these options to provide data source values for
the widget.

• Select the Query tab to choose from queries that
return data source values as output.

• Select the Global tab to choose values that are
available as global parameters.

• Select the Manual tab, and enter the value in the text
field.

• Select the Formula tab to add a formula that returns
data source values as output.
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Property Description

Result Set Index This property is applicable for Historian REST queries
only. It allows to define which index of the result set the
widget should use as input data. Default is 0.

For example, consider a Historian REST query that
returns data for three tags.

• If you want the widget to use the first tag data from
the query result set, then set the index value as 0.

• To direct the widget to use the second tag data, enter
the index value as 1.

• Similarly, you can set index values as 2, 3, 4, etc.
based on the data to provide as input to the widget.

Reverse Sorting Order This property is applicable for Historian REST queries
only. It helps to reverse the query result set.

Select the check box to provide the bottom record value
as input to the widget.

Clear the check box to provide the top record value as
input to the widget.

When you apply this property to REST queries that return
more than one record for each input tag, the records of the
selected tag (use Result Set Index to select the tag) are
reversed.

For example, consider a Historian REST query with
two input tags (tag1 and tag2); each with 100 records
as result. Set the Result Set Index as 0 and verify the
following:

• If you selected the Reverse Order check box, then
the 100th record (last) value of tag1 is displayed on
the value display.

• If you cleared the Reverse Order check box, then
the first record value of tag1 is displayed on the value
display.

iFrame

Use the iFrame widget to load content from another website within Operations Hub.

The iFrame widget is available under INTEGRATION > DISPLAY. When designing application
pages (page 262), drag-and-drop GEIFrame to a container.

The following list of properties are specific to this widget. For common properties, refer to Page
Components (page 445).

Table 19. iFrame Properties
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Property Description

Source - URL Use any of these options to provide the URL address of
the website you want to load in the iFrame widget.

• Select the Query tab to choose from queries that
return an URL as output.

Note:  If the query output returns an array with
multiple URLs, then the first URL value is taken into
consideration.

• Select the Global tab to choose from URL outputs
available as global parameters.

• Select the Manual tab, and enter the URL address in
the text field.

• Select the Formula tab to add a formula that returns
an URL as output.

◦ Select Add Formula > Add text.
◦ Enter the URL address in the text field.
◦ Select Done to save and add the formula to the

iFrame widget.

Hide Scrollbars If selected, hides the scroll bar. The horizontal and vertical
scroll bars appear only when the content in the iFrame
widget extends beyond the widget's width and height.

Enable Full Width If selected, the iFrame widget occupies 100% of the width
of the container. Enabling this property overrides the
Width (px) set for the widget.

Width (px) If you do not select Enable Full Width, then set a width
for the iFrame widget in pixels.

Height (px) Set a height for the iFrame widget in pixels.

Border Style To apply a border to the iFrame widget, select from any of
the available styles, or select None for no border.

• Solid: Applies a solid border
• Inset: Applies a 3D inset border
• Outset: Applies a 3D outset border

Border Width (px) Enter a value that defines the thickness of the iFrame
border.

Border Color Select a color to apply to the four borders of the iFrame
widget.

iFrame at Runtime
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Note:

• When you print preview a webpage, it may not look like the actual web page. The print
stylesheet formats the web page to print in a user-friendly format.

• Some website URLs may not load within an iFrame due to their security policies.
• To load YouTube videos within an iFrame, use the video’s embed URL.

DataGrid

Use this widget to access advanced features of a table.

The datagrid widget is available under INTEGRATION > DISPLAY. When designing application
pages (page 262), drag-and-drop GEDataGrid to a container.

The following list of properties are specific to this widget. For common properties, refer to Page
Components (page 445).

Table 20. DataGrid Properties

Property Description

Source - Input Use any of these options to provide values from a data
source.

• Select the Query tab. Choose a query and select
output fields to view data on the grid. The data grid
table displays the output field names as column
headers. If Alias is provided for any output field, then
the alias name overrides the column header name.

• Select the Global tab. Choose an output field value
that is available as a global parameter.

• Select the Formula tab. Add a formula that returns
columns as output.

Note:  Currently we do not support manually passing
values to the widget.
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Property Description

Height (px) - 0 equals dynamic Set the height in pixels. If set to 0, the datagrid table
occupies 100% of its container.

Background Color Select a color to apply as a background color to the
datagrid.

Border Color Select a color for the datagrid table border.

Show Borders Select the check box to apply a border to the datagrid
table. To remove the border, clear the check box.

Show Column Lines Select the check box to display column gridlines. To
remove gridlines, clear the check box.

Show Row Lines Select the check box to display row gridlines. To remove
gridlines, clear the check box.

Enable Search Select the check box to add a search field above the
datagrid widget to search the entire table.

Note:  At runtime, consider these limitations for
searching data:

• Partial search is allowed only for string data type.
• To search for numeric, boolean, or datetime values,

enter the complete value to find a match.
• Complete datetime string search does not work for

current date format.

Allow Grouping Select the check box to allow grouping of columns at
runtime.

• The message Drag a column header here to group
by that column is displayed at the top of the table.

• Select the column you want to group by, drag and
drop on the message.

• You can also group data by multiple columns. Drag
and drop columns on the message one after the other
to group data accordingly.

To undo grouping, drag the columns back to their previous
position.

Allow Filtering Select the check box to allow filtering of data in every
column. At runtime, to filter values:

1. Select and open the filter from the respective column
header.

2. Select the check box for the values you want to use
for filtering data.

3. Select OK to apply the filter to the column.
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Property Description

Rows Use these properties to configure datagrid table rows:

• Header Font Size: Set the column header text font
size in pixels.

• Header Font Color: Select a font color for the column
header text.

• Body Font Size: Set the font size for text in the
datagrid.

• Body Font Color: Set the font color for text in the
datagrid.

Add Animation Use this property to highlight a row when a condition is
met. Boolean values are represented with 1 or 0.

This property is similar to Add Cell Animation.

Add Table Column Use this property to customize the datagrid columns (page
435). Select +Add Item to show configuring options.

• Configure column (page 437)
• Configure output target (page 438)
• Add image/icon (page 438)
• Add cell animation (page 438)

To organize table columns:

• Use  and  to rearrange order of columns in the
datagrid.

• To delete a column, select  next to it.

Column Use these properties to configure a column:

• Data Field: Provide the column header name. If an
Alias is configured for the output field for the specific
column, then the alias name overrides the value
specified in this field.

• Data Type: Specify the type of data in the column.
For example, select Picture if the column contains
image URLs and images will be retrieved from the
data source.

• Visible: Select/Clear the check box if you want to
show/hide the column in the datagrid.

• Allow Filtering: Select/Clear the check box to
enable/disable filtering on column.

• Allow Sorting: Select/Clear the check box to enable/
disable sorting by this column.
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Property Description

Output Target Specify the target global data for the colum data. At
runtime, when column data is selected/modified, the target
specified in this property is triggered.

• Choose a query input value as target. (OR) Add or
choose a global value as target.

• Select Unix timestamp format to represent all time
zones at once.

Add Image Use this property to deliver an image when a condition is
met. Boolean values are represented with 1 or 0.

Add as many conditions as required. Each item here
refers to a separate condition.

• Condition: Create a condition for the column data.
For example, if column value is > than 150, then
update an image.

• Image or Font Awesome Icon: Select whether
you want to load an image, or icons from the Font
Awesome Free library.

• URL or Icon name: For image, enter its URL
address. Also ensure that the column (page 437)
Data Type is Picture. For font awesome icon, enter
the icon name.

• Icon Color: Select a color for the icon.

Add Cell Animation Use this property to highlight a cell when a condition is
met. Add as many conditions as required. Boolean values
are represented with 1 or 0.

• Column: Select a column and create a condition for
it. For example, if the value in Column 1 is = to Alarm
1, then trigger these changes.

• Font Color: Change cell text color to the selected font
color.

• Background Color: Change cell color to the selected
background color.

DataGrid at Runtime
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Dropdown

Allows for multi-select, search, and select values.

Use this widget to select between multiple choices, search through a large list of choices, perform
multiple selections, include a header, etc. For a simpler version, use a standard Dropdown (page
292).

The dropdown widget is available under INTEGRATION > GENERAL. When designing
application pages (page 262), drag-and-drop GEDropdown to a container.

The following list of properties are specific to this widget. For common properties, refer to Page
Components (page 445).

Table 21. Dropdown Properties
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Property Description

Source - Dropdown Data Use any of these options to provide values from a data
source to populate the dropdown.

• Select the Query tab. Choose a query that can return
dropdown values as output. Add as many output
fields as required. Here's a sample query response:

{"status":
{"success":true,"code":0,"reason":"Ok"},
"result":[
{"State Data.value":"dd-historian://${his1}/
KALYANMR2_Simulation.Simulation00002","State
 Data.key":"graduate"},
{"State Data.value":"dd-historian://${his1}/
KALYANMR2_Simulation.Simulation00003","State
 Data.key":"school"}
],"more":false}

• Select the Global tab. Choose an output field value
that is available as a global parameter.

• Select the Manual tab. In the text field, enter the
output field value you want to pass.

• Select the Formula tab.
◦ Select Add Formula > Add text.
◦ Enter the output field value in the text field.
◦ Select Done to save and add the formula to the

dropdown widget.

These are the two basic formats to manually enter values
for a dropdown.

[
   {"key1":"abc", "value1" : "1"},
   {"key2":"def","value2":"2"},
]

(OR)

[{"key1": "value1"}, {"key2":"value2"}]

Target - Dropdown Target Use any of these options to specify the target source for
a dropdown value. At runtime, when you select a value
from the dropdown, the value gets assigned to the target
specified in this property.

• Select the Query tab. Choose a query input value as
target.

• Select the Global tab. Add or choose a global value
as target.

Output Format Specify whether the output value should be an array or
string format.
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Property Description

Manual Input You can also use this property instead of using options in
Dropdown Data property.

Manually create values for a dropdown widget:

1. Select +Add Item to add a dropdown item.
2. Enter Display Name and Value.
3. Add as many items as required.

4. Use  and  to rearrange the items order of
display in a dropdown.

5. To delete an item, select  next to it.

Note:  If you configured both Manual Input and
Dropdown Data properties for the widget, then the
dropdown is populated with a list of combined values.
Make sure to validate and rectify your data to avoid
duplicates in the dropdown.

Label Enter a label name that appears above the dropdown
widget. For example, Choose an item

Dropdown Placeholder Enter the placeholder text that appears in the dropdown.
For example, -Select-

Dropdown height (px) Set a height for the dropdown list in pixels.

Multiple selection Allows to select multiple values from a dropdown. If you
select this property, specify the Output Format and
Output Separator.

Max Selections Specify the maximum number of values that can be
selected from the dropdown.

Enable search Select the check box to enable a search option for
dropdown values.

Output Separator By default, multiple values are separated by a comma.
You can also use other symbols like semicolon.

Width (px) (0 equals Dynamic) Enter a width for the dropdown. If set to 0, the widget
occupies 100% of its container, and fills the area in the
application.

Pivot Grid

Pivot grid allows to visualize data in a multi-dimensional format.

Use the pivot grid to arrange your data in a two-dimensional table, and compare tag names and their
columns against timestamps. With the pivot grid, you can:

• Rename rows/columns to replace lengthy tag names
• Apply conditional formatting to rows/columns based on values
• Calculate values quickly using totals
• Sort, filter, and summarize data
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• Export pivot data to Excel

The pivot grid is available under INTEGRATION > DISPLAY. When designing application pages
(page 262), drag-and-drop GEPivotGrid to a container.

The following list of properties are specific to this widget. For common properties, refer to Page
Components (page 445).

Table 22. Pivot Grid Properties

Property Description

Source - Input To enable the pivot grid, provide values from a data
source.

1. Select a query.
2. Select the query output fields you want to use to get

data for the pivot grid.

Height (px) - 0 equals dynamic Set a height for the pivot grid in pixels. If set to 0, the
widget occupies 100% of its container.

Row Header Width (px) - 0 equals dynamic Set a width for the header row in pixels.

Show Borders Select the check box to apply a border to the pivot grid
table. To remove the border, clear the check box.

Allow Sorting Select the check box to sort the rows and columns
alphabetically by default.

Allow Sorting by Summary Select the check box to provide an option to sort the rows
by column.

At runtime, right-click the column you want to sort by and
select the sorting option.

Allow Filtering Row/Column Values Select the check box to provide an option to filter data at
runtime.

Allow Expand/Collapse All Select the check box to enable expand/collapse data
levels at runtime.

Your pivot grid should have multiple data levels to use this
property. For value-based table cell data, you can expand
and collapse data details to aggregate values.

Show Row Totals Select the check box to show totals for each row.

Show Row Grand Totals Select the check box to show the grand totals for each
row.

Show Column Totals Select the check box to show totals for each column.

Show Column Grand Totals Select the check box to show the grand totals for each
column.
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Property Description

Field Configuration Configure pivot grid rows, columns, and data. Map all the
three areas (rows, columns, data).

1. Enter the tag names under Data Field.
2. Select the Data Type for the entered tag names. For

example, string.
3. Enter a Caption.

Use this option to add user-friendly captions to your
row/column/data fields. Avoid lengthy captions with
special characters.

4. Select the Area for the tags to appear. For example, if
you select column, then the respective tags appear in
the column at runtime.

5. When area is data, define additional properties for
data values.

Formatting: Set default colors (page 452) for the pivot grid.

Cell Color Select a color for the pivot grid table cells.

Cell Font Color Select a font color for the pivot grid table cell text.

Column Header Font Color Select a font color for the pivot grid table column header
text. This helps to differentiate the header text from the
cell text.

Totals Background Color Select a unique cell color for the row/column totals.

Totals Font Color Select a font color for the row/column totals text.

Item Configuration: Allows to customize the pivot grid table to override the default settings. Select +Add Item for
configuring options.

Item Display
• Row/Column Value: Enter the value that is displayed

in a row or column.

For example, if you’re viewing OPCUA tags and
their values, you can enter a tag name such as
FIX.FWT_FWP_DPUMP_1A_FLOW.F_CV.

• Display Value (optional): Use this option to display
more user-friendly values instead of tag names. This
display value overrides the Row/Column Value.

For example, enter Pump1A Flow to replace the OPC
UA tag name FIX.FWT_FWP_DPUMP_1A_FLOW.F_CV
entered under Row/Column Value. At runtime, the
column displays values for Pump1A Flow in the pivot
chart.
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Property Description

Conditional Formatting Apply conditions to format cells based on values. You
can create more than one condition for a Row/Column
Value. The conditions are applied according to their order
of display. If more than one rule matches a particular cell,
the first condition in the list to match takes effect and rule
processing for that cell will stop.

Select +Add Item for options to create conditions. For
example, format a cell if its value is less than 9000:

• Comparison: Select < from the list of comparison
operators.

• Value: Enter 9000.
• Cell Color: Select a color for the cells with values

less than 9000.
• Cell Font Color: Select a color for the cell text with

values less than 9000.

Tip:  If you want to format a row/column with a color
that does not change based on value, apply the Always
comparison operator.

Pivot Grid at Runtime

Select  to export the data to an Excel file.

Select  to show the Field Chooser option.

• You can switch the position of row and column fields. To switch a field position, drag and drop
the field in the desired row/column.

• You can apply multiple filters to the data to get focused results.
• You can sort fields by ascending/descending order.



Operations Hub for Windows | 3 - User Guide | 445

Note:  In Field Chooser, row/column/data fields may get misplaced if you remove and add fields
to the pivot chart. This is a DevExtreme control behavior. For example (refer screenshot):

1. Under All Fields, clear the check box for Name. The field is removed from Row Fields.
2. Under All Fields, select the check box again for Name.

The Name field may not show up under Row Fields. It may show up under column or data
fields. In such cases, drag and drop the field to the appropriate location.

General Reference

Page Components

This topic describes the various UI components that you can use to design your page and configure
the data.

Page Design

You can add components (page 288) of the following categories to a page:



Operations Hub for Windows | 3 - User Guide | 446

Field Description

INPUTS Contains UI components that receive input from
application users.

• Check Box (page 290)
• Radio Button (page 291)
• Dropdown (page 292)
• Input (page 294)
• Slider (page 296)
• Toggle (page 297)
• Button (page 298)
• Camera (page 299)
• Text Area (page 300)

DISPLAY Contains UI components that display information in the
application.

• Text (page 301)
• Header (page 302)
• Image (page 302)
• Graph (page 303)
• Visualization (page 305)
• Big Data (page 309)
• Grid (page 312)
• Map (page 314)
• Table (page 317)
• List (page 319)
• Gauge (page 319)
• Html (page 323)
• Interactive Map (page 332)

LAYOUTS Contains UI components that are used to design a page
layout.

• New Line (page 334)
• Separator (page 334)
• Container (page 334)
• Repeater (page 335)

TOOLS Contains UI components that allow application users to
upload an Excel worksheet to load data into an entity,
upload a list of devices in a CSV format, or manage
events.

• Event Settings (page 350)
• Upload Excel (page 351)
• Upload Devices (page 353)

INTEGRATION Contains system plug-ins/widgets.

CUSTOM Contains custom UI plug-in components that have been
uploaded by an application developer.



Operations Hub for Windows | 3 - User Guide | 447

Component Properties

To access the properties of a UI component, select the component (a container, graph, or a
breadcrumb).

Note:  Some of these fields are displayed based on the selected UI component. This list is not
comprehensive.

Field Description

Settings > General

Label The text that appears for components such as check
boxes and drop-down list boxes.

Global Data Allows the data to be available globally for use by other
components or query inputs. This check box is enabled
only after you specify an Id for the component.

Allow Export Indicates whether data that appears in the component can
be exported. By default, this check box is cleared.

Tooltips Indicates whether data in a table cell should contain
tooltips displaying the content. By default, this check box is
cleared.

Type The data type of an input component. If you are
configuring the settings of an component of the type graph
or gauge, this field contains a list of graph or gauge types.

Style The style of a meter-type gauge component.

Settings > Display

Conditions Applies a condition that executes an action at runtime. For
example, you can create a condition for the component/
widget to display a control button or a warning image if the
temperature recorded by the sensor exceeds 40 degrees
Celsius.

Select Add conditions to build and apply conditions (page
449).

Hidden Select the check box to hide the component/widget at
runtime. By default, this check box is cleared.

When a component/widget is marked as hidden, it can
be shown only on associating with a button (page 298)
using the toggle show/hide action.

As a best practice, either use Conditions or Hidden.
Avoid using these properties together.

Show on Indicates that the component/widget is visible in the
selected devices. By default, the options Mobile, Tablet,
and Desktop are selected.

Settings > Data
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Field Description

X-axis Label The label of the horizontal axis of an component of the
type graph.

Y-axis Label The label of the vertical axis of an component of the type
graph.

Required Indicates whether it is mandatory to enter a value for the
component that is used as an input to a query. By default,
this check box is cleared.

Target Data The query input that is the target for the value of the
component.

Source The source from which data should be retrieved to initialize
the component. If you are configuring the settings of an
input component, you can select one of the following
options:

• Data: Fetches data that from a global variable or the
output value of a query.

• Manual: Allows you to enter a value manually.
• Formula: Allows you to create a formula using global

variables and the output values of a query.

If you are configuring the settings of a display component,
you can select one of the following options:

• Data: Displays data from a global variable or the
output value of a query.

• Manual: Allows you to enter a value manually.
• Formula: Allows you to create a formula using global

variables and output values of a query.
• URL: Displays an image from a URL.
• File: Allows you to upload an image for the

component.

Group By Enables to group the data in a graph by the selected tag
name.

Options Indicates whether the values in the component are hard-
coded or displayed dynamically from a query.

Actions The action that should be triggered when the component is
selected.

First Option The first option that appears in an component of the type
drop-down list box (for example, select an asset).

Step The step value used for a slider component.

Settings > Behavior

Minimum The minimum value for an component that contains a
range (such as a slider or a gauge).

Maximum The maximum value for an component that contains a
range (such as a slider or a gauge).
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Field Description

True Label Customized text that appears when a toggle or an indicator
is active.

False Label Customized text that appears when a toggle or an indicator
is inactive.

Width The width of the component of the type toggle.

Show <number> rows at a time The number of rows that can appear at a time in an
component of the type grid.

Validation The validations to be applied on the value entered in an
input component. You can select the following options:

• Capital: Select this check box if you want application
users to enter a value only in uppercase.

• Minimum character: Select this check box if you want
to set a minimum character limit to values entered
in the component, and then enter the number of
minimum characters that application users must enter
in the component.

• Range Limit: Select this check box if you want to
set the maximum and minimum values that can be
entered in a numeric, date, or time input component.

Disabled Indicates whether you want the component to appear as
disabled in the application.

Range Limit The range of values that application users can enter in the
component.

Stacked Indicates whether the bars displayed in an component of
the type graph should be stacked. By default, this check
box is cleared.

Visual

Rounded Corners Applies rounded corners for the selected component.

Custom Colors Select the check box to set these options:

• Add text color.
• Add container background color.
• Add container border color, width, and style.

Horizontal Alignment Aligns the component left, right, or center.

Responsive

Responsive Pattern Select how the container layout must respond on web
pages.

Apply Conditions
Build conditional statements that execute actions at runtime.
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Create an application page, and add widget/s to a container.

1. Select the widget for which you want to add a condition.

2. Navigate to the widget's properties tab, then under DISPLAY, select

.
The conditions screen for the widget appears.

3. Create a condition using these options:

Populates values from the query/entity added to the
component/widget.

Select the first value, which is used to build a
conditional statement.

Use the operators to express the relationship between
two values and return results that match.

• = returns true if the value on the left is equal to the
value on the right.

• > returns true if the value on the left is greater than
the value on the right.

• < returns true if the value on the left is less than the
value on the right.

• >= returns true if the value on the left is greater
than or equal to the value on the right.

• <= returns true if the value on the left is less than or
equal to the value on the right.

• <> returns true if the value on the left is less than or
greater than the value on the right.

• Has value returns true if the value on the left has
any value.

• Doesn't have value returns true if the value on the
left is NULL.

Manual Allows to enter a hardcoded value.

Flow Allows to select a value from a query.

To delete a condition, select  next to it.

4. Optional:  Select  to create more conditional statements and combine them.
• Select AND to get values that satisfy two or more conditions.
• Select OR to get values that satisfy atleast one from the multiple conditions specified.

5. Select Done to save and add the condition/s to the widget.

Globals
Globals are variables with a global scope, and are available to use with all the widgets in Operations
Hub.

Globals are applied outside of a query. Save variables as global if you want multiple widgets to
access the same data. You can also declare globals as:
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• Page Global: Indicated with P, this global variable is applicable only to the page.
• App Global: Indicated with A, this global variable is applicable to all the pages in an

application.

To modify an added global, select to switch between Page Global and App Global.

These are the different types of globals you can use with the widgets in Operation Hub:

• System Globals
• Output Globals
• UI Globals
• Custom Globals
• URL Parameters

Sample Page with Historical Data
This topic describes how to create a sample page using historical data.

1. Create an application (page 117).

2. Create a page (page 262).

3. Design a page layout using widgets such as a guage, line graph, etc.
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Refer to Page Components (page 445).

4. Select the graph in the page container to access its PAGE DATA.

5. Under the page data tab, select Tag Browser from the dropdown list.
A list of data options appear.

6. Select Historical data from the dropdown list.

7. Select Browse to search the data source and select tags (page 255).

8. Drag this data and drop it on the graph.
A message appears that the data is bound successfully.

9. Select Save App.

10. Select Open App.
The application page opens in a web browser.

Select Colors
Use the color picker to select and apply a color to text, borders, and backgrounds.

You can:

• Select and apply a basic color scheme.
• Slide across the color wheel and make it lighter or darker.
• Enter the hexadecimal or RGB values to get the exact color.
• Use the alpha (A) value to set the transparency of the color.
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Organize Items

Add Items

The item values are implemented in the specified order, from first to last. Arrange the order of values
using the options for moving items up or down in a list.

1. Select  to move the item upwards in a list.

2. Select  to move the item downwards in a list.

3. Select  to remove the item from a list.
The item values are deleted.

LIKE Operator with Wildcards
The LIKE operator is used with wildcard characters to compare a string to a pattern, and return
matched values from the database.
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You can use these wildcards with LIKE to build your pattern:

• % The percent symbol stands for zero or more characters in a sequence.
• _ The underscore symbol stands for only one character. This single character can also be a

number or any punctuation character.

Note:  If using the MS Access database, use these wildcards instead of % (percent) and _
(underscore):

• * Asterisk to represent zero or more characters in a sequence.
• ? Question mark to represent a single character.

The LIKE pattern is case insensitive, and is set in single quotes. Employ % and _ with any other
character/s (denoted by XY in the table) to search through your database. The wild cards can also be
used in combination.

Pattern Description

LIKE '%X' Returns values that end with X. These values can have
zero or more characters before X.

LIKE '%XY' Returns values that end with XY.

LIKE 'X%' Returns values that start with X. These values can have
zero or more characters after X.

LIKE '%X%' Returns values that contain X. These values can have the
X character in any position (start, end, second, fourth, etc.)

NOT LIKE '%X%' Returns values that do not contain X.

LIKE 'X%Y' Returns values that start with X and end with Y. These
values can have zero or more characters between X and
Y.

LIKE 'X_' Returns values that start with X and has one character
after X.

LIKE 'X___' Returns values that start with X and has three characters
(3 underscores) after X.

LIKE 'X__Y' Returns values that start with X and end with Y, and has
two characters (2 underscores) between X and Y.

LIKE 'X__%' Returns values that start with X and has two characters (2
underscores) after X, followed by zero or more characters.

LIKE '%_X_%' Returns values that contain X if matches with these rules:

• X cannot be in the first or last position.
• Implies atleast 3 characters including X.
• Can have zero or more characters before and after

the 3 characters.
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Whitelist Websites
Operations Hub allows to load content from whitelisted URLs.

With Operations Hub v2.1 release, third party websites are no longer allowed to use iframe to embed
End Apps into their pages because of security considerations.

Starting with Operations Hub v2.1 SIM2, it is possible to whitelist trusted sites to use iframe with
End Apps. Note at this time, this whitelist applies to all End Apps.

1. Gather a list of one or more websites that you want to use iframe to embed EndApps.

a. Format each website URL as follows with the actual hostname and port number:

https://hostname:port

b. For hostname, enter simple names or fully qualified domain names (FQDNs). It is
recommended to include all referenced aliases.

c. Ignore the port if it is 443.

2. On the host machine where Operations Hub is installed, add an environment variable
TRUSTED_FRAME_SITES.

a. Open the Windows Run command.

b. Enter sysdm.cpl and select OK.
The System Properties window appears.

c. On the Advanced tab, select Environment Variables
The Environment Variables window appears.

d. Select New to create a system variable with Variable name TRUSTED_FRAME_SITES.

e. For Variable value, enter a comma-separated list of the sites gathered in the previous step.
For example, https://siteb.company-domain.com,https://sitec.company-
domain.com:8443
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3. Save and close all the windows.

4. Restart GE Operations Hub IQP EndApp service for this change to take effect.

You have successfully set up a list of whitelisted websites.

Note:

• An End App authenticates users for access. Recent versions of Chrome have enforced a
default SameSite policy on cookies. Hence, sites that embed an End App must be on the same
parent domain as the Operations Hub’s host domain. For example, if Operations Hub is on
domain ophub.company-domain.com, thenfoo.company-domain.com is acceptable, but not
bar.company.local.

• By default, Operations Hub End Apps can embed 3rd party contents using iframes without
restriction. However, customers may choose to whitelist such 3rd party contents using an
environment variable TRUSTED_FRAME_SOURCES similar to TRUSTED_FRAME_SITES. In such
cases, ensure that the certificates used for https protocol by 3rd party websites are trusted on
client (browser) nodes.
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APIs

Operations Hub M2M Device RESTful APIs

Operations Hub allows sensors to connect directly to the Operations Hub server using RESTful
services to broadcast sensor data and receive commands. The connection to the Operations Hub
server uses Standard REST POST calls.

The Operations Hub gateway identifies the information source based on the following parameters::

• Remote Device Unique Identifier: By remote device, we refer to gateways of any type
supporting an http connection. Usually, the best way to create a unique ID is by using the
gateway’s MAC address.

• Remote Sensor/Controller Unique Name: Any name can be used as long as it is unique to the
gateway. It could be a logical name (for example, Sensor1 or the address of the sensor (if it has
one)).

• The Operations Hub Account: Account username and password.

API Handshakes

The handshakes define the message structure and message types exchanged between the device and
the Operations Hub cloud. The Operations Hub API supports 3 types of request:

• Login: The device asks to be authenticated.
• Publish: The device sends new sensor data to Operations Hub.
• Subscribe: The device requests new commands or control instructions from Operations Hub.

JSON Message Format

Messages exchanged between the Operations Hub server and the device client are in the JSON
format. JSON is a string representation of data; it is lighter than XML, and hence, it is more
suitable for M2M messages. JSON messages are formatted as name/value pairs: "variable
name":"variable value"

Messages can contain more than one variable using a comma as the delimiter: {"variable
name1":"variable value1","variable name2":"variable value2"}

The variable value can be a list of parameters, enclosed in curly braces
{} using a comma as the delimiter. For example: {"variable name":
{"parameter1":"value1","parameter2":"value2"}}
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Client Login

Before communicating with the Operations Hub server, the device client must login to the server.
The login URL is: https://<Operations Hub_Site_URL>/app/iqp/rest/login

1. To login, the client sends a login request: {"handshake":{"stage":"login"},"login":
{"username":"user name of the user","password":"password of the user"}}

2. The server responds with a success or failure message: If authentication succeeds; the
server responds with code 1 and provides the client with a token: {"handshake":
{"stage":"login","code":"1"},"token":"token number"}. If authentication fails, the
server responds with code 0: {"handshake":{"stage":"login","code":"0"}}. If the login
fails, the client must request the login again.

3. The token returned by the server is a unique identifier, which serves to identify the client during
further communications with the server. The token must be included in all the publish and
subscribe messages from the client to the server. The token remains valid as long as the client
communicates with the server. If the device is inactive for 20 minutes or longer, the token will
expire. If the client attempts to communicate with the server using the token after it has expired,
an unauthorized message will be returned by the server. When this happens, the client must
login again to receive a new token.

Publishing M2M Data

The publish stage is used by the Gateway/Device/Sensor to send new data to the Operations Hub
server. The publish URL is: https://Operations Hub site URL/app/iqp/rest/publish. The
published data is in the form of a JSON string. Each message contains the following information:

• Data Channel: The Data Channel tells the server where the data is coming from. The source
is represented as a data source path, which is composed of 3 parameters, a combination of
its Account name/Gateway id/Sensor id. For example: "REST_DEMO/01-23-45-67-89-ab/
temperature0".

◦ For the Gateway id, it is recommended to use the device MAC Address or IMEI number.
◦ The Sensor id can be any logical name. The name must be unique to this gateway.

Note:  The application developer in Operations Hub will use the sensor name to build their
application. For this reason, it is recommended to use a logical name describing the sensor or
device. For example, if the device represents a temperature sensor, use the word temperature in
the name and add a number to make it unique: temperature9

Important:  For HTTP requests, avoid using spaces in names and ids.

• Metrics: The Metric Data Message defines a set of data from the sensor/device as a series
of keyname:value pairs. The “keyname” in the keyname value pair defines the field in the
Operations Hub M2M_data entity where the “value” will be stored. The following Keynames
are supported.
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Keyname
M2M_data

Field
Storage Format

met metric String Developer-defined String (compulsory field)

val data String Developer-defiined value (compulsory field)

lat latitude String WGS84 recommended for online map compatibility (common
field)

long longitude String WGS84 recommended for online map compatibility (common
field)

time timestamp DateTime ISO 8601 “YYYY-MM-DDThh:mm:ss.sss±TZ” (common field)

alt altitude String Developer-defined value (common field)

desc description String Developer-defined string

type data_type String Data type of the data field “String” or “Number”

gen1 generic_1 String Developer-defined string or value

gen2 generic_2 String Developer-defined string or value

◦ All Operations Hub payload messages must contain the metric and data keyname value
pairs.

◦ All other keyname value pairs are optional.
◦ The order of the keyname value pairs in the payload is not compulsory.
◦ If included, Timestamps must be formatted according to the ISO 8601 format specified

above.
◦ The Data Type entry can be used in cases where Operations Hub does not automatic

identify the data type correctly.
• The Publish request process: To publish a message to the server, the client uses the following

format:

{"handshake":{"stage":"publish"},"token":"token number","messages":[
                        {"dc":"data channel","cloud":"cloud server
 timestamp","data":[                              
                       
 {"alt":"value","lat":"value","long":"value","time":"timestamp recorded
 in the device","mets":[
                       
 {"met":"value","val":"value","type":"value","desc":"value","gen1":"value","gen2":"value",}
                        ]
                        }
                        }]}

The server will respond with a success failure message: {"handshake":
{"stage":"publish","code":"<0/1>","dc":"data channel"}}, where code=1
represents success, and code=0 represents failure to process the message. The returned Data
channel is the channel that was sent in the publish request that the response is replying to.

• Sending Multiple Metrics: Multiple metric data entries can be sent in a single publish message
using the JSON array format. Arrays in JSON are in the format of "[array data]". For example:
one published payload could contain several messages for a car’s speed, engine temperature,
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fuel level, odometer, etc. or from an intermediary data server, it could contain multiple
messages from several different devices. An example of a JSON publish request containing
several entries:

{"handshake":{"stage":"publish"},"token":"00000000-00000000-00409DFF-
FF521DB2", "messages":[
                        {"dc":"Operations Hub_Testing/REST_Device/
Vehicle2","cloud":"2015-03-26T18:46:38.237+09:00","data":[
                        
                       
 {"alt":"1234","lat":"35.587562","long":"139.668916","time":"2015-03-26T18:44:38.195+09:00","mets":
[
                       
 {"met":"Speed","val":"100","type":"double","desc":"kmh"},
                       
 {"met":"Heading","val":"180","type":"double","desc":"degrees"},
                       
 {"met":"Temperature","val":"98","type":"double","desc":"degrees"}
                        ]
                        },
                       
 {"alt":"1240","lat":"35.587565","long":"139.668920","time":"2015-03-26T18:45:38.195+09:00","mets":
[
                       
 {"met":"Speed","val":"75","type":"double","desc":"kmh"},
                       
 {"met":"Heading","val":"237","type":"double","desc":"degrees"},
                       
 {"met":"Temperature","val":"96","type":"double","desc":"degrees"}
                        ]
                        }
                        ]
                        }]}                        

Subscribing to receive M2M commands

The subscribe stage is used by the Gateway/Device/Sensor to check the Operations Hub server for
commands. The subscribe URL is: https://<Operations Hub_Site_URL>/app/iqp/rest/
subscribe. In the M2M world, Gateways/Devices can lose connection to the server from time-
to-time. For this reason, the Operations Hub server does not push commands to devices. It is up to
the embedded code in the device to periodically check with the server for any available commands.
Subscribe requests use the following information:

• Data channel: The Gateway/Device asks the server for all commands available for a Data
channel. Command requests may be for specific sensors, for all commands for a Gateway/
Device or all commands for an account. The corresponding Data channel formats are as follows:

◦ Specific sensor: Account_name/Gateway_ID/Sensor_ID
◦ Specific Gateway: Account_name/Gateway_ID
◦ Specific account: Account_name
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• Request type: The request type identifies what stage of the subscription process we are in. The
available request types are:

◦ subscribe: The client requests for available commands.
◦ command_list: The server sends a list of the commands.
◦ no_commands: The server notifies the client that no commands are available.
◦ result: The server replies to confirm whether or not the request has been processed

correctly.
• Commands: The command or commands to execute. Commands are usually vendor-specific or

device-specific. The commands could be AT commands or client code specific implementation
commands.

Subscribe requests have the following stages.

1. Client to Server: The client requests for available commands. The client initiates
the process by sending a subscribe request to the server: {"handshake":
{"stage": "subscribe"},"token":"<token>", "payload":

{"dc":"<channel>","request_type":"subscribe"}}

2. Server to Client: The server sends a list of commands to the client. If the server has
commands available for the device, it will return a command list: {"handshake":
{"stage":"subscribe"},"payload":{"request_type":command_list", commands:

[{"dc":"<channel>","command":"<command>"}]}}

Important:  The server will return an array of channel specific commands. If the subscribe
request was for all available commands for an account Data channel. The server response will
be an array of commands where the Data channel for each command is specific to the gateway,
device, or sensor that the command is assigned to.

If the server has no commands available for the device, it will return a no_commands
response: {"handshake":{"stage":"subscribe"},"token":"<token>","payload":
{"request_type":" no_commands","dc":"<channel>"}}. The datachannel, in this case,
is the channel of the original request. For example, if it was for a device, it would be account/
device.

M2M Device API Error codes

If an error occurs while processing requests, the server will return the following message:
{"handshake":{"stage":"error","code":"<code>"}}

Possible error codes are:

• 1: Bad JSON Format
• 2: Unauthorized user



Operations Hub for Windows | 3 - User Guide | 462

Operations Hub REST APIs for Integration

In addition to the existing APIs that allow devices to send data to the M2M_data entity, Operations
Hub provides REST Integration APIs that enable 3rd party servers to pull data from the M2M_data
entity. There are also APIs for pulling data from any custom entity in the Operations Hub database
and for inserting data into custom entities.

Authentication

Before using the integration APIs, the client system must pass authentication on the Operations Hub
server. The integration API login URL is https://<Operations Hub_Site_URL>/app/iqp/api/
rest/login.

Message sent by the client: {"username":"<user>","password":"<pass>"}

Response of the server:

• If authentication succeeds, the server responds with code 1 and provides a token for the client to
use in further communications: {"code" : "1" , "token" : "<token>"}

• If authentication fails, the server responds with code 0 and provides a reason for the failure:
{"code" : "0" , "reason" : "<reason>"}. If the authentication fails, the client will need
to request for authentication again before proceeding.

Get M2M data

The Get M2M data API allows a 3rd party server to retrieve data from the Operations Hub
M2M_data entity: The URL for the API is: https://<Operations Hub_Site_URL>/app/iqp/
api/rest/iot/data

Message sent by the client:

{"token": "<token>", "filters":
                [
               
 {"filter_type":"<column_name>","value":"<search_value>","value_type":"<type>","operator":"<operator>"}
                    ]
                    }            

• “<token>”: The token provided to the client at login.
• “<column _name>”: The name of a valid field in the M2M_data entity.
• “<search_value>”: The value to search for in the selected field.
• “<type>”: The data type of the selected field. The following values are supported:

◦ Boolean
◦ Number
◦ Real
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◦ String
◦ Long string
◦ Free text
◦ Date
◦ Time
◦ DateTime
◦ File

• “<operator>”: The operator to use in the search. The following values are supported:
◦ =
◦ >
◦ <
◦ >=
◦ <=
◦ <>
◦ LIKE (page 453)

Tip:  If required, multiple filters can be provided to filter the search results. All filters are treated
as {filter_1} AND {filter_2} AND … {filter_n}.

An example of a request to retrieve all M2M_data for the device “REST_Device” after 12:00pm on
2015-03-19:

{"token":"08ad9058-9ec9-4363-85f1-c9071004d9992","filters":
                    [
                   
 {"filter_type":"device_id","value":"REST_Device","value_type":"String","operator":"="},
                   
 {"filter_type":"iqp_timestamp","value":"2015-03-19T12:00:00.000Z","value_type":"DateTime","operator":">"}
                    ]
                    }

Response of the server:

• If there is data to match the search results, the server will respond with all of the matching rows
in the following format:

{"rows":
                        [
                        {"row":[<list of  <column_name>:<value>  pairs
 for all M2M_data columns>]},
                            {"row":[<list of <column_name>:<value> 
 pairs for all M2M_data columns>]},
                                ….
                                ]
                                }                    

• If there is no data to match the search results, the server will respond with an empty list:
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{"rows":[]}

Get Entity data

The Get Entity data API allows a 3rd party server to retrieve data from any custom entity in the
Operations Hub database: The URL for the API is https://<Operations Hub_Site_URL>/app/
iqp/api/rest/DB/data/get.

Message sent by the client:

{"token": "<token>", "entity_name":"<entity_name>", "filters":
                    [
                    {"filter_type":"<column_name>","value":"<search
 value>","value_type":"<type>","operator":"<operator>"}
                        ]
                        }                

• “<token>”: The token provided to the client at login.
• “<entity_name>”: The name of a valid custom entity.
• “<column _name>”: The name of a valid field in the specified entity.
• “<search_value>”: The value to search for in the selected field.
• “<type>”: The data type of the selected field. The following values are supported:

◦ Boolean
◦ Number
◦ Real
◦ String
◦ Long string
◦ Free text
◦ Date
◦ Time
◦ DateTime
◦ File

• “<operator>”: The operator to use in the search. The following values are supported:
◦ =
◦ >
◦ <
◦ >=
◦ <=
◦ <>
◦ LIKE (page 453)

Tip:  If required, multiple filters can be provided to filter the search results. All filters are treated
as {filter_1} AND {filter_2} AND … {filter_n}.
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An example of a request to retrieve all data from the custom entity “MathsData”, where the value in
the column “Angle” is between “180” and “270” degrees:

{“token”:”5aad6209-
bd6f-440c-9581-26ea80ec6fd32”,”entity_name”:”MathsData”,”filters”:
                [
               
 {“filter_type”:”Angle”,”value”:”180”,”value_type”:”number”,”operator”:”>=”},
               
 {“filter_type”:”Angle”,”value”:”270”,”value_type”:”number”,”operator”:”<=”}
                ]
                }            

An example of a request to retrieve all rows of data from the custom entity “MathsData” with no
conditions:

{“token”:”5aad6209-
bd6f-440c-9581-26ea80ec6fd32”,”entity_name”:”MathsData”,”filters”:[]}

Response of the server:

• If there is data to match the search, the server will respond with all of the matching rows in the
following format:

{"entity_name":"<entity_name>","rows":
                        [
                        {"row":
                        [
                       
 {"col_name":"<column_name>","type":"<column_type>","value":"<value>"},
                           
 {"col_name":"<column_name>","type":"<column_type>","value":"<value>"},
                                ….
                                ]
                                }
                                ….
                                ]
                                }                    

◦ “<entity_name>”: The name of the entity the data was retrieved from.
◦ “<column _name>”: The name of the field this value is from.
◦ “<column_type>”: The data type of the field as specified in the entity.
◦ “<value>”: The value of the field.

• If there is no data to match the search, the server will respond with a blank list:
{"entity_name":"<entity_name>","rows":[]}
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Insert Entity data

The Insert Entity data API allows a 3rd party server to insert data into any custom entity in the
Operations Hub database: The URL for the API is https://<Operations Hub_Site_URL>/app/
iqp/api/rest/DB/data/insert.

Message sent by the client:

{"token": "<token>","entity_name":"<entity_name>","rows":
                    [
                    {"row":
                    [
                   
 {"col_name":",column_name>","type":"<type>","value":"<value>"},
                       
 {"col_name":"<column_name>","type":"<type>","value":"<value>"},
                            ….
                            ]
                            }
                            ….
                            ]
                            }

• “<token>”: The token provided to the client at login.
• “<entity_name>”: The name of the custom entity that you want to insert data into.
• “<column _name>”: The name of the field in the specified custom entity that this value will be

inserted into.
• “<type>”: The data type of the specified field. The following values are supported:

◦ Boolean
◦ Number
◦ Real
◦ String
◦ Long string
◦ Free text
◦ Date
◦ Time
◦ DateTime
◦ File

Note:  The type specified in the API call must be the same as the type specified for the field
in the entity.

• “<value>”: The value to insert into the field.

An example of a message to insert 2 rows of data into the custom entity “MathsData”:

{"token":"9eb64909-3d08-43e8-b5ed-
eae57bce32402","entity_name":"MathsData","rows":
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                [
                {"row":
                [
                {"col_name":"Angle","type":"number","value":"370"},
                {"col_name":"SIN","type":"real","value":"0.1736"},
                {"col_name":"COS","type":"real","value":"0.9848"},
                {"col_name":"TAN","type":"real","value":"0.1763"}
                ]
                },
                {"row":
                [
                {"col_name":"Angle","type":"number","value":"380"},
                {"col_name":"SIN","type":"real","value":"0.342"},
                {"col_name":"COS","type":"real","value":"0.9397"},
                {"col_name":"TAN","type":"real","value":"0.364"}
                ]
                }
                ]
                }            

Response of the server:

• If the insert is successful, the server will respond with code 1: {"code" : "1"}
• If the insert fails, the server will respond with code 0 and a reason: {"code" : "0",
"reason" : "<reason>"}

Operations Hub REST APIs for App, Group, and Page Permissions

Operations Hub provides REST APIs for App, Group, and Page Permissions. The following sections
outline what these APIs are and how they work.

Authentication

For proper authentication, obtain a valid UAA token with a valid scope that includes iqp.developer.

Import App

The Import App API takes a zip or xml file (same as from the UI) and returns the application id of
the imported App.

• If the App is not already present, the type parameter is not required.
• If the App is already present and the type parameter is not provided, then the default is to

duplicate.
• The type parameter can be explicitly provided as replace or duplicate.

Sample request for HTTP POST is as follows:
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https://<hostname>/site/api/apps/import
https://<hostname>/site/api/apps/import?type=replace
https://<hostname>/site/api/apps/import?type=duplicate

The zip or xml file is part of the Request body with the key as file.

Sample response:

Http 200 Ok
{
     "uuid": <app id>
}                     

Get Apps

The Get Apps API returns all Apps from within Operations Hub .

Sample request for HTTP GET is as follows:

https://<hostname>/site/api/apps

The Get Apps API returns all of the Apps that are present.

Sample response:

Http 200 Ok
[
    {
        "name": "app name",
        "uuid": "app id"    
    },
    {
        "name": "app name",
        "uuid": "app id"    
    }
]

To filter a single App by name, the name parameter is used.

Sample request for HTTP GET is as follows:

https://<hostname>/site/api/apps?name={appname}

Sample response:

Http 200 ok
[
    {
        "name": "appname",
        "uuid": "app id"
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    }
]

Get App Details for App Id

This API takes the App Id and returns the details of the App, including the UAA permitted groups.

Sample request for HTTP GET is as follows:

https://<hostname>/site/api/apps/{app id}

Sample response:

{
    "name": "app name",
    "id": "appid",
    "permittedUaaGroups": [],
    "pages": [
        {
            "id": "pageid",
            "name": "page name",
            "permittedUaaGroups": [],
            "queries": [
                {
                    "id": "query id",
                    "name": "query name",
                    "permittedUaaGroups": [
                        {
                            "id": "id",
                            "displayName": "group name"
                        }
                    ]
                }
            ]
        }
    ]
}          

• Empty permission groups for App denotes NONE of the groups have permission to access the
App.

• Empty permission groups for Page denotes ALL the groups have permission to access the Page.
• Empty permission groups for query denoted ALL the groups have permission to access the

query.

Update App UAA Group Permissions

This API takes the application's universally unique identifier (UUID) and the list of UAA
permissions to be updated. The permissions provided will overwrite the permission list already
existing in Operations Hub.
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Group id and name should match UAA group id and group name.

Sample request for HTTP POST is as follows:

https://<hostname>/site/api/apps/{app id}/permittedUaaGroups
Request body
[
  {
    "id": "group id",
    "displayName": "group name"
  },
  {
    "id": "group id",
    "displayName": "group name"
  }
]

Sample response:

Http 204 No content. 

Update Page UAA Group Permissions

This API takes page's universally unique identifier (UUID) and the list of UAA permissions to be
updated. The permissions provided will overwrite the permission list already existing in Operations
Hub.

Group id and name should match UAA group id and group name.

Sample request for HTTP POST is as follows:

https://<hostname>/site/api/pages/{page id}/permittedUaaGroups
Request body
[
  {
    "id": "group id",
    "displayName": "group name"
  },
  {
    "id": "group id",
    "displayName": "group name"
  }
]

Sample response:

Http 204 No content.
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Update Query UAA Group Permissions

This API takes the query's universally unique identifier (UUID) and the list of UAA permissions
to be updated. The permissions provided will overwrite the permission list already existing in
Operations Hub.

Group id and name should match UAA group id and group name.

Sample request for HTTP POST is as follows:

https://<hostname>/site/api/queries/{query id}/permittedUaaGroups
Request body
[
  {
    "id": "group id",
    "displayName": "group name"
  },
  {
    "id": "group id",
    "displayName": "group name"
  }
]

Sample response:

Http 204 No content.

Get Query Id from Query Name

This API takes the query name and returns the query id.

Sample request for HTTP GET is as follows:

https://<hostname>/site/api/queries?name={query name}

Sample response:

Http 200 OK
{
    "uuid": <query id>
}

Get Query UAA Permissions for Query Id

This API takes the query id and returns the UAA permission group list present in Operations Hub.

Sample request for HTTP GET is as follows:
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https://<hostname>/site/api/queries/{query id}/permittedUaaGroups

Sample response:

Http 200 Ok
 
[
  {
    "id": "group id",
    "displayName": "group name"
  },
  {
    "id": "group id",
    "displayName": "group name"
  }
]

Delete App

The Delete App API removes the application from Operations Hub.

Sample request is as follows:

https://<hostname>/site/api/apps/{app id}

Sample response:

Http 204 no content.

Message Queuing Telemetry Transport (MQTT) APIs

Operations Hub MQTT Message Broker

Operations Hub includes an MQTT client. In the Operations Hub administrative console, the
MQTT client can be pointed at any MQTT broker that is accessible from the network where the
Operations Hub platform is installed. If there is no existing MQTT broker, a local broker can
optionally be installed on the Operations Hub server during the Operations Hub installation. Refer to
the Deployment section of the document.

Operations Hub MQTT implementation

Operations Hub receives status messages from devices and stores the information in the M2M_Data
entity. Operations Hub defines a standard for the MQTT topic structure and how the payload is
formatted in order to allow the server to identify the device source and correctly store the M2M data.
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The messages contain the following information:

• Cloud ID: When a Operations Hub tenant account is created, it is assigned a unique cloud ID
on the server. The cloud ID allows Operations Hub to control how the data from the device is
collected and stored.

• Device ID: A device or asset could be a single machine with one or more sensors
communicating directly with Operations Hub. Alternatively, a device could be a gateway device
on a production line, acting like a router to forward data from multiple machines along the line
to Operations Hub. All devices have unique IDs that often represent network card numbers,
IMEI numbers, or MAC addresses. The device ID is the minimum requirement for Operations
Hub to identify the data source.

• Instance: If you have multiple assets connected to Operations Hub through a single gateway
device, the instance name provides the ability to identify which asset from which the data has
been sent. The instance name is usually a logical name uniquely identifying the asset or sensor.

• Metric: The metric is a term used by Operations Hub to define the nature of the data send from
a device (for example, temperature, speed, air pressure, fuel level). Metrics in the M2M_Data
entity allow the application developer to define queries and events for retrieving data and
triggering responses to specific conditions.

Operations Hub MQTT Topic Structure

When Operations Hub receives a message, it needs to identify the message source. The MQTT
message format is defined as: <topic> <payload>

Operations Hub defines a standard topic format so that the server knows the source of the message.

The Operations Hub topic structure contains the following three components in the given order:

• Cloud_ID: This value must be the cloud_id defined in the entity cloud_users.
• Device_ID: This value can be anything. Normally, it identifies a specific device or gateway.
• Instance_Name: This value can be anything. Normally, it identifies a specific asset. It is

optional.

A topic with an instance name appears as follows: <Cloud_ID>/<Device_ID>/<Instance_Name>

A topic without an instance name appears as follows: <Cloud_ID>/<Device_ID>

Operations Hub MQTT Payload Structure

For each message, Operations Hub needs to identify the metric. (For example, identify whether 32 is
the reading for temperature or light.)

Operations Hub supports the following basic formats for the payload:
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• Basic Payload format: The basic Operations Hub payload is usually used for simple sensors.
The Operations Hub payload is formatted using keyname value pairs: keyname=<value>.
The keyname value pairs are separated by a Tilde character (~). The basic Operations
Hub Payload message uses two keyname value pairs to indicate the metric and the data.
met=<value>~data=<value>

Example: met=Temperature~data=32

• Multi Sensor Device/Gateway Payload format: For devices or gateways with multi sensor
capability the Operations Hub payload supports extra keyname value pairs to allow them to send
extra data.

Supported keynames: The following table provides the keynames that are supported.

Keyname
M2M_data

Field
Storage Format

Met metric String Developer-defined string

Data data String Developer-defined string

Lat latitude String WGS84-recommended for online map
compatibility

Long longitude String WGS84-recommended for online map
compatibility

Time timestamp ISO 8601 “YYYY-MM-
DDThh:mm:ss.sss±TZ”

Alt altitude String Developer-defined value

Desc description String Developer-defined string

Type data_type String Data type of the data field String or
Number

gen1 generic_1 String Developer-defined string or value

gen2 generic_2 String Developer-defined string or value

Note:

• All Operations Hub payload messages must contain the metric and data keyname value pairs.
All other fields are optional.

• The order of the keyname value pairs in the payload is not compulsory.
• If included, Timestamps must be formatted according to the ISO 8601 format specified above.
• Data Type can be specified in cases where Operations Hub does not automatically identify

the data type correctly. For example if you are sending a numeric ID, it should be treated as a
String.

The keynames in the keyname value pairs define the field in the Operations Hub M2M_data entity
where the value will be stored.
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Note:  The latitude and longitude values are also combined and added to the M2M_data LatLong
field.

Payloads with location and timestamp information

Some devices also have a built-in GPS (for example, a car). These devices can also send
GPS latitude and longitude co-ordinates indicating the location of the reading. Many modern
devices can also include the timestamp for the date and time the data was recorded. In this
case, the payload is formatted as a set of keyname value pairs such as met=Speed~data=120~
lat=35.678~long=135.678~time=2014-12-23T07:14:30.546+09:00

Payloads with multiple metrics

In order to reduce the number of calls required to send data from the device, a device that collects
several metrics can send multiple metrics in a single payload. For example, a car device may send
speed, odometer reading, and fuel level as one payload. This can be achieved by concatenating
multiple metrics together in the payload using a semi-colon (;) as the delimiter.

A payload with three metrics appears as follows:
met=Temperature~data=32;met=Pressure~data=12;met=Wind Speed~data=5.

A payload for two metrics with GPS co-ordinates appears as follows:
met=Speed~data=120~lat=35.678~long=135.678;met=Fuel~data=12~

lat=35.678~long=135.678.

A payload including GPS and time details from a multi-sensor weather device appears as follows:

met=Temperature~data=36~lat=35.388628~long=139.673573~time=2014-12-23T07:14:30.546+09:00;
               
 met=Humidity~data=70~lat=35.388628~long=139.673573~time=2014-12-23T07:14:30.546+09:00;
               
 met=Pressure~data=1.2~lat=35.388628~long=139.673573~time=2014-12-23T07:14:30.546+09:00
            

Troubleshooting

About Troubleshooting
This topic contains information to help you troubleshoot issues.

To troubleshoot errors returned for OPC UA and Historian out-of-the-box (OOTB) queries, refer to
Error Codes (page 479) description.

To troubleshoot data source test connection errors, refer to Error Messages (page 491) description.
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Resolving Extension Query Error

If you do not have sufficient privileges to read or write operations, you may run into an error when
attempting to execute the extension query in the end application. The error displays a generic
message.

For example on a write failure, the console shows the following message:

{"status":{"success":false,"code":9998,"reason":"Data distributor response:
 Write request failed: Fail"}}

The Data Distributor log (dataDistributor.log) located at C:\ProgramData\OphubLogs
\DataDistributor displays the following message:

Failed to write to NodeId ns=2;s=Channel1.testr.ss on server
 urn:CHEWY:Intellution.IntellutionGatewayOPCServer:UA%20Server with OPC UA
 error BadUserAccessDenied. Connection to server failed.

To resolve this issue, validate your data source connection, and the credentials to connect to the data
source. In the above example, you would need to check the OPC UA server.

Tags are Not Displayed with an OPC UA Data Source

If tags are not getting displayed when you browse your correctly configured OPC UA data source,
you may have to restart the GE Operations Hub OPC UA Browse Service in your Services console to
resolve this issue.

Domain Redirect Error

DNS issue occurs while trying to access Operations Hub from different machines. To avoid the error,
add hostname and ip address of the machine (where Operations Hub is installed) on to your host
file located here: windows/system32/drivers/etc/hosts.

Importing App Creates Duplicate Data Sources

If you import the application on a clean install, duplicate data sources are created in Operations
Hub. This occurs when Operations Hub does not have a model. When you import an application
containing a model (in a .csv file) and some datasources (in the .xml file), all the data sources
(containing details) that were exported during application export, are also imported. The model is
also imported, which leads to the import of data sources again (without the details for the OPC UA
data sources). This leads to some data sources appearing twice (once from the model, once from the
app xml file).

Workaround: Configure the data source without the alias string for restoring application
connectivity. Delete the duplicate (containing the alias string) if required.The model is associated
with the data sources imported from the model file i.e the ones without the alias name.
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Resolving SQL Connector EndApp Performance Issues

Implement these changes to achieve the best perfomance for your end applications using the SQL
connection database.

1. Browse to the location directory on the machine where Operations Hub is installed: ..
\ProgramData\GE\Operations Hub\iqp-config\IQP\app

2. Open the setting.conf file in a text editor.
3. Enter sqlconnector_runtime_simplejdbccall_lifetime=60000 in a new line at the end

of the file.

This means that the stored procedure meta data cache is refreshed every 60000 milliseconds
(one minute). You can modify the refresh time to your requirement, but enter its value in
milliseconds.

4. Search for sqlconnector_maxConnectionPoolSize=10 and increase the pool size to your
requirement.

Currently, the pool size indicates that you can configure 10 connections for your SQL end
application.

5. Save and close the file.
6. Restart the Operations Hub machine for the changes to take effect.

Unable to Access Data Sources on Single Machine Install

If you installed Historian followed by Operations Hub on the same machine, you were not able to
access DATASOURCES (page 243) in Operations Hub. An error message appears stating, Unable
to load data sources.

The error occurs only when the host name in the URL has mixed/upper-case letters, which get
converted to lower case. To resolve this issue, modify the registry.

1. Run regedit to open the Registry Editor.
2. Navigate to \HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Apache Software
Foundation\Procrun 2.0\WebhmiTomcat\Parameters\Java.

3. In the right pane, double-click Options.

The Edit Multi-String dialog appears.

4. Modify the property -
Dwebhmi.services.auth.fastTokenServices.trustedIssuers=https://pp-hist3/

uaa/oauth/token to append a new URL entry based on the mixed/upper-case host name.

The property is a comma-separated list of multiple URLs. For example,
a URL with upper-case PP-HIST3 is appended to the list here: -
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Dwebhmi.services.auth.fastTokenServices.trustedIssuers=https://pp-hist3/

uaa/oauth/token,https://PP-HIST3/uaa/oauth/token).

5. Restart the GE Operations Hub WebHMI Tomcat Web Server service.

Invalid Token Fix

If upgrading from 2.0 to 2.1, restart the WebClient services to allow the Plant Applications Web
Client to connect successfully to Operations Hub.

• If using Enterprise WebClient version, restart the Docker service.
• If using Standard WebClient version, restart the GE PlantApps WebClient Master Control

service.

Services Not Starting After Reboot

If services do not start up on rebooting a machine, visit the link for steps to modify the registry and
fix the issue:

https://docs.microsoft.com/en-US/troubleshoot/windows-server/system-management-components/
service-not-start-events-7000-7011-time-out-error

The operating system related issue may vary from system to system depending on the resources
being utilized at start up.

Error While Loading Data Sources

After installing Operations Hub 2.1, the error "Can't load DataSources" appears while trying to
access the data sources screen. This issue may occur due to any of the following reasons:

• A Java class cache file may have been corrupted. This file once created, does not change until it
is deleted.

1. Stop the webhmi tomcat service.
2. Delete the only file in this location folder C:\ProgramData\GE\Operations Hub
\webhmi-tomcat\j9aot

3. Start the webhmi tomcat service.
• There may be a mismatch of letter case in the UAA host name. The hostname should be ideally

in lowercase. But, if UAA (standalone or as a part of Historian install) is installed with a mixed
case or capital case, the mismatch can occur leading to the issue.

• IQP tomcat can start up much quicker than webhmi during system start up. It is possible that
the delayed webhmi tomcat start up is interfering with accessing the web UI. A generous wait
period usually resolves this issue.

https://docs.microsoft.com/en-US/troubleshoot/windows-server/system-management-components/service-not-start-events-7000-7011-time-out-error
https://docs.microsoft.com/en-US/troubleshoot/windows-server/system-management-components/service-not-start-events-7000-7011-time-out-error
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Error Codes

The following table outlines the error codes returned to Operations Hub from OPC UA and the Data
Distributor. These codes are returned for OPC UA and Historian out-of-the-box (OOTB) queries as
integers, and can be useful in troubleshooting.

Note:

• Make sure your Operations Hub logged in user matches with the user configured in the
CIMPLICITY project or iFIX node.

• For inline writes to an iFIX or CIMPLICITY mimic with direct tag bindings, make sure that
your data source matches with that of the CIMPLICITY project or iFIX node name.

Code Integer String Description

0x80010000 2147549184 BadUnexpectedError An unexpected error occurred.

0x80020000 2147614720 BadInternalError An internal error occurred as a result of a
programming or configuration error.

0x80030000 2147680256 BadOutOfMemory Not enough memory to complete the
operation.

0x80040000 2147745792 BadResourceUnavailable An operating system resource is not
available.

0x80050000 2147811328 BadCommunicationError A low level communication error
occurred.

0x80060000 2147876864 BadEncodingError Encoding halted because of invalid data
in the objects being serialized.

0x80070000 2147942400 BadDecodingError Decoding halted because of invalid data
in the stream.

0x80080000 2148007936 BadEncodingLimitsExceeded The message encoding/decoding
limits imposed by the stack have been
exceeded.

0x80B80000 2159542272 BadRequestTooLarge The request message size exceeds limits
set by the server.

0x80B90000 2159607808 BadResponseTooLarge The response message size exceeds
limits set by the client.

0x80090000 2148073472 BadUnknownResponse An unrecognized response was received
from the server.

0x800A0000 2148139008 BadTimeout The operation timed out.

0x800B0000 2148204544 BadServiceUnsupported The server does not support the
requested service.

0x800C0000 2148270080 BadShutdown The operation was cancelled because the
application is shutting down.
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0x800D0000 2148335616 BadServerNotConnected The operation could not complete
because the client is not connected to the
server.

0x800E0000 2148401152 BadServerHalted The server has stopped and cannot
process any requests.

0x800F0000 2148466688 BadNothingToDo There was nothing to do because the
client passed a list of operations with no
elements.

0x80100000 2148532224 BadTooManyOperations The request could not be processed
because it specified too many operations.

0x80DB0000 2161836032 BadTooManyMonitoredItems The request could not be processed
because there are too many monitored
items in the subscription.

0x80110000 2148597760 BadDataTypeIdUnknown The extension object cannot be
(de)serialized because the data type id is
not recognized.

0x80120000 2148663296 BadCertificateInvalid The certificate provided as a parameter is
not valid.

0x80130000 2148728832 BadSecurityChecksFailed An error occurred verifying security.

0x81140000 2165571584 BadCertificatePolicyCheckFailed The certificate does not meet the
requirements of the security policy.

0x80140000 2148794368 BadCertificateTimeInvalid The certificate has expired or is not yet
valid.

0x80150000 2148859904 BadCertificateIssuerTimeInvalid An issuer certificate has expired or is not
yet valid.

0x80160000 2148925440 BadCertificateHostNameInvalid The HostName used to connect to a
server does not match a HostName in the
certificate.

0x80170000 2148990976 BadCertificateUriInvalid The URI specified in the
ApplicationDescription does not match
the URI in the certificate.

0x80180000 2149056512 BadCertificateUseNotAllowed The certificate may not be used for the
requested operation.

0x80190000 2149122048 BadCertificateIssuerUseNotAllowed The issuer certificate may not be used for
the requested operation.

0x801A0000 2149187584 BadCertificateUntrusted The certificate is not trusted.

0x801B0000 2149253120 BadCertificateRevocationUnknown It was not possible to determine if the
certificate has been revoked.

0x801C0000 2149318656 BadCertificateIssuerRevocationUnknown It was not possible to determine if the
issuer certificate has been revoked.

0x801D0000 2149384192 BadCertificateRevoked The certificate has been revoked.
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0x801E0000 2149449728 BadCertificateIssuerRevoked The issuer certificate has been revoked.

0x810D0000 2165112832 BadCertificateChainIncomplete The certificate chain is incomplete.

0x801F0000 2149515264 BadUserAccessDenied User does not have permission to
perform the requested operation.

0x80200000 2149580800 BadIdentityTokenInvalid The user identity token is not valid.

0x80210000 2149646336 BadIdentityTokenRejected The user identity token is valid but the
server has rejected it.

0x80220000 2149711872 BadSecureChannelIdInvalid The specified secure channel is no longer
valid.

0x80230000 2149777408 BadInvalidTimestamp The timestamp is outside the range
allowed by the server.

0x80240000 2149842944 BadNonceInvalid The nonce does appear to be not a
random value or it is not the correct
length.

0x80250000 2149908480 BadSessionIdInvalid The session id is not valid.

0x80260000 2149974016 BadSessionClosed The session was closed by the client.

0x80270000 2150039552 BadSessionNotActivated The session cannot be used because
ActivateSession has not been called.

0x80280000 2150105088 BadSubscriptionIdInvalid The subscription id is not valid.

0x802A0000 2150236160 BadRequestHeaderInvalid The header for the request is missing or
invalid.

0x802B0000 2150301696 BadTimestampsToReturnInvalid The timestamps to return parameter is
invalid.

0x802C0000 2150367232 BadRequestCancelledByClient The request was cancelled by the client.

0x80E50000 2162491392 BadTooManyArguments Too many arguments were provided.

0x810E0000 2165178368 BadLicenseExpired The server requires a license to operate
in general or to perform a service or
operation, but existing license is expired.

0x810F0000 2165243904 BadLicenseLimitsExceeded The server has limits on number of
allowed operations / objects, based on
installed licenses, and these limits where
exceeded.

0x81100000 2165309440 BadLicenseNotAvailable The server does not have a license which
is required to operate in general or to
perform a service or operation.

0x002D0000 2949120 GoodSubscriptionTransferred The subscription was transferred to
another session.

0x002E0000 3014656 GoodCompletesAsynchronously The processing will complete
asynchronously.
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0x002F0000 3080192 GoodOverload Sampling has slowed down due to
resource limitations.

0x00300000 3145728 GoodClamped The value written was accepted but was
clamped.

0x80310000 2150694912 BadNoCommunication Communication with the data source is
defined, but not established, and there is
no last known value available.

0x80320000 2150760448 BadWaitingForInitialData Waiting for the server to obtain values
from the underlying data source.

0x80330000 2150825984 BadNodeIdInvalid The syntax of the node id is not valid.

0x80340000 2150891520 BadNodeIdUnknown The node id refers to a node that does
not exist in the server address space.

0x80350000 2150957056 BadAttributeIdInvalid The attribute is not supported for the
specified Node.

0x80360000 2151022592 BadIndexRangeInvalid The syntax of the index range parameter
is invalid.

0x80370000 2151088128 BadIndexRangeNoData No data exists within the range of
indexes specified.

0x80380000 2151153664 BadDataEncodingInvalid The data encoding is invalid.

0x80390000 2151219200 BadDataEncodingUnsupported The server does not support the
requested data encoding for the node.

0x803A0000 2151284736 BadNotReadable The access level does not allow reading
or subscribing to the Node.

0x803B0000 2151350272 BadNotWritable The access level does not allow writing to
the Node.

0x803C0000 2151415808 BadOutOfRange The value was out of range.

0x803D0000 2151481344 BadNotSupported The requested operation is not
supported.

0x803E0000 2151546880 BadNotFound A requested item was not found or a
search operation ended without success.

0x803F0000 2151612416 BadObjectDeleted The object cannot be used because it
has been deleted.

0x80400000 2151677952 BadNotImplemented Requested operation is not implemented.

0x80410000 2151743488 BadMonitoringModeInvalid The monitoring mode is invalid.

0x80420000 2151809024 BadMonitoredItemIdInvalid The monitoring item id does not refer to a
valid monitored item.

0x80430000 2151874560 BadMonitoredItemFilterInvalid The monitored item filter parameter is not
valid.
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0x80440000 2151940096 BadMonitoredItemFilterUnsupported The server does not support the
requested monitored item filter.

0x80450000 2152005632 BadFilterNotAllowed A monitoring filter cannot be used in
combination with the attribute specified.

0x80460000 2152071168 BadStructureMissing A mandatory structured parameter was
missing or null.

0x80470000 2152136704 BadEventFilterInvalid The event filter is not valid.

0x80480000 2152202240 BadContentFilterInvalid The content filter is not valid.

0x80C10000 2160132096 BadFilterOperatorInvalid An unrecognized operator was provided
in a filter.

0x80C20000 2160197632 BadFilterOperatorUnsupported A valid operator was provided, but the
server does not provide support for this
filter operator.

0x80C30000 2160263168 BadFilterOperandCountMismatch The number of operands provided for the
filter operator was less then expected for
the operand provided.

0x80490000 2152267776 BadFilterOperandInvalid The operand used in a content filter is not
valid.

0x80C40000 2160328704 BadFilterElementInvalid The referenced element is not a valid
element in the content filter.

0x80C50000 2160394240 BadFilterLiteralInvalid The referenced literal is not a valid value.

0x804A0000 2152333312 BadContinuationPointInvalid The continuation point provide is longer
valid.

0x804B0000 2152398848 BadNoContinuationPoints The operation could not be processed
because all continuation points have
been allocated.

0x804C0000 2152464384 BadReferenceTypeIdInvalid The reference type id does not refer to a
valid reference type node.

0x804D0000 2152529920 BadBrowseDirectionInvalid The browse direction is not valid.

0x804E0000 2152595456 BadNodeNotInView The node is not part of the view.

0x81120000 2165440512 BadNumericOverflow The number was not accepted because
of a numeric overflow.

0x804F0000 2152660992 BadServerUriInvalid The ServerUri is not a valid URI.

0x80500000 2152726528 BadServerNameMissing No ServerName was specified.

0x80510000 2152792064 BadDiscoveryUrlMissing No DiscoveryUrl was specified.

0x80520000 2152857600 BadSempahoreFileMissing The semaphore file specified by the client
is not valid.

0x80530000 2152923136 BadRequestTypeInvalid The security token request type is not
valid.
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0x80540000 2152988672 BadSecurityModeRejected The security mode does not meet the
requirements set by the server.

0x80550000 2153054208 BadSecurityPolicyRejected The security policy does not meet the
requirements set by the server.

0x80560000 2153119744 BadTooManySessions The server has reached its maximum
number of sessions.

0x80570000 2153185280 BadUserSignatureInvalid The user token signature is missing or
invalid.

0x80580000 2153250816 BadApplicationSignatureInvalid The signature generated with the client
certificate is missing or invalid.

0x80590000 2153316352 BadNoValidCertificates The client did not provide at least one
software certificate that is valid and
meets the profile requirements for the
server.

0x80C60000 2160459776 BadIdentityChangeNotSupported The server does not support changing
the user identity assigned to the session.

0x805A0000 2153381888 BadRequestCancelledByRequest The request was cancelled by the client
with the Cancel service.

0x805B0000 2153447424 BadParentNodeIdInvalid The parent node id does not to refer to a
valid node.

0x805C0000 2153512960 BadReferenceNotAllowed The reference could not be created
because it violates constraints imposed
by the data model.

0x805D0000 2153578496 BadNodeIdRejected The requested node id was reject
because it was either invalid or server
does not allow node ids to be specified
by the client.

0x805E0000 2153644032 BadNodeIdExists The requested node id is already used by
another node.

0x805F0000 2153709568 BadNodeClassInvalid The node class is not valid.

0x80600000 2153775104 BadBrowseNameInvalid The browse name is invalid.

0x80610000 2153840640 BadBrowseNameDuplicated The browse name is not unique among
nodes that share the same relationship
with the parent.

0x80620000 2153906176 BadNodeAttributesInvalid The node attributes are not valid for the
node class.

0x80630000 2153971712 BadTypeDefinitionInvalid The type definition node id does not
reference an appropriate type node.

0x80640000 2154037248 BadSourceNodeIdInvalid The source node id does not reference a
valid node.

0x80650000 2154102784 BadTargetNodeIdInvalid The target node id does not reference a
valid node.
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0x80660000 2154168320 BadDuplicateReferenceNotAllowed The reference type between the nodes is
already defined.

0x80670000 2154233856 BadInvalidSelfReference The server does not allow this type of self
reference on this node.

0x80680000 2154299392 BadReferenceLocalOnly The reference type is not valid for a
reference to a remote server.

0x80690000 2154364928 BadNoDeleteRights The server will not allow the node to be
deleted.

0x40BC0000 1086062592 UncertainReferenceNotDeleted The server was not able to delete all
target references.

0x806A0000 2154430464 BadServerIndexInvalid The server index is not valid.

0x806B0000 2154496000 BadViewIdUnknown The view id does not refer to a valid view
node.

0x80C90000 2160656384 BadViewTimestampInvalid The view timestamp is not available or
not supported.

0x80CA0000 2160721920 BadViewParameterMismatch The view parameters are not consistent
with each other.

0x80CB0000 2160787456 BadViewVersionInvalid The view version is not available or not
supported.

0x40C00000 1086324736 UncertainNotAllNodesAvailable The list of references may not be
complete because the underlying system
is not available.

0x00BA0000 12189696 GoodResultsMayBeIncomplete The server should have followed a
reference to a node in a remote server
but did not. The result set may be
incomplete.

0x80C80000 2160590848 BadNotTypeDefinition The provided Nodeid was not a type
definition nodeid.

0x406C0000 1080819712 UncertainReferenceOutOfServer One of the references to follow in the
relative path references to a node in the
address space in another server.

0x806D0000 2154627072 BadTooManyMatches The requested operation has too many
matches to return.

0x806E0000 2154692608 BadQueryTooComplex The requested operation requires too
many resources in the server.

0x806F0000 2154758144 BadNoMatch The requested operation has no match to
return.

0x80700000 2154823680 BadMaxAgeInvalid The max age parameter is invalid.

0x80E60000 2162556928 BadSecurityModeInsufficient The operation is not permitted over the
current secure channel.

0x80710000 2154889216 BadHistoryOperationInvalid The history details parameter is not valid.
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0x80720000 2154954752 BadHistoryOperationUnsupported The server does not support the
requested operation.

0x80BD0000 2159869952 BadInvalidTimestampArgument The defined timestamp to return was
invalid.

0x80730000 2155020288 BadWriteNotSupported The server does not support writing
the combination of value, status and
timestamps provided.

0x80740000 2155085824 BadTypeMismatch The value supplied for the attribute is not
of the same type as the attribute's value.

0x80750000 2155151360 BadMethodInvalid The method id does not refer to a method
for the specified object.

0x80760000 2155216896 BadArgumentsMissing The client did not specify all of the input
arguments for the method.

0x81110000 2165374976 BadNotExecutable The executable attribute does not allow
the execution of the method.

0x80770000 2155282432 BadTooManySubscriptions The server has reached its maximum
number of subscriptions.

0x80780000 2155347968 BadTooManyPublishRequests The server has reached the maximum
number of queued publish requests.

0x80790000 2155413504 BadNoSubscription There is no subscription available for this
session.

0x807A0000 2155479040 BadSequenceNumberUnknown The sequence number is unknown to the
server.

0x807B0000 2155544576 BadMessageNotAvailable The requested notification message is no
longer available.

0x807C0000 2155610112 BadInsufficientClientProfile The client of the current session does
not support one or more Profiles that are
necessary for the subscription.

0x80BF0000 2160001024 BadStateNotActive The sub-state machine is not currently
active.

0x81150000 2165637120 BadAlreadyExists An equivalent rule already exists.

0x807D0000 2155675648 BadTcpServerTooBusy The server cannot process the request
because it is too busy.

0x807E0000 2155741184 BadTcpMessageTypeInvalid The type of the message specified in the
header invalid.

0x807F0000 2155806720 BadTcpSecureChannelUnknown The SecureChannelId and/or TokenId are
not currently in use.

0x80800000 2155872256 BadTcpMessageTooLarge The size of the message specified in the
header is too large.

0x80810000 2155937792 BadTcpNotEnoughResources There are not enough resources to
process the request.
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0x80820000 2156003328 BadTcpInternalError An internal error occurred.

0x80830000 2156068864 BadTcpEndpointUrlInvalid The server does not recognize the
QueryString specified.

0x80840000 2156134400 BadRequestInterrupted The request could not be sent because of
a network interruption.

0x80850000 2156199936 BadRequestTimeout Timeout occurred while processing the
request.

0x80860000 2156265472 BadSecureChannelClosed The secure channel has been closed.

0x80870000 2156331008 BadSecureChannelTokenUnknown The token has expired or is not
recognized.

0x80880000 2156396544 BadSequenceNumberInvalid The sequence number is not valid.

0x80BE0000 2159935488 BadProtocolVersionUnsupported The applications do not have compatible
protocol versions.

0x80890000 2156462080 BadConfigurationError There is a problem with the configuration
that affects the usefulness of the value.

0x808A0000 2156527616 BadNotConnected The variable should receive its value from
another variable, but has never been
configured to do so.

0x808B0000 2156593152 BadDeviceFailure There has been a failure in the device/
data source that generates the value that
has affected the value.

0x808C0000 2156658688 BadSensorFailure There has been a failure in the sensor
from which the value is derived by the
device/data source.

0x808D0000 2156724224 BadOutOfService The source of the data is not operational.

0x808E0000 2156789760 BadDeadbandFilterInvalid The deadband filter is not valid.

0x408F0000 1083113472 UncertainNoCommunicationLastUsableValue Communication to the data source has
failed. The variable value is the last value
that had a good quality.

0x40900000 1083179008 UncertainLastUsableValue Whatever was updating this value has
stopped doing so.

0x40910000 1083244544 UncertainSubstituteValue The value is an operational value that
was manually overwritten.

0x40920000 1083310080 UncertainInitialValue The value is an initial value for a variable
that normally receives its value from
another variable.

0x40930000 1083375616 UncertainSensorNotAccurate The value is at one of the sensor limits.

0x40940000 1083441152 UncertainEngineeringUnitsExceeded The value is outside of the range of
values defined for this parameter.
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0x40950000 1083506688 UncertainSubNormal The value is derived from multiple
sources and has less than the required
number of Good sources.

0x00960000 9830400 GoodLocalOverride The value has been overridden.

0x80970000 2157379584 BadRefreshInProgress This Condition refresh failed, a Condition
refresh operation is already in progress.

0x80980000 2157445120 BadConditionAlreadyDisabled This condition has already been disabled.

0x80CC0000 2160852992 BadConditionAlreadyEnabled This condition has already been enabled.

0x80990000 2157510656 BadConditionDisabled Property not available, this condition is
disabled.

0x809A0000 2157576192 BadEventIdUnknown The specified event id is not recognized.

0x80BB0000 2159738880 BadEventNotAcknowledgeable The event cannot be acknowledged.

0x80CD0000 2160918528 BadDialogNotActive The dialog condition is not active.

0x80CE0000 2160984064 BadDialogResponseInvalid The response is not valid for the dialog.

0x80CF0000 2161049600 BadConditionBranchAlreadyAcked The condition branch has already been
acknowledged.

0x80D00000 2161115136 BadConditionBranchAlreadyConfirmed The condition branch has already been
confirmed.

0x80D10000 2161180672 BadConditionAlreadyShelved The condition has already been shelved.

0x80D20000 2161246208 BadConditionNotShelved The condition is not currently shelved.

0x80D30000 2161311744 BadShelvingTimeOutOfRange The shelving time not within an
acceptable range.

0x809B0000 2157641728 BadNoData No data exists for the requested time
range or event filter.

0x80D70000 2161573888 BadBoundNotFound No data found to provide upper or lower
bound value.

0x80D80000 2161639424 BadBoundNotSupported The server cannot retrieve a bound for
the variable.

0x809D0000 2157772800 BadDataLost Data is missing due to collection started/
stopped/lost.

0x809E0000 2157838336 BadDataUnavailable Expected data is unavailable for the
requested time range due to an un-
mounted volume, an off-line archive or
tape, or similar reason for temporary
unavailability.

0x809F0000 2157903872 BadEntryExists The data or event was not successfully
inserted because a matching entry exists.
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0x80A00000 2157969408 BadNoEntryExists The data or event was not successfully
updated because no matching entry
exists.

0x80A10000 2158034944 BadTimestampNotSupported The client requested history using
a timestamp format the server
does not support (i.e requested
ServerTimestamp when server only
supports SourceTimestamp).

0x00A20000 10616832 GoodEntryInserted The data or event was successfully
inserted into the historical database.

0x00A30000 10682368 GoodEntryReplaced The data or event field was successfully
replaced in the historical database.

0x40A40000 1084489728 UncertainDataSubNormal The value is derived from multiple values
and has less than the required number of
Good values.

0x00A50000 10813440 GoodNoData No data exists for the requested time
range or event filter.

0x00A60000 10878976 GoodMoreData The data or event field was successfully
replaced in the historical database.

0x80D40000 2161377280 BadAggregateListMismatch The requested number of Aggregates
does not match the requested number of
NodeIds.

0x80D50000 2161442816 BadAggregateNotSupported The requested Aggregate is not support
by the server.

0x80D60000 2161508352 BadAggregateInvalidInputs The aggregate value could not be derived
due to invalid data inputs.

0x80DA0000 2161770496 BadAggregateConfigurationRejected The aggregate configuration is not valid
for specified node.

0x00D90000 14221312 GoodDataIgnored The request specifies fields which are
not valid for the EventType or cannot be
saved by the historian.

0x80E40000 2162425856 BadRequestNotAllowed The request was rejected by the server
because it did not meet the criteria set by
the server.

0x81130000 2165506048 BadRequestNotComplete The request has not been processed by
the server yet.

0x00DC0000 14417920 GoodEdited The value does not come from the real
source and has been edited by the
server.

0x00DD0000 14483456 GoodPostActionFailed There was an error in execution of these
post-actions.

0x40DE0000 1088290816 UncertainDominantValueChanged The related EngineeringUnit has been
changed but the Variable Value is still
provided based on the previous unit.
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0x00E00000 14680064 GoodDependentValueChanged A dependent value has been changed
but the change has not been applied to
the device.

0x80E10000 2162229248 BadDominantValueChanged The related EngineeringUnit has been
changed but this change has not been
applied to the device. The Variable Value
is still dependent on the previous unit but
its status is currently Bad.

0x40E20000 1088552960 UncertainDependentValueChanged A dependent value has been changed
but the change has not been applied to
the device. The quality of the dominant
variable is uncertain.

0x80E30000 2162360320 BadDependentValueChanged A dependent value has been changed
but the change has not been applied to
the device. The quality of the dominant
variable is Bad.

0x00A70000 10944512 GoodCommunicationEvent The communication layer has raised an
event.

0x00A80000 11010048 GoodShutdownEvent The system is shutting down.

0x00A90000 11075584 GoodCallAgain The operation is not finished and needs
to be called again.

0x00AA0000 11141120 GoodNonCriticalTimeout A non-critical timeout occurred.

0x80AB0000 2158690304 BadInvalidArgument One or more arguments are invalid.

0x80AC0000 2158755840 BadConnectionRejected Could not establish a network connection
to remote server.

0x80AD0000 2158821376 BadDisconnect The server has disconnected from the
client.

0x80AE0000 2158886912 BadConnectionClosed The network connection has been closed.

0x80AF0000 2158952448 BadInvalidState The operation cannot be completed
because the object is closed, uninitialized
or in some other invalid state.

0x80B00000 2159017984 BadEndOfStream Cannot move beyond end of the stream.

0x80B10000 2159083520 BadNoDataAvailable No data is currently available for reading
from a non-blocking stream.

0x80B20000 2159149056 BadWaitingForResponse The asynchronous operation is waiting
for a response.

0x80B30000 2159214592 BadOperationAbandoned The asynchronous operation was
abandoned by the caller.

0x80B40000 2159280128 BadExpectedStreamToBlock The stream did not return all data
requested (possibly because it is a non-
blocking stream).
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0x80B50000 2159345664 BadWouldBlock Non blocking behaviour is required and
the operation would block.

0x80B60000 2159411200 BadSyntaxError A value had an invalid syntax.

0x80B70000 2159476736 BadMaxConnectionsReached The operation could not be finished
because all available connections are in
use.

Error Messages
A list of connection errors, their cause, and action to be taken.

These are some of the errors you may encounter when testing a data source connection:

Note:

• Make sure your Operations Hub logged in user matches with the user configured in the
CIMPLICITY project or iFIX node.

• For inline writes to an iFIX or CIMPLICITY mimic with direct tag bindings, make sure that
your data source matches with that of the CIMPLICITY project or iFIX node name.

Error Message Description

Test Connection Failed - Server not reachable. Cause: The hostname or the IP address of the server is
incorrect.

Action: Enter the correct hostname or the IP address.

Test Connection Failed - Security mode or policy not
supported.

Cause: The selected security policy is not supported by
the server.

Action: Select a security policy supported by the server.

Test Connection Failed - Authentication Failed. Cause: The user name or password to login to the sever
is incorrect.

Action: Enter the correct user name or password.

Test Connection Failed - Server not trusted. Cause: The server certificate is not trusted by the
Operations Hub client.

Action: To trust, access the untrusted server certificate,
then select Trust. The server certificate gets copied to the
Operations Hub trusted folder.

Test Connection Failed - Server doesn't trust this client. Cause: Operations Hub client certificate is not trusted by
the server.

Action: Log in to the server, and add the Operations Hub
client certificate to their trusted list.
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Test Connection Failed - Certificate Uri is Invalid. Cause: If upgrading from Operations Hub 2.0 to 2.1, you
need to revert the changes made to the ServerConfig.xml
file.

Action: Follow these steps:

1. Go to C:\Program Files\GE\Operations hub
\BrowseService.

2. Open ServerConfig.xml and search for:

<ServerUri>urn:<machine name in capital
 letters>:proficy:webhmi:dataservices</
ServerUri>

Replace <machine name in capital letters> with
[NodeName].

3. Save and close the XML file.
4. Go to Operations Hub trusted store C:\ProgramData

\GE\Operations Hub\pki\trusted\certs and delete
the existing certificate.

5. Visit your data sources and trust them all over again
to reissue the certificate.

Test Connection Failed - Connection limit on OPC UA
server exceeded.

Cause: You have exceeded the license limitation of clients
on this server.

Action: Get a license issued for this client.

Test Connection Failed to connect the opcua endpoint. Cause: The endpoint url could be incorrect.

Action: Enter the correct endpoint URL in this format:
opc.tcp://hostname:port.

Test Connection Failed - Fields are not filled properly. Cause: The information to establish a connection is either
missing, or invalid.

Action: Enter the correct information.

Configure Logs to Troubleshoot Licensing Issue
With Operations Hub licensing enforcement, you may be asked to purchase a license even when you
have a valid license activated on your license client.

In the event of a licensing issue, follow these steps to enable logging and reveal potential problems
before contacting GE Support.

1. Open the log4j.xml file located here:

C:\ProgramData\GE\Operations Hub\iqp-config\IQP

2. Find the following line of code and change "ERROR" to "DEBUG".



Operations Hub for Windows | 3 - User Guide | 493

<Logger name="com.iqp" level="ERROR" additivity="false">

3. Save and close the log4j.xml file.
4. Replicate the licensing error to log messages in the iqptomcat-stdout.log file located here:

C:\ProgramData\OphubLogs\iqp-tomcat

5. Look for log entries similar to the following:

"2021-3-2 13:24:11  - Project65.isLicenseVersionValid() :
 lc_license_ophub = 20
2021-03-02 14:37:41,720 [pool-6-thread-1] DEBUG
 com.iqp.common.utils.other.lc - LicenseClient.getLicenseValue():
 isLicenseDateValid() = 1 isLicenseVersionValid() = 1
 isLicenseVersionValid() = 4"

Tip:  Look for keywords such as Project65, LicenseClient, and LicenseService to
investigate licensing related issues.

6. Provide the log file details to the Support team.
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